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Introduction 
The Avaya Interaction Center 7.2.4 Release Notes provides information such as enhancements, defects fixed 
and known defects in this release. 

This document provides late-breaking information to supplement Interaction Center software and 
documentation. For updated documentation, product support notices, and service pack information, visit the 
Avaya Support Center Web site at http://support.avaya.com. 

http://support.avaya.com/
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Overview 
Avaya Interaction Center (IC) software updates are distributed in service packs. The Avaya Interaction Center 
(IC) 7.2.4 Service Pack is the fourth service pack for the IC 7.2 release. These software updates are used to 
correct issues and add features not included in the original release of the IC 7.2 system. 

Avaya recommends that all IC 7.2 customers update to this patch level as soon as possible to ensure they 
have a complete set of fixes. IC 7.2.4 does not include a redelivery of the entire IC product. However, IC 7.2.4 
is a cumulative Service pack, containing files from all previous Service Packs on IC 7.2 system (that is IC 
7.2.1, IC 7.2.2, IC 7.2.3 and IC 7.2.3.x Super patches). IC 7.2.4 Service Pack can be installed on any of the 
previous IC Service Packs (that is IC 7.2.1, IC 7.2.2 and IC 7.2.3) OR, any of the SuperPatches (IC 7.2.3.x) 
that were applied on top of IC 7.2.3 Service Pack. 

Please follow instructions in the Release Notes when installing and configuring the IC 7.2.4 Service Pack. It 
contains information, such as known defects and defects fixed in this release, which may not necessarily be 
included in the standard IC 7.2 documentation. The existing features in IC7.2 continue to be in use, unless 
mentioned otherwise in the release notes. 

Also, refer to the Section Product Support Information, under this releasenotes for information that were 
published as PSNs. 

The Release Notes provides detailed installation instructions and configuration information. The Installation 
Tool provided with this service pack is designed to easily install all of the fixes in the IC 7.2.4 Service Pack. 

For additional IC 7.2 documentation information, please refer to: 

 Interaction Center (IC) 7.2 Product Documentation 

 Interaction Center (IC) 7.2 Release Notes 

 Avaya IC for Siebel 7 and 8 Integration Guide 

Supported new features and configurations 

Avaya IC includes support for the following software features and configurations: 

Feature/Configurations IC 7.2.1 IC 7.2.2 IC 7.2.3 IC 7.2.4 

HTML Editor Replacement for Rich Client 

Time in Email Template enhanced to support 24 or 12 hour 
format 

Support for Siebel 7.8.2.13 

SNMP-MIB Enhancement for different OIDs in Traps based on 
priority. 

Ability to enter E-Mail display name in IC Manager 

Options to set column width, size and location of chat tasklist 
in IC agent 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 10 

Feature/Configurations IC 7.2.1 IC 7.2.2 IC 7.2.3 IC 7.2.4 

Service Class OWT data in OA reports 

Workflow Server enhanced to handle large number of 
Workflow channel assignments 

Chat Typing Status Support 

Microsoft SQL Server 2005 SP3 

Workflow Server Modification for Dynamic Queue Contact 
Entry 

Synchronization between Siebel toolbar and Hard phone 

WebAdmin Page Cancel Task with Specified Status 

TSA Server enhanced for Extended UUI Data Support 

Support for IE8 on AAWC - 

Restrict the retries by WACD on requesting the WAA to qualify 
a task when no agent is logged into IC 

- 

Enhanced ASIS to read IC group properties without restart - 

Adding UUID and ALIAS of TS in EDU for IVR application - 

HttpVOX and VOX  support TS.TransferEX method - 

Vox Server to handle extension numbers in excess of 2^31 - 

Monitoring IVR extension using *v assignment - 

Indication by WACD about invalid email requalification 
attempts 

- 

Disable 'Ready/NotReady' button if agent has not logged into 
any channel for IC-Siebel. 

- 

LDAP integration with Avaya Interaction Center    - 

SSL Enabled communication between HTTPConnector Server 
and Dialog Designer 5.1 

- 

Windows 7 support for Avaya Agents and Admin - 
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Feature/Configurations IC 7.2.1 IC 7.2.2 IC 7.2.3 IC 7.2.4 

Deploying Avaya Rich Client on Citrix XenApp 6.0 on Windows 
2008 R2 

- - 

Performance gains in SDK WebServices using DS 
Authentication-Only API over full DS Login. 

- - 

Support for Microsoft Windows 2008 Server R2 (x64) 
(Enterprise Edition*)** 

- - 

Support for Microsoft SQL Server 2008 (v10.50.1600.1*)** - - 

Support for hosting IC website using IIS 7.0 on Windows 2008 
R2 

- - 

Support for hosting IC website using IBM HTTP Server 7.x on 
AIX 6.1 

- - 

Support for deployment of IC on VMWare 4.0 - - 

Oracle Database 11g Client Release 11.2.0.1.0* - - 

Added Hyperlink button in the HTML toolbar for HTML Editor 
(only) in Rich Client. 

- - - 

Windows 7, 32-bit Support -   

Windows 7, 64-bit Support** - - - 

Siebel CRM 8.1.1.x support - - - 

Support for Oracle Database Client Release 11.0.2.1.0 on 
Windows 2008, 64-bit. 

- - - 

* Product has been tested with the specified minor versions. 

** There are limitations in using Advocate Admin and Workflow Designer. Please refer to IC 7.2.4 Known 
Issues section. 

Features not supported 

 Same Time Feature 

"Same Time" feature from Webagent is no longer supported from IC 7.2 release.  

Note: Web agent's tool bar shows Same Time button but it will not work as functionality is not supported. 
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Additional Web Browsers Supported in Service 
Pack IC 7.2.x 

Avaya IC includes support for the following Web Browsers for End-Customer Chat Escalations in Service 
Pack IC 7.2.x. 

Web Browser 

Chrome 2 (End Customer) 

Safari 4 (End Customer) 

Opera 10 (End Customer) 

Mozilla 3.5 (End Customer) 

Internet Explorer 8.0  

Important: Internet Explorer 8 alone supports IV Chat and Collaboration for End Customer use. 

IC 7.2.x interoperability with OA 7.2.x 

 OA 7.2 OA 7.2.1 OA 7.2.2 OA 7.2.3 OA 7.2.4 

IC 7.2 - - - 

IC 7.2.1  - - - - 

IC 7.2.2 - - - - 

IC 7.2.3 - - - 

IC7.2.4 - - - 

The OA 7.2.4 and IC 7.2.4 are all considered "service pack" updates to previous releases. The content of 
these releases is restricted to bug fixes, patch "roll ups", and occasional enhancements. For information 
about the OA 7.2.4 release, see the Operational Analyst 7.2.4 Release Notes. 

IC 7.2.4 interoperability with Communication 
Manager and AES 

This section describes the compatibility of IC 7.2.4 with Communication Manager and AES versions. 
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Communication Manager compatibility matrix: 

Communication Manager Telephony Server running on the operating system 

5.x 

6.0 

Windows 2003 R2 SP2 

Windows 2008 R2 

Solaris 10  

AIX 6.1 

AES compatibility matrix: 

AES 4.2.1 with CVLAN Client 5.2.1 on windows 

AES 4.2.1 with CVLAN Client 3.1 on Solaris and AIX 

Certified 

AES 5.2.1 with CVLAN Client 4.2.1 or 5.2.1 on windows 

AES 5.2.1with CVLAN Client 3.1 on Solaris and AIX 

Supported 

AES 6.1 with CVLAN client 6.1 on win2k8R2 

AES 6.1 with CVLAN client 3.1 on Solaris and AIX 

Certified 

Feature Comparisons of Avaya Agent Clients 

Below table shows the feature comparisons between various Agent clients supported by AIC 7.2.x 

Channel / 
Feature 

   Functionality 
Supported 

Avaya 
Rich 
Client 

Avaya 
Web 
Client 

Avaya 
SDK 
Client 

Avaya 
Siebel 
Native 
Client 

Avaya 
Siebel 
Hybrid 
Client 

Voice Answer 

Blind Transfer 

Consult 

Conference 

Hold/Reconnect 

Wrap 

 Transfer to Virtual 
Queue 

Switch to caller 
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Channel / 
Feature 

   Functionality 
Supported 

Avaya 
Rich 
Client 

Avaya 
Web 
Client 

Avaya 
SDK 
Client 

Avaya 
Siebel 
Native 
Client 

Avaya 
Siebel 
Hybrid 
Client 

Transfer to Agent 

Email Reply / Reply All 

Forward 

Defer 

Use local/global 
resource for 
responses 

Dismiss 

Transfer to Agent 

Transfer to Virtual 
Queue 

*

Wrapup Codes 

HTML Editor 
HyperLink toolbar 
button 

Chat Answer 

Transfer to Agent 

Conference 

Wrap 

Co-browse 

Emoticons 

Chat Typing status 

                                                      

*
 This feature is supported for Avaya Siebel Native Client. However, it has been tested only on IC BA 
(Business Advocate) setup on Windows. 
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Channel / 
Feature 

   Functionality 
Supported 

Avaya 
Rich 
Client 

Avaya 
Web 
Client 

Avaya 
SDK 
Client 

Avaya 
Siebel 
Native 
Client 

Avaya 
Siebel 
Hybrid 
Client 

Join Us     

Transfer to Virtual 
Queue 

Contact History View 

Filter 

Supervisor Monitor/Un-Monitor 

Visible / Invisible 

Multimedia 
Support 

 

Selective After 
Call Work 

 

Product updates and patches 

For a detailed, latest list of all the product updates and patches, visit the Avaya Technical Support Web site 
http://www.avaya.com/support. 

The Avaya Technical Support Web site allows you to download the latest patches and also provides you 
installation instructions. 

IC 7.2.4 Service Pack installation and configuration 
guidelines 

The following steps outline the procedures that need to be performed for installing and configuring the Avaya 
IC 7.2.4 Service Pack. Perform the installation and configuration procedures in exactly the same sequence as 
listed below. 

Note: Skip the steps that are not applicable to your IC environment. 

1. Stop Avaya Agent Web Client. 

2. Stop IC servers, IC services, and Administration and Design. 

3. Ensure your system conforms to the prerequisites. 

4. Ensure that you have a 7.2 License Key before proceeding. 

5. Check whether you have received all the installation files for the IC components included in the IC 7.2.4 
Service Pack. 

http://www.avaya.com/support
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6. Explore the installation options for installing the IC 7.2.4 Service Pack. 

7. Install IC Servers. 

8. Install the Siebel Integration Component. 

9. Install the Avaya Agent Web Client Connector. 

10. Install the Avaya Agent Web Client. 

11. Install Administration and Design. 

12. Install Avaya Agent. 

13. Start IC Servers, IC Services, and Administration and Design. 

14. Perform the following configuration procedures in the sequence given below: 

a. Configure all Server machines 

b. Configure SDK Server 

c. Configure Web Services 

d. Configure Design and Admin 

e. Configure Avaya Agent 

f. Configure Avaya Agent Web Client 

g. Configure the IC - Siebel integration 

15. Start Avaya Agent Web Client. 
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Enhancements 
This section includes the following topics: 

 Enhancements in IC7.2.4 Service Pack 

 Enhancements in IC7.2.3 Service Pack 

 Enhancements in IC7.2.2 Service Pack 

 Enhancements in IC7.2.1 Service Pack 

Enhancements in IC 7.2.4 Service Pack 

 GRIP 5392: Windows 7 64-bit support 

 GRIP 4645: No Autoconnect after Consult cancel 

Windows 7 64-bit support 
IC 7.2.4 supports Windows 7 64-bit for: 

 Avaya Agent (Rich Client) 

 Avaya Agent Web Client (Thin Client) 

 BA Admin Tool 

 BA Config Tool 

 IC Manager 

 Config Tool 

 Config Accelerator 

Support has been added to configure Advocate supervisor on Windows-7, 64 bit.  

Perform the following steps to configure Advocate on Windows 7, 64-bit: 

1. Install IC 7.2 RTM base Design & Admin tools on Windows 64 bit machine 

2. Apply IC 7.2.4 service pack on Windows 64 bit machine. 

3. Run BA configuration tool to configure Business advocate supervisor. (For more information please refer 
"IC 7.2 Business Advocate Configuration and Administration" guide. 

GRIP 4645:No Autoconnect after Consult cancel 
For more information, see the section “GRIP 4645: No Autoconnect after Consult cancel” in the IC 7.2.4 
Configurations section. 

Enhancements in IC 7.2.3 Service Pack 

 Performance gains using DS Authentication-Only API over full DS Login 
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 Deploying Avaya IC on Windows 2008 Server R2 

Performance gains using DS Authentication-Only API 
over full DS Login 
A new DS.Authenticate method is added to authenticate with username and password.  It only performs 
verification of authenticity and expiration of user credentials.  Therefore it is faster than the existing login 
process which queries and updates various tables in the database. IC SDK WebService is also changed to 
use Authenticate method instead of Login.  This reduces the authentication time when calling a WebService. 

Deploying Avaya IC on Win2008 Server R2 
With Avaya IC 7.2.3, support for Windows 2008 Server R2 Operating System has been added. Refer to IC 
7.2.3 Configuration section for detailed configuration guidelines. 

Enhancements in IC 7.2.2 Service Pack 

Below are the enhancements incorporated into IC72 release with Service pack 7.2.2: 

 Support for IE8 on AAWC.  

 Restrict the retries by WACD on requesting the WAA to qualify a task when no agent is logged into IC 

 Enhanced ASIS to read IC group properties without restart 

 Adding UUID and ALIAS of TS in EDU for IVR application 

 HttpVOX and VOX  support TS.TransferEX method. 

 Vox Server to handle extension numbers in excess of 2^31 

 Monitoring IVR extension using *v assignment 

 Indication by WACD about invalid email requalification attempts 

 Disable 'Ready/NotReady' button if agent has not logged into any channel for IC Siebel. 

 Avaya Interaction Center integration with LDAP     

 SSL Enabled communication between HTTPConnector Server and Dialog Designer 5.1 

 Windows 7 support  

Support for IE8 on AAWC 
For more information, please refer to the Avaya Agent Web Client section in Configurations. 

Restrict the retries by WACD on requesting the WAA to 
qualify a task when no agent is logged into IC 
Introducing a new Configuration variable "RequestResourceRetryCount" in WACD server. This parameter 
controls the number of "WACD.RequestResource" re-tries (made to WAA server).For e.g. if it is set to 1, 
WACD will send "WACD.RequestResource", max 2 times (1st time it will try and 2nd time it will retry). 
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This parameter will be used only for chat contacts in Advocate mode. 

In case the "ResourceRequestRetryCount" is not configured or negative value is provided, it is assumed to 
be 1000 (default).  

For more information, please refer to the IC Core Server Configuration section in Configurations 

Enhanced ASIS to read IC group properties without 
restart 
Till IC 7.2.1, after changing any of the group properties, ASIS server needed to be started to have properties 
in effect. In IC 7.2.2 ASIS server is enhanced to read the group properties set in IC manager without 
restarting the server. 

Note:  After changing the group properties, agents need to be relogged-in to have the changed properties in 
effect. 

Adding UUID and ALIAS of TS in EDU for IVR application 
TS is enhanced to add its own UUID and alias name in the edu container voice.x.uuid and voice.x.owner 
respectively. This would help to identify the TS which created that particular EDUID. 

HttpVOX and VOX support TS.TransferEX method 
HttpVOX and VOX are now supporting TS.TransferEx method so that it can preserve the Extended UUI data 
while transferring the call. 

HttpVOX 

A new configuration "Enable Extended Data Support" is added in "HttpVOX" tab of httpVox Server 
Configurations. If this configuration is checked, HttpVOX extract the Extended UUI data from TS.IncomingCall 
event and send it while transferring the call using TS.TransferEx method. If this value is not set,HttpVOX 
would still call the TS.TransferEX method with "NULL" as the extended data. 

By default "Enable Extended Data Support" configuration is unchecked. 

VOX 

A new configuration "Enable Extended Data Support" is added in "VOX" tab of Vox Server Configurations. If 
this configuration is checked, VOX extract the Extended UUI data from TS.IncomingCall event and send it 
while transferring the call using TS.TransferEx method. . If this value is not set, HttpVOX would still call the 
TS.TransferEX method with "NULL" as the extended data. 

By default "Enable Extended Data Support" configuration is unchecked. 

Vox Server to handle extension numbers in excess of 
2^31 
HttpVox and VOX server are now compliant with E.164-based dial plan.  
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Monitoring IVR extension using *v assignment 
HttpVox is changed to assign stations with '*v' criteria by-default, earlier it was *p. This change is incorporated 
to support "Converse-On" step in vector. 

Indication by WACD about invalid email requalification 
attempts 
For invalid email qualification, WACD Admin page shows "waiting for qualification" in RED text. 

Note:  Invalid Qualification means, Workflow to qualify chat or email is not available or it's taking more time to 
do qualification and WACD time out. 

Disable 'Ready/NotReady' button if Siebel agent has not 
logged into any channel for IC Siebel. 
Ready/NotReady button is disabled if agent is not logged in to any channel. The button will be enabled once 
the connection resets and agent is able to log into any channel. 

Avaya Interaction Center 7.2.2 integration with LDAP 
LDAP is widely used in enterprises for user management. IC has been using its own proprietary user 
management facility through repository database to manage users. Due to this, Enterprises end up managing 
users on Active Directory/LDAP as well as in IC separately. This makes synchronization of users difficult e.g. 
when passwords are changed, user accounts are disabled etc. IC integration with LDAP will allow users to be 
in sync with Active Directory/LDAP hence easing the job of user management. 

For more information, please refer Installation and Configuration section for Active Directory/ LDAP   

SSL Enabled communication between HTTPConnector 
Server and Dialog Designer 5.1 
The earlier HTTPConnector was accepting HTTP requests over TCP sockets. It has been enhanced to 
provide additional security to have a secure communication with its SSL enabled clients. 

For configuration, please refer to IC Core Server section in Configurations. 

Avaya Interaction Center supports Windows 7 
Only 32 bit workstations are supported till 7.2.3. 64-bit support has been added in 7.2.4 service pack. 

Refer to Windows 7 64 bit support section for the IC tools and applications supported. 

Enhancements in IC 7.2.1 service pack 

Below are the enhancements incorporated into IC 7.2 release with service pack 7.2.1. 

 HTML Editor Replacement for Avaya Agent Rich Client 

 Time in Email Template Flexible to Allow 24 or 12 hour format 
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 Support for Siebel 7.8.2.13 

 SNMP-MIB Enhancement 

 Ability to enter E-Mail display name in IC Manager 

 Options to set column width, size and location of chat task-list in IC agent 

 Service Class OWT data in OA reports 

 Workflow Server Modification for Dynamic Queue Contact Entry 

 Workflow Server enhanced to handle large number of Workflow channel assignments 

 Chat Typing Status Support 

 Synchronization between Siebel toolbar and Hard phone 

 WebAdmin Page Cancel Task with Specified Status 

 TSA Server enhanced for Extended UUI Data Support  

HTML Editor Replacement for Avaya Agent Rich Client 
This feature provides better HTML editing capabilities for AIC agents. Separate xml files are provided for 
configuring each of the below enabling Agents to use a highly customized email editor. 

 NewOutbound Email 

 Forward/Reply for Email 

 Email Preview 

 Resources Configuration 

Certain properties in Application.properties file are deprecated. Now the properties will be configured in the 
xml files. 

The new HTML editor provides the below functionality: 

 Editing or viewing or previewing resource 

 Editing or viewing or previewing email 

 Hyperlink Support - Hyperlinks will work if present in the email body. 

 Printing support - Editlive does not provide printing thus WebAgent will use JDIC for printing email. 

 Print Screen support 

 EditorUtil provides utility functions for Editor. This includes method that converts plain text to html that 
considers <br> as line break. This needs to be changed to use <p> tags. 

 Html part of email - While sending out an email, the html part needs to have associated style sheet 
declared inline. As of today we take out data within <body> tag. 

 Email Templates - Email Templates should insert <p> tag instead of <br> tag.  

Note: This will impact on existing email templates on deployment site. 

Pre-requisite: Fonts which are configured in the configuration files must already be installed on the machine 
where the Avaya Rich Client is installed before use. 

Additional feature like Email Printing Option is provided using JDIC (Java Desktop Integration Component). 
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In IC721 SP below pop-up screen will appear while printing from WebAgent. 

 

For more information, please refer to the Avaya Agent Rich Client section in Configurations. 

Time in Email Template Flexible to Allow 24 or 12 hour 
format 
In IC 7.2, Time format in the email templates sent from IC display a 24 hour format even though the system 
time is set to 12 hour format. IC7.2.1 SP provides support for 12 hour system time format display in templates 
for countries using languages below. 

 Traditional Chinese 

 Simplified Chinese 

 Korean 

 Japanese 

 Thai 

 English 

For countries using 24 hour time format will continue to observe their existing behavior. 

DST will not be considered for in the 12 to 24 hour conversion and vice-versa. 
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This feature is supported on all platforms supported by IC (Windows/Solaris/AIX). To set the locale on a 
AIX/Solaris Core server machine, please refer to the Configuration Section for IC Core Server Configuration 

Important:  

 The system time format will be used by the %TIME% macro and hence if the 12 hour time format is 
configured, then alone the above is applicable. 

 Any change to the Time Format requires a restart of the IC Servers for the change to take effect. 

Support for Siebel 7.8.2.13 
IC7.2.1 supports Siebel 7.8.2.13, in addition to Siebel 8.0.0.5 and 8.1.1. The integration objects and AICD.ini 
files are shipped with the Service Pack IC7.2.1 that is specific to Siebel 7.8. 

For more information, please refer to the IC – Siebel 7.8 Integration Configuration in configuration section. 

SNMP-MIB 
In IC 7.2 all alarms reported were under the same OID and the descriptions were changed by the IC. Hence, 
NMS could not differentiate alarms based on their priority. In IC 7.2.1 SP, the MIB includes a unique OID for 
alarms based on their priority.  

New OIDs has been added for critical (7), major (8) and minor (9).  The trap will contain one of these OID 
depending on alarm severity. 

Below image contains the added OIDs marked in BOLD. 

 

For information pertaining to configuration, please refer to Installing SNMP-MIB in section Configurations. 

Ability to enter E-Mail display name in IC Manager 
This feature provides the ability to optionally configure a display name for each e-mail account configured in 
AIC. If this feature is configured, for all Outbound emails an display name will be shown to the customer 
instead of e-mail address. 
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For example, on receiving a mail from support@testdomain.com the customers will see Support Test in 
their e-mail client. This provides a user-friendly and logical way for customers to identify emails. 

If Display Name is not configured, customers will continue to see the email address in their emails. Example 
sales@testdomain.com 

Please refer to ICManager Configuration Section to enable this feature.  Ensure the changes to ICManager 
and in ADL files using Database Designer are performed correctly. 

Important:  

 After performing configuration, please restart the DataServer, Directory Server and perform a Manager > 
Refresh on ICManager. This ensures ICManager loads the configured email accounts correctly. 
Otherwise, an error will be reported “Could not load Email Accounts” when trying to view configured Email 
accounts. 

Options to set column width, size and location of chat 
task-list in IC agent 
IC7.2.1 SP provides ability to customize the chat-list attributes like column width, size and location through cdl 
file. These changes will persist over successive logins of Avaya Agent Rich Client.  

Most recent changes either on the running application or changed cdl file, will take precedence over the other 
during the next agent login. 

For configuration details, refer to Database Designer and Avaya Agent Rich Client sections under 
Configurations. 

Service Class OWT data in OA reports 
In IC7.2 the OWT (Oldest Wait Time for OA reports) calculations were based on the EDU.Createtime. From 
IC7.2.1 SP, the definition of OWT is as below: 

OWT: Waiting time of the oldest contact in a Service class Queue. The waiting time being calculated from the 
moment the contact enters the service class and not the time (EDU.Createtime) it entered IC system. The 
time the contact enters the Service class queue is also called as “QueueArrivalTime” (QAT) and 
synonymously called as ResourceRequestDate. 

With the new definition, one can determine how long a call/contact waited in the Service class queue before 
getting assigned to an agent.  

In vespidl.pk, below APIs for ResourceRequest used by servers TSA and WAA have a new parameter added 
(in BOLD), to indicate the time, the ResourceRequest was sent to ResourceManager.  

ResourceManager_RequestRsc/ORBStatus strReqId/string strResourceId/string slQualifiers/*SeqLong 
lOriginalRequestDate/long lFlags/long lTimeoutState/long lTimeoutAction/long lResourceRequestDate/long 
out:sqRequestResult/*SeqCouple; 

ResourceManager_RequestRscExcept/ORBStatus strReqId/string slQualifiers/*SeqLong 
strExceptResourceId/string strResourceId/string lOriginalRequestDate/long lFlags/long lTimeoutState/long 
lTimeoutAction/long lResourceRequestDate/long out:sqRequestResult/*SeqCouple; 

EDU Fields 

In WAA Server 2 new values (sc.state and sc.qat) will be added in the EDU of the contact when it is 
processed by this server. These values have no relevance outside the context of WAA server.  When a 
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contact is sent for ResourceRequest, the ResourceRequestDate will be considered as a Queue Arrival time, 
in case the contact was Queued to a service class.  

TSA Server however does not add any of the fields mentioned to EDU of the contact. 

Important:  

 Merge any previous customization changes to the new vespidl.pk file 

 Do not use the fields, sc.qat and sc.state in EDU. These are only for internal server use. 

Workflow Server Modification for Dynamic Queue 
Contact Entry 
In the Postqualification block in the flows mentioned below, a new EDU parameter (a SeqCouple) has been 
added “arrival_time”. This field by default is set to EDU.Createtime, used for contact priority calculations per 
service class. This field enables Customers to Customize and use the flows to modify the contact priority 
calculations as per their business needs. 

The PostQualification and PostQualificationEx blocks of the below workflows are modified. 

 advocate.qualifyemail_adv 

 advocate.qualifychat_adv 

 advocate.qualifyvoice_adv 

 advocate.handle_exception 

 advocate.transfertoagent_adv 

After performing the IC7.2.1 SP installation steps, do the following steps: 

1. Open Workflow Designer and open ...\IC72\design\IC\Flows\Avaya\Advocate\Advocate.prj 

2. If you are using customized Advocate flows but using OOTB PostQualification & PostQualificationEx 
blocks in those flows then replaces theses blocks with new PostQualification & PostQualificationEx blocks 
from Advocate catalogue in Workflow Designer in all the flows. 

3. If you are using customized PostQualification & PostQualificationEx blocks, then merge your customized 
changes into the new PostQualification & PostQualificationEx blocks. 

4. Build the Advocate.prj flowset. 

5. Restart all the Workflow Servers. 

Note: Following changes are done in new PostQualification & PostQualificationEx blocks in Advocate 
catalogue: “arrival_time” SeqCouple is added into EDU with default value of EDU's createtimet. TSA & 
WAA would use this (arrival_time) time to prioritize the contact in the Service Class queue of RM. 

Workflow Server enhanced to handle large number of 
Workflow channel assignments 
In IC7.2, channel assignment and event-flow association is done through workflow server Configuration Tab. 
This resulted in large vesp.imp and ds.ffd files for huge number of channel associations, which at times could 
result in request timeouts. 
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 In IC7.2.1 SP, the workflow server is enhanced to provide channel assignments through scripts. The Channel 
associations will be loaded by the Workflow Server through "synchronous startup flow" / "startup flow" as 
<project_name>.<script_name> 

 Below methods are introduced at a script level:  

1. ChannelAssign String Range, String InterfaceName, String AssignCreteria 

For example, ChannelAssign "1", "TS", "*r50001"  

2. ChannelAssociate String Range, String EventName, String FlowName 

For example, ChannelAssociate "1", "TS.IncomingCall", "ts.incomingcall" 

These script extensions will now be used in a custom flow (configured as synchronous startup flow/startup 
flow) and the channel assignment and event-flow association information will go into this flow. 
The number of channel assignments for a workflow server is configured using the couple name "assigncount" 
under the server configuration tab. The Maximum recommended value for "assigncount" is 2047. 

Note: Configuring Channel assignments and event-flow associations through script is an additional option. 
Using Configuration Tab for this purpose is Still Supported. 

While configuring Channel & Association through scripts, validating the uniqueness of Range (Channel 
Assign Number) is the responsibility of script writer. The Range of Channel Association should match with 
ChannelAssign. If unique Ranges are not provided in flow script the Workflow server will log this condition and 
will not start. 

Chat Typing Status Support 
IC7.2.1 SP supports the typing status in a live chat in interaction center. This feature provides the typing 
status indication on customer side as well as the agent side with information on who (Agent preferred name / 
customer display name) is typing. 

This feature is supported for below Avaya Agent Clients 

1. Avaya Agent Rich Client 

2. Avaya Agent Web Client 

3. Avaya Agent SDK Client 

Below are features supported in Chat Typing Status support in IC 7.2.1 SP 

1. When agent starts typing, a message is being displayed at customer side that [agent preferred name] is 
typing. 

2. When customer starts typing, a message being shown to agent that [customer display name] is typing 

3. On enter key or say button or push url button, typing status message will be removed 

4. In a multiple-party conference when any one of the party starts typing, a typing status message will be 
displayed to other parties in call. 

5. In a multiple-party conference, when one or more parties are starts typing , a message “ 
[customer_display_name1,  customer_display_name 2] , [Agent_preferred_name1, 
Agent_preferred_name2] typing..” will be displayed to other respective parties in call. 

6. While typing, if a party doesn‟t press the enter/say/push-url button, after specific configurable time-
interval, the message will be removed from other parties side. 

7. After disconnecting and wrapping up a chat call , typing status message will get removed . 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 27 

8. After joining multiple customers in chat call using join-us, all customers‟ typing status will be displayed to 
each other and other parties in call. 

9. Typing status message indication to agent is configurable in website. It is configurable on admin web site. 
Please refer to Website ICM Configuration section and  Avaya Agent Rich Client and ICManager 
Configuration to enable Typing Status Support for Avaya Agent Web Client and SDK Clients.  

Synchronization between Siebel toolbar and hard phone 
In IC7.2.1 Siebel client is enhanced to allow the agents to login back through Siebel browser even if they are 
already logged-into the hard phone. The agent client toolbar and hard phone will be synchronized on agent 
login. Below scenarios are handled in this enhancement. 

Scenario 1 

Enabling an agent to remain logged in to the hard phone on Siebel browser normal/abnormal exit.  

Please refer to Configuration Section to enable this feature. Do NOT perform these steps if you want this 
feature Disabled. 

Scenario 1 Limitation 

 The feature is intended only for ACD/CM based routing. In Advocate based routing, if agent exits from 
Siebel browser, the agent will remain logged-in into the hard-phone but may not receive any queue calls, 
when this feature is enabled. 

 Agents have to logout of hard-phone manually, when this feature is enabled. 

 Once Agents exits from Siebel, IC side reporting will not be effective and call related information will not 
be available. 

 Once Agents exits from Siebel, Email channel will not work and agents will remain logged into hard 
phone. 

Scenario 2 

Agents can login through Siebel browser even if they are already logged-into hard phone and have the toolbar 
in synchronization with hard-phone. 

Please refer to Configuration Section to enable this feature. Do NOT perform these steps if you want this 
feature Disabled. 

Mentioned below are system limitations in the above mentioned Scenarios. 

Scenario 2 Limitation 

When feature for Scenario 2 is enabled and if hard phone is busy or agent is working on a call using hard 
phone then he should not try to login to Siebel. Note, CM does not allow to login to hard phone if phone is 
busy. Hence login will fail. AICD would continue to monitor the extension. 

Note: This enhancement is specific for Avaya CM/Definity Switches. 
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WebAdmin Page Cancel Task with Specified Status 
IC7.2.1 Web Admin pages allow you to cancel task with a specified status, rather than only being able to 
cancel them without any type of reason. The specified status could be any of the resolve statuses configured 
using RLManager.  

The Administrator will have a drop-down-list on the Web Admin Page containing all the resolve statuses 
configured in the system. The Administrator can select any task and cancel it using the appropriate resolve 
status as per business application. 

For information regarding configurations, please refer to section Design and Admin Configuration. 

TSA Server enhanced for Extended UUI Data Support  
In IC7.2.1, the TSA server is enhanced to handle Extended UUI data. A new Server configuration parameter 
“Enable Extended Data Support” is added that should be used to enable/disable handling extended data by 
TSA Server.  

Case 1 

If 'Enable Extended Data Support' configuration parameter is enabled, TSA will first try to get extended UUI 
data from TS events and if unsuccessful then try to get it from EDU. The newer TS APIs will be called along 
with this fetched extended UUI data.  

Case 2 

If 'Enable Extended Data Support' configuration parameter is disabled, TSA will not try to get extended UUI 
data either from TS event or from EDU. The newer TS APIs will be called with NULL / empty extended UUI 
data. 
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Installation 
This section describes the Service Pack Installer that updates existing Avaya IC 7.2 systems with the Avaya 
IC 7.2.4 Service Pack to provide fixes and enhancements for Avaya IC 7.2 

The Installation Tool performs the following steps: 

1. Creates a backup of each file that is replaced by the installer with new files. 

2. Copies the new IC 7.2.4 files into the appropriate directories on your system. 

3. Creates the Uninstaller program. 

4. Displays a screen that confirms a successful installation with the following text: 

Installation was successful. 

No errors or warnings were generated. 

Complete log messages are available at: 

.../IC72/ICServicePacks/7.2.4/<FolderNameOfComponent>/Log/install.log 

Where <FolderNameOfComponent> is the folder name of each component where the respective 
component files reside. 

The Installation Tool provides a separate installation program for each IC component to enable you to 
upgrade your machines based on the component they run. The following table lists the name of the 
component and its respective folder name: 

Component/machine Folder Name 

Administration and Design DesignAdmin 

Avaya Agent client AvayaAgent 

Avaya Agent Web Client WebClient 

Avaya Agent Web Client Connector WebConnector 

IC Servers Server 

Siebel Integration component (IC side) ICSideSiebel 

Siebel Integration component (Siebel side) SiebelSideIC 

For Windows installations, the Installation Tool also: 

 Un-registers the necessary files on your system. 

 Registers the new files on your system. 
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Before you install 

You must have separate machines for each of the IC components because Avaya does not support multiple 
IC components installed on the same machine. 

 IC Servers 

 Avaya Agent 

 Avaya Agent Web Client Connector 

 Administration and Design 

 Siebel Integration component [IC side] 

 Siebel Integration component [Siebel side] 

 SDK 

Note: Expected pop up during 7.2.4 during installation. 

In case an IC installion is being done on a fresh system using the RTM installer, then some error messages 
can popup during the installation of the Service pack. These error messages state that the file being copied 
during the Service pack installation are older than the file which already exists on the system. This is a valid 
scenario, and the customer should replace the existing files with the files being copied by the Service Pack 
installer. 

When installing IC using the RTM installer, the installer adds data regarding the installation location of IC to 
some of the files being installed by the installer. Due to this, the modification time of the file changes to the 
current time. If the IC system was installed during the development phase or after the release of the Service 
pack, then it may happen that some of the files in the service pack have a modification time which is earlier 
than those of the same files installed on the system (due to the RTM installer modifying them, as stated 
above). 

In these cases, it is perfectly valid for the message as described above to pop up during the Service Pack 
installation, and one should go ahead with the installation by chosing the Replace option on the dialog box 
which pops up. 

Stop Avaya Agent Web Client 
Before you run the IC 7.2.4 installation, you must stop the Avaya Agent Web Client. Ensure that all IC Avaya 
Agent Web Clients are logged off prior to stopping the Avaya Agent Web Client. 

On the Avaya IC 7.2 release, you can start and stop the Avaya Agent Web Client component by handling the 
javaw process. 

To start or stop the javaw process 

1. For Windows Operating System, click Start > Run to open command prompt. 

2. Change the directory to: IC_INSTALL_DIR\IC72\bin. 

3. Execute the following command: 

Operating System Procedure 
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Operating System Procedure 

Windows To stop: 

aawcclient.bat stop 

Solaris and AIX To stop: 

./aawcclient.sh stop 

Stop IC services 
Before you run the IC 7.2.4 Server installation, you must stop all the IC services and ensure those services 
are stopped. This may take several minutes because it allows the servers to complete their current tasks 
before shutting down. 

Windows 

To stop the IC Services: 

1. Bring up the Windows Services application. 

2. Stop the following services (some may not exist on every IC server): 

 Avaya IC CIRS Service 7.2 

 Avaya IC Email Template Management Service 7.2 

 Avaya ICM Service 7.2 

 Avaya IC ORB Service 7.2 

 Avaya IC Test Service 7.2 

 Avaya IC Web Management Service 7.2 

 Avaya IC WebLM Service 7.2 

 Avaya Voice Media Manager 

 Avaya SDK Services 

Solaris and AIX 

To stop the IC Services, login with root privileges and navigate to the .../IC72/bin directory: 

1. For ICM 

a. At the command prompt, type:./icm.sh stop –force. 

b. Press Enter. 

2. For CIRS 

a. At the command prompt, type:./cirs.sh stop –force. 

b. Press Enter. 

3. To stop multiple Tomcat instances 
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a. At the command prompt, type:./ictomcat.sh stop all –force. 

b. Press Enter. 

4. To stop a single Web Application 

a. At the command prompt, type:./ictomcat.sh stop <servicename> -force. 

b. Press Enter. 

5. For Sun ONE Server 

a. At the command prompt, type :<SunONE_install_dir>/servers/<my_ONE_server>/stop. 

b. Press Enter. 

6. For IBM http Web Server 

a. At the command prompt, type: ./httpserver.sh stop. 

b. Press Enter. 

Stop the VMM service (Solaris only) 
If you host your Avaya IC servers on Solaris and have VMM service configured, you must stop the VMM 
setup service to configure the Voice Media Manager (VMM) for Voice Chat. The VMM setup service 
configures the VMM to start automatically. 

You must only perform this step if you host your Avaya IC servers on Solaris. Do not perform this step if you 
host your servers on Windows machines. 

To stop VMM on Solaris: 

1. Navigate to the following directory: IC_INSTALL_DIR/IC72/bin 

2. Type the following at the command line: 

./vmm_setup stop 

3. Press Enter. 

Stop IC servers 
Before you run the IC 7.2.4 Server installation, you must stop all the IC servers and ensure all processes are 
stopped. Ensure that all IC Avaya Agents and IC Avaya Agent Web Clients are logged off prior to stopping all 
IC servers. This may take several minutes because the servers need to complete their current tasks before 
shutting down. 

You can stop IC servers on any of the supported platforms using either IC Manager or the Avaya IC Admin 
Utility. 

Windows 

IC Manager 

To stop all the IC servers in the proper order using IC Manager: 

1. Start IC Manager, if it is not already running. 

2. Click the Server tab. 
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3. Select Server > Shutdown. 

4. Select the IP address or the name of the machine on which you want to stop servers. 

5. Click OK. 

Avaya IC Admin Utility 

To stop all IC servers using the Avaya IC Admin Utility on the IC server machine: 

1. In a command window, navigate to the ...\IC72\bin directory. 

2. Stop all IC servers by performing the steps outlined in the following scenarios: 

 To stop IC servers on all/multiple machines (multi-box setup): 

i. At the command prompt, enter the command: icadmin tva <username> <password>. 

ii. Press Enter. 

 To stop IC servers on one machine: 

i. At the command prompt, enter the command: icadmin tv <username> <password>. 

ii. Press Enter. 

Note: Ensure that the login credentials used in the IC Admin Utility command have IC administrative 
privileges. 

Advocate Servers and Administration 

Perform the following steps on each Advocate Administration and Server machine: 

1. Close Advocate Administration. 

2. Click Start > All Programs > Administrative Tools > Component Services. 

3. In Component Services, click Computers > My Computer > COM+ applications > Avaya Business 
Advocate. 

4. Right-click the package and select Shutdown. 

Solaris and AIX 

IC Manager 

To stop all the IC servers in the proper order using IC Manager: 

1. Start IC Manager, if it is not already running. 

2. Click the Server tab. 

3. Click Server > Shutdown. 

4. Select the IP address or the name of the machine on which you want to stop servers. 

5. Click OK. 

Avaya IC Admin Utility 

To stop all IC servers, including the ORB server, using the Avaya IC Admin Utility on the IC server machine: 

1. In a command window, navigate to the .../IC72/bin directory. 
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2. Stop all IC servers by performing the steps outlined in the following scenarios: 

 To stop IC servers on all/multiple machines (multi-box setup): 

i. On the command line, enter the command: ./icadmin tva <username> <password>. 

ii. Press Enter. 

 To stop IC servers on one machine: 

i. On the command line, enter the command: ./icadmin tv <username> <password>. 

ii. Press Enter. 

Note: Ensure that the login credentials used in the IC Admin Utility command have IC administrative 
privileges. 

Ensure all IC servers and services are stopped 

Windows 

1. Go to the Task Manager dialog box. 

2. Click the Process tab to view a list of the processes on your machine. 

3. Check to make sure the IC servers are not running. 

Solaris and AIX 

1. At the command line, type the following command: 

ps -ef | grep <AVAYA_IC72_HOME>/bin | grep -v grep 

2. Press Enter. 

This command displays a list of processes related to IC servers. 

3. Check to ensure the IC servers are not running. 

If any processes related to IC servers are still running, you need to kill all the processes related to IC 
servers. 

4. To kill multiple processes in one command, type the following command: 

kill -9 <PID> 

Where PID is the Process ID of each individual process that is related to IC servers. 

Note: Alternatively, you can type "kill -9 <PID1> <PID2>.... <PIDn>" to kill all the processes in 

a single command. 

5. Press Enter. 

Prerequisites 

This section describes the prerequisites for installing the IC 7.2.4 Service Pack. 
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Prerequisites for installing IC 7.2.4 
1. Before you install IC 7.2.4, you must have IC 7.2 installed on your system. 

2. Microsoft Security Patch released on 20th Jan, 2010, (Cumulative Security Update for Internet Explorer 8 
(KB978207)) - specific to Operating System. Install it, if is not already installed on machines from which 
AAWC will be launched. 

Getting Started 
Avaya IC 7.2.4 is available on the Avaya Support Web site at: http://support.avaya.com/download/ 

To receive the IC 7.2.4 release on a CD, send an email requesting the media (CD) to 
icoakeyrequest@avaya.com with: 

 Customer Name 

 Avaya Sold-to Number 

 Contact Name 

 Contact Address 

 Contact Phone Number 

 What CDs you are requesting 

Obtaining a License Key 
Avaya Interaction Center (IC) and Avaya Operational Analyst (OA) are enabled for run-time operation with a 
license key that provides features and capacity based on your specific order. The information below is 
supplied to assist you in requesting your license keys. 

If you have a valid license key and move to a newer IC and OA release from an earlier release, your license 
key continues to be valid. It contains IC and OA features and capacity you are entitled to with your software 
licensed from Avaya. Unless you have made changes that modify your HostID on the server where the 
license manager is operating you will not need a new license. (For Windows deployments (of WebLM) the 
license is keyed on the server's MAC address, not the HostID) 

License Request 

1. License Key Request (New) 

Send to: icoakeyrequest@avaya.com 

Include: 

 Customer Name 

 Customer Location (city, state, country) 

 Avaya SAP Order Number 

 MAC Address (HostID for Solaris) of all Servers running WebLM Service 

 System Purpose (for example, Production, Test, Lab) 

 Return Email address 

 Implementer of system (Avaya PSO, Avaya Business Partner or SI, self) 

http://support.avaya.com/download/
mailto:icoakeyrequest@avaya.com
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2. License Key Request (Addition/change) 

Send to: icoakeyrequest@avaya.com 

Include: 

 COPY OF CURRENT LICENSE FILE (IMPORTANT) 

 Customer Name 

 Customer Location (city, state, country) 

 If adding - Avaya SAP Order Number 

 Avaya Customer Number 

 If changing - MAC Address (HostID for Solaris) of all Servers running WebLM Service 

 System Purpose (for example, Production, Test, Lab) 

 Return Email address 

 Implementer of system (Avaya PSO, Avaya Business Partner or SI, self) 

Downloading the IC 7.2.4 Service Pack 
You can download the IC 7.2.4 Service Pack files from the Avaya Support site: 
https://support.avaya.com/download/. 

To download IC 7.2.4: 

1. Click the Download My Software link. 

2. At the Login screen, enter your login id and password, and click Login. 

If you do not have an Avaya SSO Login username and password, select Register Now to create them. 
Your username and password must each be at least 6 characters long, the password must also contain at 
least one number. Your username and password cannot be the same. 

3. Click Interaction Center (IC).  

4. Select a release. 

5. Click the appropriate IC 7.2.4 file(s) to download the file(s). 

6. Move the IC 7.2.4 files to an installation directory on the machine on your system where you want to store 
them. 

Important: The name of the installation directory can contain only acceptable characters, such as A-Z, a-
z, 0-9, -, and _, for the installation to run successfully. The Installation wizard does not copy files from a 
directory that contains special characters in its name. 

Installation files 
The following table indicates the machine type, operating system, and the filename for each of the IC 7.2.4 
components: 

Note: The mapped network drive installation option is not available for the Solaris and AIX platforms. 

Component/machine Platform Filename 

https://support.avaya.com/download/
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Component/machine Platform Filename 

Administration and Design  Windows IC724WinAdmin.zip Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Avaya Agent client  Windows IC724WinAgentClient.zip Extract the files into the 
install directory on the local machine or on the 
mapped network drive, depending on the installation 
option you want to follow.  

Avaya Agent Web Client  Windows IC724WinWebClient.zip Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Avaya Agent Web Client 
Connector  

Windows IC724WinWebConnector.zip Extract the files into the 
install directory on the local machine or on the 
mapped network drive, depending on the installation 
option you want to follow.  

Solaris IC724SolWebConnector.tar Extract the files into the 
install directory on the local machine.  

AIX IC724AixWebConnector.tar Extract the files into the 
install directory on the local machine.  

IC Servers  Windows  IC724WinServer.zip Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Solaris  IC724SolServer.tar Extract the files into the install 
directory on the local machine.  

AIX  IC724AixServer.tar Extract the files into the install 
directory on the local machine.  

SDK Servers and Design  Windows, 
Solaris, AIX  

The SDK component files are installed with the IC 
Servers component.  

Siebel Integration component 
(IC side)  

Windows  ICSide724win.zip Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Solaris  ICSide724sol.tar Extract the files into the install 
directory on the local machine.  
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Component/machine Platform Filename 

AIX  ICSide724aix.tar Extract the files into the install 
directory on the local machine.  

Siebel Integration component 
(Siebel side)  

Windows  SiebelSide724win.zip Extract the files into the install 
directory on the local machine or on the mapped 
network drive, depending on the installation option you 
want to follow.  

Solaris  SiebelSide724sol.tar Extract the files into the install 
directory on the local machine.  

AIX  SiebelSide724aix.tar Extract the files into the install 
directory on the local machine.  

Installation options  
Avaya IC 7.2.4 provides the following installation options:  

 Network installation with mapped drive  

 Local installation  

 Silent installation  

 Console installation  

The IC Server components, Siebel Integration component [Siebel side], Siebel Integration component [IC 
side], and Avaya Agent Web Client Connector components are installed on the Windows, Solaris, and AIX 
platforms. All other components are installed on the Windows platform only.  

For version information on all of the supported platforms, see IC 7.2 Installation Planning and Prerequisites.  

Network installation with mapped drive  

You can install IC 7.2.4 from a network (shared) computer to upgrade other machines without having to copy 
the IC 7.2.4 files from the central computer to those machines.  

To enable your local machine to access the network computer, you must map a drive from the local machine 
to the network computer by selecting the Tools > Map Network Drive option in Windows Explorer.  

Note: If Universal Naming Convention (UNC) is not supported, you need to map the drive to be accessed 
from the installation machine. UNC specifies a common syntax for accessing network resources, such as 
shared folders and printers. 

For example, the syntax for Windows systems is as follows: \\computername\sharedfolder\resource  

Local installation  

To install on local machines, copy the component directory (for example, Server, Avaya Agent, or Avaya Web 
Agent Client) from the central machine to the machine where you want to install the component.  
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Silent installation  

When you run installation in silent mode, the user interface is not available. To run the installer in silent mode, 
run record mode followed by silent mode.  

Record mode 

In record mode, the installer runs the installation normally but records all of your inputs in a text file.  

To run the installer in record mode: 

1. Go to the package directory where the contents of the Service Pack installer are extracted. 

2. At the command prompt, type: 

<setupfile> -options-record <AbsolutePathOfFile.ext> 

For example, 

Operating System Command 

Windows setupwin32.exe -options-record "D:\temp\SP724Silent.opt" 

Solaris ./setupsolarisSparc.bin -options-record "/tmp/SP724Silent.opt" 

AIX ./setupaix.bin -options-record "/tmp/SP724Silent.opt" 

Note: The <setupfile> is the platform-specific name of the setup executable and 
<AbsolutePathOfFile.ext> is the qualified file name, where "AbsolutePathOfFile" is the name of the file 
and "ext" is the file extension. 

3. Press Enter. 

The installer creates the <AbsolutePathOfFile.ext> file containing all of your inputs. 

Silent mode 

In a silent mode, rerun the same installation on another system using the inputs from the text file. 

To rerun the installer in silent mode: 

1. Copy the <AbsolutePathOfFile.ext> file to the machine where you want to install. 

2. Go to the package directory where the contents of the Service Pack installer are extracted. 

At the command line, type: 

<setupfile> -options <AbsolutePathOfFile.ext> -silent 

For example, 

Operating 
System 

Command 

Windows setupwin32.exe -options "D:\temp\SP724Silent.opt" -silent 

Solaris ./setupsolarisSparc.bin -options "/tmp/SP724Silent.opt" -silent 
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Operating 
System 

Command 

AIX ./setupaix.bin -options "/tmp/SP724Silent.opt" -silent 

The <setupfile> is the platform-specific name of the setup executable and <AbsolutePathOfFile.ext> is 
the qualified file name, where "AbsolutePathOfFile" is the name of the file and "ext" is the file extension. 

3. Press Enter. 

The installer creates the <AbsolutePathOfFile.ext> file containing all of your inputs. 

Console installation 

When you run installation in console mode, the user interface is not available.  

To run the installer in console mode: 

1. Enter the following command at the command prompt: 

<setupfile> -console 

For example, 

Operating System Command 

Windows setupwin32console.exe -console 

Solaris ./setupsolarisSparc.bin -console 

AIX ./setupaix.bin –console 

Note: The console option can be used for installation and uninstallation of all components. 

Order of installation 

After you complete the instructions for a network installation or a local installation, install the IC 7.2.4 
components in the following order: 

1. Server installation 

2. Siebel Integration Component installation 

3. Avaya Agent Web Client Connector installation 

4. Avaya Agent Web Client installation 

5. Administration and Design installation 

6. Avaya Agent installation 

Server installation 
This section describes the installation procedures for the IC 7.2.4 Server component. The Server component 
can be installed on the Windows, Solaris, and AIX platforms.  
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This section includes the following topics:  

 Windows installation procedures  

 Solaris installation procedures 

 AIX installation procedures  

Note: The files for SDK components are currently bundled with the IC Servers installation package for the 
Windows, Solaris, and AIX platforms. If you have IC setup as a multi-box setup (primary machine, secondary 
machine, and so on), you need to install the IC Servers setup on all these machines.  

Windows installation procedures  

Note: Server installation instructions in this section pertain to existing IC setup on Windows 2003s server.  For 
installation of IC on Windows 2008 R2 server, please refer the relevant chapter in this document. 

Perform the following steps on the Windows machines running IC servers.  

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as explained in 
the sections, Stop IC servers and Stop IC services.  

2. Go to the directory where you extracted the contents of the IC724WinServer.zip file.  

3. Copy the IC724WinServer folder to the machine where you want to install the Server component. If you 
are accessing a network computer through a mapped drive, you do not need to copy the folder. Perform 
the following steps from your server machine.  

4. Open the IC724WinServer folder and double-click setupwin32.exe to start the installation program.  

5. At the Welcome screen, select Next to continue.  

6. At the next screen which displays the location of the Uninstall program, select Next.  

7. In the pop-up window that prompts Please stop all Avaya IC servers and services, click Continue.  

8. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server files to the proper directories.  

c. Registers the new .ocx and .dll files.  

d. Installs the Uninstall program.  

e. Displays the results of the installation.  

If installation is successful, displays:  

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 
...\IC72\ICServicePacks\7.2.4\Server\Log\ins
tall.log 

If installation is unsuccessful, displays:  

ALERT! Installation failed. Please fix these errors and 
re-run the installer. The following errors or warnings 
were generated. Complete log messages are available 
at: ...\IC72\ICServicePacks\7.2.4\Server\Log\install.log 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  

10. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  
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11. If a Telephony Server is configured, take the backup of the tssrv.exe and tssrv.pdb files, and delete the 
files from their current location. Make a copy of the files for your switch and rename the copies to 
tssrv.exe and tssrv.pdb.  

For example: For Avaya DEFINITY/CM, create a copy of cvlansrv.exe and rename it as tssrv.exe in 
theAVAYA_IC72_HOME\bin directory. Similarly, create a copy of cvlansrv.pdb and rename it as tssrv.pdb 
in the AVAYA_IC72_HOME\bin directory. 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  cvlansrv.exe, cvlansrv.pdb  tssrv.exe, tssrv.pdb  

Nortel Meridian  ctsrv.exe, ctsrv.pdb  tssrv.exe, tssrv.pdb  

Aspect CallCenter  tsv5aspectcmi.exe, tsv5aspectcmi.pdb  tssrv.exe, tssrv.pdb 

Cisco ICM tsv5cisco.exe, tsv5cisco.pdb tssrv.exe, tssrv.pdb 

12. If a TSQS Server is configured, take the backup of the tsqssrv.exe and tsqssrv.pdb files, and delete the 
files from their current location. Make a copy of the files for your switch and rename the copies to 
tsqssrv.exe and tsqssrv.pdb.  

For example: For Avaya DEFINITY/CM, create a copy of tsqssrv_asai.exe and rename it as tsqssrv.exe 
in theAVAYA_IC72_HOME\bin directory. Similarly, create a copy of tsqssrv_asai.pdb and rename it as 
tsqssrv.pdb in the AVAYA_IC72_HOME\bin directory. 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  tsqssrv_asai.exe, tsqssrv_asai.pdb  tsqssrv.exe, tsqssrv.pdb  

Nortel Meridian  tsqssrv_rti.exe, tsqssrv_rti.pdb tsqssrv.exe, tsqssrv.pdb 

Aspect CallCenter  tsqssrv_ aspctportal.exe (no .pdb file) tsqssrv.exe 

Cisco ICM tsqssrv_cisco.exe, tsqssrv_cisco.pdb  tsqssrv.exe, tsqssrv.pdb 

13. On the Web Management Services IC machine, delete the folder "localhost" from the following location: 

../IC72/tomcat/work/Catalina/. 

Execute this step only on the Web Management Services IC machine.  

14. If the installation is successful, reboot the machine before you restart the servers.  

Solaris installation procedures  

To have the permissions to run the Solaris installer, you must login with root privileges. Perform the following 
steps on the Solaris machines running IC servers.  

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as explained in 
the sections, Stop IC servers and Stop IC services.  

2. Go to the directory where you uncompressed the contents of the IC723SolServer.tar file.  
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3. At the command line, type: $AVAYA_IC72_HOME/bin/icenv ./setupsolarisSparc.bin (where 
$AVAYA_IC72_HOME/bin/icenv sets the IC environment variables and ./setupsolarisSparc.bin starts the 
Server installation).  

4. On the Welcome screen, click Next.  

5. On the next screen, which displays the location of the Uninstall program, click Next.  

6. In the pop-up window that prompts Please stop all Avaya IC servers and services, click OK.  

7. On the next screen, this displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server files to the proper directories.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  

If installation is successful, displays: 
Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 
.../IC72/ICServicePacks/7.2.4/Server/Log
/install.log 

If installation is unsuccessful, displays:  

ALERT! Installation failed. Please fix these errors and 
rerun the installer. The following errors or warnings were 
generated. Complete log messages are available at: 
.../IC72/ICServicePacks/7.2.4/Server/Log/install.log 

LIST OF ERRORS AND WARNINGS  

8. Click Finish.  

9. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

10. If the tssrv file exists on the system, check to see if this file is a symbolic link to the Telephony Server 
executable.  

a. At the command prompt, type ls -l tssrv.  

b. If the tssrv is a symbolic link to the Telephony Server, the system displays: lrwxrwxrwx filenameA -> 
filenameB (where filenameA is a variable for tssrv and filenameB is the absolute server name).  

11. If the tssrv file is a symbolic link to the Telephony Server, use the existing file without renaming it.  

Switch Use... 

Avaya DEFINITY/CM cvlansrv 

Nortel Meridian ctsrv 

12. If the tssrv file is not a symbolic link to the Telephony Server, take a backup of the tssrv file, and delete 
the file from its current location. Make a copy of the file for your switch and rename the copy to tssrv.  

For example:For Avaya DEFINITY/CM, create a copy of cvlansrv and rename it as tssrv in the   

AVAYA_IC72_HOME/bin directory. 

Switch  Copy...  Rename to...  
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Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  cvlansrv  tssrv  

Nortel Meridian  ctsrv  tssrv  

13. If a TSQS Server is configured, take the backup of the tsqssrv file, and delete the file from its current 
location. Make a copy of the file for your switch and rename the copy to tsqssrv.  

For example: For Avaya DEFINITY/CM, create a copy of tsqssrv_asai and rename it as tsqssrv in the 
AVAYA_IC72_HOME\bin directory. 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  tsqssrv_asai  tsqssrv  

14. Back up the qorasrv file from the ..\IC72\bin folder.  

Note: 

 If you are using an Oracle 10 DB Client, rename qora10srv as qorasrv in the ..\IC72\bin folder.  

 If you are using an Oracle 11 DB Client, rename qora11srv as qorasrv in the ..\IC72\bin folder. 

 On the Web Management Services IC machine, delete the folder "localhost" from the location 
“.../IC72/tomcat/work/Catalina/”. This step is to be executed on only the Web Management Services 
IC system.  

AIX installation procedures  

Before running the Service Pack installer on the AIX platform, you need to kill the processes that use the 
Rogue Wave binary files installed on the system.  

AIX installation prerequisites  

Perform the following steps before carrying out the installation on the AIX platform: 

1. Ensure that all IC components are stopped as explained in the sections, Stop IC servers and Stop IC 
services.  

2. Change directory to $AVAYA_IC72_HOME/lib.  

3. At the command prompt, type: slibclean  

4. At the command prompt, type: fuser -k lib*12d*.a  

Note:  After running the fuser -k lib*12d*.a command, type the following at the command prompt:  

fuser lib*12d*.a  

5. At the command line, type the command: fuser -k lib*.so  

Note:  After running the fuser -k lib*.so command, type the following at the command line:  

fuser lib*.so 

No process IDs should be displayed in the results after running this command. However, even if one 
process ID is displayed in the results, then you need to restart the AIX machine.  
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6. After carrying out the above steps, proceed with the installation on the AIX platform.  

AIX installation  

Perform the following steps on the AIX machines running IC servers.  

Note: To have the permissions to run the AIX installer, you must login with root privileges.  

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as explained in 
the sections, Stop IC servers and Stop IC services.  

2. Go to the directory where you uncompressed the contents of the IC724AixServer.tar file.  

3. At the command prompt, type:  

export AVAYA_IC72_HOME=<Avaya IC Servers installation path>  

For example, export AVAYA_IC72_HOME=/opt/Avaya/IC72  

4. Press Enter.  

5. At the command prompt, type: $ ./setupaix.bin. 

6. On the Welcome screen, click Next.  

7. On the next screen, which displays the location of the Uninstall program, click Next.  

8. In the pop-up window that prompts Please stop all Avaya IC servers and services, click OK.  

9. On the next screen, this displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server files to the proper directories.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  

If installation is successful, displays: Installation 
was successful. No errors or warnings were 
generated. Complete log messages are available 
at: 
.../IC72/ICServicePacks/7.2.4/Server/Log/install.log 

If installation is unsuccessful, displays:  

ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at: 
.../IC72/ICServicePacks/7.2.4/Server/Log/install.log 

LIST OF ERRORS AND WARNINGS  

10. Click Finish.  

11. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

12. If the tssrv file exists on the system, check to see if this file is a symbolic link to the Telephony Server 
executable.  

a. At the command prompt, type ls -l tssrv.  

b. If the tssrv is a symbolic link to the Telephony Server, the system displays: lrwxrwxrwx filenameA > 
filenameB (where filenameA is a variable for tssrv and filenameB is the absolute server name).  

13. If the tssrv file is a symbolic link to the TS, use the existing file without renaming it.  
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Switch  Use... 

Avaya DEFINITY/CM cvlansrv  

14. If the tssrv file is not a symbolic link to the Telephony Server, take a backup of the tssrv file, and delete 
the file from its current location. Make a copy of the file for your switch and rename the copy to tssrv.  

For example, For Avaya DEFINITY/CM, create a copy of cvlansrv and rename it as tssrv in the 

AVAYA_IC72_HOME/bin directory. 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  cvlansrv  tssrv  

15. If a TSQS Server is configured, take the backup of the tsqssrv file, and delete the file from its current 
location. Make a copy of the file for your switch and rename the copy to tsqssrv.  

For example: For Avaya DEFINITY/CM, create a copy of tsqssrv_asai and rename it as tsqssrv in the 

AVAYA_IC72_HOME\bin directory. 

Switch  Copy...  Rename to...  

Avaya DEFINITY/CM  tsqssrv_asai  tsqssrv  

16. On the Web Management Services IC machine, delete the folder "localhost" from the following location: 

.../IC72/tomcat/work/Catalina/. 

This step is to be executed on only the Web Management Services IC system.  

Siebel Integration Component installation  
This section describes the installation procedures for the Siebel Integration Component of the Avaya IC 7.2.4 
release. The Siebel Integration component is installed on the Windows, Solaris, and AIX machines running 
Siebel Services and Avaya IC servers. The Siebel Integration component is to be installed only when your IC 
system is integrated with Siebel.  

The Siebel section includes the following topics:  

 Windows installation procedures  

 Solaris installation procedures  

 AIX installation procedures  

 Import the AICD.def file  

Windows installation procedures  

The Siebel Integration component must be installed on the machine running Siebel Services and the machine 
running IC servers.  

Siebel Integration component on Siebel server  

Perform the following steps on the Windows machines that are running Siebel Services.  
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1. Go to the directory where you extracted the contents of the SiebelSide724win.zip file.  

2. Open the SiebelSide724win folder and double-click on setupwin32.exe to start the installation program.  

3. At the Welcome screen, click Next to continue.  

4. At the next screen, enter the path location for the Siebel Servers installation, click Next. 

For example, C:\seaxx\siebsrvr. 

5. On the next screen, which displays the location of the Uninstall program, click Next.  

6. On the next screen which prompts Please stop all Siebel Services before applying the patch, ensure that 
the Siebel Service is not running and click OK.  

7. On the next screen, this displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server file to the proper directory.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  

If installation is successful, displays: 

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at: 

C:\Seaxxx\siebsrv\ICServicePack\7.2.4\S

iebelSide\Log\install.log 

If installation is unsuccessful, displays: 

ALERT! Installation failed. Please fix these 
errors and re-run the installer. The following 
errors or warnings were generated. Complete 
log messages are available at: 

C:\Seaxxx\siebsrv\ICServicePack\7.2.4\SiebelSi
de\Log\install.log 

LIST OF ERRORS AND WARNINGS  

8. Click Finish. 

9. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

Siebel Integration component on IC servers  

Perform the following steps on the Windows machines that are running IC servers.  

1. Go to the directory where you extracted the contents of the ICSide724win.zip file.  

2. Open the ICSide724win folder and double-click on setupwin32.exe to start the installation program.  

3. At the Welcome screen, click Next to continue.  

4. At the next screen which displays the location of the Uninstall program, click Next.  

5. At the next screen which prompts Please stop all IC Services before applying the patch, ensure that all IC 
Services are stopped and click OK.  

6.  At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server file to the proper directory.  
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c. Installs the Uninstall program.  

d.  Displays the results of the installation.  

If installation is successful, displays: 

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 

...\IC72\ICServicePacks\7.2.4\ICSideSiebel\
Log\install.log 

If installation is unsuccessful, displays: 

ALERT! Installation failed. Please fix these errors and 
re-run the installer. The following errors or warnings 
were generated. Complete log messages are available 
at: 

...\IC72\ICServicePacks\7.2.4\ICSideSiebel\Log\install.lo
g 

LIST OF ERRORS AND WARNINGS  

7. Click Finish.  

8. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

Solaris installation procedures  

The Siebel Integration component must be installed on the machine running Siebel Services and the machine 
running IC servers. To have the permissions to run the Solaris installer, you must login with root privileges.  

Siebel Integration component on Siebel server  

Perform the following steps on the Solaris machines that are running Siebel Services.  

1. At the command line, navigate to the directory where you uncompressed the contents of the 
SiebelSide724sol.tar file. If the file is compressed, untar the file using the tar -xvpf command.  

2. At the command line, type the following command:  

./setupsolarisSparc.bin  

3. Press Enter.  

4. At the Welcome screen, click Next.  

5. At the next screen, enter the path location for the Siebel Servers installation, click Next. (Example, 
root/seaxx/siebsrvr)  

6. The next screen displays the location of the Uninstall program, click Next.  

7. At the next screen which prompts Please stop all Siebel Services before applying the patch, confirm the 
Siebel Service is not running and click OK.  

8. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server file to the proper directory.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  
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If installation is successful, displays: 

Installation was successful. No errors or warnings were 
generated. Complete log messages are available at: 

root/Seaxxx/siebsrv/ICServicePack/7.2.4/SiebelSide/Lo
g/install.log 

If installation is unsuccessful, displays: 

ALERT! Installation failed. Please fix these 
errors and re-run the installer. The following 
errors or warnings were generated. Complete 
log messages are available at: 

root/Seaxxx/siebsrv/ICServicePack/7.2.4/Sieb
elSide/Log/install.log 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  

10. If the installation was unsuccessful, run the Uninstall program. Correct the errors and re-run the 
Installation program.  

Siebel Integration component on IC servers  

Perform the following steps on the Solaris machines that are running IC servers.  

1. At the command line, navigate to the directory where you uncompressed the contents of the 
ICSide724sol.tar file.  

2. At the command line, type the following command: ./setupsolarisSparc.bin. 

3. Press Enter.  

4. On the Welcome screen, click Next.  

5. On the next screen, enter the path location for the IC Servers installation and click Next. 

For example, root/IC72 

6. The next screen displays the location of the Uninstall program, click Next.  

7. On the next screen which prompts Please stop all IC Services before applying the patch, ensure that the 
IC Services are not running and click OK.  

8. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server file to the proper directory.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  

If installation is successful, displays: 

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 

.../IC72/ICServicePacks/7.2.4/ICSideSiebel/L
og/install.log 

If installation is unsuccessful, displays: 

ALERT! Installation failed. Please fix these errors and 
re-run the installer. The following errors or warnings 
were generated. Complete log messages are available 
at: 

.../IC72/ICServicePacks/7.2.4/ICSideSiebel/Log/install.lo
g 

LIST OF ERRORS AND WARNINGS  
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9. Click Finish.  

10. If the installation was unsuccessful, run the Uninstall program. Correct the errors and re-run the 
Installation program.  

AIX installation procedures  

The Siebel Integration component must be installed on the machine running Siebel Services and the machine 
running IC servers.  

Note:  To have the permissions to run the AIX installer, you must login with root privileges. 

Siebel Integration component on Siebel server  

Perform the following steps on the AIX machines that are running Siebel Services.  

1. At the command line, navigate to the directory where you uncompressed the contents of the 
SiebelSide724aix.tar file.  

2. At the command prompt, type: ./setupaix.bin  

3. Press Enter.  

4. On the Welcome screen, click Next.  

5. On the next screen, enter the path location for the Siebel Servers installation, click Next. 

For example, root/seaxx/siebsrvr 

6. The next screen displays the location of the Uninstall program, click Next.  

7. On the next screen, which prompts Please stop all Siebel Services before applying the patch, confirm the 
Siebel Service is not running and click OK.  

8. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server file to the proper directory.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  

If installation is successful, displays: 

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at: 

root/Seaxxx/siebsrv/ICServicePack/7.2.4/SiebelSi
de/Log/install.log 

If installation is unsuccessful, displays: 

ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at: 
root/Seaxxx/siebsrv/ICServicePack/7.2.4/SiebelSide
/Log/install.log 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  

10. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  
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Siebel Integration component on IC servers  

Perform the following steps on the Solaris machines that are running IC servers.  

1. At the command line, navigate to the directory where you uncompressed the contents of the 
ICSide724aix.tar file. If the file is compressed, untar the file using the tar -xvpf command.  

2. At the command line, type: ./setupaix.bin. 

3. Press Enter.  

4. At the Welcome screen, click Next.  

5. At the next screen, enter the path location for the IC Services installation and click Next. 

For example, root/IC72. 

6. The next screen displays the location of the Uninstall program, click Next.  

7. At the next screen which prompts Please stop all IC Services before applying the patch, ensure that the 
IC Services are not running and click OK.  

8. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing server files to that directory.  

b. Copies the new server file to the proper directory.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  

If installation is successful, displays: 

Installation was successful. No errors or warnings 
were generated. Complete log messages are 
available at: 

.../IC72/ICServicePacks/7.2.4/ICSideSiebel/Log/ins
tall.log 

If installation is unsuccessful, displays: 

ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log 
messages are available at: 

.../IC72/ICServicePacks/7.2.4/ICSideSiebel/Log/i
nstall.log 

LIST OF ERRORS AND WARNINGS  

9. Click Finish.  

10. If the installation was unsuccessful, run the Uninstall program. Correct the errors and re-run the 
Installation program.  

Import the AICD.def file  

To import the AICD.def file:  

1. Start the Siebel Servers/Services. 

2. Login to Siebel Thin Client call center application from the web browser as Siebel Administrator.  

3. Navigate to the AICD profile for Siebel, click Site Map > Administration - Communications > All 
configurations.  

4. Select the existing configuration for AICD.  
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5. Click Import Configuration, located on the right side of the window under the Configurations tab.  

Result - A new browser window opens with following text message:  

Caution: Importing communications configuration parameters, commands, events, or drivers and profiles 
will overwrite all existing definitions of those types in the selected configuration. Click Next to proceed.  

6. Click Next.  

7. Select the Commands check box.  

8. Browse to the AICD.def file.  

9. Click OK. 

Avaya Agent Web Client Connector installation  
This section describes the installation procedures for the Avaya Agent Web Client Connector component of 
the Avaya IC 7.2.4 release. You need to install the Avaya Agent Web Client Connector on the machine that 
hosts Tomcat Server.  

 Installation path procedures  

 Windows installation procedures  

 Solaris installation procedures 

 AIX installation procedures  

Installation path procedures  

The IC 7.2.4 installer checks for the installation path through an environment variable or the registry. The 
Avaya Agent Web Client Connector installation path is not stored in an environment variable or in the registry. 
Before starting the Avaya Agent Web Client Connector setup, you must declare the environment variable for 
the installer to use.  

Windows  

To declare the Avaya Agent Web Client Connector installation environment variable on Windows:  

1. Right-click My Computer and select Properties.  

2. Click the Advanced tab.  

3. Click Environment Variables.  

4. In the System variables section, click New.  

5. At the New System Variable dialog box, enter the installation path name and value. 

Field Name  Enter...  

Variable Name  AVAYA_IC72_HOME  

Variable Value  The actual installation path, for example,C:\AvayaWebClientConnector\IC72 

6. Click OK to save the new variable.  

7. On the Environment Variables dialog, click OK.  
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8. On the Advanced tab, click OK.  

9. Run the Avaya Agent Web Client Connector installation procedures described in Windows installation 

procedures.  

Solaris and AIX 

To declare the Avaya Agent Web Client Connector installation environment variable on Solaris or AIX:  

1. At the console, type:  

export AVAYA_IC72_HOME=<Avaya Agent Web Client Connector installation path>  

For example, export AVAYA_IC72_HOME=/opt/AvayaWebClientConnector/IC72  

2. Press Enter.  

3. Run the Avaya Agent Web Client Connector installation procedures described in the following section for 
your operating system:  

Windows installation procedures  

Perform the following steps on the Windows machines that are running the Avaya Agent Web Client.  

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as explained in 
Stop Avaya Agent Web Client.  

2. Go to the directory where you extracted the contents of the IC724WinWebConnector.zip file.  

3. Open the IC724WinWebConnector folder and double-click on setupwin32.exe to start the installation 
program.  

4. On the Welcome screen, click Next to continue.  

5. On the next screen, which displays the location of the Uninstall program, click Next.  

6. On the next screen, this displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing web client connector files to that directory.  

b. Copies the web client connector files to the proper directories.  

c. Copies the files from the Java folder to the proper directories.  

d. Installs the Uninstall program.  

e. Displays the results of the installation.  

If installation is successful, displays: Installation was 
successful. No errors or warnings were generated. 
Complete log messages are available at:  

...\IC72\ICServicePacks\7.2.4\WebConnector\Log\in
stall.log 

If installation is unsuccessful, displays: ALERT! 
Installation failed. Please fix these errors and re-
run the installer. The following errors or warnings 
were generated. Complete log messages are 
available at:  

...\IC72\ICServicePacks\7.2.4\WebConnector\Log
\install.log 

LIST OF ERRORS AND WARNINGS 

7. Click Finish.  
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8. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

Solaris installation procedures  

To have the permissions to run the Solaris installer, you must login with root privileges.  

Perform the following steps on the Solaris machines that are running the Avaya Agent Web Client.  

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as explained in 
Stop Avaya Agent Web Client.  

2. Go to the directory where you uncompressed the contents of the IC724SolWebConnector.tar file. 

3. At the command prompt, type: ./setupsolarisSparc.bin. 

4. Press Enter.  

5. At the Welcome screen, click Next.  

6. At the next screen which displays the location of the Uninstall program, click Next.  

7. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing web client connector files to that directory.  

b. Copies the new web client connector files to the proper directories.  

c. Copies the files from the Java folder to the proper directories.  

a. Installs the Uninstall program.  

b. Displays the results of the installation.  

If installation is successful, displays: 
Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at:  

.../IC72/ICServicePacks/7.2.4/WebConnect
or/Log/install.log 

If installation is unsuccessful, displays: ALERT! 
Installation failed. Please fix these errors and re-run the 
installer. The following errors or warnings were 
generated. Complete log messages are available at:  

.../IC72/ICServicePacks/7.2.4/WebConnector/Log/install

.log 

LIST OF ERRORS AND WARNINGS 

8. Click Finish.  

9. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

AIX installation procedures  

Proceed from the Installing Avaya Agent Web Client Connector on AIX section.  

AIX installation prerequisites  

Perform the following steps before carrying out the installation on the AIX platform: 

1. Ensure that all IC components are stopped as explained in Stop Avaya Agent Web Client.  

2. Change directory to $AVAYA_IC72_HOME/lib.  
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3. At the command line, type the command: slibclean. 

4. At the command line, type the command: fuser -k lib*12d*.a. 

Note: After running the fuser -k lib*12d*.a command, type the following at the command line:  

fuser lib*12d*.a. 

5. At the command line, type the command: fuser -k lib*.so. 

Note: After running the fuser -k lib*.so command, type the following at the command line:  

fuser lib*.so 

No process IDs should be displayed in the results after running this command. However, even if one 
process ID is displayed in the results, then you need to restart the AIX machine.  

6. After carrying out the above steps, proceed with the installation on the AIX platform.  

AIX installation  

Perform the following steps on the AIX machines that are running the Avaya Agent Web Client.  

Note: To have the permissions to run the AIX installer, you must login with root privileges.  

1. Before you begin the Service Pack Installation, ensure that all IC components are stopped as explained in 
Stop Avaya Agent Web Client.  

2. At the command line, navigate to the directory where you uncompressed the contents of the 
IC724AixWebConnector.tar file.  

3. At the command line, type: ./setupaix.bin  

4. Press Enter.  

5. At the Welcome screen, click Next. 

6. The next screen displays the location of the Uninstall program, click Next.  

7. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

8. Creates a backup directory and moves the existing web client connector files to that directory.  

a. Copies the new web client connector files to the proper directories. 

b. Copies the files from the jre folder to the proper directories. 

c. Installs the Uninstall program. 

d. Displays the results of the installation. 

If installation is successful, displays: Installation 
was successful. No errors or warnings were 
generated. Complete log messages are available 
at:  

.../IC72/ICServicePacks/7.2.4/WebConnector/Log/
install.log 

If installation is unsuccessful, displays: ALERT! 
Installation failed. Please fix these errors and re-run 
the installer. The following errors or warnings were 
generated. Complete log messages are available at:  

.../IC72/ICServicePacks/7.2.4/WebConnector/Log/in
stall.log 

LIST OF ERRORS AND WARNINGS 

9. Click Finish.  
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10. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program. 

Avaya Agent Web Client installation  
This section describes the installation procedures for the Avaya Agent Web Client component of the Avaya IC 
7.2.4 release.  

This component must be installed on the machine where the Avaya Agent Web Client package is installed, 
not the deployment machine.  

This section includes the following topics:  

 Installation path procedures  

 Windows installation procedures  

Installation path procedures  

The IC 7.2.4 installer checks for the installation path through an environment variable or the registry. The 
Avaya Agent Web Client installation path is not stored in an environment variable or in the registry. Before 
starting the Avaya Agent Web Client setup, you must declare the environment variable for the installer to use.  

Windows  

To declare the Avaya Agent Web Client installation environment variable on the Windows platform:  

1. Right-click My Computer and select Properties.  

2. Click the Advanced tab.  

3. Click Environment Variables.  

4. In the System variables section, click New.  

5. On the New System Variable dialog, enter the installation path name and value.  

Field Name  Enter...  

Variable Name  AVAYA_WEBCLIENT72_HOME  

Variable Value  The actual installation path, for example,C:\AvayaWebClient\IC72 

6. Click OK to save the new variable.  

7. At the Environment Variables dialog, click OK.  

8. At the Advanced tab, click OK.  

9. Run the Avaya Agent Web Client installation procedures described in Windows installation procedures.  

Windows installation procedures  

Perform the following steps on the Windows machines that are running the Avaya Agent Web Client.  

1. Go to the directory where you extracted the contents of the IC724WinWebClient.zip file.  

2. Open the IC724WinWebClient folder and double-click on setupwin32.exe to start the installation program.  
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3. At the Welcome screen, click Next to continue.  

4. At the next screen which displays the location of the Uninstall program, click Next.  

5. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing web client files to that directory.  

b. Copies the web client files to the proper directories.  

c. Installs the Uninstall program.  

d. Displays the results of the installation.  

If installation is successful, displays: 
Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at:  

...\IC72\ICServicePacks\7.2.4\WebClient\Log
\install.log 

If installation is unsuccessful, displays: ALERT! 
Installation failed. Please fix these errors and re-run the 
installer. The following errors or warnings were 
generated. Complete log messages are available at:  

...\IC72\ICServicePacks\7.2.4\WebClient\Log\install.log 

LIST OF ERRORS AND WARNINGS 

6. Click Finish.  

7. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

8. Once the installation is successful, manually merge the customization files if any, and generate the war 
file and deploy on to the webconnector machines. 

Note: To generate webclient.war file and deploy on Windows/AIX/Solaris Webconnector machines, 
please refer to "IC7.2 Installation and Configuration guide" in Avaya Support Site 
http://support.avaya.com 

Administration and Design installation  
This section describes the installation procedures for the IC 7.2.4 Administration and Design component. This 
component is supported only on the Windows platform.  

Windows installation procedures  

Perform the following steps on each machine where administration tools are installed.  

1. Stop the IC Manager, Avaya Database Designer, and Workflow Designer applications if they are already 
running.  

2. Go to the directory on the central server where you extracted the contents of the IC724WinAdmin.zip file.  

3. Copy the IC724WinAdmin folder to the machine where you want to install the Admin component. If you 
are accessing a network computer through a mapped drive, you do not need to copy the folder. Perform 
the following steps from your administration machine.  

4. Open the IC724WinAdmin folder on the machine from which you want to install.  

5. Double-click the setupwin32.exe to start the installation.  

6. At the Welcome screen, click Next.  

7. At the next screen which displays the location of the Uninstall program, click Next.  

http://support.avaya.com/
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8. In the pop-up window that prompts “Please log out from IC Manager”, click Continue.  

9. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing admin files to that directory.  

b. Copies the new admin files to the proper directories.  

c. Registers the new .ocx and .dll files.  

d. Installs the Uninstall program.  

e. Displays the results of the installation.  

If installation is successful, displays: 

Installation was successful. No errors or 
warnings were generated. Complete log 
messages are available at: 

...\IC72\ICServicePacks\7.2.4\DesignAdmin\L
og\install.log 

If installation is unsuccessful, displays: 

ALERT! Installation failed. Please fix these errors 
and re-run the installer. The following errors or 
warnings were generated. Complete log messages 
are available at: 

...\IC72\ICServicePacks\7.2.4\DesignAdmin\Log\inst
all.log 

LIST OF ERRORS AND WARNINGS 

10. Click Finish.  

11. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  

Importing the sc.xml file  

You must import the sc.xml file to fix configuration related issues in IC Manager. The sc.xml file is located in 
the folder where you unzipped the contents of IC724WinAdmin.zip file.  

To import the sc.xml file: 

1. Rename the existing file <AVAYA_IC72_HOME>\etc\sc.xml to  <AVAYA_IC72_HOME>\etc\sc.xml.bak  

2. Copy the new sc.xml file to <AVAYA_IC72_HOME>\etc.  

Note:  In case, if you have performed any customization in the existing "sc.xml" file, merge that changes 
from "sc.xml.bak" to the new "sc.xml" file you copied in step 2 above.  

3. Log on to IC Manager as Admin.  

4. From the IC Manager, click Manager > Options > Environment tab.  

5. Click the Import Configuration button.  

6. From the Open dialog box, select the sc.xml file that you copied in step 2 above, and click the Open 
button.  

7. If the file is successfully validated, Validate sc.xml dialog box displays a Successfully Validated message. 
If the validation is unsuccessful you will get an xml parsing error.  

Note: If you have merged any previous customization changes in the new sc.xml file, check the xml 
syntax for well-formedness and import the sc.xml file again. 
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Avaya Agent installation 
This section describes the installation procedures for the IC 7.2.4 Avaya Agent (rich client) component. The 
Avaya Agent installation is supported only on the Windows platform.  

Note: You can install the IC 7.2.4 Avaya Agent (rich client) component after all the other IC 7.2.4 Service 
Pack components are installed and configured. You do not require stopping the IC Servers before installing 
the IC 7.2.4 Avaya Agent (rich client) component.  

Installation procedures  

Perform the following steps on each agent workstation.  

1. Stop the Avaya Agent application if it is running.  

2. Go to the directory on the machine where you extracted the contents of the IC724WinAgentClient.zip file.  

3. Copy the IC724WinAgentClient folder to the machine where you want to install the Agent component. If 
you are accessing a network computer through a mapped drive, you do not need to copy the folder. 
Perform the following steps from your agent desktop machine.  

4. Open the IC724WinAgentClient folder and double-click on setupwin32.exe to start the installation 
program.  

5. At the Welcome window, click Next.  

6. The installation runs the Preinstall options which unregister the .ocx and .dll files that are patched in this 
installation.  

7. At the next screen which displays the location of the Uninstall program, click Next.  

8. In the pop-up window that prompts Please logout Avaya Agent, click Continue.  

9. At the next screen which displays the installation summary, click Next to run the installation. The 
Installation Tool:  

a. Creates a backup directory and moves the existing agent files to that directory.  

b. Copies the new agent files to the proper directories.  

c. Registers the new .ocx and .dll files.  

d. Installs the Uninstall program.  

e. Displays the results of the installation.  

If installation is successful, displays: Installation 
was successful. No errors or warnings were 
generated. Complete log messages are 
available at:  

...\IC72\ICServicePacks\7.2.4\AvayaAgent\Log\i
nstall.log 

If installation is unsuccessful, displays: ALERT! 
Installation failed. Please fix these errors and re-run 
the installer. The following errors or warnings were 
generated. Complete log messages are available at: 

...\IC72\ICServicePacks\7.2.4\AvayaAgent\Log\insta
ll.log 

LIST OF ERRORS AND WARNINGS 

10. Click Finish.  

11. If the installation is unsuccessful, run the Uninstall program. Correct the errors and re-run the Installation 
program.  
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12. If the installation is successful, reboot the agent machine.  

Avaya Agent installation in silent mode  

On the Windows platform, you can also run the IC 7.2.4 Avaya Agent installation in silent mode. The silent 
mode option is for Avaya Agent installations on multiple machines.  

To run the installer in silent mode, run record mode followed by silent mode.  

 In record mode, the installer runs the installation normally but records all of your inputs in a text file.  

 In silent mode, re-run the same installation in silent mode on another machine using the inputs from this 
text file.  

Record mode  

To run the installer in record mode:  

1. Click Start > Programs > Accessories > Command Prompt.  

2. Go to the package directory where the contents of the Service Pack installer are extracted.  

3. At the command prompt, type: setupwin32.exe -options-record 

<AbsolutePathOfFile.ext>. 

Note: The <AbsolutePathOfFile.ext> is a placeholder for the qualified complete file name, where 
"AbsolutePathOfFile" is the name of the file and "ext" is the file extension.  

4. Press Enter. 

5. Complete the installation using the information in Avaya Agent installation. The installer creates the 
<AbsolutePathOfFile.ext> file containing all of your inputs.  

Silent mode  

To re-run the installer in silent mode:  

1. Copy the <AbsolutePathOfFile.ext> file to the machine where you want to install.  

2. Click Start > Programs > Accessories > Command Prompt. 

3. Go to the package directory where the contents of the Service Pack installer are extracted.  

4. At the command prompt, type: 

setupwin32.exe -options <AbsolutePathOfFile.ext> -silent  

For example, setupwin32.exe -options "D:\temp\SP724Silent.opt" -silent  

5. Press Enter. 

The installation runs (without a GUI) using the <AbsolutePathOfFile.ext> file for your inputs. 

Start IC servers  
After you complete the Avaya IC 7.2.4 Server installation program, delete all the files under the tomcat cache 

path AVAYA_IC72_HOME\tomcat\\work\Catalina\localhost\rlmanager\org\apache\jsp. Now 

restart the IC servers by running both of these tools in the following order:  

Avaya IC Admin Utility  

To restart the ORB server using the Avaya IC Admin Utility on the server machine:  
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6. At the command prompt, navigate to the following directory:  

 Windows: ...\IC72\bin  

 Solaris and AIX: .../IC72/bin  

7. Type the following command:  

 Windows: icadmin so  

 Solaris and AIX: ./icadmin so  

8. Press Enter.  

IC Manager  

In IC Manager, you must restart the IC servers individually and in the proper order. Before you begin, run the 
procedures described in Avaya IC Admin Utility restart the ORB server.  

To restart IC servers in IC Manager:  

1. Click the Server tab and select the server to be restarted. The following table lists the order in which to 
start the servers.  

2. Click the Start Server button. 

Server Category  Server Name  

Core Engine servers  Alarm server, Data server, Directory server, License server  

Reporting Services  Event Collector server, Report server  

DU (Data Unit) servers  ADU server, DUStore server, EDU server  

Web Management servers  WebACD server, Web Admin Adapter (WAA) server, Attribute server, 
ComHub server, Paging server, Web Schedule Callback  

Email Management servers  IC Email server (requires the WebACD server), CAServer server, 
CAAdmin server  

Telephony servers  Telephony and TSQS servers (all switches), Telephony Server, Adapter 
(TSA) server, Predictive Dialing Kernel (Outbound Contact) server, 
SoftDialer server, VOX server  

Business Logic servers  Workflow server, Blender server, Notification server  

Web and Support servers  HTTP Connector server, WebQ server, WebQ Router server  

Siebel Native Integration  ASIS Server 

Start IC services  
On the Windows platform, after you complete the Avaya IC 7.2.4 Server installation program, all the IC 
Services need to be started if they are not already started.  
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Windows 

The steps given below are for the Windows platform. 

To start the IC Services: 

1. Bring up the Windows Services application.  

2. Start any of the following services that are not already started (some may not exist on every server).  

 Avaya IC CIRS Service 7.2 

 Avaya IC Email Template Management Service 7.2 

 Avaya ICM Service 7.2 

 Avaya IC ORB Service 7.2 

 Avaya IC Test Service 7.2 

 Avaya IC Web Management Service 7.2 

 Avaya IC WebLM Service 7.2  

 Avaya Voice Media Manager 

 Avaya SDK Services 

Solaris and AIX 

The steps given below are for the Solaris and AIX platforms. 

To start the IC Services: 

1. Move to the .../IC72/bin directory.  

2. For ICM  

 At the command prompt, type: ./icm.sh start. 

 Press Enter. 

3. For CIRS  

 At the command prompt, type: ./cirs.sh start  

 Press Enter.  

4. To start multiple Tomcat instances:  

 At the command line, type: ./ictomcat.sh start all  

 Press Enter. 

5. To start single Web application:  

 At the command line, type: ./ictomcat.sh start  <servicename> 

 Press Enter.  

6. For Sun ONE Server  

 At the command line, type: <SunONE_install_dir>/servers/<my_ONE_server>/start  

 Press Enter.  
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7. For IBM http Web Server  

 At the command line, type: ./httpserver.sh start  

 Press Enter.  

Start the VMM service (Solaris only)  
If you host your Avaya IC servers on Solaris and have the VMM service configured, you must restart the VMM 
setup service for Voice Chat. The VMM setup service configures the VMM to start automatically.  

You only must perform this step if you host your Avaya IC servers on Solaris. Do not perform this step if you 
host your servers on Windows machines.  

To run the VMM setup script and start the VMM on Solaris:  

1. Navigate to the following directory: IC_INSTALL_DIR/IC72/bin. 

2. At the command line, type: ./vmm_setup start. 

3. Press Enter.  

Start Avaya Agent Web Client 
After you run the IC 7.2.4 installation, you can start the Avaya Agent Web Client component by handling the 
javaw process. 

To start the javaw process 

1. Click Start > Run to open the command prompt. 

2. Change the directory to: IC_INSTALL_DIR\IC72\bin. 

3. Execute the following command: 

Operating System Procedure 

Windows To start:  

aawcclient.bat start 

Solaris and AIX To start: 

./aawcclient.sh start 
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Configurations 
Note: 

1. Configuring IC 7.2.4 on top of IC 7.2.  

Please follow steps mentioned under IC 7.2.1 Service Pack Configuration, follow steps mentioned in IC 
7.2.2 Service Pack Configuration, follow steps mentioned in IC 7.2.3 Service Pack Configuration and then 
follow steps mentioned in IC 7.2.4 Service Pack Configuration. 

2. Configuring IC 7.2.4 on top of IC 7.2.1. 

Skip IC 7.2.1 Service Pack Configuration if you already configured IC 7.2.1 and follow steps mentioned in 
IC 7.2.2 Service Pack Configuration, IC 7.2.3 Service Pack Configuration and then follow steps 
mentioned in IC 7.2.4 Service Pack Configuration. 

3. Configuring IC 7.2.4 on top of IC 7.2.2. 

Skip IC 7.2.1 Service Pack Configuration and IC 7.2.2 Service Pack Configuration and follow steps 
mentioned in IC 7.2.3 Service Pack Configuration and then follow steps mentioned in Section  IC 7.2.4 
Service Pack Configuration 

4. Configuring IC 7.2.4 on top of IC 7.2.3. 

Skip IC 7.2.1 Service Pack Configuration, IC 7.2.2 Service Pack Configuration and IC 7.2.3 Service Pack 
Configuration if you already configured IC 7.2.1, IC 7.2.2 and IC 7.2.3 directly follow steps in Section IC 
7.2.4 Service Pack Configuration. 

Note: Configuration instructions for Windows server and Citrix virtualiztaion for Rich Client under IC 7.2.1 and 
7.2.2 configuration sections are for existing deployments on Windows 2003 Server.  For Windows 2008 R2 
server deployment, refer relevant chapter in this document. 

IC 7.2.1 Service Pack Configuration 

Below Section provides the component-wise configurations. Please note the sub-sections mentions 
configurations for specific features. 

 Deploying Avaya Rich Client on Citrix presentation Server v4.5 

 ICManager 

 Database Designer 

 Avaya Agent Rich Client 

 IC – Siebel 7.8 Integration Configuration 

 Siebel configuration for Hard phone-browser synchronization 

 ASIS Server env.properties file parameters 

 Installing SNMP-MIB file 

 Website and ICM 

 Workflow 

 Design and Admin Configuration 
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 IC Core Server Configuration 

 SDK Server Configuration 

 Configuring Web Services 

Deploying Avaya Rich Client on Citrix presentation 
Server version 4.5 
This section provides detailed information on how to deploy Avaya Rich client on Citrix presentation server 
version 4.5. 

Install Avaya Rich client on Citrix server 

To install Avaya Rich client, refer IC72install.pdf. 

Deploying Avaya Rich client on Citrix server 

1. Launch Citrix Access Management Console. 

2. Right-click the Presentation Server option under the Citrix Resources node and select Create a new Citrix 
Farm. 

 

3. Right click NewFarmCitrix > Applications and select New > Publish application. 

4. Click the Next button on the welcome screen. 

5. Enter the application display name and description and Click Next.  

6. On the Publish Application screen, select the Installed application option and click Next. 
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7. Browse and select “qui.exe” path in command line. 

Note: Working directory path is automatically reflected. 

 

8. Modify command line path “C:\Program Files\Avaya\bin\qui.exe” to below text 

"C:\Program Files\Avaya\bin\qui.exe" -d C:\Program Files\Avaya\apps\interaction_center -n 
interaction_center, if AVAYA_IC72_HOME resides on C drive. Else, select the appropriate drive and path. 
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9. Click the Add button at the bottom of the screen. 

10. Select Citrix server name and click OK button. 

11. Click Next. 

 

12. Select allow only configured users option (You can select Allow anonymous users option) 

13. Click the Add button. 
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14. Add users, click OK button 

15. On adding Users successfully, Click Next. 

16. Click Next on the screen below. 

 

17. Select Configure advanced application settings now and click Next. 
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18. Access control should be any connection (You can set appropriate filter also), click Next. 

19. Leave redirection option click Next. 

 

20. Select maximum number of instance that are allowed to run in server farm 

21. If you want only one instance of application for each user then select “Allow only one instance of 
application for each user” option and Click on Next button 

22. Click Next on the Client options screen. 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 70 

 

23. Select appropriate Session window size and Colors and Click Finish. 

24. Verify that rich client application is added under Citrix applications. The published application setting can 
be changed from Citrix access management console 

Modifying the Avaya Agent INI file  

1. Update the Citrix server's qui.ini file with the following two lines  

[QConsole] 

ResizeDesktop=FALSE  

2. Save the qui.ini file 

Using same system user for logging multiple Citrix ICA clients 

To use same system user for logging more than two session of Avaya rich client, set “Restrict each user to 
one session” to No under terminal services configuration. 
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. 

Creating ICA (Citrix Client) connection with Citrix server  

1. Install Citrix Program Neighborhood on Windows XP / 2003 machine 

2. Open Citrix Program Neighborhood from Citrix client machine 

3. Add new ICA connection 

4. Select Local Area Network and Click on next button 

5. Enter a Description for the new ICA connection 

6. Select network protocol 

7. Select the Published Application you want to connect. 

Note: Selecting server option it will do direct RDC to Citrix server 

8. Click on Server Location button and add Citrix server name 
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9. Click OK 

10. Select published application name and click on next button 

 

11. Select published view option. And click on next. Select appropriate option  

12. Select encryption level and click on next (Use default) 

13. Enter login credential of Citrix server 

Note: User should have access permission of published application from Citrix presentation server. 

14. Select the display options and click on Next. 
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15. Click Finish 

16. Observe that connection is added under Citrix Program Neighborhood. 

17. Double-click the added connection. It will open start session from server side, after you can access 
published applications. 

ICManager 
This section describes configuration requirements for IC7.2.1 ICManager  

 Enabling Email Display Name in ICManager 

 Enabling Chat Typing Status for Avaya WebClient and Avaya SDK Clients 

Configuring ICManager to enable Email Display name 

In ICManager > Services > Email Accounts tab, open an existing email account. Please note the addition of a 
new field Display Name as in the sample snapshot below in the Email Accounts tab. 

 

Note: Display Name by default will be empty. IC administrator needs to add a „Display Name‟ to use this 
feature. 

On Adding a Display Name value, for example “Support Test”, this name will appear in the Email Accounts 
Tab as below:  
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Consider the example above, the Customers will see “From” address in their email clients as “Support Test”  
for replies to emails sent to support@testdomain.com.  And while mails received as reply to emails sent to 
sales@testdomain.com will contain “From” address as sales@testdomain.com. 

ICManager will save the Display name in database in UTF-8 charset with 64-bit encoding. Hence, all the 
languages supported by AIC 7.2.1 supports this feature. 

Enabling Chat Typing Status for Avaya WebClient and Avaya 
SDK Clients 

To Enable Chat Typing Status for Avaya Agent WebClient and SDK Clients, modify following properties in IC 
Manager in section Agent/Desktop/Chat/Application. 

 ShowTypingStatus = true 

 TypingStatusThreshold=12 

Database Designer 
This section describes configuration requirements for IC7.2.1 Database Designer.  

 Display Name 

 ChatList 

Adding Display Name field to database table 

IMPORTANT: It is mandatory to perform changes to both ccq.adl and repository.adl as per below instructions. 
Use of the „Display Name‟ feature is optional; however the configurations are mandatory, as the changes are 
made to the IC core schema tables. 

On Design and Admin machine, modify the ccq.adl and repository.adl using the Database Designer 
application and Re-Configure the database. 

Please follow the steps below: 

1. On the Design machine, launch the Database Designer application. 

mailto:support@testdomain.com
mailto:sales@testdomain.com
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2. Select Open from the File menu. 

3. Select the "...\<AVAYA_IC72_HOME>\design\CallCenterQ\ccq.adl" file. 

4. Navigate to "Components->Tables->qem_mailaccount" table. 

5. Right Click and select "New Field..." option. A dialog will pop up. 

6. Enter field name as "displayname" and description. Click Next. 

7. Enter the database field name as "displayname". 

8. Select Type as "Variable Char". Read-only: NO. 

Enter the length of the field as: 

Windows 1024 

Solaris 342 

AIX 192 

Field Required: No 

9. Click Next. 

10. Leave the default value blank. Click Finish. 

11. Click File > Save. 

12. Now, reconfigure the Database and Generate Windows Application using the normal reconfiguration       
procedure. (Please refer Admin guide --admin1.pdf--for detailed steps) 

13. After reconfiguration is completed, click “close” on the “File” Menu to close the adl file. 

14. Repeat the steps 1 through 12 for "...\<AVAYA_IC72_HOME>\design\repository\repository.adl" file.  

15. Click File > Close to close the adl file.   

NOTE: After performing above configuration, please restart the DataServer, Directory Server and perform a 
Manager->Refresh on ICManager. This ensures ICManager loads the configured email accounts   correctly. 
Otherwise, an error will be reported “Could not load Email Accounts” when trying to view configured Email 
accounts. 

ChatList – Changes to Scripts files and localized CDL files 

You need to perform the below steps on the Design and Admin machine to enable the ChatList feature 

Below section is added in the localized .cdl files which enable you customize Chat-List width, size, location 
etc. 

This section can be used to customize the chat-list. 

<QSection Name="ChatList" 

Columns="{0,16,'',''},{0,16,'',''},{1,16,'Name',''},{2,54,'Duration',''},{3,54,'Wa

iting',''}"/> 

Note: The above section will be localized for each of the .cdl files. 

Perform the following steps on the Design and Admin machine using localized .cdl files. 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 76 

1. Exit the Avaya Agent if it is running. 

2.  Backup the following files: 

  ...\IC72\design\QConsole\QConsole_InitializeComponents.qsc 

  ...\IC72\design\QConsole\avaya_agent_en.cdl 

3. Replace the files you backed up with the files of the same name from IC7.2.1 SP. 

4. Copy ChatList_Initialize.qsc to ...\IC72\design\QConsole folder. 

5. Start the Avaya Database Designer. 

6. Load the CCQ.ADL file in the ...\IC72\design\CallCenterQ directory. 

7. Incorporate any previous in-house customizations done in these replaced script files. 

8. Generate Windows Application. 

Avaya Agent Rich Client 
This section describes configuration requirements for IC7.2.1 Avaya Agent Rich Client for following features. 

 HTML Editor Replacement for Rich Client 

 Enabling Options to set column width, size and location of chat task list 

 Chat Typing Status 

HTML Editor Replacement for Rich Client 

When you install IC721 Rich Client, a new folder “..\IC72\WebAgent\editlive” will be created. This folder will 
contain the following xml configuration files: 

 NewOutboundEmail.xml 

 PreviewEmailConfig.xml 

 ReplyForwardEmailConfig.xml 

 ResourcesConfig.xml 

The above files contain the configuration parameters to configure the text plain/Html properties for specific 
functions as the name of the xml suggests. 

Application.properties file: This file contains a property to Enable/Disable the editor logging using the property 
email.editor.log.level. By default this property is disabled. Default value is email.editor.log.level=false 

This property can be used to debug the editor. 

Important: If the Shared Path “HomeDir” for WebAgent is configured in ICManager, using the property 
“Agent/Desktop/WAC“, then copy the folders lexicons, images and editlive under this path. 

Below properties of Application.properties file are deprecated: 

 email.edit.defaultNewFont 

 email.edit.defaultNewFontSize 

 email.edit.defaultReplyFont 

 email.edit.defaultReplyFontSize 
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 email.HtmlNewMessage.r 

 email.HtmlNewMessage.g 

 email.HtmlNewMessage.b 

 email.HtmlReplyMessage.r 

 email.HtmlReplyMessage.g 

 email.HtmlReplyMessage.b 

Default style-sheet can be configured for email reply/replyall, forward, new outbound etc. by configuring the 
following HTML p-tag in the appropriate xml configuration file.  

For example: 

<style type="text/css"> 

   p{ 

   font-family: Arial; 

   font-size: 12pt; 

   color:rgb(0,0,0) 

   } 

body{ 

   font-family: Arial; 

   }     

   p{ 

    margin: 0 1 

    } 

</style> 

Default fonts can be configured for Email Reply/Forward, New Outbound Email and Email Resources. 

The configuration xml file contains options to add/remove a toolbar button and shortcut menus. Inserting text 
can be performed using <br> or <p> which can be configured using the property “brOnEnter“ set to true. 

Font family (size, font‐face) can be updated under toolbar format section. Few attributes are disabled under 

section <wysiwygEditor>, like the element showTableGridlines. The property showTableGridlines for 
example is used to display GRID when text, table, paragraph is inserted in HTML Editor. 

Sample configuration file for Email Reply/Forward is as below: 

<?xml version="1.0" encoding="US-ASCII"?> 

<editlive> 

    <document> 

       <html> 

            <head> 

                <style type="text/css"> 
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              p{ 

                    font-family: Arial; 

                    font-size: 12pt; 

                    color:rgb(0,0,0) 

                    } 

                body{ 

                    font-family: Arial; 

                    }     

                   p{ 

                    margin: 0 1 

                    } 

               </style> 

            </head> 

            <body> 

            </body> 

        </html>     

    </document> 

    <htmlFilter allowUnknownTags="true" commentStyles="true" 

        encloseText="true" indentContent="false" logicalEmphasis="true" 

        outputXHTML="true" outputXML="false" quoteMarks="false" 

        uppercaseAttributes="false" uppercaseTags="false" wrapLength="0"/> 

    <wysiwygEditor brOnEnter="false" disableInlineImageResizing="false" 

        disableInlineTableResizing="false" enableTrackChanges="false" 

        showDocumentNavigator="false" showGridlines="false" 

        showSectionGridlines="false" showTableGridlines="false"  

        tabPlacement="off" > 

    <plugins> 

     <plugin name="autolink" /> 

     <plugin name="insertHTML" /> 

     <plugin name="imageEditor" /> 

     <plugin name="BrokenHyperlinkReport" /> 

    </plugins> 

    <sourceEditor enabled="true" showBodyOnly="true"/> 

    <wordImport styleOption="merge_inline_styles"/> 

    <htmlImport styleOption="merge_inline_styles"/> 
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    <menubar showAboutMenu="false"/> 

    <toolbars> 

        <toolbar name="Format"> 

            <toolbarComboBox name="face"> 

                <comboBoxItem name="Arial" text="Arial"/> 

                <comboBoxItem name="Arial Black" text="Arial Black"/> 

                <comboBoxItem name="Arial Narrow" text="Arial Narrow"/> 

                <comboBoxItem name="Comic Sans MS" text="Comic Sans MS"/> 

                <comboBoxItem name="Courier New" text="Courier New"/> 

                <comboBoxItem name="Georgia" text="Georgia"/> 

                <comboBoxItem name="Impact" text="Impact"/> 

                <comboBoxItem name="Times New Roman" text="Times New Roman"/> 

                <comboBoxItem name="Trebuchet MS" text="Trebuchet MS"/> 

                <comboBoxItem name="Gautami" text="Gautami"/> 

                <comboBoxItem name="latha" text="latha"/> 

                <comboBoxItem name="mangal" text="mangal"/> 

                <comboBoxItem name="shruti" text="shruti"/> 

            </toolbarComboBox> 

            <toolbarComboBox name="size"> 

                <comboBoxItem name="1" text="8"/> 

                <comboBoxItem name="2" text="10"/> 

                <comboBoxItem name="3" text="12"/> 

                <comboBoxItem name="4" text="14"/> 

                <comboBoxItem name="5" text="18"/> 

                <comboBoxItem name="6" text="24"/> 

                <comboBoxItem name="7" text="36"/> 

            </toolbarComboBox> 

            <toolbarSeparator/> 

            <toolbarButton name="bold"/> 

            <toolbarButton name="italic"/> 

            <toolbarButton name="underline"/> 

            <toolbarSeparator/> 

            <toolbarButtonGroup name="align"/> 

            <toolbarSeparator/> 

            <toolbarButtonGroup name="list"/> 
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            <toolbarSeparator/> 

            <toolbarButton name="highlightcolor"/> 

            <toolbarButton name="color"/> 

            <toolbarButton name="imageserver"/> 

        </toolbar> 

    </toolbars> 

    <shortcutMenu> 

        <shrtMenu> 

            <!-- <shrtMenuItem name="undo"/> --> 

            <shrtMenuItem name="redo"/> 

            <shrtMenuSeparator/> 

            <shrtMenuItem name="cut"/> 

            <shrtMenuItem name="copy"/> 

            <shrtMenuItem name="paste"/> 

            <shrtMenuSeparator/> 

            <!-- <shrtMenuItem name="select"/> --> 

            <shrtMenuSeparator/> 

            <shrtMenuItem name="acceptchange"/> 

            <shrtMenuItem name="rejectchange"/> 

            <shrtMenuItem name="nextchange"/> 

            <shrtMenuItem name="previouschange"/> 

            <shrtMenuSeparator/> 

            <shrtMenuItem name="hyperlink"/> 

            <shrtMenuItem name="removehyperlink"/> 

            <customMenuItem 

            name="customItem2" 

            text="Select All" 

            action="raiseevent" value="selectall" />  

            <customMenuItem 

            name="customItem3" 

            text="Clear" 

            action="raiseevent" value="clear" />               

        </shrtMenu> 

    </shortcutMenu> 

</editlive> 
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Enabling Options to set column width, size and location of chat 
task list 

Perform the below steps on each machine where Avaya Agent Rich Client is installed. 

1. Shut down Avaya Agent, if it is running. 

2. In Command Prompt, go to the ...\IC72\bin directory and use the following commands to un-register the 
existing file: 

regsvr32 /u ChatList.ocx 

3. Back up the following files in the ...\IC72\bin directory: 

 ChatList.ocx 

 ChatList.pdb  

4. Replace the files you just backed up with the files of the same name from IC 7.2.1 SP. 

5. In the ...\IC72\bin directory, use the following command to register the new file: 

regsvr32 ChatList.ocx 

6. Restart Avaya Agent. 

Chat Typing Status 

Modify the <AARC install_dir>\Webagent\Application.properties file with the following properties. 

 chat.typingstatus.enable=true 

 chat.typingstatus.messagetimeout=12 

The property chat.typingstatus.statusmessage is set in the localized file 
ClientMessages_<lang>.properties. 

Note: The value of property chat.typingstatus.messagetimeout should be in seconds 

IC – Siebel 7.8 Integration Configuration 
Follow the procedure below for IC 7.2.1 integration with Siebel 7.8. If you are trying to integrate IC 7.2.1 with 
Siebel 8.0.0.5 or Siebel 8.1.1, skip the below steps. 

1. Extract the AICD.ini file from Integration.zip provided as part of IC 7.2.1 SP 

Note: Integration.zip will not be installed with any of the SP installer. Download the integration.zip from 
http://support.avaya.com  

2. Copy this new AICD.ini file and paste it to the existing location of AICD.ini e.g. (C:\sea78\siebsrvr\BIN) 

3. To integrate IC 7.2.1 with Siebel 7.8 the integration objects are provided separately in a folder named 
integrations/sea78. These integration objects should to be used while performing IC 7.2.1 integration with 
Siebel 7.8.  

Refer to “Avaya IC Siebel Integration Guide” for Integration procedure. Integration Steps mentioned for 
IC-Siebel 8.0.0.5 Integration SHOULD be followed for IC-Siebel 7.8 Integration. 

Important: 

http://support.avaya.com/
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 For Solaris and AIX with Siebel 7.8, the expected driver location for AICD is "//siebsrvr/bin". The AICD 
driver needs to be copied to this location after Service Pack installation. 

 For Solaris and AIX with Siebel versions 8.0.0.5/8.1.1, the expected driver location for is "//siebsrvr/lib" 

Siebel configuration for Hard phone-browser synchronization 

To enable an agent to remain logged in to the hard phone on Siebel browser exit (Scenario 1), perform steps 
below: 

Siebel side 

1. Login to Siebel as Siebel Administrator 

2. Go to Site map > Administration - Communications > Communications Drivers and Profiles > Driver 
Parameter. 

3. Select Appropriate Profile from Communication Driver Window. 

4. In Driver Parameter window set following parameter: 

Driver:TSLogout = false 

IC side 

1. Start IC Manager. 

2. Select configured TS server -> Right Click -> Edit. 

3. Go to Configuration tab. 

4. Add following parameter in configuration tab as a Couple,   logout_on_deassign = false 

5. Restart TS. 

For Scenario 2 

1. Start IC Manager. 

2. Right-click the configured TS server and select Edit. 

3. Click the Configuration tab. 

4. Add following parameter in configuration tab as a Couple - 

logout_on_deassign = false 

5. Add following parameter in configuration tab as a Couple - 

force_logout_for_login = true 

6. Restart TS. 

ASIS Server env.properties file parameters 
Below table provides information pertaining to properties in env.properties file and their usage. There are 3 
layers in thin-client-VESP, Basic Services, UOM and Application below: 

Property Name Default Value Description 
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Property Name Default Value Description 

AICDTIMEOUT 30 This time will be used for all worker tasks 
to be completed. Useful to wait for dust 
to settle after activate, deactivate. 

application.asyncwork.poolsize 50 Specifies number of threads that will 
handle the Asynchronous tasks at the 
application layer. 

application.asyncwork.queue.maxsize 2048 Specifies the size of queue for en-
queuing Asynchronous task, applicable 
at application layer  

basicservices.cachereadytimeout 60000 Specifies time (in millisecond) to wait for 
requests against a basic service to be 
ready, before returning potentially stale 
data  

basicservices.initialwaittimeout 2000  

On application startup, this is time (in 
millisecond) to wait between retries for 
the cache to be ready.  

basicservices.initialwaittries 10 Specifies number of retry attempts for a 
request to basic services on application 
startup. 

queuesizelogger.enabled FALSE Specifies whether queues/work items will 
be monitored 

queuesizelogger.polltimeout 5000 Specifies how often a polling thread will 
write the current queue sizes to the log.  
0 means don't write to the log. Time is in 
Milliseconds. 

queuesizelogger.queuesizethreshold 1 Specifies the size that must be met 
before a queue size will be written to the 
log. 

queuesizelogger.trackperuser FALSE Specifies whether "per-user" queues will 
be logged 

uom.asyncwork.poolsize 50 Specifies Minimum size of thread for 
handling Asynchronous tasks in the UOM 
layer. Maximum thread poolsize is twice 
this value.  
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Property Name Default Value Description 

uom.asyncwork.queue.maxsize 2048 Specifies the size of queue for en-
queuing Asynchronous task at UOM 
layer.  

uom.event.queue.poolsize 50 Specifies the size of thread pool for 
handling UOM events, applicable at 
UOM layer only.  

uom.executor.pollinterval 250 Specifies the time when the thread 
will pick next available task from queue 
for processing. Time specified 
in Milliseconds.  

uom.scheduler.queue.poolsize 50 Specifies the Minimum thread pool size 
for handling scheduled task in queue, 
applicable at UOM layer only. For ex. 
Rona Timeout. Maximum thread poolsize 
is twice this value. 

vesp.alarm.unrecoverable.reportthreshold 3600 Minimum number of seconds to wait 
before repeating an unrecoverable alarm 
for an IC interfaces.  Time in Seconds  

vesp.event.queue.poolsize 20 Specifies the size of thread pool for 
handling VESP events in queue. 

vesp.event.queuesize 1024 Specifies the size of queue for en-
queuing VESP events.  

vesp.event.waittime 60000 How long to wait before retrying to 
enqueue an event. An event is attempted 
to be re-queued once. There is no 
indication of failure if en-queuing 
fails. Time in milliseconds  

vesp.taskpool.maxsize 70 Maximum number of threads to create to 
handle Assigns and De-assigns (for 
VespConnection) request.  

vesp.taskpool.minsize 20 Minimum number of threads to create for 
handling Assigns and De-assigns (for 
VespConnection) request.  

Important: 

 Please note that changing any of the above parameters will have some impact on CPU and memory 
utilization of the system. It is recommended to test with changed parameters (if they are changed), before 
deploying with new values. 

 It mandatory to restart ASIS server if any of the above parameters are changed. 
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Installing SNMP-MIB file 
Perform the following steps on the machine where NMS (for example, HP-OpenView) is installed. 

1. Unload the existing AVAYAGEN-MIB.mib and AV-IC-ALARM-MIB.mib from NMS. 

2. Download the latest AVAYAGEN-MIB.mib and AV-IC-ALARM-MIB.mib files from the Avaya Support Site: 
http://support.avaya.com 

3. Load the downloaded MIB files in NMS. First load AVAYAGEN-MIB.mib and then load AV-IC-ALARM-
MIB.mib. 

Perform the following steps on the machine on which the Alarm server is running. 

1. Stop Alarm Server. 

2. Backup the following files for your operating system: 

Operating System Command 

Windows .../IC72/bin/armsrv.exe 

.../IC72/bin/armsrv.pdb 

Solaris .../IC72/bin/armsrv 

AIX .../IC72/bin/armsrv 

3. Replace the files backed up with the files of the same name and type from the IC 7.21 SP 

4. On Windows, if the armsrv.pdb does not exist on your system, copy the file from this patch request to the 
.../IC72/bin directory. 

5. Ensure the newly copied files have the same read/execute permissions as the backed-up ones. 

6. Start Alarm Server. 

Website and ICM 
Below are the steps to be performed for Website and ICM to enable the “Chat Typing Status Feature”. 

1. Launch the web browser and navigate to the IC Website Administration Pages. 

2. Login and navigate to http://<server_name>/website/admin/tenancy/addmd.jsp 

3. Add the following metadata properties:     

 Metadata name = chat.htmlclient.typingstatusmsg 

Default value = typing 

Tenant Property (Check this field) 

4. Click Add Metadata. 

 Metadata name = chat.htmlclient.typingstatusenable 

http://support.avaya.com/
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Default value = true 

Tenant Property (Check this field) 

5. Click Add Metadata. 

 Metadata name = chat.htmlclient.typingmsgtimeout 

Default value in secs= 12 

Tenant Property (Check th 

is field) 

6. Close the Browser. 

Note: 

 Above mentioned properties are default values. 

 The website admin page property “chat.htmlclient.timestamps.showdate" used till IC7.2 is no longer used. 

Workflow 
This section describes the changes to the Workflow scripts and server. 

Exception Requeue option for Preferred Agent 

In Scenario where the Preferred Agent is not available, the contact will either be requeued, re-qualified 
depending on the configuration of Preferred Agent Setup block in workflows. On requeue-timeout, the 
contact  

To enable the exception requeue option for preferred agent, set the certain properties in the “Preferred Agent” 
block in the flows (advocate.qualifyemail_adv, advocate.qualifychat_adv and advocate.qualifyvoice_adv) as 
mentioned below. 

Three properties of the preferred agent block are as below 

requeue_agentid Agent Id for the contact to be requeued 

requeue_exclusionflag Flag indicating the Agent mentioned should/not be excluded on contact 
requeue 

If value is „0‟, the contact will be assigned to preferred agent alone. 

If value is „1‟, on agent un-availability, the contact will be assigned to an 
appropriate Service Class. 

requeue_lrmid LRM Id 

These properties can control the behavior contacts to get re-queued to service class or wait for preferred 
agent to login back.  

Following are the sample values which need to be set to requeue the contact to the service class in case 
preferred agent is not available. 

Example: 

 requeue_agentid = $PreferredAgent 
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 requeue_exclusionflag = 1 

 requeue_lrmid = $LRMId 

By setting these values, after timeout the contact will be requeued to the service class than waiting for the 
preferred agent to log in. 

Design and Admin Configuration 
For Web Admin Page cancel task with resolve status, follow steps below: 

Perform the following steps on Windows machine (Where Design and Admin is installed):  

1. Login into ICManager 

2. Open Tools menu and click IC Data Sources. 

3. On the IC Data Sources, expand the interaction_center node. 

4. Click ccqDBConnection. 

5. Note down Database Name and Database Server Values. 

Execute sql queries on Database that you noted down in the above step. 

insert into w_log_event_master (event_type,event_name)values (700,'Resolve Status'); 

insert into w_log_event_detail values (700,'pkey','qem_resolvestatus','pkey',0); 

insert into w_log_event_detail values (700,'name','qem_resolvestatus','name',1); 

IC Core Server Configuration 
This section describes configuration requirements for IC7.2.1 Core Servers. 

Time in Email Template Flexible to Allow 24 or 12 hour format 

Perform the steps below (For Solaris and AIX Only) to set the desired locale. 

1. Stop AIC servers on the current machine. 

2. export LC_TIME=<desired_locale_name> 

3. Verify the format of time using "date +%X" 

4. Start AIC servers from the same terminal where step b. was performed 

Note: Above steps MUST be performed on all servers (Solaris/AIX), where ICEmail Server is configured to 
run. 

SDK Server Configuration  
You need to manually replace the IC SDK Server files installed on the Windows, Solaris, and AIX platforms if 
IC SDK Server is installed and configured.  

Perform the following configuration steps to replace the files:  

1. Stop the IC SDK Service, if running, on the applicable platforms using following:  

Windows:  
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a. Start the Windows Services application.  

b. Stop the IC SDK Service.  

Solaris/AIX:  

a. At the command line, type:  

./ictomcat.sh stop SDK -force  

b. Press Enter. 

2. Backup the following files from the specified folder location: 

Windows: 

...\IC72\sdk\server\icsdk\WEB-INF\lib\avaya-ic-services.jar  

...\IC72\sdk\server\icsdk\WEB-INF\lib\avaya-ic-webui.jar  

...\IC72\sdk\server\icsdk\WEB-INF\lib\avaya-ic-sdk-common.jar 

...\IC72\sdk\server\icsdk\WEB-INF\lib\avaya-ic-sdk-server.jar  

...\IC72\sdk\server\icsdk\WEB-INF\lib\avaya-common.jar  

...\IC72\sdk\server\icsdk\WEB-INF\lib\avayaiccommon.jar 

…\IC72\sdk\server\icsdk\WEB-INF\lib\icm.jar 

…\IC72\sdk\server\icsdk\WEB-INF\lib\WebAgent.jar 

AIX and Solaris: 

.../IC72/sdk/server/icsdk/WEB-INF/lib/avaya-ic-services.jar  

.../IC72/sdk/server/icsdk/WEB-INF/lib/avaya-ic-webui.jar  

.../IC72/sdk/server/icsdk/WEB-INF/lib/avaya-ic-sdk-common.jar  

.../IC72/sdk/server/icsdk/WEB-INF/lib/avaya-ic-sdk-server.jar 

.../IC72/sdk/server/icsdk/WEB-INF/lib/avaya-common.jar 

.../IC72/sdk/server/icsdk/WEB-INF/lib/avayaiccommon.jar  

…/IC72/sdk/server/icsdk/WEB-INF/lib/icm.jar 

…IC72/sdk/server/icsdk/WEB-INF/lib/WebAgent.jar 

3. Manually copy the following files from the IC 7.2.1 Service Pack to the ..\IC72\sdk\server\icsdk\WEB-
INF\lib folder:  

 avaya-ic-services.jar  

 avaya-ic-webui.jar  

 avaya-ic-sdk-common.jar  

 avaya-ic-sdk-server.jar        

 avaya-common.jar  

 avayaiccommon.jar  

4. Backup following files from ..\IC72\sdk\design\dotnet\lib folder and manually copy the following files from 
sdk folder of IC 7.2.1 Service Pack to the ..\IC72\sdk\design\dotnet\lib folder:  

 AvayaICSDKClient.dll 
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 AvayaICSDKClient.pdb 

 AvayaICSDKClient.xml 

 Com.Avaya.Util.dll 

 Com.Avaya.Util.Messaging.dll 

 Com.Avaya.Util.Messaging.pdb 

 Com.Avaya.Util.pdb 

 CSharptester.pdb 

5. Backup following files from sdk\design\dotnet\sample\bin folder and manually copy the following files from 
sdk folder of IC 7.2.1 Service Pack to the ..\IC72\sdk\design\dotnet\sample\bin folder:  

 AvayaICSDKClient.dll 

 AvayaICSDKClient.pdb 

 AvayaICSDKClient.xml 

 Com.Avaya.Util.dll 

 Com.Avaya.Util.Messaging.dll 

 Com.Avaya.Util.Messaging.pdb  

 Com.Avaya.Util.pdb 

 CSharptester.exe 

 CSharptester.pdb 

6. Backup the following folders from the specified folder location:  

 The Controller and UI folders from sdk\design\dotnet\sample\src\Com.Avaya.Ic.Sdk.Sampleclient. 

 The MSDN folder from sdk\design\dotnet\doc.  

 The Doc folder from sdk\design\java\doc.  

 The src folder folder from sdk\design\java\sample.  

7. Manually copy the following from the IC 7.2.1 Service Pack to the specified folder location:  

 The Controller and UI folders to sdk\design\dotnet\sample\src\Com.Avaya.Ic.Sdk.Sampleclient. 

 The contents of the sdk\doc\MSDN folder to sdk\design\dotnet\doc.  

 The contents of the Doc folder to sdk\design\java\doc.  

 The src folder to sdk\design\java\sample.  

8. Ensure that the newly copied files have the same read/execute permissions as the backed-up files.  

9. Start IC SDK Service on the applicable platforms:  

Windows:  

a. Start the Windows Services application.  

b. Start Avaya SDK Services  

Solaris/AIX:  

a. At the command line, type: ./ictomcat.sh start SDK. 
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b. Press Enter. 

Configuring Web Services 
Perform the following steps, if IC Webservice is installed and configured:  

1. Stop the IC Webservice, if running on:  

Windows:  

a. Start the Windows Services application.  

b. Stop the Avaya IC 7.2 Web Services.  

Solaris/AIX: 

a. At the command line, type: ./ictomcat.sh stop webservices –force. 

b. Press Enter. 

2. Backup the following file from the specified folder location:  

Windows: 

...\IC72\sdk\webservices\webservices\WEB-INF\lib\avaya-ic-webservices.jar  

AIX/Solaris: 

 .../IC72/sdk/webservices/webservices/WEB-INF/lib/avaya-ic-webservices.jar  

3. Replace the file you just backed up with the file of the same name from this service pack.  

4. Ensure that the newly copied file has the same read/execute permissions as the backed-up file.  

5. Start IC Webservice on:  

Windows:  

a. Start the Windows Services application.  

b. Start Avaya IC 7.2 Web Services.  

Solaris/AIX:  

a. At the command line, type: ./ictomcat.sh start webservices. 

b. Press Enter. 

IC 7.2.2 Service Pack Configuration 

Below Section provides the component-wise configurations. Please note the sub-sections mentions 
configurations for specific features. 

 Avaya Agent Web Client 

 Design and Admin Configuration 

 Update Fulcrum indexes 

 Installation and Configuration section for Active Directory/ LDAP 
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Avaya Agent Web Client 

Internet Explorer 8 

This section describes configuration requirements for Internet Explorer 8 for Avaya Agent Web Client. 

1. Microsoft has released Security Patch on 20th Jan, 2010, (Cumulative Security Update for Internet   
Explorer 8 (KB978207)) - specific to Operating System. Install it, if is not already installed on agents 
machine. 

2. Uninstall Avaya WindowManager Control from Agent machine if it is already installed, follow below steps 

a. Open IE Browser. 

b. Select Tools > Internet Options.menu item. 

c. On General tab, click Settings command button under Browsing History. 

d. Click View Objects command button, to view already installed Avaya WindowManager Control. 

e. Right click Avaya WindowManager Control and select Remove menu item. (This will uninstall 
Avaya WindowManager Control). 

3. Change following Internet Options (Select Tools > Internet Options menu item) of Internet Explorer 8 for 
proper functioning of Avaya Agent Web Client.  

a. Advanced Tab - Browsing section 

 Uncheck - Enable automatic crash recovery 

 Uncheck - Enable third-party browser extensions. 

b. General Tab  

 Click Settings button of Tabs section, this will open new dialog window. Uncheck - Enable 
Tabbed Browsing 

 OR  

 Click Settings button of Tabs section, this will open new dialog window.Check - Enable Tabbed 
Browsing and ensure “Always open pop-ups in a new window” option is selected under “When 
pop-up is encountered” section. 

4. Restart Internet Explorer. 

5. Access Avaya Agent Web Client, select install if prompted for installing avayaicagent.cab. 

6. On completion of avayaicagent.cab installation, close Internet Explorer. 

7. Step 1 to 6 is one time activity.  

Note: Don't access another website in new tab of same Internet Explorer instance from which Avaya Agent 
Web Client login page is launched. 

Design and Admin Configuration 
Perform the following steps on Windows machine (Where Design and Admin is installed):  

WACD infinitely keeps on requesting the WAA to qualify a task when no agent is logged into IC, which is 
impacting the WkCancelledCnt in OA reporting. 

Perform following steps in IC Manager 
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1. Select the server tab. 

2. Select the WACD server under Web domain. 

3. Select the configuration tab. 

4. Select "new"  

Under the couple 

  .Name = RequestResourceRetryCount 

  .value = 3 (WACD will send WACD.RequestResource for 3 times: 1 try and 2 re-try) 

5. Select ok and update the WACD server. 

Virtual Queue Transfer selects the wrong Wait Treatment 

1. In IC Manager, stop the following servers (in the following order): 

 Blender Server 

 All Workflow Servers    

2. Make sure following files are from IC 7.2.2 SP. 

 transfertovq.qfd 

 update_vq_cache.qfd   

3. Compile the project sys_transfer.prj using WorkFlow designer. 

4. Restart the following servers (in the following order): 

 All the Work Flow Servers 

 Blender Server. 

SSL Enable HTTP Connector Server 

Configuration Steps: 

In ICManager > HTTPConnector_Server > HTTPConnector tab below are the new fields added. 

1. Enable SSL (Check box): By Default, this check-box is not ticked and the server will work in the 
conventional TCP mode. 
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If this check-box is selected, it shows the default configuration for the server to work in SSL mode. Users do 
not have to change any of these parameters. 

 

2. Certificate file: This is the server certificate file used by the HTTPConnector server.  

The instructions to generate Server certificate are provided in the section Generate Cerificate. 

3. Key File:   This is the key file used by the HTTPConnector server. Default keyfile. 

The instructions to generate Server keyfile are provided in the section Generate Cerificate. 
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Important: Please rename these files ones they are created. There are certificates already shipped in IC7.2.2 
SP with these names. 

If the Key file used is encrypted with a Passphrase, remember to enter a new entry and enter the passphrase 
in the ICManager > Configuration Tab > Private Key PassPhrase > HTTPConnector Server > Password 
Phrase.    

Note:  

1. The Server Certificate and Server Keyfile MUST be placed in the path  %AVAYA_IC72_HOME%/etc. 

2. If the Keyfile is not passphrase protected, then please DO NOT creates entry the "ICManager > 
Configuration Tab > Private Key PassPhrase > HTTPConnector Server > Password Phrase" for the 
said keyfile. 

3. The server will work either in the TCP/TLS mode based on the property "Enable SSL" in the 
HTTPConnector Server > Configuration tab. 

4. The root/CA certificate MUST be deployed in the DD5.1. 

For more information about installing and configuring the same, please refer the IC section (Point 33) on 
page 14 in the DD Release Letter 5.1.0.14.01 (http://support.avaya.com/css/P8/documents/100111377). 

Important: Please use FQDN (Fully Qualified Domain Name) of server hosting HTTPConnector as CN 
(Common Name) while generating Server Certificate.  

Remember to add this FQDN, IP mapping in the host file of Server hosting the Dialong Designer 5.1 
application. Please use the same FQDN in the "Address:" (Address of HTTP Server) in the Dialog Designer 
Admin page > IC VRUSM/HTTPVOX. 

 

5. The Mode of operation from TCP >SSL or SSL > TCP cannot be achieved at runtime. This needs the 
user to stop and start the server. 

http://support.avaya.com/css/P8/documents/100111377
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Update Fulcrum indexes 
1. If your IC deployment has WACD server and Admin and Client website hosted on separate machine then 

follow below steps to syncronize Fulcrum indexes. 

a. Copy "IC72/logs/fulcrum_updateout.fte" file from Admin website machine. 

b. Place the copied file to WACD server and Client website machine under "IC72/etc/wru_sql" folder. 

c. Shutdown IC services and servers on WACD and Client website machine. 

d. Execute "IC72/etc/wru_sql/fulcrum_updateout" script as follows: 

On Windows: 

i. Open command prompt and navigate to "IC72\etc\wru_sql" folder. 
Execute command "fulcrum_updateout.cmd" without double quotes. 

On Solaris and AIX: 

i. Using shell, navigate to "IC72/etc/wru_sql" directory. 

ii. Execute command "sh fulcrum_updateout.sh" without double quotes.    

e. Execute "IC72/etc/wru_sql/fulcrum_updatendx" script as follows: 

On Windows: 

i. Open command prompt and navigate to "IC72\etc\wru_sql" folder. 

ii. Execute command "fulcrum_updatendx.cmd" without double quotes. 

On Solaris and AIX: 

i. Using shell, navigate to "IC72/etc/wru_sql" directory. 

ii. Execute command "sh fulcrum_updatendx.sh" without double quotes. 

NOTE: Not performing these steps will not enable WACD and Client website to search updated WRU 
documents. 

2. On Admin website machine, if you observe file "IC72/logs/fulcrum_updateerr.fte" then follow below 
steps on Admin website machine to update Fulcrum indexes. 

a. Copy "IC72/logs/fulcrum_updateerr.fte" file. 

b. Place the copied file at "IC72/etc/wru_sql" directory. 

c. Shutdown IC services and servers and website on Admin website machine. 

d. Execute "IC72/etc/wru_sql/fulcrum_updateerr" script as follows: 

On Windows: 

i. Open command prompt and navigate to "IC72\etc\wru_sql" folder. 

ii. Execute command "fulcrum_updateerr.cmd" without double quotes. 

On Solaris and AIX: 

i. Using shell, navigate to "IC72/etc/wru_sql" directory. 

ii. Execute command "sh fulcrum_updateerr.sh" without double quotes. 

e. Execute "IC72/etc/wru_sql/fulcrum_updatendx" script as follows: 

On Windows: 
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i. Open command prompt and navigate to "IC72\etc\wru_sql" folder. 

ii. Execute command "fulcrum_updatendx.cmd" without double quotes. 

On Solaris and AIX: 

i. Using shell, navigate to "IC72/etc/wru_sql" directory. 

ii. Execute command "sh fulcrum_updatendx.sh" without double quotes. 

NOTE: Not performing these steps will not enable Admin website WRU search feature to fetch updated 
WRU documents. 

Installation and Configuration section for Active 
Directory/ LDAP 
In order to successfully enable LDAP integration support with Interaction Center, it needs to be configured as 
the steps outlined below. Otherwise skip these steps and goto Next Section. 

The order of installation and configuration and the steps for the same are outlined below: 

1. Install and configure IC Server component 

2. Install and configure IC Design & Admin component 

3. Install and configure IC Client component 

4. Install and configure IC Website component 

5. Install and configure Siebel Integration component [IC Side] 

6. Install and configure Siebel Integration component [Siebel Side] 

7. Replace default certificate for Directory Server and Client 

IC Server component 

1. Install the Service Pack to the secondary servers of IC. 

2. Make sure that the following certificates are installed in the <AVAYA_IC72_HOME>\etc folder. 

 domain_cert_AvayaIC_Server.pem 

 domain_key_AvayaIC_Server.pem 

 root_cert_AvayaIC_Client.pem 

3. Install Active Directory/LDAP server certificate if the SSL communication is used between them. 

4. Restart IC servers on this machine. 

5. If Directory Server is configured for that secondary server then check following things: 

Check if Directory Server is up and running. 

 Go through the Directory Server logs and ensure that there are no certificate/SSL related errors or 
warnings. 

 Confirm that Directory Server is listening on port 14433 for SSL requests. 

6. Follow steps 1 to 4 for all the secondary servers. 
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7. Once all the secondary servers are updated with the Service Pack, and respective Directory Server 
servers are running, follow steps 1 to 4 for the primary server machine. 

8. In case of any error or warnings reported in the logs, ensure that the required certificates mentioned in 
step 2 are available on the machine and copied to the correct folder i.e. <AVAYA_IC72_HOME>\etc, and 
that the port 14433 is not being used by any other process.  

Note: In case of Directory Server not being able to listen for SSL requests, older clients can still login. 
However, clients where the Service Pack has been applied may face issues while logging in to IC. The 
certificate names and ports can be changed through IC Manager, once the Service Pack is installed on 
Design & Admin machine. 

Installing Active Directory/LDAP certificate for Directory Server 

Directory Server can communicate with Active Directory/LDAP over non-SSL and SSL both modes. The 
Directory Server Active Directory/LDAP communication is required for authenticating login credentials of 
Active Directory/LDAP users. Directory Server will work as a client for Active Directory/LDAP server and it 
should be ensured that it trusts Active Directory/LDAP server‟s certificate if it is connecting to it over SSL. For 
SSL communication between Directory Server and Active Directory/LDAP Server, Active Directory/LDAP 
Server's certificate (or its CA's certificate) must be installed in to Directory Server machine. This will allow 
Directory Server to trust the certificate coming from Active Directory/LDAP server during SSL handshake. 
Installing the signing authority (CA) credentials, which has signed the certificate of Active Directory/LDAP 
server, in to Directory Server is described below for different supported platforms (Windows, Solaris/AIX). 

Directory Server running on Windows 

In case of Directory Server configured to run on a windows machine, the Active Directory/LDAP CA certificate 
needs to be installed in the windows certificate store, on the machine on which Directory Server is running. In 
case there are multiple Directory Servers, then the certificate needs to be installed in the certificate store of 
every machine where Directory Server is configured. To import CA certificates into the Windows Certificate 
Store, it is easiest if they are PEM-encoded and have a .cer extension.  

When creating a secure connection to the Active Directory/LDAP server, the SSL libraries are automatically 
going to use the correct CA certificate used to sign the certificate presented by the Active Directory/LDAP 
server. In this case the certificate field specified in the Active Directory/LDAP configuration can be left blank. 

Directory Server running on UNIX 

In case the Directory Server is configured to run on IC supported UNIX platform (Solaris or AIX), then the CA 
certificate needs to be saved on the file system, encoded in a PEM format. The filename containing the 
certificate is to be specified in the Certificate Name field during the Active Directory/LDAP server 
configuration. The certificate is required to be copied to the <AVAYA_IC72_HOME>/etc folder on the 
machine where Directory Server is running.  

Note: Ensure that value of LDAP Server Name field specified in the Active Directory/LDAP server 
configuration matches the hostname specified in the Active Directory/LDAP certificate‟s commonName field. 
If these values are different, then the SSL handshake between Directory Server and the Active 
Directory/LDAP server will not succeed, and Active Directory/LDAP authentication for users will not going to 
work. 

IC Design & Admin component 
Install the Service Pack on the Design & Admin machine. Following configurations steps are required to 
integrate IC with Active Directory/LDAP: 
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 Importing Active Directory/LDAP server certificate to IC Manager 

 Importing sc.xml to IC Manager 

 Reconfiguring database and generating Windows application 

 Enabling LDAP integration support 

 Configuring Active Directory/LDAP server properties 

 Importing users from Active Directory/LDAP 

 Synchronizing users with Active Directory/LDAP 

 Configuring Directory server 

 Configuring password management options for Active Directory/LDAP users 

Importing Active Directory/LDAP server certificate to IC 
Manager 

IC Manager can communicate with Active Directory/LDAP over non-SSL and SSL both modes. The IC 
Manager Active Directory/LDAP communication is required for importing and synchronizing Active 
Directory/LDAP users in to IC system. IC Manager will work as a client for Active Directory/LDAP server and it 
should be ensured that it trusts Active Directory/LDAP server‟s certificate if it is connecting to it over SSL. For 
SSL communication between IC Manager and Active Directory/LDAP Server, Active Directory/LDAP Server's 
certificate (or its CA's certificate) must be installed in to IC Manager used JRE's database of trusted 
certificates. This will allow IC Manager to trust the certificate coming from Active Directory/LDAP server during 
SSL handshake. Following steps will install the signing authority (CA) credentials, which has signed the 
certificate of Active Directory/LDAP server, in to IC Manager used JRE's database of trusted certificates. 

1. Copy Active Directory/LDAP Server's certificate (or its CA's certificate) from Active Directory/LDAP server 
machine to IC Design & Admin machine‟s <AVAYA_IC72_HOME>\IC72\Java\lib\security folder and 
rename it to root_cert_LDAP_server.pem. 

2. Open command prompt and run following commands to import above certificate: 

 cd <AVAYA_IC72_HOME>\IC72\Java\lib\security 

 <AVAYA_IC72_HOME>\IC72\Java\bin\keytool.exe -import -file root_cert_LDAP_server.pem -alias 
<Certificate Unique Alias Name> -keystore jssecacerts -storepass changeit 

3. Verify that jssecacerts keystore is present in <AVAYA_IC72_HOME>\IC72\Java\lib\security folder in the 
form of a file and check if root_cert_LDAP_server.pem is successfully imported in to jssecacerts keystore 
by checking the output of following command: 

 <AVAYA_IC72_HOME>\IC72\Java\bin\keytool.exe -list -v -alias <Certificate Alias Name> -keystore 
jssecacerts -storepass changeit 

Note: 

 The default password for jssecacerts keystore is changeit. Use the appropriate password if it is changed. 

 All keystore entries (key and trusted certificate entries) are stored and accessed via unique, case-
insensitive aliases through the keystore. If certificate alias name is not provided then default alias name 
mykey will be used by keytool. 
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Importing sc.xml to IC Manager 

Directory Server will now listen on a separate port over SSL for Login requests only. There are new 
configurations added for Directory Server to make it SSL enabled. Following steps will allow IC Manager to 
import new configurations added for IC Active Directory/LDAP integration. 

Start IC Manager. Import the sc.xml file into the system through following steps: 

1. In IC Manager, go to Manager > Options > Environment (tab) > Import Configuration. 

2. Browse through <AVAYA_IC72_HOME>\etc directory and select sc.xml. 

3. Verify if validation of sc.xml is successful and then press Ok to import it. 

4. Exit IC Manager and restart it. 

5. Ensure that Admin user is able to login into IC Manager. 

Enabling Active Directory/LDAP integration support 

Enablement of IC Active Directory/LDAP integration can be controlled by EnableLDAP IC property. IC system 
will communicate to Active Directory/LDAP only if this property is set to true. Following steps will add this new 
property to IC system. 

1. Open IC Manager and select Tools > Property Declaration. 

2. In Property Declarations dialog box select System/Configuration from Property Section, add a 
property with following values selecting New from Props for System/Configuration section: 

Name:    EnableLDAP 

Description:   EnableLDAP 

Property Data Type:  boolean 
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3. Select Tools > Groups through IC Manager. Select IC from the left pane in Group Manager dialog box. 

4. Select System/Configuration under Properties tab in the left pane in Group Manager dialog box and 
assign a new property EnableLDAP with the property value Yes. 

 

5. Exit from IC Manager and restart it. 

6. Login to IC Manager using administrative privileges (Admin user). 

7. The LDAP menu will be available under Services menu in IC Manager. 

 

Configuring Active Directory/LDAP server properties 

IC Manager communicates to Active Directory/LDAP for importing and synchronizing Active Directory/LDAP 
users in to IC system. Similarly Directory Server communicates to Active Directory/LDAP server for user 
authentication. Following steps will allow IC system to store Active Directory/LDAP configuration details that 
can be used by IC Manager or Directory Server for the above mentioned purposes. 

1. Select Services  LDAP  LDAP Configuration through IC Manager 

2. For creating a new Active Directory/LDAP configuration click on the New button. For editing the existing 
configuration use Edit button in Active Directory/LDAP Configuration dialog box. 

 New LDAP Configuration dialog box has following fields:  
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 LDAP Server Name: Host name or IP address of Active Directory/LDAP server machine. 

 LDAP Server Port: Active Directory/LDAP port number over which IC Manager/ Directory Server 
will communicate with Active Directory/LDAP. The default value of non-SSL port is 389 and 
default value of SSL port is 686. 

 Base DN: Active Directory/LDAP base DN name. e.g. dc=ldap,dc=com 

 SSL Enabled: Check box to set if the communication between IC system and Active 
Directory/LDAP is over SSL. 

 Certificate Name: Active Directory/LDAP server‟s CA certificate name. This configuration will be 
used by Directory Server only for UNIX platform. For Windows, this field can contain any value. 

 New LDAP Configuration dialog box also has following buttons: 

 OK button: Clicking this button will save the Active Directory/LDAP configuration to the 
ldapconfig table in repository database. 

 Cancel button: Clicking this button will exit the form without saving the Active Directory/LDAP 
configuration changes. 

 Map Fields button: This button provides option to map IC Fields to Active Directory/LDAP fields. 
Refer IC-LDAP Field Mapping for more details. 

Note: Only one Active Directory/LDAP configuration creation is supported with 7.2.2 Service Pack. Thus after 
saving first Active Directory/LDAP Configuration, the New button will be disabled in LDAP Configuration 
dialog box. 
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IC-LDAP field mapping 

IC-LDAP field mapping is required to map Active Directory/LDAP user attributes with columns of employee 
table in IC repository database. This mapping is used in importing or synchronizing Active Directory/LDAP 
users in to IC system. Active Directory/LDAP user‟s mapped attribute‟s values will be populated into the 
corresponding column of employee table at the time of import or synchronize. 

It is required to map the Active Directory/LDAP fields to IC fields before performing Import or Synchronization 
activity. Mapping fields is a one time activity and the IC-LDAP field map gets saved in ldapconfig table along 
with other configuration details provided through New LDAP Configuration dialog box. 

IC Manager reads the Active Directory/LDAP fields and IC fields from agentAttributes.xml file placed in 
<AVAYA_IC72_HOME>\IC72\etc folder to populate options/values for Field Mapping in IC-LDAP Map 
dialog box. This file has two sections: 

1. LDAP fields 

In this section Active Directory/LDAP attributes can be specified as XML tags. The tag name represent 
actual Active Directory/LDAP attribute name and value represents display name for that attribute. e.g. 

<Snippet> 

. 

. 

. 

 <LdapFields> 

  <sAMAccountName>sAMAccountName</sAMAccountName> 

  <givenName>Given Name</givenName> 

  <sn>Last Name</sn> 

  <distinguishedName>Distinguished Name(AD)</distinguishedName> 

   <!-- This must be used for Active Directory systems. --> 

  <entryDN>Entry DN(OpenLDAP)</entryDN>  

              <!-- This must be used for OpenLDAP systems. --> 

 </LdapFields> 

. 

. 

. 

</Snippet> 

Here givenName is the attribute name of Active Directory/LDAP user and Given Name is the display 
name. 

Important: There should be at least one Active Directory/LDAP user attribute which has unique value 
associated with it across the Active Directory/LDAP server users. This attribute should always be mapped 
to IC‟s loginname attribute. The other required attribute is DN which needs to be mapped to userDN field 
of IC. The attribute name for DN could vary depending upon LDAP server type e.g. for Active directory 
the attribute‟s name is distinguishedName and for OpenLDAP it is entrydn. 
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2. IC fields 

In this section IC attributes can be specified as XML tags. The tag name represent actual IC attribute 
name from IC repository database‟s employee table and value represents display name for that attribute. 
e.g. 

<Snippet> 

. 

. 

. 

 <ICFields> 

  <loginname>Login Name</loginname> 

  <firstname>First Name</firstname> 

  <lastname>Last Name</lastname> 

  <fullname>Full Name</fullname> 

  <preferredname>Preferred Name</preferredname> 

  <userDN>User DN</userDN> 

 </ICFields> 

. 

. 

. 

</snippet> 

Here loginname is the actual IC attribute name and Login Name is the display name. 

Note: It is recommended to review the agentAttributes.xml file, installed with this Service Pack, to verify 
that the Active Directory/LDAP schema has the all the attributes present as defined in LDAPFields 
section, before mapping fields. This file can be modified to add more mapping fields in IC/LDAP section. 
However this should be done carefully so that LDAP user attributes should match with the desired IC user 
attribute. 

Active Directory/LDAP configuration verification: 

Active Directory/LDAP configuration details provided through New LDAP Configuration dialog box can 
validate the configuration data provided: 

1. Fill up the details in LDAP Configuration Properties tab of New LDAP Configuration dialog box. 

2. Go to Verification tab of New LDAP Configuration dialog box. 

3. Provide LDAP DN and Password information. 

4. Select Test button. Test result will be displayed in the Message box. 
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Importing users from Active Directory/LDAP server 

IC Manager has the capability to import Active Directory/LDAP users to IC system as per the rules set through 
IC-LDAP Field Mapping. Following steps will allow importing Active Directory/LDAP user information in to the 
IC system. 

1. Select Services > LDAP > LDAP Import through IC Manager. 

2. Input Active Directory/LDAP login credentials in to the Login Screen and select Login button. 

3. Select all the users to be imported from Import Screen and select Import button. 

4. Verify if all the users selected are imported successfully in Import Summary Screen and select Finish. 

Login screen 

Login screen has following input fields: 

 LDAP DN: Active Directory/LDAP user name (DN), who has permission to search users in Active 
Directory/LDAP server. 

 Password: Password of the above user. 

Login screen has following buttons: 

 Login: Selecting this button will take to the Import Screen on successful login. 

 Cancel: To exit the Import LDAP users dialog box. 

Import screen 

Import screen lists users to be selected to import in to IC system. The list of users will be populated based on 
the Filter/Search criteria.  

This screen has following components: 

Filter/Search Criteria: Active Directory/LDAP query string for additional filtering on the list of users to be 
fetched from Active Directory/LDAP. This search criterion must follow the Active Directory/LDAP query 
creation rules. 

 For example:  

 Query string for the list of users belonging to division „rnd‟: (division=rnd) 
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 Query string for the list of users who do not belong to „rnd‟ and have Email ID: 
(&(!(division=rnd))(mail=*)) 

 Query string for the list of users whose name begins with agent: (name=agent*) 

 etc. 

Search Button: Selecting this button will search Active Directory/LDAP users on Active Directory/LDAP 
server based on the filter criteria set. It will use Active Directory/LDAP server details set through Configuring 
Active Directory/LDAP server properties. 

Select all checkbox: To select all users listed. 

List of Users with selection checkbox: The checkboxes will provide option to select users those are to be 
imported in to IC system. Following user attributes will be shown: 

 Serial No 

 sAMAccountName 

 Given Name 

 Last Name 

 Distinguished Name(AD) / Entry DN(OpenLDAP) 

Note: 

These fields are populated with the help of entries present in LDAPFields section of 
<AVAYA_IC72_HOME>\IC72\etc\agentAttributes.xml file. The values could be different based on the 
changes made in agentAttributes.xml file. Refer IC-LDAP Field Mapping for details. 

Import screen has following buttons: 

 Import: To import selected Active Directory/LDAP users into IC system. Only users who do not exist 
already in IC system are imported.  

 Cancel: To exit the Import LDAP users dialog box. 

Import Summary screen 

Import Summary Screen displays the progress of import operation and the import status for each user. This 
screen has following components: 

Progress Bar: Displays import operation progress. 

Summary Text Area: Displays import status for each user. 

Import Summary Screen has following buttons: 

Finish: To exit from Import Wizard after completion of import operation. This button is enabled only after 
the completion of import activity. 
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Synchronizing users with Active Directory/LDAP server 

If the attribute(s) of any Active Directory/LDAP user, who were already imported to IC system, is changed on 
any Active Directory/LDAP server, they need to be synchronized in IC system too. Following steps will allow 
synchronizing Active Directory/LDAP user attributes with the IC system. 

1. Select Services  LDAP  LDAP Synchronization through IC Manager. 

2. Input Active Directory/LDAP login credentials in to the Login Screen and select Login button. 

3. Select Start Synchronization button on Sync Summary Screen to start the synchronization. 

4. Verify if all the users imported are synchronized successfully in Sync Summary Screen and select Finish. 

Login screen  

 Login screen has following input fields: 

 LDAP DN: Active Directory/LDAP user name (DN), who has permission to search users in Active 
Directory/LDAP server. 

 Password: Password of the above user. 

 Login screen has following buttons: 

 Login: Selecting this button will take to the Sync Summary Screen on successful login. 

 Cancel: To exit the Synchronize LDAP users dialog box. 

Sync Summary screen 
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Sync Summary Screen displays the progress of synchronization operation and the sync status for each user. 

This screen has following components: 

 Start Synchronization Button: To start synchronization operation of Active Directory/LDAP enabled IC 
users. This button is disabled once synchronization is started. 

 Progress Bar: Displays synchronization operation progress. 

 Summary Text Area: Displays synchronization status for each user. 

Sync Summary Screen has following buttons: 

 Cancel: To exit from Sync Wizard without completing the user synchronization operation. This button is 
disabled once synchronization is started.   

 Finish: To exit from Sync Wizard after completion of synchronization operation. This button is enabled 
only after the completion of synchronization activity. 

 

Directory Server SSL configuration 

The IC client authentication mechanism is undergoing a change with the installation of this Service Pack. 
Going forward IC Clients will be using a secure channel to login into the VESP framework. The Directory 
Server will now listen for SSL login requests on a different port apart from the VESP port. Only login requests 
are going to be serviced by this port, all other requests are still going to be routed to the normal VESP port. 
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New configuration properties are added in to Directory Server to make it SSL enabled. These properties need 
to be configured through IC Manager if default values are not being used. Following new properties are added 
in to Directory Server‟s Directory tab for IC-LDAP integration: 

General properties 

 Certificate File: Directory Server SSL Certificate (PEM format) file name. Default value is 
domain_cert_AvayaIC_Server.pem. 

 Key File: Directory Server SSL Certificate Private Key file name. Default value is 
domain_key_AvayaIC_Server.pem. 

 SSL Socket Port: Port to be used for SSL communication for accepting Login request. Default value is 
14433. 

Advanced properties 

Update LDAP Config on Generic Update: To update IC-LDAP integration related Directory Server 
properties at run time through Generic Update. 

DHParam File: This parameter is not used currently though a warning log message will be logged in to 
Directory Server log about the missing dh1024.pem file. This option is kept for future implementation and 
should not be altered. 

 

The Directory Server SSL Certificate Private Key file can be pass phrase protected. This passphrase 
information should be configured through Configuration tab in IC Manager. 

1. Go to Configuration tab in IC Manager and expand Private Key PassPhrase tree node in the left panel. 

2. Select New and choose the Directory Server alias from Directory Server drop down list. 

3. Select Password Phrase and enter the password in setPassword dialog box. 

4. Save this information by selecting Ok button. 

Note: The default Directory Server SSL Certificate Private Key installed with this Service Pack is not 
passphrase protected and this configuration is not required for that key.  
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The Directory Server SSL Certificate Private Key file passphrase information (if configured) will be stored in 
an encrypted format in ds.ffd file only. 

 

Reconfiguring database & generating Windows application 

There are changes to the Database Schema for IC-LDAP integration, which is available through ADL files in 
the <AVAYA_IC72_HOME>\design folder. Following steps will allow IC system to update its database with 
new entries related to IC-LDAP integration. 

1. Open DB Designer. Open the repository.adl file. Reconfigure the database, and regenerate the windows 
application again.  

2. Repeat the above step with ccq.adl. 

3. In case there are errors, check the logs to find and resolve the cause. 

Configuring password management options 

IC system would not manage the passwords for Active Directory/LDAP users in IC-LDAP integration. For 
authentication of Active Directory/LDAP user, the user-password and a unique identifier (usually the 
Distinguished Name of the user) will be sent by IC system to the Active Directory/LDAP server. The 
authentication result received from Active Directory/LDAP server is passed back to the respective clients. 

To avoid confusion among Active Directory/LDAP users, IC system‟s password management related 
configurations should be turned off as described below: 

1. Agent/Security > PasswordChange option, which allows agent to change their password, should be set 
to No through IC Manager for Active Directory/LDAP users. This option can be set at IC (Root Node), 
Tenants, Workgroup or Individual Agents level as per the configuration and requirement of contact 
center. 
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Note: If Agent/Security  PasswordChange option is set to Yes for Active Directory/LDAP users, the 
respective agents will get an option to change the password through IC Client, but using this option will 
not have any effect on Active Directory/LDAP password maintained at Active Directory/LDAP server. This 
may create confusion among agents when they will try to use the new password changed through IC 
Client. 

2. Values of following password management options will not be used for Active Directory/LDAP users: 

 Agent/Security  ForcePasswordChange 

 Agent/Security  MaxPasswordLength 
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 Agent/Security  MinPasswordAlphabets 

 Agent/Security  MinPasswordLength 

 Agent/Security  MinPasswordNumerics 

 Agent/Security  NumOfDays 

 Agent/Security  NumOfPasswordChanges 

 Agent/Security  PasswordChangeDuration 

 Agent/Security  PasswordReuseCycles 

Note: Following fields will be disabled for all agents imported from Active Director/LDAP server: 

 Password 

 Confirm 

 Force password change on login 

 

3. Agent/Security > MaxLoginAttemptsAllowed option value will be used for Active Directory/LDAP users 
in the same manner as for regular users to control the login attempts in to IC system. It will not affect the 
similar rule set at Active Directory/LDAP server. 

Example: 

 MaxLoginAttemptsAllowed is set to 3 in IC system and 5 in Active Directory/LDAP server. After 3 
unsuccessful attempts of login through IC system, IC will disable the login for that agent and will not 
consult Active Directory/LDAP server for login authentication for subsequent attempts even though 
there are 2 more attempts available for that agent on Active Directory/LDAP server. 

 MaxLoginAttemptsAllowed is set to 5 in IC system and 3 in Active Directory/LDAP server. After 3 
unsuccessful attempts of login through IC system, Active Directory/LDAP server will disable the login 
for that agent but IC system will consult Active Directory/LDAP server for login authentication for next 
2 subsequent attempts as agent‟s login will be disabled only after 5 unsuccessful attempts in IC 
system. 

Note:   LDAP Users created with Empty password will not be allowed to login into AIC. 
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IC Client component 
Run the Service Pack client installer on each of the client machines. Machines running SDK client or 
accessing AAWC using IE do not require this Service Pack to be installed. 

Note: The Directory Server‟s SSL Certificate‟s signing authority‟s (CA‟s) certificate should be installed (in 
PEM format) on each Client machine‟s <AVAYA_IC72_HOME>\etc folder with the name 
root_cert_AvayaIC_Client.pem. 

IC Website component 
 If the website resides on the same machine where WACD has been configured to execute, then the 

Service Pack is already installed, and no additional steps are necessary. 

 If the website is on a machine different from which hosts the WACD server, then the Service Pack needs 
to be installed on the website machines as well. Restart the website after installing the Service Pack. 

Siebel Integration component [IC Side] 
Install the Service Pack on IC server machine. 

Siebel Integration component [Siebel Side] 
Install the Service Pack on Siebel server machine. 

Note: If IC-Siebel Native integration is configured using the 'AgentPassword' parameter where AICD will use 
a common Avaya IC password for all agents, do not configure LDAP for IC. In this case, if LDAP is desired for 
agents, it needs to be configured for the Siebel Agents on the Siebel side. 

Replacing default certificate for Directory Server and 
Client 
In order to enable SSL between IC Clients and Directory Server for Login request, certificates are exchanged 
between Directory Server and the client requesting login. The client then verifies the certificate to ensure that 
it is communicating with a valid Directory Server, and an encrypted channel is created between them. The 
login information is then exchanged between the client and Directory Server, and Directory Server 
authenticates the client against the credentials passed. The Service Pack bundles Out-of-Box self signed 
certificates for this purpose of creating the encrypted channel between the client and Directory Server. 
However, customers are free to create and use their own certificates for the same. The certificates for this 
kind of usage falls broadly under 2 categories: 

We will look at each of these categories, and when and how to use them for different scenarios 

Certificates signed by Certificate Authority (CA) 

These certificates are either signed by a well known CA e.g. VeriSign etc. or signed by a self-created CA. The 
signing authority verifies the existence of the business and the ownership of the fully qualified domain name 
(FQDN) to provide additional security. When using this option, the customers need to ensure that the FQDN 
on the certificate needs to match the FQDN of the Directory Server on which it is installed. As IC operates on 
IP addresses rather than host names, a proper reverse IP lookup mechanism needs to be setup so that the IP 
is resolved to the correct hostname. This can be achieved through either of the well know mechanisms like 
DNS, NIS, local hosts file, etc. The signed certificate should be installed on the machine running the Directory 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 113 

Server, in <AVAYA_IC72_HOME>\etc folder. The certificate name can be entered in the respective server‟s 
configuration tab using IC Manager. The CA‟s (signing authority‟s) certificate, who has signed the Directory 
Server SSL certificate, is to be distributed to all the client machines, and needs to be copied in to 
<AVAYA_IC72_HOME>\etc folder with the name root_cert_AvayaIC_Client.pem. The name of the CA 
certificate cannot be changed, and has to be the one mentioned above. It also needs to be ensured that all 
the certificates are in PEM format. During the initial handshake, the client receives the server certificate and 
validates its credentials using the CA certificate which it has. If the certificate is validated successfully, then 
the client tries to match the FQDN of the host it is connecting to with the FQDN name in the certificate's 
commonName field or certificate‟s dNSName field of the subjectAltName. If the DNS names match, then 
the handshake is successful, and encrypted data is exchanged between the two nodes. If the DNS names do 
not match, the client rejects the connection. 

IC clients support the use of wildcard characters in FQDN name in CA signed server certificate's 
commonName field or certificate‟s dNSName field of the subjectAltName. The accepted wildcard characters 
are described at http://support.microsoft.com/kb/258858. 

Accepted wildcard examples 

 www.example.com matches www.example.com 

 *.example.com matches www.example.com 

 w*.example.com matches www.example.com 

 ww*.example.com matches www.example.com 

 Www.Example.com matches www.examPle.cOm 

Non-accepted wildcard examples 

 *www.example.com 

 *w.example.com 

 w*w.example.com 

 *ww.example.com does not match www.example.com 

 www.e*ample.com does not match www.example.com 

 www.*ample.com does not match www.example.com 

 www.ex*.com does not match www.example.com 

 www.*.com does not match www.example.com 

 example.com does not match *.com does not match www.example.com  

 www.example.abc.com does not match *.abc.com 

 example.com does not match *.* 

 example does not match * 

 abc.def.example.com does not match a*.d*.example.com 

 www.example.com.au does not match *.*.com.au 

 www.example.com.au does not match www.*.com.au 

Note:  

http://support.microsoft.com/kb/258858
http://www.example.com/
http://www.example.com/
http://www.example.com/
http://www.example.com/
http://www.example.com/
http://www.example.com/
http://www.example.com/
http://www.example.com/
http://www.e*ample.com/
http://www.example.com/
http://www.*ample.com/
http://www.example.com/
http://www.ex*.com/
http://www.example.com/
http://www.*.com/
http://www.example.com/
http://www.example.com/
http://www.example.abc.com/
http://www.example.com.au/
http://www.example.com.au/
http://www.*.com.au/
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 The Directory Server fully qualified domain name (FQDN) must be present in the respective 
certificate's commonName field or certificate‟s dNSName field of the subjectAltName or both for the 
successful SSL handshake in case of CA signed certificate. 

 IC Client supports multiple commonName fields in the server certificate as well as multiple FQDN 
configured in certificate's dNSName field of the subjectAltName. This means, multiple FQDN can be 
used in one certificate either by using multiple commonName fields in certificate or having multiple 
dNSName field entry in the certificate‟s subjectAltName field. 

Important: 

1. If Directory Server is using CA signed certificate on different Directory Server machines (Primary and 
Secondary), then it is recommended that only single certificate containing multiple FQDNs of different 
Directory Server machines (Primary and Secondary) should be used by entering different FQDNs in the 
certificate with the help of: 

a. Multiple commonName field of the certificate, or 

b. Multiple dNSName field of the subjectAltName of the certificate, or 

c. Both (above), or 

d. Using accepted wildcard characters for FQDN in the certificate. 

In this case the single CA‟s certificate should be distributed to all the client machines, and needs to 
be copied in to <AVAYA_IC72_HOME>\etc folder with the name root_cert_AvayaIC_Client.pem. 

2. Multiple CAs can be used to sign certificate(s) under following circumstances: 

a. Different CAs signing a single certificate at different hierarchy level and creating a certificate chain 
inside that certificate, or 

b. Different certificates (containing different FQDN information) used for different Directory Server 
machines (Primary and Secondary) signed by different CAs, or 

c. Both (above) 

In this case certificates of ALL of the CAs involved in signing server certificate(s) needs to be 
appended one after another (not necessary in any particular order) in to 
root_cert_AvayaIC_Client.pem file. This file should be distributed to all the client machines and 
should be copied in to <AVAYA_IC72_HOME>\etc folder with the same name. For example, 

-----BEGIN CERTIFICATE----- 

<CA 1 Certificate> 

-----END CERTIFICATE----- 

-----BEGIN CERTIFICATE----- 

<CA 2 Certificate> 

-----END CERTIFICATE----- 

-----BEGIN CERTIFICATE----- 

<CA 3 Certificate> 

-----END CERTIFICATE----- 

…………. 

…………. 
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Multiple CA certificates can be appended in to root_cert_AvayaIC_Client.pem file using notepad or 
any other text editing tools. 

Note: IC Active Directory/LDAP integration feature supports certificate chain depth (signing hierarchy) 
up to 9 levels. 

Following openSSL commands can be used to create a CA and then create a server certificate 
signed by that CA. 

Generate Certificate 

 

Self signed certificates 

Using CA signed certificates could mean a complicated setup in terms of host name validation, as we have 
seen above. Some customers may not be in a position for such an arrangement, or may not have need for 
such a complicated setup. To help such situations, IC also supports self-signed certificates to be used to 
establish a secure SSL connection between the clients and Directory Server. In this case, the CA certificate to 
be used on the client side is essentially the same self-signed server certificate. When the client attempts a 
secure connection to the Directory Server, it tries to validate the certificate the server sends it. If the certificate 
is self-signed, it tries to match the certificate received from the server with the certificate which exists on the 
client side. If they match, then the handshake is successful, else the connection is rejected by the client. 

REM 1. Generate pass-phrase protected Private Key for CA: 

openssl genrsa -des3 -out root_key_AvayaIC_CA.pem 1024 

 

REM 2. Create the CA Certificate: 

openssl req -new -x509 -extensions v3_ca -key root_key_AvayaIC_CA.pem -out 
root_cert_AvayaIC_CA.pem -days 5475 

 

REM 3. Generate pass-phrase protected Private Key for Server: 

openssl genrsa -des3 -out domain_key_AvayaIC_Server.pem 1024 

 

REM 4. Create the Server Certificate Request: 

openssl req -new -key domain_key_AvayaIC_Server.pem -out domain_req_AvayaIC_Server.pem -
days 1825 

 

REM 5. Sign the request with the Root CA and make a Server certificate containing Server public key: 

openssl x509 -req -days 1095 -in domain_req_AvayaIC_Server.pem -extensions v3_usr -CA 
root_cert_AvayaIC_CA.pem -CAkey root_key_AvayaIC_CA.pem -CAcreateserial -CAserial ca.srl -out 
domain_cert_AvayaIC_Server.pem 

 

REM 6. Make a copy of CA Certificate to be used as Client's trusted CA: 

copy root_cert_AvayaIC_CA.pem root_cert_AvayaIC_Client.pem 
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Note: In case of self-signed certificate, successful certificate‟s FQDN validation by the client is optional during 
SSL handshake and Directory Server certificate may contain any information in certificate's commonName 
field or certificate‟s dNSName field of the subjectAltName. 

Important: If Directory Server is using self-signed certificate then only single certificate should be deployed 
and configured on different Directory Server machines (Primary and Secondary). The same self-signed 
certificate should be distributed to all the client machines, and needs to be copied in to 
<AVAYA_IC72_HOME>\etc folder with the name root_cert_AvayaIC_Client.pem. 

Following openSSL commands can be used to create a self-signed server certificate. 

 

 

 

 

 

 

 

 

 

 

The same process is applicable for windows as well UNIX based clients/servers. 

Pass-Phrase protected server private key  

Every server side certificate contains the public key along with other information e.g. FQDN etc. and has a 
corresponding private key which is used for asymmetric encrypt-decryption of SSL communication. The 
private key could be a part of the certificate file itself or resided in a different file. The default key file Directory 
Server will read at startup is domain_key_AvayaIC_Server.pem. The key file name can be changed using 
Directory Server configuration properties using IC Manager. In case the key file is a part of the certificate 
itself, give the certificate file name in the properties. 

The private key could be saved on the file system as is, or in an encrypted form protected by passphrase. If 
the key is encrypted, then a passphrase is required by Directory Server for decoding the private key. The 
passphrase can be configured through IC Manager‟s Configuration tab for respective Directory Server. 

Note: The default certificates installed with this Service Pack will not provide a true SSL security due to the 
fact that the default server private key is shared to all the customers using this Service Pack. In order to keep 
the Active Directory/LDAP password secure, it is highly recommended that customers create either a new 
self-signed certificate or create/get a CA signed certificate. CA signed certificate is more recommended as it 
prevents Man in the Middle attack through certificate‟s FQDN validation which is absent in self-signed 
certificate. 

Directory Server login process 
Once the SSL handshake and verification is successful, the login request is sent in a secure manner to the 
Directory Server by the IC client. There are 2 options which Directory Server could use to authenticate the 
agent. The first is the usual method of authentication of IC agents, wherein the data received in the login 
requested is compared with the employee table data in the repository database. With this Service Pack, 

REM 1. Generate pass-phrase protected Private Key for Server: 

openssl genrsa -des3 -out domain_key_AvayaIC_Server.pem 1024 

 

REM 2. Create the Self-Signed Server Certificate: 

openssl req -new -x509 -extensions v3_usr -key 

domain_key_AvayaIC_Server.pem -out domain_cert_AvayaIC_Server.pem 

-days 1095 

 

REM 3. Make a copy of Self-Signed Server Certificate to be used as Client's trusted 

Certificate: 

copy domain_cert_AvayaIC_Server.pem root_cert_AvayaIC_Client.pem 
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support is added for authenticating agents against an Active Directory/LDAP server. This requires creating 
agents by importing relevant data from an Active Directory/LDAP server. 

Every login request that Directory Server receives could either be for an agent which needs to be 
authenticated against the IC system, or which needs to be authenticated against an Active Directory/LDAP 
server. In case of authentication against an Active Directory/LDAP server, the user-password and a unique 
identifier (usually the Distinguished Name) need to be sent to the Active Directory/LDAP server for 
authentication. The authentication result received from Active Directory/LDAP server is passed back to the 
respective IC clients. 

 

Note: IC does not support SASL authentication with Active Directory/LDAP server at present. 
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IC 7.2.3 Service Pack Configuration 

Deploying IC 7.2.3 on Windows 2008 Server R2 
IC 7.2.3 has added support for Windows 2008 R2 Server operating system.  However, IC 7.2 RTM installer 
was changed for the same. In case you have downloaded the IC 7.2 RTM installer prior to 7.2.3 Service Pack 
GA, then it needs to be downloaded again. (For downloading the updated IC 7.2 RTM installer, visit the Avaya 
Support Center Web site: http://support.avaya.com) 

Therefore, any deployment on Windows 2008 R2 Server shall require IC 7.2 RTM installation followed by IC 
7.2.3 SP installation followed by configuration as described in the steps below. 

The installation of IC 7.2.3 requires the following steps to be performed: 

1. Install IC 7.2 RTM on the machine where Win2008 R2 has been installed. No configurations should be 
performed at this point of time. Any configuration related screens which pop up during installation should 
be cancelled. Configuration tool should also not be run to configure the server as 
Primary/Secondary/Client. 

2. Install IC 7.2 SP3 on the machine on which 7.2 RTM was installed in the previous step. Steps to install 
the service pack provided in this document should be followed. 

3. Run the configuration tool to configure the server as a Primary/Secondary IC server or as a client for 
Design/Admin machine. 

Perform configuration steps as appropriate for the role designated for the newly installed IC. 

The following IC features can be deployed on a Windows 2008 Server R2 machine: 

 Servers (Primary/Secondary) 

 Design/Admin 

 AAWC Connector 

 Avaya Business Advocate 

 Website (using IIS7) 

 Siebel Integration 

 XenApp Application server (citrix) 

Configuration and prerequisites for Windows 2008 Server R2. 

Windows 2008 Server introduces a new concept of Roles/Feature to make management of Servers easier 
and more efficient. This section lists the Roles and Features required to successfully install/configure IC on 
Windows 2008 Server R2. 

Roles 

 Web Server (IIS), for servers hosting website. Following Role Services are required for this role: 

 Common HTTP Features 

 Application Development 

 (ISAPI Filters) 

http://support.avaya.com/
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 (ISAPI Extensions) 

 Health and Diagnostics (Optional) 

 Management Tools 

 IIS Management Console 

 IIS Management Scripts and Tools 

Note: Only the essential roles/services required for successfully configuring the website are listed above. 
Additional Roles/services are required for maintaing and running a website using IIS. 

Features 

 Message queuing (for servers hosting Advocate) 

 .Net Framework 3.51 Features 

 Role Administration – Webserver (IIS) Tools 

 Windows PowerShell Integrated Scripting Environment 

 Windows Process Activation Service 

Please note, only the essential Features/services required for successfully configuring and running IC are 
listed above. Additional Features/services may be required for a fully functional server running other software 
besides IC. 

Servers 

Prerequisites 

There are no prerequisites in addition to those mentioned in the pre requisite guide to deploy IC servers which 
are to be deployed on a Windows 2008 Server R2 OS machine. Some of the prerequisites may need to be 
installed in a different manner as specified in the beginning of this section. 

Configuration 

As already mentioned, no configuration should be done for the machine hosting Avaya IC on a Windows 2008 
Server machine before the IC Service Pack 7.2.3 is installed. Once the IC Service Pack 7.2.3 is installed, 
normal process of configuring the servers to be deployed on a Windows OS are to be followed – follow the 
relevant sections in the install guide for the same. 

Design/Admin 

Prerequisites 

There are no prerequisites in addition to those mentioned in the pre requisite guide to deploy IC Desig/Admin 
tools which are to be run on a Windows 2008 Server R2 OS machine. Some of the prerequisites may need to 
be installed in a different manner as specified in the beginning of this section. 

Configuration 

As already mentioned, no configuration should be done for the machine hosting Avaya IC on a Windows 2008 
Server machine before the IC Service Pack 7.2.3 is installed. Once the IC Service Pack 7.2.3 is installed, 
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normal process of configuring the Design/Admin tools to be run on a Windows OS are to be followed – follow 
the relevant sections in the install guide for the same. 

AAWC Connector 

Prerequisites 

There are no prerequisites in addition to those mentioned in the pre requisite guide to deploy AAWC 
Connector on a Windows 2008 Server R2 OS machine. 

Configuration 

As already mentioned, no configuration should be done for the machine hosting Avaya IC on a Windows 2008 
Server machine before the IC Service Pack 7.2.3 is installed. Once the IC Service Pack 7.2.3 is installed, 
normal process of configuring the AAWC Connector to be run on a Windows OS are to be followed – follow 
the relevant sections in the install guide for the same. 

Avaya Business Advocate 

Prerequisites 

There are no prerequisites in addition to those mentioned in the pre requisite guide to deploy Avaya Business 
Advocate on a Windows 2008 Server R2 OS machine. Some of the prerequisites may need to be installed in 
a different manner as specified in the beginning of this section. 

Configuration 

As already mentioned, no configuration should be done for the machine hosting Avaya IC on a Windows 2008 
Server machine before the IC Service Pack 7.2.3 is installed. Once the IC Service Pack 7.2.3 is installed, 
normal process of configuring Avaya Business Advocate are to be followed – follow the relevant sections in 
the install guide for the same. 

Website 

Prerequisites 

Prerequisites for successfully deploying a website on Windows 2008 Server R2 machine are listed earlier in 
this section. Please be sure to have the necessary Roles and features required for the same. 

Configuration 

Windows 2008 Server R2 supports only IIS7.x web server. There are architectural changes between the 
previous versions of IIS and IIS7.x. Due to this, new scripts have been packaged along with the service pack 
which will configure an IIS7.x web server for successfully hosting an Avaya IC website. 

Before the website configuration is performed, please be sure to apply the service pack on a Design/Admin 
machine and follow the steps to be performed after applying the service pack on the Design/Admin machine. 
A new sc.xml file has been packaged along with this service pack. Be sure that the new sc.xml file has been 
imported into ICManager before configuring the website on a machine hosting Avaya IC on a Windows 2008 
Server machine. 

When the configtool is run after the necessary steps as mentioned above are performed, a new checkbox – 
IIS7.x will be visible in the “Web” tab of the configtool, as shown below: 
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This checkbox is to be enabled when configuring a website which is to be hosted on an IIS7.x web server. 
Enabling the checkbox ensures that the correct scripts are used to configure the web server. As previously 
mentioned, there are some architectural changes in IIS7.x, and the fact that it is a 64-bit application, some 
changes done by the configtool/ IIS configuration scripts are mentioned below: 

All websites/applications are run using an application pool. During configuration, the default application pool 
for the website is used as the application pool for the application created during the web server configuration. 
The application pool associated with these applications has a property “Enable 32 bit applications to run”, 
which is required to be enabled to allow the 32 bit ISAPI filters/extensions which are used by Avaya IC. The 
scripts change this property to true. 
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This property can be found in the Advanced Settings for an application pool. 

Every Application Pool is associated with an Identity (user) under which it is run. The process has all the 
rights allotted to that Identity (user). As any filters/extensions on the website are run under this identity, this 
identity needs access to be able to write logs to the required directories. Hence, write permissions are granted 
to the identity associated with Application pool under which the website is running under for the following 
folders: 

<AVAYA_IC_HOME>\tomcat\logs 

<AVAYA_IC_HOME>\logs 

Read permissions are also granted for the above mentioned user Identity for the folders under which the 
ISAPI filters are installed: 

WebAdmin - <AVAYA_IC_HOME>\comp\icws 

Tomcat Redirector - <AVAYA_IC_HOME>\tomcat\modules 

ICM - <AVAYA_IC_HOME>\comp\icm\vdir 

Email template management - <AVAYA_IC_HOME>\email\jsp 

Public/Admin pages - <AVAYA_IC_HOME>\comp\website 

Siebel Integration 

Refer to Siebel Installation Guide available with Siebel 8.1.1.3 product for installation on Windows 2008 
Operating System. 

Avaya Agent Web Connector (AAWC) 

Perform the following steps on machine where Avaya Agent Web Connector is installed. 

1. Stop AAWC server <AVAYA_IC72_HOME>\bin\aawcclient.bat stop. 

2. Edit <AVAYA_IC72_HOME>\bin\aawcclient.bat in text editor.  

3. Find line starting with SET JAVA_OPTS 
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4. Add Parameter "-Xss128k" to Java Options 

Example: SET JAVA_OPTS=-server -XX:+UseParallelGC -XX:+UseParallelOldGC -Xms1124m -
Xmx1124m -Xss128k -Xbootclasspath/a:"%CATALINA_HOME%\common\lib\mail.jar" 

5. Save and close. 

6. Start AAWC Server - <AVAYA_IC72_HOME>\bin\aawcclient.bat start 

Deploying Avaya Rich Client on Citrix XenApp 6.0 

This section provides detailed information on how to deploy Avaya Rich client on Citrix XenApp version 6.0 on 
Windows 2008 Server R2. 

Install Avaya Rich client on Citrix server 

To install Avaya Rich client, refer IC72install.pdf  

Deploying Avaya Rich client on Citrix server 

1. Launch Citrix Delivery Services Console. 

 

2. Farm has been already created while configuring XenApp for servers. For eg. XenAppFarmIC 
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3. Expand XenAppFarmIC. Select Application and Right click > Applications and select > Publish 
application. 

 

4. Click the Next button on the welcome screen. 

5. Enter the application display name and description and Click Next.  
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6. On the Publish Application screen, select the Installed application option and click Next. 
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7. Browse and select “qui.exe” path in command line. 

Note: Working directory path is automatically reflected. 
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8. Modify command line path “C:\Program Files\Avaya\bin\qui.exe” to below text 

"C:\Program Files\Avaya\bin\qui.exe" -d C:\Program Files\Avaya\apps\interaction_center -n 
interaction_center, if AVAYA_IC72_HOME resides on C drive. Else, select the appropriate drive and path. 

Click Next. 

9. Click the Add button at the bottom of the screen. 

10. Select Citrix server name and click OK button. 

11. Click Next. 

 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 128 

 

12. Select allow only configured users option (You can select Allow anonymous users option) 

13. Click the Add button. 
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14. Add users, click OK button 

15. On adding Users successfully, click Next. 

16. Click Next on the screen below. 
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17. Select Configure advanced application settings now and click Next. 
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18. Access control should be any connection (You can set appropriate filter also), click Next. 
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19. Click Next for content redirection. 
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20. Select maximum number of instance that are allowed to run in server farm 

21. If you want only one instance of application for each user then select “Allow only one instance of 
application for each user” option and Click on Next button 
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22. Click Next on the Client options screen. 
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23. Select appropriate Session window size and Colors and Click Finish. 
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24. Verify that Avaya Agent Rich Client application is added under Citrix applications. The published 
application settings can be changed from Citrix Delivery Services Console. 

Modifying the Avaya Agent INI file  

1. Update the Citrix server's qui.ini file with the following two lines  

[QConsole] 

ResizeDesktop=FALSE  

2. Save the qui.ini file. 

Note: Make sure that all the qui.ini files (files under agent account) are also updated with the above code. 

Creating ICA (Citrix Client) connection with Citrix server  

1. Install Citrix ICA Client, CitrixOnlinePlugin for Web and Citrix QuickLaunchTool(Download from Citrix) on 
Windows XP / 2003 machine 

2. Open Citrix Citrix QuickLaunch Tool from Citrix client machine. 
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3. Click Options. 

 

4. Add XenApp Server address and XML port (Specified while configuring  PNAgent) 

5. Select published application name from Dropdown. 

6. Select Display options. 

7. Select encryption level for ICA Options. 

8. Enter login credential of Citrix XenApp Server. 

Note: User should have access permission of published application from Citrix presentation server. 
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9. Click on “Write ICA File” and give a location to save ICA file. 

Double click on saved ICA file or use Connect button of Citrix QuickLaunch Tool to start Avaya agent. 

Support for Authentication-Only against full DS Login 

Design & Admin Configuration: 

1. Exit all IC Design & Admin applications. 

2. Install IC 7.2.3 Design & Admin Service Pack on the respective machines. 

3. Start IC Manager and import the sc.xml file (if not already imported) into IC Manager 

4. Open WebServices Server through IC Manager and go to WebServices tab. 

5. A new Configuration 'Enable SSL for DS Authentication' should be visible and checked by default. 

IC Webservice Configuration for applicable platform(s): 

1. Stop the IC Webservice, if running on the applicable platform(s). 

2. Remove the already deployed IC WebServices. 

3. Run IC 7.2.3 Service Pack installer on the applicable platform(s). 

4. Re-deploy IC WebServices. Make sure that the latest jars from service pack are present in 
<AVAYA_IC72_HOME>/sdk/webservices/webservices/WEB-INF/lib folder after re-deployment. 

5. Start IC Webservice on the applicable platform(s). 

'Enable SSL for DS Authentication' Configuration for WebServices: 

 

1. If 'Enable SSL for DS Authentication' configuration parameter is checked, DS.Authenticate request will be 
sent over SSL by WebServices to DS in SSL encrypted format. It will support authentication for both 
LDAP and non-LDAP users. 

2. If 'Enable SSL for DS Authentication' configuration parameter is unchecked, DS.Authenticate request will 
be sent over VESP by WebServices to DS. The password will be in MD5 encrypted format and rest of the 
request parameter will be in plain text format in this case. It will support authentication for ONLY non-
LDAP users and authentication for LDAP users will fail. 
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Important Note: 

 Response time for DS.Authenticate over SSL will be slower compared to the reponse time of 
DS.Authenticate over VESP because of SSL overhead of handshake, encryption/decryption etc. 

 If 'Enable SSL for DS Authentication' configuration parameter is unchecked, DS.Authenticate request 
for LDAP enabled users will fail. To authenticate LDAP enabled users, DS.Authenticate MUST be 
sent over SSL by checking 'Enable SSL for DS Authentication' configuration parameter. 

RFC 5321 Compliance (Address Comparisons): 
1. A new property "EnableRFC5321LocalPart" (without double quotes) is introduced in this FIX. This 

property can be manually added in the ICManager->Poller_Server->Configuration Tab. A value '1' 
ALONE will enable usage of this property for the purpose specified below. (Any other value will disable 
this property) 

To configure the enablement of this feature perform the following steps: 

a. Click the Server tab. 

b. Double-click the Poller server.   

c. Click the Configuration tab. 

d. Add a new "Couple" with name: "EnableRFC5321LocalPart" 

e. Value: 

 1 - Turn ON this fix 

 0 - Turn OFF this fix 

 [Any other value is treated as OFF] 

f. Click OK. 

2. This property will decide if the address comparisons will compare email local-parts as per RFC5321. (As 
per RFC5321 "The local-part of a mailbox MUST BE treated as case sensitive.") 

3. Enabling (setting value to'1') will enable case-sensitive comparisions of local-parts of Mailboxes with 
email polling/logon accounts. (By default, this property is turned off) 

4. This property should be used and configured in ICManager ONLY if the external Email Server (for ex. 
Exchange) at your installation can differentiate the local-part cases. i.e. external Email Server treats 
Support@xyz.com and support@xyz.com as two different mailboxes. 

Usage of Reply-To Address when From Address is 
invalid or missing 
1. A new property "UseReplyToIfNoFrom" (without double quotes) is introduced. This property can be 

manually added in the ICManager->Poller_Server->Configuration Tab. A value '1' ALONE will enable 
usage of this property for the purpose specified below. (Any other value will disable this property) 

2. To configure the enablement of this feature perform the following steps: 

a. Click the Server tab. 

b. Double-click the Poller server.   

c. Click the Configuration tab. 
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d. Add a new "Couple" with name: "UseReplyToIfNoFrom" 

e. Value: 

 1 - Turn ON this fix 

 0 - Turn OFF this fix 

[Any other value is treated as OFF] 

f. Click OK. 

3. Enabling (setting value to'1') will enable usage of "Reply-to" address in case "From" address is invalid of 
missing. (By default, this property is turned off) 

NOTE: An email having ALL invalid or missing "From" address, "Reply-To" address and "Sender" address, 
will be skipped by Poller on every poll cycle as per the existing design, so that there is no data loss and the 
email can be handled by the IC Administrator. 

Usage of Return Address while populating "From" 
header of outbound email 
1. A new configurable parameter "UseReplyToForReturnAddress" is added to the icemail server 

configuration. This flag decides how the return address is sent. This propery can be set in ICManager-
>ICEmail Server->Configuration tab Key value pair. (UseReplyToForReturnAddress, value). 

2. Value can be "1"(meaning Property Enabled) / "0"(meaning Property Disabled). 

a. "From:" header in this case is consistent with as in IC7.1 which is return address configured for the 
email account. By default this property is disabled (not configured or configured to value <>1) and 
end-customer will see the Return address in the "From:" header of the mail received from agent. So, 
replies to this email will arrive at Return address.  

This property need not be configured, unless behavior in b) is desired. 

b. "From:" header in this case contains the Polling-address and "Reply-To" header consists the Return-
address. When this property is enabled (set to 1), the Return-address will be populated in the "Reply-
To:" header of the mail received from agent, while "From:" header continues to contain polling 
address. So, replies to the email sent from end-customer to agent will use "Reply-To:" header and the 
email will arrive at Return address.  
The respective configured DisplayNames will appear alongside the mail-address in the email. 

Configuring stations with leading zeros to be used as 
VP stations in HTTPVox 
Perform the following steps on the Windows Design and Admin machine: 

1. Start IC Manager and import the sc.xml file (if not already imported) into IC Manager. 

Note:  The configured extensions with leading zeros will be preserved only if all line numbers in the range 
have the same number of digits. 

Example: 

 Range 08132-09132 has same number of digits so the leading zeros will be preserved 

 Range 008123-09132 does not have same number of digits so the leading zeros will not be 
preserved 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 141 

AAWC/UOM configuration (to fix Agent AutoIn and 
INIT_AUX issues as a result of TS.Ready being issued 
on Workitem Completion) 
Perform the following steps on the windows machine where AAWC is installed: 

1. Create the new webclient.war file using wargenerator.bat on WebClient machine.  

2. Redeploy the newly created webclient.war file on WebClient Connector machine. For more information, 
refer IC 7.2 Installation and Configuration.pdf. 

Note: To generate webclient.war file and deploy on Windows/AIX/Solaris Webconnector machines, please 
refer to "IC7.2 Installation and Configuration guide" in Avaya Support Site http://support.avaya.com 

Handling OTHER_PARTY_CONFERENCE event from IC 
Scripts (customizations) 
With this Service Pack, VTel will send a new event "OTHER_PARTY_CONFERENCE" when a party is 
conferenced to the call monitored by the agent. In order to handle this event in the scripts, following steps 
need to be taken: 

1. Login to datatbase. 

2. Open the apporpriate ccq.adl file 

3. On the menu navigate to Edit > IC Scripts. This will open the 'IC Script Editor' 

4. In 'Scripts' section, navigate to a script named "Softphone_Login". Click on the script name to edit the 
script in the panel below. 

5. Add the following line where Telephony Event ID Constants are defined  
Const evCallOtherPartyConference= 308 

6. Inside the function SetupEvents(), add the following line to register to listen for this event 
bSuccess = iPhoneEngine.AddEventToListenFor(evCallOtherPartyConference) 

7. Now one can modify the script 'PhoneEngine_OnTelephonyStateChanged' to handle the event 
“evCallOtherPartyConference”. 

Configuring IBM HTTP server 7.x on AIX-6.1 
1. Run configtool (Web tab), and fill in the value of "Web Server Home" with the folder in which IHS7.x is 

installed. 

2. Edit <AVAYA_IC72_HOME>/etc/ictomcat.cfg and search for the LoadModule directives. Replace the 
names of the modules (last parameter) in these directives as follows:  

a. Replace libapachedatasensor.so with libapachedatasensor_ihs7.so. 

b. Replace libapachedatasensor.so with libapachedatasensor_ihs7.so. 

c. Replace mod_jk.so with mod_jk_ihs7.so. 

3. Edit <AVAYA_IC72_HOME>/lib/httpserver.sh and ensure that the variable WEBSERVER_HOME has 
been assigned the correct IHS7.x installation path. 

http://support.avaya.com/
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IC 7.2.4 Service Pack Configuration 

IC 7.2.3.1 Configuration 
Note: If customer is on 7.2.3 update1 and already applied this configuration, this IC 7.2.3.1 Configuration 
should be skipped. 

Disabling auto generation of a new TrackingID for incoming 
emails: 

The behavior of the Poller server in IC 7.2.3 for an email with a TrackingID in the subject that doesn't match 
any existing record in the IC database due to purging of database is that the email will remain on the email 
server and the Poller server will alarm every polling interval about this email until the email is cleared from the 
email mailbox. This issue has been address by this update, by generating new TrackingID for such emails 
and treating them as new email contacts. The default behavior of this fix is to generate a new TrackingID for 
emails having purged parent entry from the IC database. For more information please refer to wi00840365 

In case it is desired not to treat such emails as new contacts (email will remain on external email server and 
alarms will be generated), this fix can be disabled by performing the below steps (set value to 1): 

1. Login to ICManager using admin account. 

2. Click the Server tab. 

3. Double-click the Poller server.    

4. Click the Configuration tab. 

5. Add a new "Couple" with name: "NoNewTrackingIDForPurgedParent" 

(Without double quotes) 

6.  Value: 

 1 - Disable this fix (email will not be polled by poller server) 

 0 - Enable this fix (email will be polled by poller server) 

(NOT ADDING THIS VALUE OR ADDING ANY VALUE APART FROM 1 WILL ENABLE THIS  

FIX. i.e. The default behavior is that a new tracking id is generated for emails for which the parent contact 
entry has been deleted from the database.) 

7. Click OK. 

8. Restart the Poller server. 

Allowing non-RFC-compliant emails to be processed by AIC 

From IC72 onwards poller server checks email headers (From/Sender/ReplyTo) for RFC compliance. By 
default if none of these headers are compliant to RFC then such email will remain on the email server and the 
Poller server will alarm every polling interval about this email until it is cleared from the mailbox. To disable or 
enable RFC compliance a new configuration value for the poller server has been provided. For more 
information please refer to wi00845454. 

1. Allowing Poller Server to download NON-RFC compliant emails to into the system:  

(NON-RFC compliance is based on invalid from/sender/reply-to addresses) 
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a. Login to ICManager using admin account. 

b. Click the Server tab. 

c. Double-click the Poller server.    

d. Click the Configuration tab. 

e. Add a new "Couple" with name: "DisableEmailAddressRFCCheck"  

(without double quotes) 

f. Value: 

 1 - Turn OFF RFC compliant checking. 

 0 - Turn ON RFC compliant checking. 

(NOT ADDING THIS VALUE OR ADDING ANY VALUE APART FROM 1 WILL ENABLE THIS 
FEATURE. i.e. the default behavior is that RFC compliant checking will take effect.)  

Note: Such emails with invalid from/sender/reply-to addresses will be bounced by the poller server's 
SPAM plugin (through email server) to the bounce address of the respective Mail Account from which 
the email was polled. (Unless the flag “DisableRFCCheckInSpamPlugin”, mentioned in following point 
(2) is used) 

g. Click OK. 

h. Restart the poller server. 

2. To configure Poller Server to allow NON-RFC compliant emails to be delivered to agent:  

(NON-RFC compliance is based on invalid from/sender/reply-to addresses) 

a. Click the Server tab. 

b. Double-click the Poller server.    

c. Click the Configuration tab. 

d. Add a new "Couple" with name: "DisableRFCCheckInSpamPlugin" 

(Without double quotes) 

e. Value: 

 1 - Turn OFF SPAM RFC checking. 

 0 - Turn ON SPAM RFC checking. 

(NOT ADDING THIS VALUE OR ADDING ANY VALUE APART FROM 1 WILL ENABLE THIS 
FEATURE. i.e. The default behavior is that RFC compliant checking will take effect.)  

f. Click OK. 

g. Restart the Poller Server. 

Note: If steps in "2" are performed while the steps in "3" are not performed, then the respective bounce 
address for mail account will be used as a substitute email address. 

3. Configuring a substitute email address which will be shown to the agent:    

Substitute email address will be used in place of FROM address of the incoming email in case the email 
MIME does not contain FROM address or contains an invalid one. 

a. Click the Server tab. 
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b. Double-click the Poller server.    

c. Click the Configuration tab. 

d. Add a new "Couple" with name: "SubstitueFromAddress" 

(Without double quotes) 

e. Value:  Any valid email address. 

Note: If email address is not provided or an invalid email address is provided in "d", the respective 
polling account‟s bounce email address will be used as a substitute address. 

f. Click OK. 

g. Restart the Poller Server. 

ADL changes to enable loop-detection type “BOTH” 

In IC manager, for an email account, loop detect type can be set to either "sender", "from" ,"replyto"  or “both” 
( Miscellaneous tab). Before applying this fix ICManager was allowing to select value as “both” but that value 
was not getting reflected into database. After reopening the email account window, it shows the value for loop 
detects which was set prior to being changed to "both". To overcome this problem below configuration steps 
are needed. 

Note: Perform the steps mentioned in the section below, only if the functionality fixed in the items wi00830582 
and wi00895056 are desired. 

The ccq.adl and repository.adl files (files are not part of the IC 7.2.3 update1. Use the current adl from the 
design and admin machine) need to be modified to ensure that the loop-detection type BOTH works correctly. 

The following steps have to be performed after the IC 7.2.3.1 is applied. 

1. On the Design and Admin system, run the Database Designer application. 

2. Select Open from the File menu. 

3. Select the "...\<AVAYA_IC72_HOME>\design\CallCenterQ\ccq.adl" file. 

4. Navigate to "Components->Tables->qem_mailaccount" table. 

5. Click on the table fieldname “loopdetectiontype”. 

6. Select the “FROM_REPLYTO” from Enumerated_value (value tab) list box and click the Edit button. 

7. Replace “FROM_REPLY” with “BOTH”. 

8. Click File > Save. 

9. Click on File > Generate Windows Application menu. This will popup “Generate Windows Application” 
dialog box.  Uncheck all the check boxes(Messages, IC Scripts, Help File, Avaya Agent Layout and EDU 
Layout) from the save tab. Click on Ok button. After reconfiguration is completed, click “close” on the 
“File” Menu to close the adl file.  

10. Repeat the steps 1 through 9 for "...\<AVAYA_IC72_HOME>\design\repository\repository.adl" file.  

11. Execute the query “UPDATE qw_fieldinfo SET enum_label = 'BOTH' WHERE table_name = 
'qem_mailaccount' AND column_name = 'loopdetectiontype' AND enum_value = '3'” on both ccq and 
repository databases if MSSQL is used as database. 

If oracle database is used, execute above query by loging in ccq and repository user. If db2 database is 
used, execute above query on ccq and repository schemas. 
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Note: After performing above configuration, please restart the DataServer, Directory Server and Poller 
Servers. Perform a Manager->Refresh on ICManager. This ensures ICManager loads the configured 
email accounts correctly to reflect the modified value “BOTH”. 

IC 7.2.3.2 Configuration 
Note: If customer is on 7.2.3 update2 and already applied this configuration, this IC 7.2.3.2 Configuration 
should be skipped. 

CDL file changes to prevent Rich Client (AARC) from crashing 
while exiting the application 

The loading and unloading of various components in Rich Client depends on sequence mentioned in the .cdl 
file. The sequence mentioned in the current .cdl file unloads EDUViewer before unloading components 
dependent on it causing Rich Client to crash. Perform the following steps on the machine where Design and 
Admin tool is installed to correct the sequence in the CDL file: 

1. Open the appropriate .cdl file from “<AVAYA_IC72_HOME>\design\QConsole” directory. (Open the 
language specific file) 

Example: For „english‟ language open avaya_agent_en.cdl file 

2. In the „Contact Pane‟ section move the EDUViewer control which is currently placed after ACViewer 
control, above the CHBrowser control. The difference lies in the order within the CDL file. The actual 
physical layout and layout within the panes will and should remain unchanged. 

Example: 

Snippet from current file:  

 <QControl Name="ACViewer" ProgID="AvayaACViewer.ACViewerCtrl72" Left="454" Top="32" 
Width="20" Height="20" Visible="TRUE"/>                                                                              

 <QControl Name="EDUViewer" ProgID="AvayaEduViewer.EduViewerCtrl.72" Left="490" Top="0" 
Width="300" Height="141" Visible="TRUE"/> 

After moving EDUViewer above CHBrowser: 

 <QControl Name="EDUViewer" ProgID="AvayaEduViewer.EduViewerCtrl.72" Left="490" Top="0" 
Width="300" Height="141" Visible="TRUE"/> 

 <QControl Name="CHBrowser" ProgID="AvayaCHBrowser.CHBrowserCtrl.72" Left="5" Top="25" 
Width="441" Height="111" Visible="TRUE"> 

3. Save the .cdl file. 

4. Start the Avaya Database Designer. 

5. Load the ccq.adl file in the “<AVAYA_IC72_HOME>\design \CallCenterQ” directory. 

6. Generate windows application by selecting appropriate .cdl file. (Check only Avaya Agent Layout option.) 

Configuration file changes for WebAgent(AARC) Hyperlink 
feature 

A new feature has been introduced in WebAgent to support text hyper linking in HTML mode. Two new 
buttons have been added in the HTML toolbar of Email and Resource editor, namely: 
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1. Insert Hyperlink: To hyperlink selected text. 

2. Remove Hyperlink: To remove the hyperlink from selected text. 

 

The Hyperlink Dialog Box would pop up with click on the „Insert Hyperlink‟ button. It contains following 
options for hyper linking: 

1. Existing File or Web Page: Hyperlink to existing file or Web Page. 

2. Email Address: Hyperlink to email address. 
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Displaying default values for Web-Links and Email Addresses 

The Hyperlink dialog box can be configured to display default Web Links and Email Address which can be 
used for hyper linking any text inside the WebAgent HTML Editor. 

To enable default Web-Links and Email addresses, the Editlive! Configuration files can be modified as below: 

1. Go to <AVAYA_IC72_HOME>\IC72\WebAgent\editlive directory on the machine where AARC is installed. 

2. Edit the file NewOutboundEmail.xml. 

3. Go to “<hyperlinks>” tag. 

4. Uncomment <hyperlinkList> and <mailtoList> tags as shown in below snippet.  

5. To customize the hyperlinks and email ids, provide appropriate values for “href” and “description” 
attributes in <hyperlink> and <mailtolink> tags. 

6. Follow the steps #1 to #5 for following files   

a. <AVAYA_IC72_HOME>\IC72\WebAgent\editlive\ReplyForwardEmailConfig.xml 

b. <AVAYA_IC72_HOME>\IC72\WebAgent\editlive\ResourcesConfig.xml 

Snippet from <AVAYA_IC72_HOME>\IC72\WebAgent\editlive\NewOutboundEmail.xml: 

<hyperlinks> 

 <!--  Provide default hyperlink and email ids  --> 
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 <hyperlinkList>     

  <hyperlink href="http://www.avaya.com" description="Avaya Web site" 

/> 

  <hyperlink href="http://support.avaya.com" description="Avaya 

Support Web site" />   

 </hyperlinkList>  

 <mailtoList> 

  <mailtolink href="mailto:test@xyz.com" description="Test ID" /> 

 </mailtoList>  

 <!--  Disable the "Places in Document" option --> 

 <placesInDocumentList enabled="false" />   

</hyperlinks> 

Note: Copy the changed configuration files to the respective „WAC/HomeDir‟ if it is other than the default 
Home Directory defined in ICManager. 

CCFieldPopulation (How to bypass changes to TO and CC 
headers in MIME of incoming emails) 

By default, the Poller Server(s) changes the TO and CC headers in MIME of all incoming emails so that the 
TO header contains the IC polling address and all other address are moved to CC header. This allows the 
agent to display only 1 email address in the TO field when the agent views the email. Also, additional 
advantage of this approach is when the agent uses the “Reply All” functionality, all the non-polling address 
(which were moved to CC) are retained in the CC field of reply from the agent. However, with this approach, 
the agent cannot understand the original intention of the sender of incoming contact, whether the polling 
address was specified in TO or the CC header. Thus causing misinterpretation when the polling address was 
originally added to CC header, but the Poller Server moved it to the TO header. 

To bypass this default behavior, use the below mentioned configuration steps: 

1. In, ICManager Click the Server tab. 

2. Double-click Poller server. 

3. Navigate to Configuration tab and add the following property and click OK.   

Property Name Acceptable Values 

CCFieldPopulation 0 ("Cc" list will be changed if required) 

CCFieldPopulation 1 ("Cc" list will not be changed) 

Note:  

 This property will take effect only on server restart. 

 In case of absence of this property, default "0" value will be used. 

 Configuring this property with value 1 will cause the agent to receive the email MIME as is, the 
way it was polled from the Exchange Server. 
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 This configuration needs to be applied to ALL Poller Servers in the system so that consistent 
behavior is maintained. 

Populating original TO and CC headers of incoming emails in 
new EDU fields: 

Poller Server, by default changes the TO and CC headers of incoming emails so as to address loss-of-email-
addresses issue at the agent side while using the “Reply All” feature. However, this means that the original 
values of TO and CC headers will not be written to the EDU. The changed values of TO and CC headers will 
be present in the EDU (since it always contains values of headers from the MIME of email). 

In order to create a copy of original TO and CC headers (the values before the Poller Server changes it) in 2 
new EDU fields, use the following configuration steps: 

1. In, ICManager Click the Server tab. 

2. Double-click ICEmail server. 

3. Navigate to Configuration tab and add the following property and click OK.  

"OrigToCcInEDU" is a new configuration parameter added to the ICEmail Server. Following are the 
acceptable values for the configuration parameter: 

OrigToCcInEDU Property Value Behavior 

0 No change in functionality. This is the default setting. 

1 Poller server will add new custom headers with the original 
header values if the "To" or "Cc" headers are modified. The new 
custom headers are "XWF_OH_To" and "XWF_OH_Cc" (this is 
a new Poller Server behavior, and not dependent on the value of 
this flag). ICEmail Server will populate new EDU fields using 
values from these custom headers. The corresponding EDU field 
names would be "currentemail.header.XWF_OH_To" and 
"currentemail.header.XWF_OH_Cc". If any of the "To" or "Cc" 
headers have not been modified, then the corresponding custom 
header will not be present, and therefore the corresponding EDU 
field will not be present in the EDU. 

2 Same behavior as '1', except that the new EDU fields will be 
added to the EDU regardless of whether the "To" and "Cc" 
headers are modified. In case the original headers are not 
changed, the new EDU fields will contain values from the actual 
"To" and "Cc" headers. 

Note: 

 This property will take effect only on server vesp update. 

 In case of absence of these properties, default "0" value will be used. 

 This configuration needs to be applied to ALL ICEmail Servers in the system so that consistent 
behavior is maintained. 
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IC 7.2.3.3 Configuration 
Note: If customer is on 7.2.3 update3 and already applied this configuration, this IC 7.2.3.3 Configuration 
should be skipped. 

Multi Language support for email templates: 

RLManager now supports creation of Multi-Language templates for use in acknowledgements. Usually, the 
language used in the template is to be specified when creating or editing the template. This limits the template 
to a single language, and if the language contains characters from another language (other than English), 
then corruption of those characters can occur. The corrupted characters are seen either as boxes or arrows 
when it is received by the customer. To allow creating templates consisiting of more than one language, a 
new “Multi-Language” option has been added to the “Language” selection list when creating or editing a 
template.  

 

Notes: 

 The time format when using the Multi-Language option will be set as 24 hour time format. 

 Multi-Language templates are currently not supported for use as Header/Footer templates. 
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Telephony Server „Wait Time Before Merge Call” 

Configuration mentioned below need to be applied to avail fixes done for the wi00858281 and wi00904616. 
Before appling fix, the functionality of “Wait Time Before Merge Call' configuration available in IC Manager on 
the TS tab, was not effective. After applying the fixes value set for 'Wait Time Before Merge 
Call/merge_call_wait_time‟ will take into the effect. 

TS 'Wait Time Before Merge Call/merge_call_wait_time' should now be set in multiple of 200 milliseconds. 
The default and the minimum values are 200 milliseconds, and the maximum value is 5 seconds. Any 
intermediate value that is not a multiple of 200ms will be rounded off to the lower side (e.g. configuring 2500 
will have effect of 2400ms). If the configured value is exceeded, then the appropriate boundary value will be 
set. If value for “Wait Time Before Merge Call/ merge_call_wait_time'” is set less that 200 ms or greater than 5 
seconds, below low alarm will be generated.  

 If value for “Wait Time Before Merge Call/ merge_call_wait_time” < 200 milli seconds 

 “merge_call_wait_time value is out of operating range (200 milliseconds). Using default value of 200 
milliseconds” 

 If value for “Wait Time Before Merge Call/ merge_call_wait_time” > 5000 milli seconds 

 merge_call_wait_time value is out of range. Resetting it to maximum 5000 milliseconds. 

Please note that the delay before merge will be upto the maximum configured value (and not necessarily the 
absolute configured value). If CM sends events for the outbound call leg (except origination), then the merge 
will happen immediately and will not wait further. Example, the maximum value is configured for 5 seconds. 
However, in the call scenario, if Alerting was received after 1 second for the outbound call leg, the merge will 
happen immediately and not wait for another 4 seconds. 

Note: Default value for 'Wait Time Before Merge Call/merge_call_wait_time' is 50 milli seconds. So you may 
observe low priority alarm whenever telephony server is restarted. 

Perform the below steps to change the value of “Wait Time Before Merge Call” value to 200 milli seconds:  

 Login to IC Manager and select TS Server  

 Select edit option and in the TS tab, right click and select “Advanced properties”  

 Change the value of “Wait Time Before Merge Call” to 200  

 Apply and restart TS  

 Perform this change for every TS that is configured in the system  

Note: If the value is not changed to 200, TS will raise Alarm and set the value to 200 internally. 

The emailcount field update in EDU 

For more details on emailcount, please refer following  

 IC Administration Volume 1: Servers & Domains 7.2, Section: Avoiding an email auto response loop, 
Page 93. 

 Media Workflow Reference 7.2, Section: Detecting email loops, Page 212. 

Limitations: 

 Since primary server and secondary server do not have loopdetect cache in sync, they will not work 
seamlessly in failover scenario. 
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 ICEmail now has a capability of detecting if the customer email has reached loopdetect count after 
Workflow Analyze, Hence it will stop sending any template to customer after Workflow Analyze if the 
loopdetect count is reached. So if any customization done for emailcount to block the acknowledgement 
will be preceeded by the loopdetection count value specified in the mail account configuration. 

IC 7.2.4 Configuration 

The ResetScriptIteration setting for WACD 

With this feature when the WACD server is restarted, WACD will maintain the same priority and same 
workgroup for email contacts that it had prior to the restart, rather than resetting the priority of tasks. 

However, enabling of this new behavior depends on the parameter „ResetScriptIteration‟ and pushing the new 
script to the database. 

Note: The parameter “ResetScriptIteration” is applicable only for the email contacts. If email channel is not 
being used, then the following configurations can be skipped. 

The following steps need to be performed, only if the new behavior is required. Otherwise, the below steps (1 
to 6) can be skipped 

 If the parameter is set to 1, WACD will behave as it used to, before the fix i.e. queue scripts will start from 
iteration zero (priorities of tasks will be reset) 

 If the parameter is set to 0, WACD will recreate tasks at the same priority and workgroup that it had prior 
to the restart provided the new script is uploaded by following steps 1 to 6 (priorities will be maintained as 
prior to restart) 

By default (i.e if not configured) WACD server considers the value of „ResetScriptIteration‟ parameter to be 0 
unless the value is explicitly set to 1 in the WACD configuration in IC Manager. 

Configuration steps to be performed after installing IC 7.2.4 SP: 

1. If the new behavior of WACD server is desired, perform the following steps for all WACD servers: 

a. Login to ICManager 

b. Go to the „Server‟ tab and double click on a WACD server to edit its configuration. 

c. Go to the configuration tab and add a new configuration parameter 

 Name: ResetScriptIteration 

 Value: 0 

d. Click OK to save the WACD configuration 

2. Gathering database information. 

a. Log in to ICManager. 

b. Open Tools menu and click on "IC Data Sources...". 

c. Once "IC Data Sources..." dialog opens expand "interaction_center". 

d. Click on ccqDBConnection. 

e. Note down Database Name and Database Server Values. 

3. Update the w_script_details table 

a. If the CCQ DB is of type SQL Server or DB2, execute the SQLDB2 Script given below 
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b. If the CCQ DB is of type Oracle execute the ORACLEDB script given below 

4. After executing the query, from ICManager restart the WACD server. 

SQLDB2 Script 

update w_scripts_detail set script_text =''' This is the default script 

'' 

'' It looks for the following key-values 

'' 

'' Expectedqueuetime 

'' - If present, it will disply the expected 

'' hold time 

'' 

'' Workgroup 

'' - The value should be a Workgroup to enqueue 

'' to 

'' 

'' Agent 

'' - The value should be an agent name to 

'' enqueue to 

'' 

'' Priority 

'' - The priority of an enqueue (team or 

'' agent) 

'' 

'' Say 

'' - A string message to say to the customer 

'' 

'' PushURL 

'' - A URL to push to the customer 

'' 

'' Wait 

'' - A value (in secs) to wait before 

'' processing the next set of keys 

'' 

'' If Expectedqueuetime is defined, get 
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'' the expected hold time 

if acd.GetValue("Expectedqueuetime") <> "0" then 

acd.sv("time", ACD.ExpectedQueueTime(10)) 

if acd.gv("time") = 0 then 

say("An agent will be with you shortly.") 

endif 

if acd.gv("time") <> -1 then 

say("Your approximate wait time is " & acd.gv("time") & " minutes.") 

endif 

endif 

'' First check if pacAgentName is provided. If so, this will be 

'' used first, and the main loop only entered if the requested 

'' agent does not become available within 30 seconds 

if acd.GetValue("pacAgentName") <> "0" then 

acd.GetAgent(acd.GetValue("pacAgentName")).Enqueue() 

Say("Agent " & acd.GetValue("pacAgentName") & " will be with you shortly.") 

Sleep(30) 

endif 

acd.sv("exit", 0) 

'' 

'' Start the loop 

'' 

while (acd.gv("exit") = 0) 

acd.sv("exit", 1) 

'' 

'' Check to see if a team is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Workgroup" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(low) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(normal) 
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endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(high) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetTeam(Cstr(acd.getvalue("Workgroup" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 

'' 

'' Check to see if an agent is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Agent" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(low) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(normal) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(high) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetAgent(Cstr(acd.getvalue("Agent" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 
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'' 

'' check for a say value 

'' 

if acd.GetValue("Say" & acd.gv("cnt")) <> "0" then 

say(acd.getvalue("Say" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a push url value 

'' 

if acd.GetValue("PushURL" & acd.gv("cnt")) <> "0" then 

pushurl(acd.getvalue("PushURL" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a wait value 

'' 

if acd.GetValue("Wait" & acd.gv("cnt")) <> "0" then 

acd.setvalue("sleep", acd.getvalue("Wait" & acd.gv("cnt"))) 

sleep(Int(CDbl(acd.getvalue("sleep")))) 

acd.sv("exit",0) 

endif 

'' 

'' If this was the 1st time through and 

'' no values were set, then we need to do 

'' a normal routing. 

'' 

'' 

if acd.gv("exit") = 1 AND acd.gv("cnt") = 0 then 

say("Please wait for the next available eContact agent.") 

while(true) 

''ACD.GetTeam("Default").Enqueue() 

Sleep(30) 

Say("Please continue to wait...") 

wend 
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endif 

'' 

'' 

'' If any values were set for this count 

'' then up the counter and continue, 

'' otherwise, set the counter back to zero 

'' and start over. 

'' 

if acd.gv("exit") = 0 then 

acd.sv("cnt", acd.gv("cnt") + 1 ) 

else 

acd.sv("cnt", 0) 

endif 

acd.sv("exit", 0) 

wend' 

where script_name='DefaultQueueScript'; 

ORACLEDB Script 

set scan off; 

declare sScriptVar varchar2(32767) := ''' This is the default script 

'' 

'' It looks for the following key-values 

'' 

'' Expectedqueuetime 

'' - If present, it will display the expected 

'' hold time 

'' 

'' Workgroup 

'' - The value should be a Workgroup to enqueue 

'' to 

'' 

'' Agent 

'' - The value should be an agent name to 

'' enqueue to 

'' 
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'' Priority 

'' - The priority of an enqueue (team or 

'' agent) 

'' 

'' Say 

'' - A string message to say to the customer 

'' 

'' PushURL 

'' - A URL to push to the customer 

'' 

'' Wait 

'' - A value (in secs) to wait before 

'' processing the next set of keys 

'' 

'' If Expectedqueuetime is defined, get 

'' the expected hold time 

if acd.GetValue("Expectedqueuetime") <> "0" then 

acd.sv("time", ACD.ExpectedQueueTime(10)) 

if acd.gv("time") = 0 then 

say("An agent will be with you shortly.") 

endif 

if acd.gv("time") <> -1 then 

say("Your approximate wait time is " & acd.gv("time") & " minutes.") 

endif 

endif 

'' First check if pacAgentName is provided. If so, this will be 

'' used first, and the main loop only entered if the requested 

'' agent does not become available within 30 seconds 

if acd.GetValue("pacAgentName") <> "0" then 

acd.GetAgent(acd.GetValue("pacAgentName")).Enqueue() 

Say("Agent " & acd.GetValue("pacAgentName") & " will be with you shortly.") 

Sleep(30) 

endif 

acd.sv("exit", 0) 

'' 
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'' Start the loop 

'' 

while (acd.gv("exit") = 0) 

acd.sv("exit", 1) 

'' 

'' Check to see if a team is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Workgroup" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(low) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(normal) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(high) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetTeam(acd.GetValue("Workgroup" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetTeam(Cstr(acd.getvalue("Workgroup" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 

'' 

'' Check to see if an agent is defined 

'' and if so, check for a priority 

'' 

if acd.GetValue("Agent" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) <> "0" then 

if acd.GetValue("Priority" & acd.gv("cnt")) = "low" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(low) 
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endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "normal" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(normal) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "high" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(high) 

endif 

if acd.GetValue("Priority" & acd.gv("cnt")) = "urgent" then 

ACD.GetAgent(acd.GetValue("Agent" & acd.gv("cnt"))).Enqueue(urgent) 

endif 

else 

ACD.GetAgent(Cstr(acd.getvalue("Agent" & acd.gv("cnt")))).Enqueue() 

endif 

acd.sv("exit",0) 

endif 

'' 

'' check for a say value 

'' 

if acd.GetValue("Say" & acd.gv("cnt")) <> "0" then 

say(acd.getvalue("Say" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a push url value 

'' 

if acd.GetValue("PushURL" & acd.gv("cnt")) <> "0" then 

pushurl(acd.getvalue("PushURL" & acd.gv("cnt"))) 

acd.sv("exit",0) 

endif 

'' 

'' check for a wait value 

'' 

if acd.GetValue("Wait" & acd.gv("cnt")) <> "0" then 

acd.setvalue("sleep", acd.getvalue("Wait" & acd.gv("cnt"))) 

sleep(Int(CDbl(acd.getvalue("sleep")))) 
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acd.sv("exit",0) 

endif 

'' 

'' If this was the 1st time through and 

'' no values were set, then we need to do 

'' a normal routing. 

'' 

'' 

if acd.gv("exit") = 1 AND acd.gv("cnt") = 0 then 

say("Please wait for the next available eContact agent.") 

while(true) 

''ACD.GetTeam("Default").Enqueue() 

Sleep(30) 

Say("Please continue to wait...") 

wend 

endif 

'' 

'' 

'' If any values were set for this count 

'' then up the counter and continue, 

'' otherwise, set the counter back to zero 

'' and start over. 

'' 

if acd.gv("exit") = 0 then 

acd.sv("cnt", acd.gv("cnt") + 1 ) 

else 

acd.sv("cnt", 0) 

endif 

acd.sv("exit", 0) 

wend'; 

begin 

update qw_text set text=sScriptVar where qwkey=1; 

end; 
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Allow emails with blank body having attachment 

To allow emails having attachment and blank body to enter to IC system a new configurable property ” 
BlankWithAttachment” is added to the Poller Server. 

Setting this property value to 1 will enable Poller Server to treat emails with attachment having blank body as 
“Valid” emails. 

Setting this property value to 0 will enable Poller Server to treat emails with attachment having blank body as 
“Blank” emails. 

Perform the following configuration steps for Poller Server in ICManager after installing IC 7.2.4 SP 

1. In ICManager double-click Poller server.  

2. Click the Configuration tab. 

3. To turn on this feature, add the property „BlankWithAttachment‟ with value '1' and click OK. 

 Property: BlankWithAttachment 

 Value: 1 

4. Update the poller server. 

Note: This property is not defined in the Poller server with OOTB configuration. The default value (in absense 
of this property on configuration tab) is '0'. 

Forwarding Emails with inline images on WebAgent 

Inline images in an incoming email are also added as attachments when the email is presented to the Agent 
in WebAgent. If such email is forwarded, these inline image attachments will get forwarded as well. If the 
original incoming email had any attachments, the inline images will be displayed along with the original 
attachments. 

It may be confusing for an Agent to differentiate between an original email attachment and an inline image 
added as attachment. Also when there are more inline images (typically images in signature that can grow in 
number with every reply) the attachment list grows unnecessarily due to the addition of inline images as an 
attachment. 

A new parameter "email.preview.InlineAsAttachment" is introduced in SP IC7.2.4 SP. By setting this 
parameter to “false”, webagent behaves as following: 

1. Webagent will not include inline images in the attachment list while rendering the email having inline 
images in its body. The inline images will be displayed as inline images only and the Attachment list will 
include only the original attachment (if any) associated with the email. 

2. If agent does a “Forward Copy”, only the original attachments (if any) will be sent out. 

3. If agent does a “customer history search” and selects an email having inline images, attachment list will 
not include the inline images. 

4. If agent changes the preference to view the email (email having inline images) in “Plain” mode, webagent 
will pop a warning message for formatting loss and render the email with plain text. Attachment list will 
include the inline images as an attachment along with the original attachments (If any). 

5. If the agent changes the email preference to view the email in "Plain" mode, then all the inline images will 
be attached in the attachment list. If the agent changes back the email view preference to “html” mode, 
then the inline images will not be rendered by the wegabent‟s email editor and the attachment list will 
contain only the original attachment (if any). 
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Note: If the agent does a “Forward copy” with email view preference set to “plain” mode then the inline 
images will be sent as a part of the email body and not as an attachment.  

Configuration steps to get the new behavior after installing IC 7.2.4 SP: 

1. Goto to the system where Avaya Agent is installed. 

2. Open the "Application.properties" file  to set the configuration parameter value: 

Location: <Avaya_IC_Agent>/webagent 

3. Add this parameter and set its value to "false" 

email.preview.InlineAsAttachment = false  

If this parameter is not present in the file or it is set to „true‟, the same behavior prior to applying SP 7.2.4 i.e. 
"webagent includes the inline images in the attachment list" will be seen. 

“Default Email Cluster (Mandatory for Email Channel)” setting 
for WACD 

The “Default Email Cluster (Mandatory for Email Channel)” attribute is present under „WACD‟ tab of WACD 
server. This is a required attribute for Email Channel to work properly.  

This attribute needs to be set for all the configured WACD servers for Email Channel. It is not marked as 
mandatory in ICManager as it is not required for Chat channel. 

Channel Throttling for Agent Clients 

Channel Throttling has been made functional for Avaya Agent Web Client, Siebel Native and SDK client as 
part of IC7.2.4 Service Pack. 

When an agent goes from Auxwork state to Available state, the channels are made available based on ADU 
Events. The voice channel is made available first followed by the Email and Chat channels.  However, this 
process is asynchronous. Hence, the sequence in which the channels become available may change 
depending on the time required for processing to make each channel available.  

This could cause email/chat channel going available before voice channel. Hence, the agent may get 
email/chat contact prior to voice contact. 

Channel throttle is introduced to give enough time for processing to make each channel available so that the 
channels become available in a desired sequence viz. voice, email and chat. 

ChannelThrottleTime is the delay introduced between one channel going available and prior to next channel 
in the sequence. Although the process continues to be asynchronous, setting sufficient Throttle Time would 
ensure voice channel becomes available first. 

To set this property in IC Manager, configure the property Agent/Desktop->ChannelThrottleTime 

The value is configured in seconds. The Default value is „0‟. It is suggested that incremental values are tested 
to identify sufficient throttle time for the environment. 

PhonePresetACD parameter in Vtel.ini 

For Avaya Agent Rich Client, in Vtel.ini, the PhonePresetACD parameter should be set in accordance with the 
AutoIn parameter. Namely, if AutoIn is set to „y‟, then PhonePresetACD should be set to „y‟. And if AutoIn is 
set to „n‟, then PhonePresetACD should also be set to „n‟. 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 164 

Adding devices or voice queues at runtime 

When new devices or voice queues are added in the IC Manager, the ADUID for the new devices are not 
created. Therefore reporting does not happen for the calls added in the new queues. Whenever a new device 
or a voice queue is added to the system, the TSQS Server needs to be updated. This ensures that the ADUID 
is created for a newly added device or voice   

ServerFailed Loop Control for AARC 

If two agents happen to login into AARC configured with the same IP, then a ServerFailed-Assign loop is 
initiated between the agents and the IC servers ( note that, different agents with the same IP is not a 
supported configuration in AIC, but may happen under some circumstances e.g. APIPA etc.).  
This activity detects the loop by monitoring the intensity/rate of ServerFailed events. When such a loop is 
detected, the agent is prompted to log out of AARC, and web channels are disabled. 

The following configurations (through environment variables) were introduced to control the threshold rate of 
the LoopDetect event. 

 CDK_LOOPCOUNT = Threshold count of ADU.ServerFailed events detected by MTT thread of 
CDKToolkit. Default value is 10. 

 CDK_LOOPINTERVAL = Maximum interval (in seconds) between two consecutive above 
ADU.ServerFailed events to increment the loop-detect count. Default value is 3. 

 SERVER_LOOPCOUNT = Threshold count of ICServer.ServerFailed events detected by event-
processing thread of CDKToolkit. Default value is 5. 

 SERVER_LOOPINTERVAL= Maximum interval (in seconds) between two consecutive above 
ICServer.ServerFailed events to increment the loop-detect count. Default value is 5. 

Note: The rate of ServerFailed-Assign loop between MTT and ADU server is far more as compared to other 
servers. As such, different parameters are being used to set the threshold rate. 

GRIP#4645, No Auto-reconnect after consult-cancel 

Before IC7.2.4, when an consultation call is cancelled, the agent is automatically reconnected to the 
customer. The GRIP#4645, requires the Customer should not be automatically reconnected instead should 
allow the agent to initiate another consult. 

For example,  

1. Customer calls Agent1.  

2. Agent1 answers the call. 

3. Agent1 initiates a consultation call to Agent2. 

4. Agent2 is busy/no-answer/answer the call. 

5. Agent1 cancels the consultation call. 

Till IC7.2.3, when Agent1 cancels the consultation call, Agent1 would be automatically reconnected to the 
customer. 

In IC7.2.4 based on the below settings, the Agent1 would not be automatically reconnected to the customer 
and his current call will be placed on-hold. Agent1 will also be able to initiate another consult. 

Two new properties are added under Agent\Desktop\Voice section as: 

 AllowTransferOnHold: By default set the value as “No” 
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If this is set to “Yes”, the call which is on Hold will be allowed to transfer/conference/consult. 

If this is set to “No”, the call which is on “Hold” will be not allowed to transfer/conference/consult. 

 ReconnectOnTransferCancel: By default set the value as “Yes” 

If this is set to “Yes”, the call will be reconnected on cancel of conference/consult  

If this is set to “No”, the call will be put on “Hold” on cancel of conference/consult  

Perform the following steps on the Design and Admin machine:  

This section describes configuration requirements for IC7.2.4 ICManager.  

Property declaration In IC manager: 

1. Log in to IC manager.  

2. Go to  Tools > Property Declarations.  

3. From Property Section select Agent/Desktop/Voice. 

4. Add the following properties under Agent/Desktop/Voice. Both these properties should have “Property 
Datatype” as “boolean” 

 AllowTransferOnHold  

 ReconnectOnTransferCancel  

5. Click OK on Property Declarations dialog box after performing above steps. 

6. Go to  Tools > Groups and set values for the above properties under Agent/Desktop/Voice. 

For default behavior:  

 Set AllowTransferOnHold as No. 

 Set ReconnectOnTransferCancel as Yes. 

ChatList – Changes to Scripts files and localized CDL files  
Siebel (Hybrid agents) 

Perform the following on the Design and Admin machine to enable the ChatList customization 

1. The highlighted new section “ChatList” needs to be added as below to customize the chat-list for the 
localized .cdl file (for example, avaya_agent_sbl_en.cdl) to enable customization of Chat-List width, size, 
location etc. 

<QSection Name="TaskList" 

 .. 

 .. 

/> 

<QSection Name="ChatList" 

Columns="{0,16,'',''},{0,16,'',''},{1,16,'Name',''},{2,54,'Duration',''},{3,

54,'Waiting',''}"/> 

Note: The above section will be localized for each of the .cdl files. 
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2. Start the Avaya Database Designer. 

3. Load the CCQ.ADL file in the ...\IC72\design\CallCenterQ directory. 

4. Incorporate any previous in-house customizations done in these replaced script files. 

5. Generate Windows Application. 

Enabling XSS filters for Public Website 

Perform the following steps on the machine where IC Website is installed to enable the XSS filter to prevent 
the XSS attacks in case there are no customizations to website. 

1. Stop the website 

2. Take a backup of the following file in a separate directory. 

For example, C:\BackupAYA_IC72_HOME>/comp/website/WEB-INF/web.xml 

3. Delete folder "<AVAYA_IC72_HOME>/tomcat/work/Catalina/localhost/website" for cleaning tomcat 
cache. 

4. Run the config tool and apply the Web settings. This will create/update the web.xml file in the path 
<AVAYA_IC72_HOME>/comp/website/WEB-INF/ 

For more information, see Configuring Web Management services on Windows section in the IC 
Installation and Configuration Guide. 

5. Start the Web site. 

Perform the following steps on the machine where IC Website is installed to enable the XSS filter to prevent 
the XSS attacks in case there are customizations made to the website. 

1. Stop the website 

2. Take a backup of the following file in a separate directory. 

For example, C:\Backup <AVAYA_IC72_HOME>/comp/website/WEB-INF/web.xml. 

3. Delete the <AVAYA_IC72_HOME>/tomcat/work/Catalina/localhost/website directory for cleaning tomcat 
cache. 

4. Copy the following in the filter section of the existing web.xml file 

<web-app> 

<display-name>Website for Avaya Web Management </display-name> 

<description>Website runs the customer-facing web site for Avaya Web 

Management.</description> 

<filter> 

<description>This filter is used to clean input paramaters.Since no validation 

is done in the respecitve JSP's they are susceptible to XSS and Clickjacking 

attackes. This filter avoids the same. 

</description> 

<display-name>cssFilter</display-name> 

<filter-name>cssFilter</filter-name> 

<filter-class>com.quintus.security.cssFilter</filter-class> 
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</filter> 

<filter-mapping> 

<filter-name>cssFilter</filter-name> 

<url-pattern>/*</url-pattern> 

</filter-mapping> 

<servlet> 

<servlet-name> 

InitServlet 

</servlet-name> 

5. Start the website service. 

Updation of DCO Money fields 

Consider the following points that specify the Currency formats in the “Regional and Language Options” when 
updating the Money fields, if custom applications use dcoMoney fields. 

1. The Money fields will not accept input strings with space in between the digits ( eg: 123 456 789) 

2. The default settings for „Decimal symbol‟ and „Digit grouping symbol‟ of any locale used needs to be 
same as these default setting on the machine where DataServer runs.  

3. The„Digit grouping‟ format should not be customized. Use the default formats for all the locales. 

To Skip ADU Events for WebServices User 

WebService Server can now skip receiving ADU events using a new configuration parameter in the 
WebServices tab of Webservices Server.  

Perform the following steps on the Design and Admin machine to import the sc.xml into ICManager. 

1. Login to ICManager. 

2. Select the "Manager" tab and navigate to Options -> Environment -> Import Configurtion 

3. In the file chooser dialog box, select "<AVAYA_IC72_HOME>/etc/sc.xml" 

4. Click "Open" button on the dialog box. 

5. Click on "Ok" button in the Validate sc.xml dialog box to import the configuration. 

6. Click on "Ok" button on the Options dialog box. 

7. Restart IC Manager. 

The below is the snapshot of the New Property added: 
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Note: Checking the Tick Box “Skip ADU Events for WebServices User”, will prevent the Webservice Server 
from receiving the ADU events. By Default, this Tick Box is not checked and the server will receive ADU 
events. 

Restart the WebService on Avaya Webservices Machine after you change the above property. 

Disabling Authentication for IC WebServices 

Perform the following steps on the on Avaya Webservices Machine to Turn-Off the Authentication in IC Web-
Services for Workflow Service: 

1. Open the <AVAYA_IC72_HOME>\sdk\webservices\webservices\WEB-INF\server-config.wsdd file in 
notepad and go to <service name="AicWorkflow" section. 

2. Comment out (using XML Style Comment i.e. <!-- -->) or delete following lines under that section. 

<requestFlow> 

<handler type="Authenticate"/> 

</requestFlow> 

For example: 

<!-- 

  <requestFlow> 

   <handler type="Authenticate"/> 

  </requestFlow> 

--> 

3. Save the file and restart the webservices. 
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4. Repeat the above steps for <service name="AicAgentAdmin" section if you want to disable 
Authentication for Agent Admin Service. 

Upgrade Steps for WebLM Server from version 4.5.x.x to 
version 4.7.1 

Perform the below steps to determine the current version of WebLM Server installed in your system.  

1. Paste the url https://<WebLM Server IP>:<WebLM Server Port>/WebLM/LicenseServer in a 

browser. 

2. From the login page, note down the WebLM version. 

Perform the instructions mentioned in the section below, only if the installed version of WebLM server is 
earlier than 4.7.1. Skip this section, if the installed version of WebLM server on your system is 4.7.1 or later. 

Retain the following files of the WebLM server version 4.5.x.x installed on your system. 

File/Folder File Location Required  Description 

Users.xml – File AVAYA_IC72_HOME/tomcat/webapps/WebLM/admin Yes, if any 
users are 
added that 
are to be 
retained. 

This file 
contains the 
list of users. 

Product_folder – 
Folder 

AVAYA_IC72_HOME/tomcat/webapps/WebLM/data/ Yes The product 
folder that 
contains the 
configuratio
n files. E.g 
aic 

License file (.xml) – 
File 

AVAYA_IC72_HOME/tomcat/webapps/WebLM/licenses Yes The installed 
license file 

usagehistory.properties 
– File 

AVAYA_IC72_HOME/tomcat/webapps/WebLM/data Yes The Usage 
History 
Information 

weblmserver.properties 
– File 

AVAYA_IC72_HOME/tomcat/webapps/WebLM/data Yes, if 
WebLM 
configuration 
properties 
have been 
modified 

The server 
properties 
file. 

Perform the following steps on the machine where WebLM server is installed. 

1. Stop Tomcat server (Stop the WebLM service) 

2. Before upgrading the WebLM server, back up the set of files as described in the table above. 

3. Delete the AVAYA_IC72_HOME/tomcat/webapps/WebLM folder recursively. 
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4. Start the tomcat server. 

This will extract the new WebLM.war file from the IC724 server installer of respective platforms (AIX, 
Solaris, Windows) 

5. Stop the tomcat server. 

6. Restore/Overwrite the above set of files in the respective file/folder location. 

7. Start Tomcat/WebLM service and access WebLM. 

Adding attachments and email addresses for additional 
recipients to outbound email through Workflow server 

For more information on Adding email attachments through Workflow, see the Email components topic in the 
Media Workflow Reference Guide. 

The below information will override the information provided for Step 9, under Description for Block Name 
“Add Email Component”, page 230 of the Media Workflow Reference 7.2. 

Specifies attachments and additional recipients for the outbound email contact.  

If you want to add more than one email address to a field, separate the entries with comma. 

If you want to add more than one attachment, separate the entries with semicolon. 

To use this block, set the following properties in the Basic tab 

 BCCEmailAddresses – Adds email addresses to the BCC field 

 ToEmailAddresses – Adds email addresses to the To field 

 CCEmailAddresses – Adds email addresses to the CC field 

 FileAttachments – Adds these attachments to the outbound email. 

To include an attachment: 

1. Store the file on the machine that hosts the ICEmail Server 

2. Create directory "<%AVAYA_IC72_HOME%>/email/Attachments"  

3. Add attachment files to the above mentioned directory.            

Note: Once the workflow changes are done, save and rebuild the flow. Also reload the flow from the workflow 
server. 

Limitations:  

1. Primary and Secondary ICEmail should have the Attachments directories in sync, so that this feature 
works in failover scenario. 

2. Display name will not be supported in the BCCEmailAddresses, ToEmailAddresses and 
CCEmailAddresses. 

3. Filename with spaces will not be supported 

4. In SME/REQ and QA email address and attachments might be added multiple times if email goes through 
outbound workflow again and again. 
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Uninstall program  
The Avaya IC 7.2.4 Installation Tool installs an Uninstall Program that uninstalls the files from the IC 7.2.4 
installation and returns your system to its previous state. If your installation fails, you must run the Uninstall 
program before attempting to rerun the Installation Tool. Running the Uninstall program returns the system to 
its previous state and preserves the files.  

When the Service Pack installer fails to complete the installation, any one of the following events may happen 
based on the progress achieved during installation:  

 The uninstaller is created 

You need to run the uninstaller to remove the Service Pack to restore the system to its original state. After 
running the uninstaller, the system is restored to its previous state.  

 The uninstaller is not created 

When the uninstaller is not created, it implies that the Service Pack installer has already rolled back all 
the changes made to the system during installation. In this case, no action is required from the user.  

Before running the Uninstall program 

 For uninstalling servers, stop all of the servers using the procedures described in Stop IC services and 
Stop IC servers.  

 Exit the Agent and IC Manager applications on the system.  

Note: On the AIX platform, you need to kill the processes that use the Rogue Wave binary files installed 
on the system.  

Perform the following steps before carrying out the uninstallation on the AIX platform:  

a. Change directory to $AVAYA_IC72_HOME/lib.  

b. At the command line, type the following command: slibclean  

c. At the command line, type the following command:  

 fuser -k lib*12d*.a  

 fuser -k lib*.so 

d. After running the fuser -k lib*12d*.a and fuser –k lib*.so commands, type the following at the 
command line:  

 fuser lib*12d*.a  

 fuser lib*.so 

No process IDs should be displayed in the results after running this command. However, even if one 
process ID is displayed in the results, then you need to restart the AIX machine.  

Uninstall 

Perform the following steps on a system from where you want to uninstall IC 7.2.4 files: 

1. Navigate to the following directory:  
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a. Windows: ...\IC72\ICServicePacks\7.2.4\<FolderNameOfComponent>\Record\  

b. Solaris and AIX: .../IC72/ICServicePacks/7.2.4/<FolderNameOfComponent>/Record/  

2. Start the Uninstall program: 

Windows 
 Double-click the uninstall7.2.4.bat file. 

Note: In cases where “<AVAYA_IC72_HOME>/SPBackup” folder is not deleted automatically by Uninstall 
program, we need to manually delete this folder. 

Solaris and AIX (server only) 
1. At the command prompt, type: ./uninstall7.2.4.sh. 

2. Press Enter. 

3. At the Welcome screen, click Next. 

4. The next screen indicates the directory from which the files are uninstalled.  

5. Click Next to start the Uninstall program which:  

a. Restores the component to its previous state. 

b. Displays confirmation of a successful uninstallation with a list of uninstallation warnings and errors 
that were encountered. 

6. Click Finish if the uninstallation is successful. 

7. On the Windows platform, restart the machine for the system to be restored to its previous state. Solaris 
and AIX systems do not require restarting the machine.  

Un-Installation using the Silent command line option  
IC 7.2.4 Service Pack components can be uninstalled using the Silent command line option. IC 7.2.4 Service 
Pack supports only the Silent option. When you run un-installation in silent mode, the user interface is not 
available. 

Silent mode  

In a silent mode, rerun the same uninstallation in silent mode on another machine using the inputs from this 
text file. 

To re-run the uninstaller in silent mode: 

1. From the command prompt (command line, in case of Solaris and AIX), go to the following directory: 

Windows:  

...\IC72\ICServicePacks\7.2.4\<FolderNameOfComponent>\Record where <FolderNameOfComponent> 
is the folder name of each component where the respective component files reside. 

Solaris and AIX: 

.../IC72/ICServicePacks/7.2.4/<FolderNameOfComponent>/Record where <FolderNameOfComponent> 
is the folder name of each component where the respective component files reside. 
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2. At the command prompt (command line, in case of Solaris and AIX), type the following command: 

<uninstallscriptname> -silent 

Note: The <uninstallscriptname> is the uninstaller script. For example, 

For example: 

Operating System Command 

Windows uninstall7.2.4.bat -silent 

Solaris and AIX ./uninstall7.2.4.sh -silent 

3. Press Enter. 

Note: After the un-installation is complete, sometimes the uninstaller does not delete the 7.2.4 subfolder. In 
such a case, you need to manually delete the 7.2.4 subfolder from the .../IC72/ICServicePacks folder. 
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Fixed MRs / WIs in Service Packs 

Fixed MRs / WIs in IC 7.2.4 Service Pack 

The following table lists the MRs/WIs that is fixed in Avaya IC 7.2.4 Service Pack. 

Component Parent WI Child WI Summary of reported defect 

IC:Admin:AdvocateConfig Tool wi00889312 wi00896305 Advocate uninstaller script 
"cleanupadvocate.vbs" does not cleanup 
advocate on 64 bit operating system. 

IC:Admin:ConfigTool wi00226044 wi00935830 ictomcat.sh not installed if SDK is 
configured without the Website 
configuration, hence can not start the 
SDK service 

IC:Admin:DB Designer wi00727212 wi00830582 It is not possible to select or save a loop 
detection type of "both" in IC Manager for 
an email account. ADL 
qem_mailaccount.loopdetectiontype 
enum values do not match IC Manager. 
"FROM_REPLYTO" should be changed 
to "BOTH". 

IC:Admin:ICManager wi00376569 wi00385555 Mutli edit allows Administator to change 
passwords of LDAP imported agents. 

IC:Admin:ICManager wi00308172 wi00691636 ICManager does not fetch the "Default 
Email Cluster" information and does not 
show the Templates 

IC:Admin:ICManager wi00835970 wi00848908 Any change to a set of agent records 
using the Multi Agent Editor in IC 
Manager forces each agent to change 
his/her password on next login. 

IC:Admin:ICManager wi00277554 wi00886596 Cannot delete Voice Devices having the 
same Queue ID using IC Manager. 

IC:Admin:ICManager wi00410019 wi00886630 ICManager hangs when an user with role 
as "Clerk" tries to add advocated enabled 
agent. 

IC:Admin:ICManager wi00886640 wi00886646 For Clerk user, Email Account and cluster 
configuration menus should not be 
displayed. 
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Component Parent WI Child WI Summary of reported defect 

IC:Advocate:Advocate 
Resource Manager 

wi00850963 wi00881831 Advocate Resource Manager does not 
create MxRscMgr_service.log in IC7.2.x 

IC:Advocate:Advocate 
Resource Manager 

wi00873166 wi00884396 RM server goes down when component 
manager is shutdown 

IC:Advocate:TSA wi00907622 wi00921265 TSA fails to call the  Workflow for 
Qualification,incase of a TS.ServerFailed 
event 

IC:Advocate:TSA wi00857818 wi00935836 TSA crashes when voice contact with 
large no. of qualifiers comes in. 

IC:Advocate:WAA wi00349124 wi00373004 WAA server is crashing on Primary 
Resource Manager bounce with no 
standby 

IC:Advocate:WAA wi00843137 wi00847120 On Solaris, the Qualification flow 
(qualifyemail) does not return and 
contacts do not get qualified. 

IC:Advocate:WAA wi00882162 wi00895901  WAA needs to change the logic of 
processRetry in the same manner as it is 
done for TSA (wi00226152). 

IC:Advocate:WAA wi00859227 wi00921291 Potential Buffer over runs, if qualifier 
string length > 255 chars can lead to 
server crash. 

IC:Client:AAWC wi00774720 wi00817331 When contact comes in and connection 
between Application server and AAWC is 
broken, task remains in agent tasklist 
upon RONA. 

IC:Client:AAWC wi00844319 wi00898144 Request to update German dictionary 
used by Webagent's spellchecker. 

IC:Client:AAWC wi00890976 wi00903821 In AAWC, chat transcript Print option is 
disabled for supervisor. 

IC:Client:AAWC wi00906056 wi00921269 When Auto-sync for Chat is turned on 
and agent pushes an invalid url from 
agent's transcript area, urls are pushed in 
a loop and finally gives error pop-up:lost 
connection to application server. 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:AAWC wi00904184 wi00921279 The thinclient's datacontroller cannot 
handle periods (".") in virtual queue 
names when building nodes. This causes 
problems in the Address Book 

IC:Client:AAWC wi00940104 wi00943618 Agent UI doesn't have the option to 
hangup the call (Thin Client and Java 
SDK Client) 

IC:Client:AAWC:Other wi00866666 wi00872760 AddressBook fails to add all added 
emails in TO field while replying/creating 
an email. 

IC:Client:AAWC:Other wi00873661 wi00873791 The AAWC 7.2.3 agent freezes in IE8 
while printing an email and chat contact. 

IC:Client:AAWC:RefApp wi00894459 wi00898095 AAWC Client freeze while chatting with 
customer in production environment. 

IC:Client:AAWC:RefApp wi00898000 wi00898099 AAWC Client hangs while doing spell 
checking in chat/email. 

IC:Client:AAWC:RefApp wi00899025 wi00949859 In AAWC agent is not able to perform any 
operation after accepting the chat from 
customer. 

IC:Client:AAWC:UOM:Voice wi00844699 wi00844720 GRIP (4645)-IC SDK Client API has lost 
a simple but critical feature that was 
previously available with IC VTEL API. 

IC:Client:AAWC:UOM:Voice wi00872334 wi00881857 Conference initiating call-leg is dropped 
when a party leaves the conference. 

IC:Client:AAWC:UOM:Voice wi00340864 wi00956326 Agent1 not able to complete the 
conference, when agent1->Conf->Agent2 
and Agent2-> Conf same call->agent3 
and agent2 completes the conference. 

IC:Client:RichClient wi00832928 wi00848561 qui.exe.dmp getting created in Avaya Ic 
Logs Folder on Rich Client machine after 
the agent exits 

IC:Client:RichClient wi00308705 wi00853144 Agent is not able to create resources 
specific to tenant when only chat channel 
is set 

IC:Client:RichClient wi00869629 wi00886257 DB Record methods erroneously 
removed from 7.2 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient wi00898620 wi00898632 qui.exe.dmp getting created in Avaya Ic 
Logs Folder on Rich Client machine after 
the agent exits 

IC:Client:RichClient wi00893135 wi00899561 Intermittently dialog pops up with msg 
"QUI stopped working" at Rich Client. 

IC:Client:RichClient wi00893201 wi00899564 Intermittently Web agent fails to 
appear/not visible when an agent enabled 
for email, chat and voice is logged in as 
Rich client. 

IC:Client:RichClient wi00903255 wi00905957 There is no way to hyperlink text in 
webagent 

IC:Client:RichClient wi00906406 wi00907389 The cancel button when doing Blind 
transfer is not doing any action 

IC:Client:RichClient wi00931252 wi00933297 "Switch to caller" message box 
disappears, when recorders are involved 
in the Consult Transfer. 

IC:Client:RichClient wi00943469 wi00943726 With IC-PC integration Agents are going 
in to wrong state in inbound and 
outbound mode and during Inbound-
Outbound mode change. 

IC:Client:RichClient wi00937420 wi00946825 Assign cycle is initiated if two agents 
assigns to WACD with the same IP and 
port in the Assign‟s session ID. 

IC:Client:RichClient wi00948248 wi00948956 QUI.exe is not coming up when the user 
installs IC 7.2.3.2 on windows XP with 
USER permissions intermittently. 

IC:Client:RichClient:BlenderClie
nt 

wi00835405 wi00837619 When TS server fails 
voice.device_address is set to "" twice by 
the client, this needs to happen only 
once. 

IC:Client:RichClient:BlenderClie
nt 

wi00835415 wi00837664 IC Agent uses the previously selected 
aux reason code under a particular 
scenario. 

IC:Client:RichClient:BlenderClie
nt 

wi00870943 wi00881782 QUI is crashing intermittently on graceful 
exit. 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient:BlenderClie
nt 

wi00869564 wi00895305 Rich Client sending a TS.Ready request 
even after preset of Busy. 

IC:Client:RichClient:BlenderClie
nt 

wi00890305 wi00898628 While moving from Aux to available agent 
is sending extra busy request along with 
Ready to TS. 

IC:Client:RichClient:BlenderClie
nt 

wi00936630 wi00941369 IC Agent (AARC) infinitely sends 
ADU.SetOneValue requests if connection 
to blender server breaks and restores 
while the agent is in init-aux state. 

IC:Client:RichClient:BlenderClie
nt 

wi00942847 wi00943591 Customer call can not be put on hold 
after the below mentioned scenario is 
performed.Agent logout and relogin is 
required. 

IC:Client:RichClient:BlenderClie
nt 

wi00225514 wi00949361 There should be a way in OOTB IC to 
disallow agents using IC Agent Thick 
Client to change their agent blending 

IC:Client:RichClient:ChatList wi00869127 wi00876323 Qui.exe crashing intermittently when 
agents are working multiple chats (2) 

IC:Client:RichClient:Qconsole wi00841463 wi00853121 IC 7.2 RichClient is not coming up if it is 
coexisting with IC 7.1 RichClient on the 
same machine as per IC 7.2 Migration 
Document 

IC:Client:RichClient:Qconsole wi00946811 wi00951364 Unable to get the windows handle for 
Bottom_frame and Right_frame 

IC:Client:RichClient:Softphone wi00904374 wi00907750 Disconnecting a call while in AUX(on 
login) intermittently causes agent to go to 
available 

IC:Client:RichClient:StausDialog wi00832188 wi00832468 Siebel Hybrid qui.exe crashes when 
exiting with AUX window open 

IC:Client:RichClient:UAD wi00867726 wi00889856 Avaya Agent Rich Client UAD does not 
allow addressing an email to a queue. 
This contradicts the Avaya Agent User 
Guide. 

IC:Client:RichClient:UAD wi00925965 wi00926472 OK' button gets disabled on the UAD 
window, when agent clicks on View--
>Refresh 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient:Vtel wi00734076 wi00817333 Agent cannot switch to AUX mode if he 
has previously set ACW from hardphone 

IC:Client:RichClient:Vtel wi00844699 wi00852859 GRIP (4645)-IC SDK Client API has lost 
a simple but critical feature that was 
previously available with IC VTEL API. 

IC:Client:RichClient:Vtel wi00842382 wi00863702 With TimedACW, if Aux is pressed 
immediately on entering ACW both 
phones remain in ACW and not AUX. 

IC:Client:RichClient:Vtel wi00892136 wi00899552 Voice.device_address is getting set twice 
by vtel when EDU server is restarted 

IC:Client:RichClient:WebAgent wi00357750 wi00373005 Line spaces in an email composed in 
HTML mode are getting removed when 
received at customer side. 

IC:Client:RichClient:WebAgent wi00820154 wi00826306 Webagent should show warining 
message, when email addresses starting 
and ending with single quotes are being 
sent. 

IC:Client:RichClient:WebAgent wi00733066 wi00829560 web agent fails to hyperlink the first 
character in the URL. 

IC:Client:RichClient:WebAgent wi00830011 wi00830647 WebAgent fails to parse attachments in 
an inbound email if the attachments are 
not all tagged with the same Content-
Type boundary. 

IC:Client:RichClient:WebAgent wi00825506 wi00830649 WebAgent attempts to spellcheck base64 
encoding of inline image and throws java 
exception 

IC:Client:RichClient:WebAgent wi00835195 wi00837661 During the chat session the right click 
"paste" option remain disabled 

IC:Client:RichClient:WebAgent wi00844955 wi00846346 WebAgent's Search Email/History tool 
does not display all attachments 
associated with the selected email. 

IC:Client:RichClient:WebAgent wi00844319 wi00847126 Request to update German dictionary 
used by Webagent's spellchecker. 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient:WebAgent wi00845445 wi00853072 Login into rich client and web agent to 
appear for an email enabled agent takes 
around 1 min 52 sec and sometime more 
than 2 min when RL manager is loaded 
with around 2500 templates. 

IC:Client:RichClient:WebAgent wi00887567 wi00889844 Email with a multi-line subject and TAB 
character causes java exception in 
WebAgent when performing a Customer 
History search 

IC:Client:RichClient:WebAgent wi00857248 wi00898206 WebAgent hangs up when Email address 
with " (double quotes) is used when 
replying/composing a new outbound 
email. 

IC:Client:RichClient:WebAgent wi00225878 wi00898212 Proper Error check window doesn't pops 
up when an Email is sent without having 
proper "To", "Cc" and "Bcc" fields 

IC:Client:RichClient:WebAgent wi00224326 wi00899083 Rich Client: HTML Resources text gets 
inserted with extra line break when used 
in a chat. 

IC:Client:RichClient:WebAgent wi00867800 wi00899085 The webagent (Ephox editor) doesnt 
preserve the line spaces for the copy & 
pasted HTML text. 

IC:Client:RichClient:WebAgent wi00893340 wi00899135 Email data copied from Microsoft word 
does not retain the formatting while 
displayed on the end email client 

IC:Client:RichClient:WebAgent wi00900395 wi00900409 Slow performance in fetching emails after 
failover as observed in the WebAgent. 

IC:Client:RichClient:WebAgent wi00899511 wi00904203  Webagent doesnt display's the inline 
images for an email send from the Lotus 
notes client 

IC:Client:RichClient:WebAgent wi00733064 wi00905949 Web Agent is not highlighting  URLs 
embedded in outgoing email when TAB is 
pressed 

IC:Client:RichClient:WebAgent wi00927366 wi00927438 Webagent renders email sent from the 
Lotus notes having inline images as an 
attachment named as "untitle". 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient:WebAgent wi00931292 wi00931631 There is no way to remove hyperlink in 
webagent 

IC:Client:RichClient:WebAgent wi00936284 wi00937072 Header(plain/HTML) sent from webagent 
(RC) in HTML mode is not getting 
displayed on customer side in html mode 

IC:Client:RichClient:WebAgent wi00356514 wi00953873 All the formating is lost on using bullets 
and numbering 

IC:Client:RichClient:WebAgent wi00931299 wi00955135 Tab is identified as a character in url 
instead of as a trigger character for url. 

IC:Client:RichClient:WebAgent wi00932995 wi00955137 Compose a new email using any font 
type, size,colour which has been 
bolded,italic and underlined followed with 
some another font type and size without 
pressing enter key and send it, at 
customer end after bolded,italic and 
underlined font,followed font t 

IC:Client:RichClient:WebEngine wi00867805 wi00881848 Qui.exe crashing intermittently when 
agents are working multiple chats (2) 

IC:Client:SDK:WebServices wi00895155 wi00898566 IC WebServices assigns to ADU with 
"(type=per){loginid,state}" creteria and 
receives all Agent ADU events 

IC:Client:UOM wi00863601 wi00863685 UOM collects property from the incorrect 
TS server if there are multiple TS are 
configured and one of the TS server is 
down 

IC:Common wi00884284 wi00886605 IC SSL Client should consider a scenario 
where socket selects function times out. 

IC:Common wi00932072 wi00932078 Log archiving does not happen in Solaris 
for similar spelt servers. 

IC:Common:MTT wi00841809 wi00843358 MTT is not able to handle 
subjectAltName->DNS entry or case 
insensitive DNS comparision in the 
certificate while doing post connection 
DNS match. 

IC:Common:MTT wi00868279 wi00868170 MTT should validate multiple common 
names and blank common name from 
server certificate 
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Component Parent WI Child WI Summary of reported defect 

IC:Common:MTT wi00906874 wi00921263 Servers crash intermittently when rollover 
happens due to daycount set. 

IC:Common:MTT wi00937420 wi00937427 Assign cycle is initiated if two agents 
assigns to WACD with the same IP and 
port in the Assignâ€™s session ID. 

IC:Common:Qscripts(IC Scripts) wi00873199 wi00886270 OOB IC 7.23 script 
StatusDialog_ButtonClicked.qsc does not 
confirm the iControl object variable is set 
before attempting to modify the object 

IC:Common:STT wi00826343 wi00832464 STT server aborts, reporting multi-
threading as cause. 

IC:Common:STT wi00867916 wi00896850 TS crashes on Update if fopen fails for 
vesp.imp 

IC:Common:STT wi00871885 wi00903868 Log level is reset after Vesp_Login 
command of STT 

IC:Common:STT wi00937420 wi00937429 Assign cycle is initiated if two agents 
assigns to WACD with the same IP and 
port in the Assign‟s session ID. 

IC:Installer:SP Installer wi00948428 wi00952951 The system throws an error while trying 
to configure Administrative Client on 
windows7 64-bit machine 

IC:Installer:Win Install wi00887911 wi00903854 7.2 RTM installer(modified for win2k8 R2 
support) is not copying required jar in 
$AVAYA_IC72_HOME\sdk\design\java\li
b 

IC:Integration:IVR:VOX wi00935820 wi00935825 HTTPVOx server crashes if start/end 
extension range which is not configured 
in CM, is used in HTTPVox configuration. 

IC:Integration:Siebel wi00907647 wi00921282 IC Native Siebel client requires wrap-up 
even after RONA of a call. 

IC:Integration:Siebel:Agent 
Integration 

wi00888868 wi00957949 In hybrid Siebel,chat is not displayed in 
the tasklist even upon accepting the 
contact. 

IC:Other:Migration:Chat/Email 
Migration 

wi00884452 wi00894291  Email Migration tool take Very long time 
to migrate data. 
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Component Parent WI Child WI Summary of reported defect 

IC:Other:Migration:Chat/Email 
Migration 

wi00894293 wi00894301 IC 7.1.5 to IC 7.2.3 Email Data Migration 
tool does not consider the DST time 
offset 

IC:Other:Documentation 

  

wi00307651 wi00691641  Wrong file extension mentioned for 
required files in web-inf folder in 
icconnector directory of Dialog Designer 
Machine. 

IC:Other:Documentation:Releas
eNotes 

wi00844979 wi00847144  Configuration to Enable Channel 
Throttling for AAWC 

IC:Other:Documentation:Releas
eNotes 

wi00845906 wi00847148  The chat contacts are not getting routed 
to the agent when the 
'ResetScriptIteration' set to value 
'0'(default value) 

IC:Other:Documentation:Releas
eNotes 

 

wi00844951 wi00853125 In IC 7.2 Siebel 8 Integration.pdf, adding 
AICD responsibility for profile should be 
applicable for Siebel 8.0.0.0 as well. 

IC:Other:Documentation wi00884707 wi00889847 Documentation detailing expected 
AAWC/SDK client behavior when primary 
ICEmail in cluster fails and secondary 
server becomes active 

IC:Other:Documentation wi00871965 wi00889851 Documentation on providing JVM options 
for ASIS 

IC:Other:Documentation wi00880592 wi00892795  Documentation needed for the maximum 
load handling for WSCallback server. 

IC:Other:Documentation:Releas
eNotes 

wi00891589 wi00903843 When a new voice queue is added in 
device tab, we need to update the TSQS 
server to get ADU entity in EC active 
pool. 

IC:Other:Documentation wi00905107 wi00921271  IC72 Installation and Configuration guide 
doesn't have the steps to configure 
Component Manager on separate 
machine 

IC:Other:Documentation wi00905086 wi00921273 IC72 Installation and configuration 
document needs to be corrected for the 
information under "Building the database 
schema for an additional Logical 
Resource" 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 184 

Component Parent WI Child WI Summary of reported defect 

IC:Other:Documentation wi00927777 wi00941367  Large number of templates takes time to 
load in the resources window of AAWC 

IC:Other:Documentation:Releas
eNotes 

wi00956837 wi00957955  Poller Server Configuration Parameter 
"BlankWithAttachment" to allow emails 
with attachment, but no body.  

IC:Other:Tools wi00732436 wi00817337 When the Report Wizard application is 
customized to include a money field, the 
DCO throws errors when searching and 
updating the field/column. 

IC:Other:Tools wi00964847  wi00964852 Report Wizard Application does not get 
launched in Windows 7 64 bit agent 
machine. 

IC:Other:Tools:LogCollector wi00864923 wi00889854 LogCollectorSrv.exe crashes when user 
repeatedly clicks the Run button in the 
LogCollectorClient.exe. 

IC:Other:WebLM wi00951148 wi00951377 ICWebLM certifcate expiration 

IC:Server:Attribute wi00885648 wi00896289 Attribute Server crashes when an 
exception is raised by the Network Layer 

IC:Server:Directory wi00871678 wi00871684 DS allowing Login to LDAP user with 
correct as well as empty password, even 
though non-empty password is 
configured for the user at LDAP Server 

IC:Server:Directory wi00897752 wi00900017 DS is processing DS.Login request 
coming over VESP port as well as SSL 
port. 

IC:Server:Email wi00836320 wi00837622 ForwardTo feature of ICEmail workflow 
handling is broken in 7.2.2 

IC:Server:Email wi00841481 wi00850317 Email Template Adminstration slows 
down under 1000+ templates load 

IC:Server:Email wi00845445 wi00862865 Login into rich client and web agent to 
appear for an email enabled agent takes 
around 1 min 52 sec and sometime more 
than 2 min when RL manager is loaded 
with around 2500 templates. 
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Component Parent WI Child WI Summary of reported defect 

IC:Server:Email wi00872833 wi00884231 Counter mismanagement within ICEmail 
server causes server to stop sending 
ICEmail.analyze events because it 
believes no workflow servers are 
available. 

IC:Server:Email wi00887567 wi00891554 Email with a multi-line subject and TAB 
character causes java exception in 
WebAgent when performing a Customer 
History search 

IC:Server:Email wi00860965 wi00898201 currentstatus of the emails with invalid 
email address stuck at 60027 in DB and 
causing the smtp to send such emails 
again when the icemail server restarts. 

IC:Server:Email wi00905664 wi00905675 CCField Population flag added in 
wi00332483 causes loss of original 
toaddress in email MIME. 

IC:Server:Email wi00907680 wi00924647 When HTML footer template is added to 
outgoing HTML email, the footer to not 
automatically line wrap when received by 
the Customer. 

IC:Server:Email wi00927569 wi00931569 EDU should contain original TO and CC 
fields for incoming emails even if Poller 
changes it as per CCFieldPopulation 
logic. 

IC:Server:Email wi00286167 wi00935818 The emailcount field in EDU is not being 
updated when an email account is 
configured loop detect 

IC:Server:Email wi00939671 wi00941378 Japanese characters get replaced by 
arrows when AIC client sends Auto reply 
mail to a Customer mail account. 

IC:Server:Email wi00937615 wi00943595 Accurate messagestatus values are not 
getting inserted for "forward a copy", 
"SME", "REQ" & specialstatus for 
outbound email. 

IC:Server:Email wi00240785 wi00945455 Email Server does not attach a file as 
instructed by WorkFlow Server. 

IC:Server:Email wi00945424 wi00946349 Memory leak in cluster server when 
buddy is configured but not running 
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Component Parent WI Child WI Summary of reported defect 

IC:Server:Email wi00967671  wi00967676 ICEmail is not deleting the email objects 
created in its memory when unable to 
send an email to the customer due to 
SMTP failure. 

IC:Server:Email wi00965320  wi00965744 In IC 7.2, Email resolved with status code 
without template are not recorded in 
qem_messagestatlog table 

IC:Server:Email:poller wi00839481 wi00840365 Emails with old or unknown tracking 
number not polled by poller server 

IC:Server:Email:poller wi00845448 wi00845454 IC Poller won't poll messages with an 
unknown MIME-Type (Non RFC emails) 

IC:Server:Email:poller wi00861318 wi00861325 Poller Loopdetect functionality does not 
work as designed for FROM and BOTH 
detection-types. 

IC:Server:Email:poller wi00877448 wi00895056  If loop detect type is set to BOTH, a loop 
is detected if the Loop_Detection_Count 
number of emails with invalid from but 
valid reply to are sent to IC, with same 
from address each time. The loop should 
not have been detected. 

IC:Server:Email:poller wi00937096 wi00944112 Miscalculation of string length in 
qwtranscoder library causes Poller Server 
to hang while converting UTF8 string to 
Japanese locale. 

IC:Server:Email:poller wi00949433 wi00949926 If we select loop detection & blank mail 
together then after specified loopcount 
blank email doesn't work. 

IC:Server:Email:poller wi00956357 wi00956454 Poller server goes down when the email 
filterlist is updated from the ICManager. 

IC:Server:Email:RLManager wi00936780 wi00937304 We can not associate a Template with 
Status in RL Manager and cannot be 
used at agent's end to Resolve any mail. 

IC:Server:HttpConnector wi00883817 wi00883825  Webchannel consumes 100% CPU on 
receiving requests from Loadbalancer. 

IC:Server:HttpConnector wi00877663 wi00892496 HttpVox.Transfer is failing if the call is 
attached to a SingleStepConference. 
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Component Parent WI Child WI Summary of reported defect 

IC:Server:HttpConnector wi00323828 wi00921292 The memory leak has observed for  
HTTPConnector(webchannel process) 
server during longetivity testing 

IC:Server:HttpConnector wi00925307 wi00930035 When sending https requests from IVR 
application to httpconnector server, if the 
packet size of the request is more than 
500 bytes, then the IVR application 
receives a timeout. 

IC:Server:HttpConnector  wi00958015 HTTPConnector (webchannel) server is 
crashing on update 

IC:Server:ICM wi00362600 wi00853074 Properties chat.transcript.email.footer 
and chat.transcript.email.header do not 
effect transcript email sent to customer 

IC:Server:ICM:Website:Web 
Management IC:Website - 
Server Pages 

wi00222946 wi00857407 Old Quintus HTML pages and images 
should not be installed 

IC:Server:ICM:Website:Web 
Management IC:Website - 
Server Pages 

wi00884630 wi00889862 When agent send a large size text 
resource to customer while chatting, chat 
transcript is not rendered/repaint properly 
on customer website in IE6/7/8. 

IC:Server:ICM:Website:Web 
Management IC:Website - 
Server Pages 

wi00942676 wi00943585 The public website pages are vulnerable 
to XSS attacks. 

IC:Server:License Server wi00898592 wi00899029 WebLM client libraries needs to be 
upgraded to 4.7.1 for Win2k8 support 

IC:Server:ORB Server wi00909802 wi00921330 Avaya Interaction Center ORB Service 
Buffer Overflow Vulnerability 

IC:Server:ORB Server  wi00948558 On windows2k8R2 64-bit ORB Server 
doesn't starts 

IC:Server:TSV5 wi00732335 wi00817286 "Agent_key" is getting wrongly updated 
incase another IC Agent unknowingly 
uses the same station number to login in 
a free seating environment. 

IC:Server:TSV5 wi00844699 wi00844721 GRIP (4645)-IC SDK Client API has lost 
a simple but critical feature that was 
previously available with IC VTEL API. 
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Component Parent WI Child WI Summary of reported defect 

IC:Server:TSV5 wi00852672 wi00853558 TS needs to increase the size of 
qualifiers it gets from TSA, this impacts 
OA contacts delivered count 

IC:Server:TSV5:ASAI wi00828456 wi00830580 TS crash due to simultaneous access to 
VESP by the main and worker threads. 

IC:Server:TSV5:ASAI wi00828458 wi00830645 TS crashes while attempting to establish 
connection to LS which is down. 

IC:Server:TSV5:ASAI wi00852395 wi00853554 TS  asai lower layer does not delete the 
call object, during a cut through scenario 

IC:Server:TSV5:ASAI wi00834765 wi00858281 TS Transfer waits for 500ms for the call 
merge to happen. 

IC:Server:TSV5:ASAI wi00866214 wi00872757 7TS sends a TS.abandon event  when 
Service Observers are involved. 

IC:Server:TSV5:ASAI wi00885338 wi00889859 Contact count is incremented to 2, when 
an agent makes an outbound call and the 
customer rejects the call. 

IC:Server:TSV5:ASAI wi00904616 wi00907387 TS continues to wait for value set in "wait 
time before merge call" even for calls 
which are blind transferred to Hunt group 

IC:Server:TSV5:ASAI wi00931252 wi00934789 "Switch to caller" message box 
disappears when recorders are involved 
in the Consult Transfer. 

IC:Server:TSV5:ASAI wi00937073 wi00937878 Agents  gets a TS.Drop & TS.abandon, 
when multiple parties are involved and 
the recording happens using Singlestep 
Conference 

IC:Server:TSV5:ASAI wi00942737 wi00942743 CVLAN Client libraries used by TS needs 
to be upgraded to AES 6.1 on windows 

IC:Server:WACD wi00316400 wi00856381 With using Advocate, ADU is not updated 
when chat RONAs, which is causing 
problems in OA reporting 

IC:Server:WACD wi00872325 wi00876333 WACD Crashes and Emails do not get 
qualified and stays in “Waiting for 
Qualification” State and BA Agents do not 
receive Emails. 
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Component Parent WI Child WI Summary of reported defect 

IC:Server:WACD wi00876424 wi00880852 Email queuetime is not getting updated in 
the EDU after RONA in case of advocate 
routing. 

IC:Server:WACD wi00867820 wi00881853 The old legacy logo "Quintus eContact" 
page is displayed on the WACD web 
page when an agent with a supervisor 
role tries to browse it from the agent 
machine. 

IC:Server:WACD wi00879968 wi00884386 WACD's plaid script "DefaultQueueScript" 
is not processing all PushURL's created 
in the "Set Chat Wait Treatment" 
workflow blocks of the wacd.qualifychat 
workflow. 

IC:Server:WebConnector wi00831267 wi00844027 Potential memory leak when the socket 
read operation throws an exception. 

IC:Server:WF Server wi00909782 wi00925948 Workflow exception causes counter 
mismanagement within ICEmail server 
which causes server to stop sending 
ICEmail.analyze events because it 
believes no workflow servers are 
available. 

IC:Server:WF Server wi00949734 wi00951360 DBNow function called thru WF returns 
an invalid date. 

IC:Server:WSCB wi00863146 wi00864888 WSCallback server stops (goes in sleep 
mode), if contact shedule time is of 
previous day. 

IC:Server:WSCB wi00863150 wi00864961 In WSCallback server changing  value of 
"call queue size" at run time does not 
works as per expected 

Fixed MRs / WIs in IC 7.2.3 Service Pack 

The following table lists the MRs/WIs that is fixed in Avaya IC 7.2.3 Service Pack. 

Component Parent WI Child WI Summary of reported defect 

IC:Admin wi00385506 wi00385787  In IC Manager, the Workgroup Right-
click menu on Agent tab stops displaying 
after IC Manager refresh is performed 
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Component Parent WI Child WI Summary of reported defect 

IC:Admin:ICManager wi00407962 wi00408203  Email: Intermingling of Loop-Detection 
and Blank-email parameters skewing IC 
Manager settings. 

IC:Admin:ICManager wi00385509 wi00385783  IC Manager's "Multi Agent Edit" does not 
allow the Admin to set "Disable Login" to 
true on the Security tab if the 
ccq.w_offline_task table has more than 
zero records in it. 

IC:Admin:ICManager wi00462146 wi00462255  In the Group manager dialog window 
(Under IC Manager), the “cancel” and 
“closing” the dialog window functions not 
working as designed, behave same as 
the OK or APPLY buttons. 

IC:Admin:ICManager wi00462946 wi00704290 The HTTPVOX server require changes in 
the SC.xml, to allow the configuration for 
the extensions having leading zeros 

IC:Advocate wi00664760 wi00689286 Advocate Events are not reaching ECB 
Servers. 

IC:Advocate:Advocate Admin wi00386280 wi00386835 IC BA Admin tool user login gets an error 
if login is re-created with change in role. 

IC:Advocate:Advocate Admin wi00429552 wi00429554 Advocate Supervisor is sending incorrect 
data to ECB when profile is assigned to 
agent 

IC:Advocate:WAA wi00368746 wi00369906  In BA, Emails stuck in queue while 
transferring to another agent with 
message in logs 'contact detail object not 
found in the map' 

IC:Client:AAWC wi00330469 wi00599408 The voice.contactcount is getting 
incremented to 2 instead of 1 on the first 
incoming call as a result of which the 
agent is not able to go AutoIn in a 
particular scenario. 

IC:Client:AAWC:UOM:Email wi00384487 wi00385769  Attachments cannot be viewed using 
Find Email feature in IC 7.2.1 Web Client. 

IC:Client:AAWC:UOM:Voice wi00461447 wi00462259  SDK client is unable to complete/cancel 
a consult call if the agent/party you are 
transferring to, consults/blind transfer to 
another agent/extension. 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient wi00330469 wi00599407 The voice.contactcount is getting 
incremented to 2 instead of 1 on the first 
incoming call as a result of which the 
agent is not able to go AutoIn in a 
particular scenario. 

IC:Client:RichClient wi00376207 wi00376360  From ICAgentClient to the TS, there are 
two requests of TS.BusywithReason after 
the agent logs-in 

IC:Client:RichClient:BlenderCli
ent 

wi00827463 wi00827491  After RONA voice channel does not 
become available for Rich Client though 
Agent state is available in automatic 
blending mode. 

IC:Client:RichClient:BlenderCli
ent 

wi00823828 wi00825257  Avaya Agent Blender client continually 
updates ADU state when agent attempts 
to enter AUXWORK with email that is not 
deferred 

IC:Client:RichClient:EDUView
er 

wi00388513 wi00409016  An email with "%n" in its Message-ID 
header crashes the EDu Viewer which 
results in the IC agent thick client crash. 

IC:Client:RichClient:Softphone wi00223560 wi00362096 If client network connectivity is  broken 
briefly then re-establish, invalid EDU 
object is established  by blender  client 
when vdu server assign is performed. 

IC:Client:RichClient:Softphone wi00411215 wi00462262  Reconnect button doesn‟t change back 
to Hold in Avaya Agent client in a specific 
scenario. 

IC:Client:RichClient:Softphone wi00411211 wi00411335  Reconnect button is not getting enabled 
in the scenario where the consult transfer 
to a VDN fails. 

IC:Client:RichClient:UAD wi00301960 wi00408202  UAD window does not display 
OK/Cancel button after agent selects 
Show Directory option from Media tab 

IC:Client:RichClient:Vtel wi00461447 wi00774904 VTel does not check initiator before 
forwarding conference event to Rich 
client. 

IC:Client:RichClient:WCAgent
Client 

wi00296900 wi00331116 Web Agent is not properly forming HTML 
tags for URLs embedded in outgoing 
email. 
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Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient:WCAgent
Client 

wi00406919 wi00410823  During a WebAgent chat, if the agent 
double clicks anywhere in the Resource 
tree view pane, a highlighted resource is 
sent to the customer again and again. 

IC:Client:RichClient:WCAgent
Client 

wi00384252 wi00385793  If an inbound email parsed by Webagent 
contains a blank "Content-type:" header 
the webagent throws a ParseException 
and places the body of the email in an 
attachment. The agent sees a blank email 
body in the Webagent's HTML Editor. 

IC:Client:RichClient:WCAgent
Client 

wi00409991 wi00410265  WebAgent does not sends a broadcast 
message to remove typing status 
message from the customer side of chat 
when agent selects (but does not send) 
agent/global resource. 

IC:Client:RichClient:WCAgent
Client 

wi00429170 wi00462261  Webagent fails to properly terminate 
HTML img tag's src attribute with a 
double quote when changing the image 
source from cid to file 

IC:Client:RichClient:WrapupDi
alog 

wi00379792 wi00380365  Multiple clicks of the "OK" button on 
Avaya Agent's WrapUpDialog causes 
11023 error,results in agent hang. 

IC:Client:SDK:WebServices wi00554506 wi00554520 [GRIP#1645] SDK WebServices should 
use newly created lightweight 
DS.Authenticate API for authentication 
instead of DB-heavy DS.Login 

IC:Client:SDK:WebServices wi00817367 wi00817375  WebServices LookupSites()  returns an 
array of Sites that includes deleted sites. 

IC:Client:SDK:WebServices wi00729833 wi00732671  WebServices LookupWorkgroups() 
returns an array of workgroups that 
includes deleted workgroups. 

IC:Client:UOM wi00382937 wi00599414  Workitem complete issuing a TS.Ready 
request even when agent is in INIT_AUX. 

IC:Common:MTT wi00554506 wi00599602  [GRIP#1645] MTT & STT changes for 
sending DS.Authenticate request over 
SSLas we need to authenticate both 
LDAP and non-LDAP users 

IC:Common:MTT wi00704222 wi00704232  MTT leaks memory with DS.Login over 
SSL 
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Component Parent WI Child WI Summary of reported defect 

IC:Common:STT wi00700897 wi00703974  „Bad magic value: Memory Corruption‟ 
error seen after a TS.GenericUpdate 
operation. 

IC:Integration:IVR:VOX wi00462946 wi00554522 Stations with leading zeros cannot be 
used as VP stations in HTTPVox. 

IC:Integration:Siebel:AICD wi00498443 wi00554518 Agent cannot complete 
conference/consultative transfer using the 
AICD toolbar when recorder is involved 

IC:Integration:Siebel:AICD wi00330469 wi00599409 The voice.contactcount is getting 
incremented to 2 instead of 1 on the first 
incoming call as a result of which the 
agent is not able to go AutoIn in a 
particular scenario. 

IC:Other:Documentation:Relea
seNotes 

 wi00369742 Information related to "Display Name" 
feature needs to be updated 

IC:Server:Directory wi00480881 wi00480897 In IC7.2.2 Directory server not able to 
restart successfully, when DS is 
autostarted or IC is rebooted 

IC:Server:Directory wi00554506 wi00599417  [GRIP#1645] Directory Server to expose 
a new API (DS.Authenticate) which does 
not do all the DB queries done by 
DS.Login today 

IC:Server:Email wi00408066 wi00408197  IC 7.2.1 does not bounce emails to the 
configured bounce email address 

IC:Server:Email wi00461829 wi00554529  The original inbound email to the AAWC 
cannot be fetched by "Find Email" using 
"From address" option, after a „forward‟ 
operation. 
 
Note: After applying this fix, the inbound 
email will be visible using 'Find Email' 
after an interval that has been configured 
in the 'No User Interval' field of the email 
EDU server. (This behavior is as per the 
design of the product.) 

IC:Server:Email wi00700909 wi00704231  ICEmail SMTP manager is not using the 
IC email account's "Return Address" 
while populating the outbound email's 
"From" header field. 
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Component Parent WI Child WI Summary of reported defect 

IC:Server:Email:poller wi00379074 wi00379266  Poller server considers inbound email's 
entire "TO" address as case sensitive, 
result in copying "To" address into CC 
field (violates RFC 5321) 

IC:Server:Email:poller wi00382925 wi00410822  Poller server exit/crash for an email, 
containing "Reply-to" header with no 
value (email address). 

IC:Server:Email:poller wi00385016 wi00385773  Poller Server is not using "Reply-To" 
header when "From" address is invalid, 
results the email travel through IC without 
a "From" address. It restricts the Thick 
Client from wrapping the email contact. 

IC:Server:Email:RLManager wi00410012 wi00410267  Unable to save/modify email templates in 
IC (RL manager) with user account 
having roles of the  "supervisor" and 
"editor" 

IC:Server:ICM:Website:PDM wi00380495 wi00381559  Website/ICM do not pick the correct 
default language for a tenant when the 
default language of that tenant is 
changed multiple times. 

IC:Server:ICM:Website:WCSh
aredBrowsing 

wi00215963 wi00462263  In Autosync session, if the caller pushes 
a page to the agent, the agent pushes the 
same page back to the caller 

IC:Server:ICM:Website:Web 
Management IC:Website - 
Server Pages 

wi00697250 wi00703968  Extra space present in the chat typing 
status message. 

IC:Server:License Server wi00400224 wi00407266  Need to upgrade WebLM client library as 
the one currently used (4.5.4) by License 
Server (IC 7.2.1) crashes when multiple 
requests are sent to it simultaneously. 

IC:Server:TSV5 wi00461447 wi00689352 SDK client is unable to complete/cancel a 
consult call if the agent/party you are 
transferring to, consults/blind transfer to 
another agent/extension. 

IC:Server:TSV5 wi00330469 wi00367706  The voice.contactcount is getting 
incremented to 2 instead of 1 on the first 
incoming call as a result of which the 
agent is not able to go AutoIn in a 
particular scenario. 
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Component Parent WI Child WI Summary of reported defect 

IC:Server:TSV5:ASAI wi00380802 wi00385470  Call not cleared if agent disconnects 
using hardphone when inisde converse-
on step in vector. 

IC:Server:TSV5:ASAI wi00350227 wi00372793  On Link down TS is still adding events to 
device queue. 

IC:Server:WACD wi00373724 wi00374772  WACD does not retry request a resource 
for Tasks which got stucks 

IC:Server:WACD:AdminSite wi00359484 wi00822313  Support IBM HTTP server 7.x in AIX-6.1 
with IC-7.2 release 

Fixed MRs / WIs in IC 7.2.2 Service Pack 

The following table lists the MRs/WIs that is fixed in Avaya IC 7.2.2 Service Pack. 

Component Parent WI Child WI Summary of reported defect 

AAWC wi00313072 wi00356783 Emails are not delivered,when an agent is 
associated with a TS Link Group and if the 
voice channel is down 

AAWC wi00356203 wi00362627 In BA RM using ThinClient (ASIS), email 
contact is delivered to agent before voice 
contact, when agent 

AAWC wi00305089 wi00362834 If wacd is down and agent logs out, 
WACDRedundancy thread is not getting 
terminated 

AAWC wi00339742 wi00362890 IE 8.0 support issue. When a supervisor logs 
in and clicks 'Begin supervisor session', the 
agents under supervisor are not visible. 

AAWC wi00340287 wi00362891 IE 8.0 support issue - Spelling checker hangs 
on invoking. 

AAWC wi00340363 wi00362892 IE 8.0 support issue - When agent click 'Exit' 
button or close (X) button for exiting the thin 
agent application, the 'exit' window will not 
close on clicking 'yes'  button on it. 

AAWC wi00366250 wi00366405 chat transfer/conference is not working in 
AAWC 

AAWC wi00333388 wi00333390 Need to add support for IE8 on AAWC 
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Component Parent WI Child WI Summary of reported defect 

AAWC:UOM:Chat wi00294362 wi00362893 Message Mismatch "Can not Resolve text You 
Entered." 

AAWC:UOM:Voice wi00371696 wi00372059 Agents are unable to complete 
conference/consult-transfer a call having 
recorder using single step conference. 

Admin:ICManager wi00289524 wi00363235 VOX server with extension numbers in excess 
of 2^31 thawing error. 

Admin:WF Designer wi00225125 wi00361981 Workflow Designer toolbar displaying invalid 
entry and missing tooltip for valid one. 

Advocate Admin wi00352626 wi00364200 MxDBFx consumes lot of memory while 
associating profiles to agents or vise-versa 

Advocate Resource 
Manager 

wi00313072 wi00355267 Emails are not delivered, when an agent is 
associated with a TS Link Group and if the 
voice channel is down. 

Advocate:Advocate Admin wi00322179 wi00364201 When using Advocate Administrator to view or 
edit agents with a profile with large capability 
set errors are encountered on the desktop and 
seen in the dllhost log. 

Client:RichClient wi00356651 wi00360854 TransferComplete event conversion to 
OtherPartyTransfer causing dependent scripts 
to fail. 

Client:RichClient:Qconsole wi00370978 wi00372215 IC_Agent hangs in IC-siebel hybrid integration 
while doing repeatedly call transfers and 
switching between the Agent states 
(Ready/Aux). 

Integration:IVR wi00367691 wi00367692 IC should be able to monitor IVR extension 
using *v assignment 

Integration:IVR:VOX wi00356590 wi00362334 HttpVOX and VOX should support 
TS.TransferEX method 

Integration:Siebel wi00315272 wi00356184 The 'Ready/Not Ready' button gets disabled 
under a particular scenario (includes multiple 
AICDs) 

Integration:Siebel wi00305709 wi00375044 Disable 'Ready/NotReady' button if agent has 
not logged into any channel. 
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Component Parent WI Child WI Summary of reported defect 

Integration:Siebel:AICD wi00297729 wi00361036 Call state is shown as wrapup in WIDL, when 
Aux is pressed before Switch Time ACW 
expires. 

Integration:Siebel:ASIS wi00333444 wi00363740 AICD does not deassign from TS in hard-
phone logout scenario. 

Integration:Siebel:ASIS wi00226297 wi00356144 Needs to restart ASIS server after changing IC 
group properties 

RichClient wi00312607 wi00356774 For Chat and Callback functionality, if we wrap 
chat, call still remained at agent desktop. 

RichClient wi00361631 wi00362376 For ADU.SetOneValue (), both key-value is 
being set to "" (no value), Fixed in 7.1.4 but 
removed from mainline (7.2). 

RichClient wi00361631 wi00366697  For ADU.SetOneValue (), both key-value is 
being set to "" (no value), Fixed in 7.1.4 but 
removed from mainline (7.2). 

RichClient:BlenderClient wi00313072 wi00356578 Emails are not delivered,when an agent is 
associated with a TS Link Group and if the 
voice channel is down 

RichClient:BlenderClient wi00296914 wi00361880 Aux reason codes are not propagating 
correctly to switch in Manual blending mode.  

RichClient:BlenderClient wi00355315 wi00362091 From ICAgentClient to the TS, there are 
multiple requests of TS.BusywithReason while 
making the agent from ready to aux 

RichClient:Qconsole wi00370978 wi00371008 IC_Agent hangs in IC-siebel hybrid integration 
while doing repeatedly call transfers and 
switching between the Agent states 
(Ready/Aux). 

RichClient:UAD wi00312961 wi00362090 After modifying a UAD qscript, the contact list 
tab in the UAD does not display the media 
icons 

RichClient:WCAgentClient wi00225774 wi00362852 Switching between to reply windows of two 
different customers does not change the edu 
viewer window. 
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Component Parent WI Child WI Summary of reported defect 

RichClient:WCAgentClient wi00340957 wi00362888 Every time supervisor clicks on customer 
name to monitor chat, website starts from 
blank & supervisor cannot see the web page 
on which agent & customer is. 

Server:Email wi00310282 wi00361879 %recipientname% used in header/footer 
shows agent's name 

Server:Email wi00339440 wi00362855 ICEmail server should raise High Alarm and 
retry ICEmail.Analysis when it does not receive 
disposition in Analyzed call 

Server:HttpConnector wi00376008 wi00376015 SSL Enable HTTP Connector Server. 

Server:ICM wi00343271 wi00368815 While agent is typing, customer also starts 
typing simultaneously and at this time when 
agent press enter/Send button, the status 
message that 'Agent1 is typing' is not getting 
removed on customer side. 

Server:ICM wi00352657 wi00352657 Chat typing status is not displayed on the 
agent side if original customer in joinus 
disconnects the chat 

Server:ICM:Website:Web 
Management IC:Website - 
Server Pages 

wi00214344 wi00369880 WebACD should give some indication about 
invalid email requalification attempts, maybe 
throw an alarm 

Server:Notification wi00301554 wi00362092  Version of QuikSoft's emsmtp.dll shipped with 
IC reports error in Windows Application Event 

Server:TSV5 wi00362178 wi00362180 UUID & Alias of the TS creating the container 
should be added in EDU so that it is available 
for IVR application 

Server:TSV5:ASAI wi00352972 wi00360835 Oubound call with Cut-Through does not 
updates UCID on EDU. 

Server:TSV5:ASAI wi00352354 wi00360857 A two step blind transfer to a VDN introduces a 
delay of 4 to 5 seconds. 

Server:TSV5:ASAI wi00350236 wi00362160 Miss-spelt parameter for 
call_record_time_to_live causing the value to 
be not read on TS initialization. 

Server:TSV5:ASAI wi00368222 wi00368606 Outbound cut-through call with single-step-
conference (recorder) disconnects when put 
on hold. 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 199 

Component Parent WI Child WI Summary of reported defect 

Server:TSV5:ASAI wi00373713 wi00374124 A phantom call is delivered to agent after 
completing a blind/consult transfer. 

Server:TSV5:Aspect wi00359387 wi00359463 Aspect Calls are getting dropped during the 
second log on 

Server:WACD wi00224930 wi00366262 When the WebACD is restarted the queue 
scripts for recreated tasks restart from iteration 

Server:WACD wi00338367 wi00349530 WACD infinitely keeps on requesting the WAA 
to qualify a task when no agent is logged into 
IC which is impacting the WkCancelledCnt in 
OA reporting. 

Server:WACD  wi00338372 wi00349521 Chat Transfer to queue that fails due to no 
agent logged-in is increasing wktransferedcnt 
because of code 102 terminate. 

Server:WACD:FTSE wi00355918 wi00355920 Avaya FTSE is not re-indexing existing FAQ 
documents that are updated via WRU 

Tools:CommandScripter wi00355216 wi00358915 7.2 Avaya Agent Script Debugger does not 
work 

Workflows:Prompter wi00351961 wi00362329 The prompter block when clicked on page 
space is not opening the DHTML editor 
window. 

Workflows:VoiceRouting wi00225286 wi00362157 Virtual Queue Transfer selects the wrong Wait 
Treatment 

Fixed MRs / WIs in IC 7.2.1 Service Pack 

The following table lists the MRs/WIs that is fixed in Avaya IC 7.2.1 Service Pack. 

Component Key Summary of reported defect 

AAWC wi00331598  Pure HTML Email is not displayed in HTML, 
when Agents Read incoming emails  

AAWC wi00331601  Only Display Name is displayed and email 
address is not displayed in Email 
Composition Body when 
Reply/ReplyAll/Forward is done in Thinclient.  
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Component Key Summary of reported defect 

AAWC wi00331596  Need to remove getTrackingHistory API from 
EmailMediaInteraction class since it is not 
used anywhere but still consumes loads of 
memory  

AAWC wi00332400  Problem in calling an agent using UAD in 
thinclient when agent's first name ends with a 
space  

AAWC wi00333105  TS.GetPhoneInfo is not always successful 
and fails the login process for the agent.  

AAWC  wi00331635  Need to add support for chat typing status in 
WebClient  

AAWC  wi00333394    Localization issue - Dynamically re-adjust 
sizes of the Collaboration Dialog so longer 
strings would not be truncated  

Advocate Resource Manager  wi00329572  OA reports for Advocate Service Class shows 
incorrect OWT (Oldest Wait Time) value.  

Advocate Resource Manager  wi00332586  Advocate routes the calls to parking device 
even though the agent is not logged-in into 
voice channel.  

Alarm Server wi00340632  Grip request - For SNMP traps set priority of 
alarms so we will have 3 OID i.e. critical, 
Major, Minor.  

Cisco TS wi00313573 Cisco TS does not ask for feature license 
from license server. This issue is been fixed 
in Cisco TS. Note that now Cisco TS will 
consume Ericsson TS licenses. 

Config Accelerator wi00354341 Wrong domain failover order set for 
Site2_Voice2_helper domain in vesp.imp file 
for Scenario 8. 

ConfigAccelerator  wi00281558    Database panel for Oracle database should 
not show plain password.  

ConfigAccelerator  wi00284781   For oracle server there must be two 
password options for ccq & repository 
databases  
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Component Key Summary of reported defect 

ConfigAccelerator  wi00310594    Email Cluster name changes from CA tool 
don‟t get reflected in "Default Email Cluster" 
field under WACD server.  

ConfigAccelerator  wi00330696    Localization support for Russian language is 
not available in CA  

ConfigAccelerator  wi00330722    In Email Account panel, on selecting/de-
selecting “Use TLS” checkBox, the “Incoming 
port” value should be changed accordingly.  

ConfigAccelerator  wi00330732    Banner information is scrolled down initially 
on 'IC Configuration' panel.  

ConfigAccelerator  wi00330745    Do not show 'Email Account Creation' panel 
for voice only scenarios  

ConfigAccelerator  wi00332460  User must be allowed to select multiple 
domains at a single shot under Failover order 
field in Domains option.  

HttpVox wi00345463  HttpVOX and IC Manager supports extension 
Range till 10 digits, needs to be increased in 
7.2.  

ICEmail Server wi00332483  CC address is populated erroneously when 
the Email Account configuration in IC 
Manager is such that the General tab's name 
and domain differs from the Server tab's 
logon account and POP3 fields  

ICEmail Server wi00332596  On Email reply customer name is not being 
sent.  

ICEmail Server wi00332601  Resolving email by status does not wrap 
email on solaris  

ICEmail Server wi00332602  Email Server:Over the load 1200 emails per 
hour,the Email server was generating alarm 
as Unable to Force Terminate EDU id.  

ICEmail Server wi00336880    GRIP #717 - Ability to enter E-Mail display 
name in IC Manager  

ICEmail Server wi00337837    Time in templates is in 24 hour format even 
though system time is set to 12 hour format  
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Component Key Summary of reported defect 

ICEmail Server wi00344595  Web Admin pages should allow you to cancel 
task with a specified status, rather than only 
being able to cancel them without any type of 
reason1  

ICM wi00330413  Need to add support for chat typing status in 
HTML Chat Client and WebAgent  

ICM wi00332080    Chat typing status message is displayed 
both in Customer and Agent's chat windows, 
if any of the key (all keys present in the 
keyboard) is being pressed on the chat text 
area of either side.  

ICM wi00332101    If customer sends the chat texts by clicking 
the Send Message button, the chat typing 
status message should get removed on the 
agent's chat window.  

ICM wi00332402  Customer wishes that chat timestamp format 
should be configurable  

ICM wi00342914    The chat type status is not removed when 
the customer disconnects the chat either by 
logging off or by closing the public web 
page.  

ICM wi00342923    During a chat between a customer and a 
thin agent, when agent is inserting a 
resource, the chat type status is not 
displaying on the customer side.  

ICM wi00342928    When 'SpellCheckOnSend' property is set 
'yes' and agent types something in the chat 
type area and click 'Send' button , the spell 
checking window opens up.Without waiting 
for the TypingStatusThreshold time to expire, 
the status message is removed.  

ICM wi00343275    While agent1 is typing some text in chat 
area, agent1 transfers the chat contact to 
another agent, agent2, the chat type status 
message 'agent is typing' is not getting 
removed from agent2 and customer even 
after agent1 wraps the contact  
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Component Key Summary of reported defect 

ICM wi00343749    When the chat type status is disabled from 
agent side, the chat status message is not 
displaying on both customer side and agent 
side.  

ICM:Website:WCSharedBrowsing  wi00333392  Pages are pushed in display frame in a 
certain chat conference scenario despite java 
plugin being enabled in browser  

ICM:Website:Web Management 
IC:Website - Server Pages  

wi00341211    HTML Chat Client's TextArea remains 
disabled in Chrome and Safari browsers  

ICM:Website:Web Management 
IC:Website - Server Pages  

wi00332415    Remove the limitation of JoinUS Handle 
cannot be more than 25 chars  

ICManager   wi00331113  The agent state is not reflected in ICManager 
when the agent selects to go to Aux while on 
active call/email/chat.  

ICManager wi00336894  Unable to add extensions range in VRU tab 
of VOX server  

License Server  wi00337230  License Server raises an Alarm "License File 
Expired" for the obvious license file with 
permanent expiry Date  

Localization  wi00332432  Grip Request #939 - Enhancment request to 
change the columns width, size and location 
on the chat tasklist.  

Localization  wi00334128  Localization wi in reference with wi00305400 
- Correction needed in the parameter name in 
OOTB def file for SendDTMF command.  

Localization  wi00346373  Need translated strings for the chat typing 
feature  

Patch Installer  wi00344937  Siebel side Installer currently does not 
support integration with Siebel 7.8  

Poller Server wi00352030 Same emails are re-polled and requeued 
when there are connectivity issues with 
Exchange server. 
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Component Key Summary of reported defect 

Poller Server wi00343315  Emails with attachment and no body should 
not be treated as blank email  
Note:  
Requires configuration parameter 
„BlankWithAttachment‟ 

Poller Server wi00313222    Poller Stops polling mail account if there is 
connectivity issues with Exchange server.  

Report Server  wi00332489  ReportServer creates .bad files which contain 
no error when original edu for hudedu is no 
longer in dustore. No such Vdu error is in log  

RichClient wi00332454  BusyReason not correct when going to Aux in 
manual mode  

RichClient wi00332593  If agent logs out of softphone but does not 
exit IC and then logs back in to Softphone, 
agent is placed in auto in rather than AUX.  

RichClient wi00332594  Thick client doesnt update Agent's status 
control for channel state ,while declining an 
email/chat in manual blending mode  

RichClient wi00332452  Grip Request #939 - Enhancment request to 
change the columns width, size and location 
on the chat tasklist.  

RichClient  wi00331639  CreateObject for "AvayaAgent.Application" is 
not returning current instance of running Rich 
Client Application class.  

RichClient  wi00330780  WebAgent replaces Leading/Trailing spaces 
found on agent supplied "to email address" 
Field with a tilda (0x7e '~') while using 
"Forward Original" option.  

RichClient  wi00332493  WebAgent is unable to view attachments 
having same file name individually  

RichClient  wi00330776  WebAgent crashes when image with very 
long URL is embedded in an email.  

RichClient:ActiveContactViewer wi00347017 IC 7.2 Thick client - Active Contact Viewer 
does not work for Email channel. 
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Component Key Summary of reported defect 

RichClient:Qconsole  wi00332529  On Avaya Web Agent, "Error 61704. Internal 
Application Error(QWApp.StartApp)" 
message is displayed when the system date 
is changed.  

RichClient:Qconsole  wi00342615  Citrix client users get error "client already 
running" while running IC Agent client 
application  

RichClient:WCAgentClient  wi00331107  WebAgent is displaying only 2nd set of HTML 
tag, for Emails having multiple <HTML>, 
<HEAD>, and <BODY> tags  

RichClient:WCAgentClient  wi00331115  HTML forms data embedded within an HTML 
email is not displayed properly in WebAgent  

RichClient:WCAgentClient  wi00331116  Web Agent is not properly forming HTML 
tags for URLs embedded in outgoing email.  

RichClient:WCAgentClient  wi00331118  In WebAgent, when switching from plain text 
to HTML, the editor does not use the new 
7.1.5 default font properties from the 
application.properties file when determining 
font, size, and color.  

RichClient:WCAgentClient  wi00331119  Webagent client should be able to pick up the 
default font set in the application.properties 
file for its plain text resources instead of using 
the system default font(Times New Roman).  

RichClient:WCAgentClient  wi00332494  Chats get stuck when supervisor keeps 
switching between agents  

RichClient:WCAgentClient  wi00332613  Erasing text while composing email resets 
the font to system default font and not the 
default font mentioned in the 
application.properties file  

RichClient:WCAgentClient  wi00336058  Double clicking an email's task in the Thick 
Client's TaskList control will cause existing 
email draft to be erased from GUI  

RichClient:WCAgentClient  wi00336065  HTML Editor Replacement in WebAgent  

RichClient:WCAgentClient  wi00336881  GRIP #717 - Ability to enter E-Mail display 
name in IC Manager  
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Component Key Summary of reported defect 

RichClient:WCAgentClient  wi00346739 When sending an outbound email using a 
WebAgent with a shared HomeDir, 
screenshots pasted from the clipboard are 
not encoded and sent with the email. 

RichClient:WCAgentClient  wi00347010 IC 7.2 Webagent – Status resolution window 
with Status takes too long or freezes when 
either "Resolve or Cancel" is clicked. 

SDK  wi00332399  UOM throws exceptions while attempting to 
change the channel state for agent login and 
logut  

SDK:WebServices  wi00338342  LookUpAgentIds returns agent list that 
includes deleted agent.  

Siebel  wi00332576  Agent cannot defer existing email after 
attending an inbound/outbound call.  

Siebel  wi00332580  After PR1495, agent have to logout of 
hardphone manually every time. 
Enhancement request to allow the agents to 
login back through Siebel browser even if 
they are already logged-into the hard phone 
and have the toolbar in synch with the hard  

Siebel  wi00332582  Agents are logged out of their phones if 
Siebel is shutdown either on purpose or due 
to a system error.  

Siebel  wi00341873  IC 7.2.1 Support for Siebel 7.8.2.13  

Siebel:AICD  wi00332578  Correction needed in the parameter name in 
OOTB def file for SendDTMF command.  

Siebel:ASIS  wi00334240  Switch time ACW functionality is not working 
with IC-Siebel  

SIP TS wi00225943 Failed to register route point if using sips 
protocol for outbound proxy in SIP TS 
configuration. This issue is been fixed in SIP 
TS which will support TLS now. 

TSA  wi00329570  TSA to employ TS.RouteEx and 
TS.UnparkEx methods to handle the 
extradata.  
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Component Key Summary of reported defect 

TSQS wi00355165 When a call is placed in queue for 15 or 
lesser seconds, offered to the agent, and 
then is abandoned, 'Abandonmiss' has a 
negative value. 

TSV5  wi00332536  Need a automatic recovery mechanism of 
failed MSHS connection when ping times out 
or receipt of ServerFailed Connection  

TSV5  wi00332581  TS is unable to suppress the drop event 
caused by a recorder in case of 
single/multiple transfer/conference scenarios  

TSV5  wi00333020  TS should always move the data from the 
34th byte to the extdata field in the EDU and 
also in the TS.IncomingCall event  
Note: Refer to Section UUI Container 
Information 

TSV5:Cisco wi00355167 When a conference to a route point is made 
in a Rich agent, the “Complete” button is 
enabled when the call rings in the other agent 

UOM  wi00332444  In Advocate environment, RONA occurs on 
direct call causing impact on call-center 
operation and incorrect reports  

WAA  wi00332464  Exception requeue option for preferred agent 
is not working  
Refer to Section Workflows 

WAA  wi00332475  contactcound and specificcount are not being 
decremented as expected when contacts go 
through the preferred agent block in the 
qualification flow and then are routed to the 
exception flow  

WACD  wi00332478  With using Advocate, ADU is not updated 
when chat RONAs, which is causing 
problems in OA reporting  

WACD  wi00332480  Talk Time, Wrap Time, and Deferred Time 
columns in the WACD Page under Active 
Task list are always 00:00:00.  
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Component Key Summary of reported defect 

WACD  wi00332603  Web Admin pages should allow you to cancel 
task with a specified status, rather than only 
being able to cancel them without any type of 
reason.  

WACD  wi00332604  WACD shouls query the DS for "default Email 
cluster" value, during generic update  

WF Server  wi00329010  Enhance the workflow server to enable large 
number of workflow channel assignments.  

Workflows:Advocate wi00347999 Advocate workflows are not delivering the 
transferred contact in correct order to the 
agent for modified contact arrival time. 
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Known Issues and Resolutions 
This section provides the known issues or limitations that pertain to the IC 7.2.4 release, in addition to the IC 
7.2 release. 

The following section describes these issues and their workaround, wherever possible. 

Known issues in Avaya IC 7.2.4 

The following table lists the known issues in the Service Pack IC 7.2.4. 

Component Parent WI Key Summary  

IC:Advocate:Advocate 
Admin 

wi00952710  In Windows 7 64 bit machine, if Advocate 
Admin client is installed, Advocate Supervisor 
cannot be logged in if the user is logged into 
the machine as a domain user with 
administrative privileges. 
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Component Parent WI Key Summary  

IC:Admin:Config Tool wi00948314 wi00954479 Config tool does not reflect changes on 
"magnus.conf",when IC web managment 
deployed on solaris 
WorkAround: 

1. Stop the webserver. 

2. Go to the Webserver‟s home directory. 

3. Navigate to the “config“ directory for the 
current server instance name. For 
example, /opt/SUNWwbsvr/https-
<servername>/config. 

4. Open the file named “magnus.conf” in 
editor e.g. Vi editor. 

5. Goto the "Configure Datawake Sensor 
plugin" section. 

6. Comment the lines in the snippet as 
below: 

<Snippet> 

# 

# Configure Datawake Sensor plugin 

(only turn this on if you want DW 

functionality) 

#Init fn="load-modules" 

shlib="/opt/Avaya/IC72/lib/libipla

netdatasensor.so" 

funcs="DWSensorInit,DWSensorNameTr

ans" 

#Init fn="DWSensorInit" 

logFile="/opt/Avaya/IC72/logs/dw.l

og" datawakeServer= 

"<Datawake_Server_IP>" 

datawakePort="2300" 

datawakeLoginID="AS" 

datawakePassword="AS" 

filterName="main" 

domain="<domain_name>" 

serverName="<Server_Name>" 

</Snippet> 

IC:Admin:ICManager wi00934894 wi00939616 IC Manager deletes wrong email account 
Note: 
Currently do not perform sorting on account list 
in IC Manager before selecting an account for 
deletion 
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Component Parent WI Key Summary  

IC:Admin:ICManager wi00964376  Users with Supervisor + operator role when 
logged into Ic Manager do not have Services 
Menu displayed. 

IC:Admin:WF Designer  wi00950192 The prompter block when clicked on page 
space is not opening the DHTML editor 
window on Windows7. 

IC:Client:RichClient:WebAg
ent 

wi00941899  Inline image and attachment which is part of 
HTML Header & HTML Footer sent from 
webagent (RC) in HTML mode is not getting 
displayed at customer side in html mode. 

IC:Server:ICM wi00954382  When customer profile contains more number 
of attributes chat not able to escalate from 
Customer Website 

RichClient:WCAgentClient wi00954456 wi00956350 When an agent copies and pastes text 
containing quotes (“) from a word document to 
webagent and sends the email and when the 
customer receives the same, the quotes are 
displayed as "?" 
Workaround: 

1. The agent should select the encoding as 
"UTF-8" before sending the email for the 
above copy/paste scenario. 

2. Alternately Set the property 
email.charsetdetection.converttoutf8 = 
"true" in Application.property file. Note: 
Setting this would convert all the outbound 
emails to UTF-8. 

IC:Server:ICM wi00903247 wi00970020  OK is enabled as emoticon shortcut in chat 
channel.  Whenever the customer/agent types 
OK in chat it is converted as a "shake hand 
emoticon icon ". 
Workaround: 
In the <AVAYA-IC72-
HOME>/comp/icm/emoticons.properties file, 
change the following line : 

 
OK=thankyou.gif 
to 
\:U=thankyou.gif 
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Component Parent WI Key Summary  

IC:Client:AAWC wi00906409 wi00969507  W8 shortcut invokes Spellcheck instead 
of emoticon in AAWC initially. 

Workaround: 
In the <AVAYA-IC72-
HOME>/comp/icm/emoticons.properties file, 
change the following line : 

 
\:W8=holdon.gif 

to 

\:8=holdon.gif 

Known issues in Avaya IC 7.2.3 

The following table lists the known issues in the Service Pack IC 7.2.3. 

Component Parent WI Key Summary   

Admin:ICManager wi00728546  wi00817330 In ICmanager, for any email account the Blank 
email template browse button is active when 
the window is opened for the first time even 
when Blank Template Detection parameter is 
set to FALSE. 

On switching the Blank Template Detection 
check box value the browse button appears to 
work correctly. 

IC:Admin:ICManager NA wi00351565 Text box in Routing Hints allow invalid queue 
id‟s to be added. 

IC:Admin:ICManager wi00227045 wi00411057 In IC-Manager, loading of devices should be 
deferred until the Device tab is accessed. 
ICManager might become slow or 
unresponsive during the loading of this 
information at startup. 

IC:Advocate:Advocate 
Admin 

wi00251767 wi00817456 If multiple sessions for IC Advocate 
administrator client are opened on the same 
machine the application freezes or crashes. 

IC:Advocate:TSA NA wi00225787 With Advocate, contacts which are qualified, 
but not answered (abandoned), fail to create a 
routingevent record for routingattempt 
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Component Parent WI Key Summary   

IC:Client:AAWC wi00734269 wi00817280 In AAWC- Supervisor is not able to see inline 
images for monitored agent. 

IC:Client:AAWC NA wi00410466 During active chat with customer on customer 
website & IC agent on thin client if 
javaappbridge server experiences any 
failure/outage, IC agent goes in hang state. 
Agents can‟t logout neither they can release 
active task. Agents can‟t take any action on 
thin client. 
Workaround: 
To exit it is required to kill the processes from 
task manager. 

IC:Client:RichClient:Blend
erClient 

NA wi00836495 AuxWorkonLogin Property not working as 
expected for Rich Client. 
i.e. AuxWorkon Login property is set to "Yes" 
in IC Manager.Now Login an agent enabled 
with only Voice channel as Rich client.It is 
observed that the agent head is in aux state 
while the Voice channel is in available 
state.Here the Voice channel should be in aux 
state. 
It works fine for Email and Chat channel 
individually or all the three channels 
together.This issue is seen with Voice 
channel. 
Now set AuxWork on Login property to "No" in 
IC Manager.Login an agent enabled with only 
Voice channel as Rich client.It is observed that 
agent head is in aux and Voice channel is in 
available state ,which ideally should not 
happen.If we login an agent which is enabled 
for all the three channels,all the channels 
along with agent head are in aux state ,which 
again is not expected.If an agent enabled with 
email or chat channel solely is logged in,the 
particular channel is seen in aux state along 
with the agent head too. 

IC:Client:RichClient:WCA
gentClient 

NA wi00351443  “Switch to Chat Mode” & “Switch to Chat & 
Phone Mode” buttons on WebAgent are 
enabled & on Clicking on them it switches to 
chat & phone mode though voice & chat 
channels are not configured for this agent. 

IC:Client:RichClient:WCA
gentClient 

NA wi00313479 Webagent is unable to display Gautami font 
for HTML email3 
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Component Parent WI Key Summary   

IC:Client:RichClient:WCA
gentClient 

NA wi00697408 Agent logs into the rich client and accepts a 
chat session escalated by the customer. Agent 
selects a resource, right clicks and selects 
'say'. Quickly after that the agent clicks in the 
white space in the resource tree viewpane. 
The same resource is sent twice to the 
customer at the other end. 

IC:Client:RichClient:WCA
gentClient  

wi00225558 wi00332490 The "Contact -> Print" menu option in AVAYA 
Web Agent is disabled for newly composed 
emails. 

IC:Other:Documentation NA wi00300244 The property "chat.attributes.cookiesEnabled" 
should not be shown in the Tenant Chat 
properties as applet chat is not supported in IC 
7.1 

IC:Other:Tools:LogCollect
or 

NA wi00824860 The Log Collector Assigns one time when Run 
button is hit for zipping the log files and de-
assigns when the client exits. Also all the logs 
are zipped on the server side, even when the 
request from client is sent only for zipping logs 
for a specific server. Moreover they are not 
deleted as deassign is not recieved from client 
side. not even on exiting the client when the 
deassign is eventually sent. 

IC:Other:Tools:LogCollect
or 

NA wi00824880 Log Collector reads vesp and tries to pick logs 
from all the existing servers even if 
Logcollectorsrv.exe is not present on the 
server side 
For example, If the Web connector server is 
configured and vesp has its entry, Logcollector 
populates Webconnectors IP in the list of 
servers, from where you can pick up the logs. 
Although as the server does not have log 
collector server running on it there are no logs 
sent back. 

IC:Server NA wi00836371 Selecting Enable SIP for TSA causes memory 
leak in TSA server under normal load 
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Component Parent WI Key Summary   

IC:Server:ICM NA wi00231599 In Multi-tenant administration, a property value 
change in a non-Roman language such as 
Chinese or Korean requires a restart of ICM 
service to show the new value properly in that 
language. 

Note: This WI Will Not be Fixed due to 
restriction at the architecture level. 

IC:Server:TSV5:ASAI  wi00734638 wi00830593 When Link between TS and AES goes down 
TS also goes down irrespective of the value of 
AbortOnLinkDown flag. Ideally when 
AbortOnLinkDown is set to TRUE TS should 
go down as soon as the Link goes down and 
should remain UP when AbortOnLinkDown is 
set to FALSE and Link goes down, but TS is 
going down in both the cases. 

Known issues in Avaya IC 7.2.2 

The following table lists the known issues in the Service Pack IC 7.2.2. 

Component Parent WI Key Summary 

AAWC  wi00320591   wi00320589   Avaya thin client – SIP: conference, transfer, 
consult button gets disabled when we delay 
to answer the call from hard phone. 

Server:TSV5:SIPTS wi00357127 wi00373009 AUX Agent is made available, if the agent is 
consulted and the consultation is cancelled. 

Note: This Issue is Not Reproducible 

Server:TSV5:SIPTS wi00361354 wi00373011 AUX Agent is made available, if the customer 
call is transferred to an AUX agent and the 
agent answers the call 

Client:AAWC wi00353962 wi00373065 Consult button is never enabled for chat & 
callback request. 

RichClient:Email wi00355558 wi00368821 Contents of the html control like list box are 
not displayed in preview mode 

RichClient:WCAgentClient wi00356216 wi00368816 Customer email address which is seen as a 
tag in Reply mode, is not visible when 
customer views the Agent reply 
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Component Parent WI Key Summary 

Server:WACD:AdminSite wi00312895 wi00362840 Customer name of customer created through 
MultiTenancy Administration is not getting 
displayed as display name before email 
address if email is sent from the customer to 
IC. 

Client:AAWC wi00357130 wi00372091 Dialpad does not work. 

Installer:Patch Installer  wi00343405 During uninstallation of 7.2.1 uninstaller on 
Solaris shows the error executing postinstall 
script. 

ICEmail Server  wi00308611 Emails with inline image and no body should 
not be treated as blank email. 

TSV5  wi00226519 Events Lock timer is not being checked for 
expiration until new switch event is received 
on the locked monitor. 
Workaround: Main route point should not be 
part of the device list and VDN should be 
monitored. 

Server:TSV5:SIPTS wi00225943 wi00361925 Failed to register route point if using sips 
protocol for outbound proxy in SIP TS 
configuration. 

RichClient:WCAgentClient wi00352390 wi00363723 Fonttype, fontsize, and formatting, such as 
Bold, Italic, Underline, Color changes to 
default, on deleting text in the email 
composition. 

ICEmail Server wi00295328   wi00332600  From Address is not displayed at agent side 
when an email is send with a from address 
formatted like: 
scotiabankmexico@scotiabank.com.mx 
<scotiabankmexico@scotiabank.com.mx>  

RLManager  wi00339695 Help is not working in RL manager.  

Client:AAWC wi00360903 wi00372090 Hold button is disabled when the agent 
performs consult operation. 

Client:AAWC wi00353965 wi00372018 IC agent can send voice contact but can not 
send chat to another agent in Chat & callback 
request. 

RichClient  wi00340961 IC chat crashes after enabling default 
visibility during monitoring chat sessions. 
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Component Parent WI Key Summary 

Server:TSV5:ASAI wi00361352 wi00372089 IC TTS agent cannot transfer a call to IC SIP 
agent. 
Workaround: Make sure Traditional agent 
use SigleStepTransfer and not 
TwoSteptransfer. 

IC Common STT  wi00224353 If agent pc goes out of network, it does not 
recover unless voice calls are completed 
manually. 
Workaround: As soon as the network 
between the Agent desktop application and 
IC servers goes down, there will be a 
message box popping up on the agent 
desktop saying the connection to the core 
service failed.                                                                                                                                                                                                                                         
When this happens, the agent should 
manually logout of the hard phone, making 
the agent unavailable for any calls. This will 
make the TS to logout the agent internally 
and update the routing engine accordingly.                                                                                                                     
When the network comes back up, the agent 
can restart the agent application which will 
log the agent into the switch and the system 
will work without any problem. 

RichClient:Softphone wi00320606 wi00320603  If an agent drops from the conference via 
Hard phone, the call is still active on Rich 
Client GUI. 

Advocate:WAA wi00368746 wi00369906 In BA, Emails stuck in queue while 
transferring to another agent with message in 
logs 'contact detail object not found in the 
map' 
Workaround:  
1. Open the workflow project "Advocate.prj". 
2. Open the flow "transfertoagent_adv". 
3) Add a Delay block of 50ms before the 
block "Post Qualification". 
4) Compile the workflow. 
5) Restart the workflow servers. 

ICM  wi00231599 In Multi-tenant administration, a property 
value change in a non-Roman language such 
as Chinese or Korean requires a restart of 
ICM service to show the new value properly 
in that language. 
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Component Parent WI Key Summary 

RichClient:WCAgentClient NA wi00385503 In the webagent when the agent composes a 
new email, either by copy & past a text 
template or by typing the text manually,for 
the following scenarios the text of the email is 
not displayed propery: 

RichClient:WCAgentClient wi00357750 wi00373005 Line spaces in an email composed in HTML 
mode are getting removed when received at 
customer side. 

WACD Server  wi00225285 Network or DB problems can cause WACD 
and Email server to get out-of-sync with DB. 
This can lead to old emails coming back into 
system. 

RichClient:WCAgentClient wi00355650 wi00373063 Non English email templates when used in a 
HTML email composition on WebAgent, the 
characters are displayed as? 

Installer:Patch Installer  wi00343706 On AIX sp installer is not removing all folders 
after uninstalling service pack 

Server:TSV5:ASAI wi00350227 wi00372793 On Link down TS is still adding events to 
device queue. 

ICEmail Server  wi00280061 On mapping new poller cluster to an email 
cluster, email server does not fetch email 
from that poller server. 
Workaround: Email servers part of the 
mapped email cluster need to be restarted. 

Admin:ICManager wi00308361 wi00362849 On the workflow server, while selecting 
service on the "Channel editor" it does not 
select the server name if you press particular 
alphabet. 
Workaround: Type/paste/scroll to the 
complete server alias into the combo box. 

RichClient:WCAgentClient wi00355251 wi00363748 On Webagent, non english characters are not 
printing 

ICM  wi00226338 Selecting pre-typed/existing value in text 
control of collaborated browser window using 
mouse is not getting reflected at another end. 
Workaround: Change some value in pre-
typed text to make it visible. 
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Component Parent WI Key Summary 

SIPTS  wi00226087 SIPTS: MSHS feature stops working if one of 
the TS looses network connectivity and then 
reconnects. 
Workaround: Restart one of the SIPTS 
servers. 

AAWC    wi00310283 Supervisor doesn‟t show an transferred 
contact of the supervised agent 

Server:TSV5:SIPTS wi00226434 wi00356476 'Switch to Caller' and 'Complete' buttons are 
enabled before second agent answer a 
consult call: Consult transfer from Traditional-
TS agent to SIP-TS agent 

WorkFlow Designer  wi00305673 Sys_transfer.update_vq_cache crashes 
when used with regions where decimal 
separator is other than ".". 
Workaround: Use val instead of CDbl 
function in this flow. 

RichClient  wi00225558   wi00332490  The "Contact > Print" menu option in AVAYA 
Web Agent is disabled for newly composed 
emails.  

WACD Server  wi00225091 The non functional WACD Server fails to stop 
completely. 
Workaround: Kill the WACD Server process, 
if it is running. 

ConfigAccelerator  wi00340391 There is no feature rollback the 
configurations made in CA tool 

RichClient:WCAgentClient wi00350167 wi00362894 Tracking history shows Agent name "null", 
when Administrator will Resolve Contact with 
status from WACD Admin Page before Agent 
accepts the contact. 

Client:SDK:JavaSampleCli
ent 

NA wi00388552 UI related issues on the SDK Java sample 
client. Like email preview content is not 
shown. 

Installer:Patch Installer NA wi00343706 Uninstaller is not removing 
ICServicePacks/7.2.1/Server/Record/_jvm/jre
/bin folder after uninstalling service pack. 
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Component Parent WI Key Summary 

WACD Server  wi00280567 WACD Admin page shows ACD down (For 
Non-Functional Server) when the server goes 
off network for 6-8 seconds & comes back on 
network. 
Workaround: Restart the non functional 
WACD server. 

Tools:ConfigAccelerator wi00347494 wi00374667 When a scenario is saved the password 
provided is not getting saved in encrypted 
form. 

Server:ICM wi00343269 wi00373059 when system generated handle for 'join us ' 
feature is used for inviting the second 
customer, then the display name of second 
customer during chatting is not correct.( if the 
first customer uses an existing account to 
chat) 
Workaround:  Agent should make sure that , 
there should be no space in joinus-handle , 
before passing joinus-handle to customer. 

RichClient:WCAgentClient wi00312634 wi00361877 When WACD/Pagging server is made 
down,after transfer attempt (which is 
unsuccessfull) , transfer button is still enabled 

RichClient:WCAgentClient  wi00355864 While moving between the original text in the 
Reply composition of a HTML Email, extra 
line breaks are seen 

RichClient:WCAgentClient wi00355864 wi00368825 While moving between the original text in the 
Reply composition of a HTML Email, extra 
line breaks are seen 
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Avaya Product Support Information 
This section contains information on the information that has been published as PSNs, yet relevant to IC 7.2.4 
Service Pack. 

 WorkFlow Server throws an “Out of String” error when an email comes with a huge CC list 

 IC 7.2 AARC Uninstaller removes certain binaries from the system32 directory that may be commonly 
used by other applications 

 Interaction Center License Server uses extra TotalAgents license when agent is configured for all media 
channels in multi-domain, multi-LS environment 

 Silent Installation mode 

 Interaction Center (IC) & Operational Analyst (OA) impact by Russia abandoning Winter time/DST 

 Limitation of the existing Interaction Center (IC) 7.1 to IC 7.2 migration process that the incomplete 
contacts when migrated to IC 7.2 are not recovered by Poller and ICEmail Servers 

WorkFlow Server throws an “Out of String” error 
when an email comes with a huge CC list  

Problem description: 

The VBA used by WorkFlows restricts string to a maximum of 32KB. When an Email comes up with a huge 
CC list, the email server would copy the cc list to the VDU container, if the debug is turned on, the flows would 
copy the VDU data to the debug variable used in the scripts. In the OOTB flows, some of the blocks have 
debug turned on, In this case, when the flows tries to copy string length more than 32KB, VBA raises an 
exception “Out of String space.” 

Resolution: 

The Workflows used by IC Email servers and WACD has to be modified to check for the string length 
condition in the following blocks: 

 Block name: FetchEDU block 

Line number: 70 

Current code: 

debugOut = debugOut & {_#vduData}(i).name & ":" & _ 

String$(numSpaces," ") & {_#vduData}(i).value & ebCrLf 

'This block could have a lot of output when in debug mode. 

'Limit it to {_#maxDebugLength}, or 32k, whichever is smaller. 

If len(debugOut) >= {_#maxDebugLength} Then 

debugOut = debugOut & "Debug output exceeded max of " _ 

& {_#maxDebugLength} & " bytes! Aborting printout..." 

Exit For 
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ElseIf len(debugOut) >= 32000 Then 

debugOut = debugOut & _ 

"Debug output approaching 32k! Aborting printout..." 

Exit For 

End If 

This needs to be modified as: 

If (len(debugout) + len({_#vduData}(i).name) + _ 

numSpaces + len({_#vduData}(i).value) + 3) < {_#maxDebugLength} then 

debugOut = debugOut & {_#vduData}(i).name & ":" & _ 

String$(numSpaces," ") & {_#vduData}(i).value & ebCrLf 

Else 

'This block could have a lot of output when in debug mode. 

'Limit it to {_#maxDebugLength}, or 32k, whichever is smaller. 

debugOut = debugOut & "Debug output exceeded max of " _ 

& {_#maxDebugLength} & " bytes! Aborting printout..." 

Exit For 

End if 

 Block name: ICEmail Analysed 

Line number: 113 

Current code 

debugOut = debugOut & vduSeqCpl(i).name & ":" & _ 

String$(numSpaces," ") & vduSeqCpl(i).value & ebCrLf 

'This block could have a lot of output when in debug mode. 

'Limit it to 32k 

If len(debugOut) >= 32000 Then 

debugOut = debugOut & "Debug output approaching 32k! Aborting printout..." 

Exit For 

End If 

This needs to be modified as: 

If (len(debugout) + len(vduSeqCpl(i).name) + numSpaces + 

len(vduSeqCpl(i).value) + 3) < 32000 then 

debugOut = debugOut & vduSeqCpl(i).name & ":" & _ 

String$(numSpaces," ") & vduSeqCpl(i).value & ebCrLf 
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Else 

'This block could have a lot of output when in debug mode. 

'Limit it to 32k 

debugOut = debugOut & "Debug ouput approaching 32K! Aborting printout" 

Exit For 

End if 

 Block name: ICEmail Outbound Response 

Line number : 114 

Current code 

debugOut = debugOut & vduSeqCpl(i).name & ":" & _ 

String$(numSpaces," ") & vduSeqCpl(i).value & ebCrLf 

'This block could have a lot of output when in debug mode. 

'Limit it to 32k 

If len(debugOut) >= 32000 Then 

debugOut = debugOut & _ 

"Debug output approaching 32k! Aborting printout..." 

Exit For 

This needs to be modified as: 

If (len(debugout) + len(vduSeqCpl(i).name) + numSpaces + 

len(vduSeqCpl(i).value) + 3) < 32000 then 

debugOut = debugOut & vduSeqCpl(i).name & ":" & _ 

String$(numSpaces," ") & vduSeqCpl(i).value & ebCrLf 

Else 

'This block could have a lot of output when in debug mode. 

'Limit it to 32k 

debugOut = debugOut & "Debug ouput approaching 32K! Aborting printout" 

Exit For 

End if 

The following flows needs to be modified with the above change. 

 Flow Name : icemail.analyzeca 

 Block name : fetchEDU and ICEmail Analyzed 

 Flow Name : icemail.analyzenoca 

 Block name : fetchEDU and ICEmail Analyzed 
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 Flow Name : icemail.outboundca 

 Block name : fetchEDU and ICEmail Outbound response 

 Flow Name : icemail.outboundnoca 

 Block name : fetchEDU and ICEmail Outbound response 

 Flow Name : WACD.qualifyemail 

 Block name : fetchEDU 

Note: The above listed blocks are some of blocks identified which need the code changes. However, there 
may be other blocks where the string copy is done without checking the string length. 

Workaround or alternative remediation 

The debug which is turned on by default in the OOTB flows can be turned off in all the blocks and flows 
mentioned above. Once this is turned off, the Workflows need to be complied and uploaded to the database. 
All the Workflow servers need to be restarted or the 

Workflows needs to be reloaded in all the Workflow server by selecting reload flows -> Include file based 
flows -> Force immediate reload. 

IC 7.2 AARC Uninstaller removes certain binaries 
from the system32 directory that may be 
commonly used by other applications 

Problem description: 

After running the Avaya Agent Rich Client (AARC) uninstaller of IC 7.2, certain binaries from system32 folder 
are also removed. 

These binaries, primarily from Microsoft Corporation, are installed during AARC installation. However they 
may be commonly used by other applications installed on the same machine. Hence removal of these 
binaries during un-installation of AARC may affect other applications installed on the same machine.  

Here is the list of binaries that may be uninstalled by the AARC uninstaller:  

Binary Description 

vbar332.dll Visual Basic for ApplicationsRuntime - Expression Service  

dbgrid32.ocx Microsoft Data Bound Grid Control  

dblist32.ocx Microsoft DBList Object Library  

mci32.ocx Media Control Interface  

msflxgrd.ocx Microsoft FlexGrid Control  

msinet.ocx Microsoft Internet Transfer Control  
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Binary Description 

msjet35.dll Microsoft Jet Engine 3.5  

msjint35.dll Microsoft Jet Engine 3.5  

msjter35.dll Microsoft Jet Engine 3.5  

msmapi32.ocx MSMAPI Controls Library  

msmask32.ocx Masked Edit Control  

msrdc20.ocx RemoteData Control  

mswinsck.ocx WinSock Control  

odbctl32.dll ODBC Helper Function DLL  

tabctl32.ocx SSTab Control  

vb6stkit.dll DLL de la biblioteca de Visual Basic Setup Toolkit  

regtlib.exe Visual Studio RegTLib  

msvcr71.dll Microsoft C Runtime Library  

comct332.ocx Microsoft Common Controls 3 Object Library  

comctl32.ocx Windows Common Controls ActiveX Control DLL  

comdlg32.ocx CMDialog ActiveX Control DLL  

mscomct2.ocx Microsoft Common Controls 2 ActiveX Control DLL  

mscomctl.ocx Windows Common Controls ActiveX Control DLL  

richtx32.ocx RichTextBox Control  

mscomm32.ocx Communications Control  

msadodc.ocx ADO Data Control  

 

Resolution: 

The wi00380519 has been created to resolve this issue 

Workaround or alternative remediation: 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 226 

The AARC uninstaller reads the list of files to be uninstalled from “<AARC_HOME>\Uninstall_Avaya Agent 
Rich Client\.com.zerog.registry.xml”. This file is created during AARC installation and contains entries of the 
above listed binaries that were installed by the AARC installer. Hence as a workaround, we need to delete the 
entries of these binaries from the file or just change the value of „uninstall‟ property for each of the entries to 
“false”, AARC Uninstaller will not remove them.  

For example, delete the following entry from .com.zerog.registry.xml file  

<resource keyfile="false" name="vbar332.dll" location="C:\Windows\system32\vbar332.dll" type="file" 
uninstall="true"/>  

Or just change the value of „uninstall‟ property to “false” as shown bellow  

<resource keyfile="false" name="vbar332.dll" location="C:\Windows\system32\vbar332.dll" type="file" 
uninstall="false"/> 

Interaction Center License Server uses extra 
TotalAgents license when agent is configured for 
all media channels in multi-domain, multi-LS 
environment 

Problem description: 

Issue: License Server procures extra “TotalAgents” license when the Telephone Server (voice) and WebACD 
(email+chat) requests different License Servers for the same agent having all channels enabled in multi-
domain, multi-LS environment. 

Detail: 

The issue seems to occur when the request for licenses for a single agent is going to two different License 
Servers (LS) viz. first from TS (for voice channel), and the second from WACD (for email and chat).   

TS could be requesting from the primary LS, whereas WACD is requesting from the secondary LS or vice 
versa.   

Essentially, for a particular agent, license request for all media channels should go to the same LS i.e. TS and 
WACD should request from the same LS.  

License Server procures a “TotalAgents” license for the first time if it has not already been done for that 
agent, irrespective of the channel requesting it. For subsequent request from remaining channels for the 
same agent, License Server does not request for “TotalAgents” license.   
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„TotalAgents‟ parameter is a local resident value per LS and not across multiple LSs. So if the multiple license 
requests of different channels for the same agent go to same LS, there is no issue (Figure 1). 

 

However if the different license requests (from TS and WACD) goes to different LSs, then each LS procures a 
“TotalAgents” license in addition to the license for the channel. This is so, because either of the LS is not 
aware of the other LS procuring “TotalAgents” license for the same agent (Figure 2).  

Another factor is that only one WACD can be active at a given time.  

An e.g. of occurrence of this issue is when active WACDs domain failover for LS might not match with TSv2 in 
domain Voice2, and both the active WACD and TSv2 send requests to different LSs.  

Resolution: 

MR 138400: marked as Will Not Fix 
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Silent Installation mode 

Problem description: 

Providing the detailed steps for silent installation.  

Resolution: 

Installation mode  

All Avaya IC installers can run Silent mode.   

This section is intended to provide instructions to perform silent installation for Avaya Interaction Center 7.2 
products which uses Install Anywhere platform for its RTM installers. Silent installation can be done in two 
ways.   

1. Run installer in silent mode that simply accepts default values (Refer Option 1)  

2. Create a response file and change the default values as per the requirement  

Option 1: Run the install with the default values (no response file) 

a. Open command/shell prompt on Windows or Unix 

b. Go to the installer directory (directory where installer is copied)  

c. At the command/shell prompt execute command as per the OS (refer below table). 

 

Note: There are multiple install sets within some installers (for ex. icwinserversuite contains Server, Design/ 
Admin and AAWC); only „default‟ install set will be installed when the installer is run without using a response 
file. Table 2 lists the default Install set for multi-set installer in IC.  

Use this option only in case default installs set needs to be installed. 

 

Option 2: Using a response file to supply values for installer variables 

1. Create the response file 

a. Open  command/shell prompt on Windows or Unix   
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b. Go to the installer directory (directory where installer is copied)  

c. At the command prompt, execute the below commands  

This will create default installer. properties response file in installer directory itself 

Table 3: 

 

This will create response file at the specified location file. 

 

d. Installer will be launched after executing the above command. Change the default values as per your 
need and these values will be reflected in response file.  

2. Modify the response file(This step is required for installers mentioned in Table 2) 

a. Once the installation is done, a response file will be created in the same directory   where the installer 
is located, or at the absolute path location if specified.  

b. Open the response file in any text editor like Notepad/WordPad  

c. Add the lines mentioned in Data column from the below table in response file for the respective 
installations. This step is must for all IC7.2 installers having multiple install sets (refer Table 2). 
Values related to install set do not get written to the response file, this is known issue of IA 2009.  

d. Save and close the file 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 230 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 231 

 

Note: 

  [1] This is specific to Solaris/AIX platform, open response file to edit and remove the trailing 
Avaya/IC72 path from USER_INSTALL_DIR path variable value as Avaya/IC72 directory 
structure gets appended to the path during installation.  

  N/A – Not Applicable (No install sets)  

  Rows starting with „#‟ are treated as comments  

3. Now run the silent install on different system (where silent installation is desired) 
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a. Go to the installer directory  

b. Open  command/shell prompt and execute the below command 

 

Interaction Center (IC) and Operational Analyst 
(OA) impact by Russia abandoning Winter 
time/DST 

Problem description: 

2011 - Russia Abolishes Winter Time  

The new legislation eliminates the yearly switch between standard time and daylight saving time. The country 
will turn its clocks one hour forward for the last time on March 27 2011, making daylight saving time as 
Russia's new standard time.  

If corrective action is not implemented before 30
th
 October 2011, then IC and OA will revert back to Winter 

time on October 30
th
, which would affect reporting. The error in reporting would be of one hour.  

Resolution: 

IC & OA  

IC and OA use the resident operating system‟s timezone utility. Therefore applying the appropriate timezone 
patch for the resident OS (viz, Windows, Solaris, AIX) should alleviate the problem.  

This applies for both IC 7.1 and IC 7.2.  

Also, the Java SE platform's timezone data is not read from the local or host operating system (OS), so OS 
timezone patches will not update the JRE software's timezone data. To resolve this, it might be necessary to 
run the TZUpdater tool (more details in the Remarks section). 

Remarks: 

The following lists some helpful links to avail of patches /write-ups/ tools.  

-------------------------- OS -----------------------------  

Windows:  

http://support.microsoft.com/kb/2570791 

AIX:  

https://www-
304.ibm.com/support/docview.wss?q1=tz&dc=DB520&rs=111&uid=isg3T1000252&context=SWG10&cs=utf-
8&lang=en&loc=en_US#5 

-------------------------- Java TZUpdater  -----------------------------  

http://support.microsoft.com/kb/2570791
https://www-304.ibm.com/support/docview.wss?q1=tz&dc=DB520&rs=111&uid=isg3T1000252&context=SWG10&cs=utf-8&lang=en&loc=en_US#5
https://www-304.ibm.com/support/docview.wss?q1=tz&dc=DB520&rs=111&uid=isg3T1000252&context=SWG10&cs=utf-8&lang=en&loc=en_US#5
https://www-304.ibm.com/support/docview.wss?q1=tz&dc=DB520&rs=111&uid=isg3T1000252&context=SWG10&cs=utf-8&lang=en&loc=en_US#5
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Refer to http://www.oracle.com/technetwork/java/javase/timezones-137583.html 

Perform the following steps:  

1. Check which version of the Olson timezone data is included in your JRE version. See Timezone Data 
Versions in the JRE Software.   

2. If the latest timezone data for your region is still not correct, then you should download and run the 
TZUpdater tool.   

For Windows/Solaris:  

http://www.oracle.com/technetwork/java/javase/tzupdater-readme-136440.html 

http://www.oracle.com/technetwork/java/javase/downloads/index.html 

For AIX: IBM Time Zone Update Utility for Java (JTZU), that applies Daylight Saving Time (DST) changes 
directly to Java SDKs and JREs.  

The tool can be downloaded from: http://www.ibm.com/developerworks/java/jdk/dst/jtzu.html 

http://www-01.ibm.com/support/docview.wss?uid=swg21515564 

More information on the tool releases and the respective TZ changes it supports.  

http://www.ibm.com/developerworks/java/jdk/dst/olson_table.html 

Limitation of the existing Interaction Center (IC) 7.1 
to IC 7.2 migration process that the incomplete 
contacts when migrated to IC 7.2 are not recovered 
by Poller and ICEmail Servers 

Problem description: 

The current documented email migration process from IC 7.1 to IC 7.2 does not properly migrate the older IC 
7.1.x emails to the current IC 7.2.3 structure. The migration process migrates the data but all emails need to 
be completed in IC 7.1.x prior to the migration and this is clearly stated in the IC documentation. However 
once emails are completed they cannot be recycled once migrated as the database structures between IC 7.1 
and IC 7.2.x are different. What this means is that if you have a copy on the exchange server of the original 
email you can send it as a new email and it will be processed again but no history for that case will be found.  

This document explains the steps required to be performed so that the IC 7.2 system (Poller and ICEmail 
Servers) pick up the migrated contacts in non-completed state for further processing.  

Within the IC documentation it states that all emails in the IC system must be in the completed state in order 
to migrate to IC 7.2.x.  

Resolution: 

To facilitate the smooth recovery of all migrated email contacts, a multiple step approach is required. It can be 
broken down into following major operations:  

1. Migrate ALL email contacts. 

2. Run SQL scripts for Poller and ICEmail Servers. 

3. Restart IC Servers. 

http://www.oracle.com/technetwork/java/javase/timezones-137583.html
http://www.oracle.com/technetwork/java/javase/tzupdater-readme-136440.html
http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.ibm.com/developerworks/java/jdk/dst/jtzu.html
http://www-01.ibm.com/support/docview.wss?uid=swg21515564
http://www.ibm.com/developerworks/java/jdk/dst/olson_table.html
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Each step is described in detail in this document.  

1. Migration of ALL email contacts  

Run the existing IC 7.1 to IC 7.2 Email Migration Tools as per the existing the IC Documentation.  Once 
the migration tool is run successfully on ALL contacts, the IC 7.2 database will have email contacts in the 
following possible states:  

 Complete/Dismissed – Completed migrated contacts  

 Incomplete – Contacts that were not completed prior to the migration. These contacts need to be 
recovered by the Poller and ICEmail Servers of the IC 7.2 system. However, with the introduction of 
Redundancy of Servers in IC 7.2, each contact requires “ownership” information, which depicts which 
server (cluster, to be precise) will recover and process the email contact further. This ownership 
information needs to be populated correctly in the new IC 7.2 database. This task is explained in 
detail in the next section.   

2. Running the SQL Scripts  

This step of the migration process details the steps required to populate ownership information for all 
incomplete contacts.  

Using the following 2 SQL cursors for Poller and ICEmail Servers will automate the populations of the 
ownership information:  

 Poller Server Cursor - This cursor works only on email contacts which will be recovered by Poller 
Server. Working:  

 Find queue_key for contact from qem_message table.  

 Find mailaccount record for the queue_key found in #1.  

 Find PollerClusterName from the qem_mailaccound table and use it to populate contact row, 
found in #1. 

 Repeat the process for all incomplete emails which Poller Server must recover.  
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 ICEmail Server Cursor - This cursor works only on email contacts which will be recovered by ICEmail 
Server.  

 Find queue_key for contact from qem_message table.  

 Find mailaccount record for the queue_key found in #1.  

 Find PollerClusterName from the qem_mailaccound table.  

 Find ClusterMap record from clustermap table and use the first ICEmail Cluster mapped to Poller 
Cluster and populate the ClusterName in the record found in #1.  

 Repeat the process for all incomplete emails which ICEmail Server must recover. 
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3. Re-Starting the IC Servers  

Restart Poller, ICEmail and WACD servers in IC 7.2 if already running, else start them. This will cause the 
recovery routines of all these servers to be run. Now, each server will pick up tasks in their respective 
recovery routines and process them further. (Poller and ICEmail Servers will pick up contacts based on 
ownership information which is populated in the previous step, using SQL scripts). 

Remarks: 

The above steps to migrate email contacts have been tested by Avaya.  Some items to highlight  

 EDU‟s created in IC 7.1 cannot be recreated in the IC 7.2 system – see the workaround section below to 
address this 
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Workaround or alternative remediation: 

As highlighted above, EDU‟s created in IC 7.1 cannot be recreated in an IC 7.2 system. The impact of this is 
that any operations that require EDU updates or related will be impacted.  

To workaround this, the following needs to occur: 

 In order to allow the contacts to be processed further, the EDUID information MUST be DELETED from 
the contact records so that new EDUs will be created.   

 This will impact reporting (and functionalities at times) which are based on EDU existence and their 
values.  

 Contact Creation time will change.  

 OA live reporting will be impacted.  

 Flows will require proper error handling and recovery (i.e. corrective action) in case of such EDU access 
failures. 
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Avaya IC 7.2 Documentation Errata 
The below section contains additional information and modifications to some existing information in IC7.2 
documentation. 

UUI Container Information for Telephony Server in 
IC7.2.1 

Following section describes the format of the UUI field that the „Telephony Server‟ (TS) of IC7.2.1 expects for 
it to preserve the UUI data set by third party applications.  

TS is responsible for decoding the UUI field that comes in the event data from the switch. TS expects the 
value of the uudata to be specified in the following format to separate out EDU-ID and extended data from the 
uui field 

 EDU-ID 32 bytes (Index - 0 – 31) 

 Field separator 1 byte (Index - 32) 

 Extended data 63 bytes (Index - 33 – 95) 

The “field separator” between the EDU-ID and the “extended data” is “;” by default. It can be adjusted by 
changing TS configuration parameter “extdata_separator”. The parameter can be added in the “Configuration” 
tab of TS Server in “IC Manager”. The value of this parameter should not be more than a character.  

Example: 4a700d14000000009493a94923340002; cust=4567213/ivr=1, 3, 9 

Here EDU-ID will be considered as “4a700d14000000009493a94923340002” and the extended data as 
“cust=4567213/ivr=1,3,9”. Note that TS will always verify if the EDU-ID is valid. 

TS, irrespective of any data in the first 32 bytes (Valid EDU\Non EDU\Invalid EDU) would always move the 
data from the 34th byte to a field “extdata” in the EDU as well as in TS.IncomingCall event. The 33rd byte 
should be a separator. 

Following table provides the log file container examples for different UUI scenarios with or without extended 
data and with various couples being populated. 

UUI Extended 

Data 

Couple(s) 

populated 

uudata and Log file container example 

EDU None EDU uudata: 

4a700d14000000009493a94923340002 

Event: 

[TS.IncomingCall.event({0,"TS.IncomingCall",{0,13,{"vdu_i
d","4a700d14000000009493a94923340002"},{"call_ref_id",
"556"},{"monitor","4992"},{"orig","4993"},{"dest","4992"},{"an
i","4993"},{"dnis","4992"},{"called","4992"},{"calltype","direct
"},{"ctype","direct"},{"eventQual","new asai 
call"},{"ucid","09999005561116683500"},{"queue",""}}})] 
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UUI Extended 

Data 

Couple(s) 

populated 

uudata and Log file container example 

EDU extra data EDU, extdata uudata: 

4a700d14000000009493a94923340002; 
cust=4567213/ivr=1,3,9 

Event: 

[TS.IncomingCall.event({0,"TS.IncomingCall",{0,14,{"vdu_i
d","4a700d14000000009493a94923340002"},{"call_ref_id",
"567"},{"monitor","4992"},{"orig","4993"},{"dest","4992"},{"an
i","4993"},{"dnis","4992"},{"called","4992"},{"calltype","direct
"},{"ctype","direct"},{"eventQual","new 
asaicall"},{"extdata","cust=4567213/ivr=1,3,9"},{"ucid","099
99005671116684033"},{"queue",""}}})] 

Invalid EDU None uui uudata: 

428f3e4b00000000ac2aad06232f0002 

Event: 

[TS.IncomingCall.event({0,"TS.IncomingCall",{0,14,{"vdu_i
d","4a700d14000000009493a94923340002"},{"call_ref_id",
"570"},{"monitor","4992"},{"orig","4993"},{"dest","4992"},{"an
i","4993"},{"dnis","4992"},{"called","4992"},{"calltype","direct
"},{"ctype","direct"},{"eventQual","new 
asaicall"},{"ucid","09999005701116684193"},{"queue",""},{"
uui","428f3e4b00000000ac2aad06232f0002"}}})] 

Invalid EDU extra data uui, extdata uudata: 

428f3e4b00000000ac2aad06232f0002; 
cust=4567213/ivr=1,3,9 

Event: 

[TS.IncomingCall.event({0,"TS.IncomingCall",{0,15,{"vdu_i
d","4a700d14000000009493a94923340002"},{"call_ref_id",
"570"},{"monitor","4992"},{"orig","4993"},{"dest","4992"},{"an
i","4993"},{"dnis","4992"},{"called","4992"},{"calltype","direct
"},{"ctype","direct"},{"eventQual","new 
asaicall"},{"extdata","cust=4567213/ivr=1,3,9"},{"ucid","099
99005701116684193"},{"queue",""},{"uui","428f3e4b00000
000ac2aad06232f0002"}}})] 
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UUI Extended 

Data 

Couple(s) 

populated 

uudata and Log file container example 

Non EDU None uui uudata: 

123456 

Event: 

[TS.IncomingCall.event({0,"TS.IncomingCall",{0,14,{"vdu_i
d","4a700d14000000009493a94923340002"},{"call_ref_id",
"576"},{"monitor","4992"},{"orig","4993"},{"dest","4992"},{"an
i","4993"},{"dnis","4992"},{"called","4992"},{"calltype","direct
"},{"ctype","direct"},{"eventQual","new 
asaicall"},{"uui","123456"},{"ucid","09999005761116684499
"},{"queue",""}}})] 

Non EDU extra data uui (UUI and 
Extended 
Data with 
field 
separator), 
extdata 

uudata: 

12345678901234567890123456789012; 
cust=4567213/ivr=1,3,9 

Event: 

[TS.IncomingCall.event({0,"TS.IncomingCall",{0,15,{"vdu_i
d","4a700d14000000009493a94923340002"},{"call_ref_id",
"570"},{"monitor","4992"},{"orig","4993"},{"dest","4992"},{"an
i","4993"},{"dnis","4992"},{"called","4992"},{"calltype","direct
"},{"ctype","direct"},{"eventQual","new 
asaicall"},{"extdata","cust=4567213/ivr=1,3,9"},{"ucid","099
99005701116684193"},{"queue",""},{"uui","1234567890123
4567890123456789012;cust=4567213/ivr=1,3,9"}}})] 

 

Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2 
Siebel 8 Integration 
Guide  

/ IC72sbl8int.pdf 

Page 266,  

Section : Diagnosing and 
clearing AICD loading 
problems-> For Solaris and 
AIX platforms 

Missing 
Information. 

The configured user for Siebel 
MUST have Write permissions for 
directories and files under 
$AVAYA_ICXX_HOME. 

Best practice is to have both Siebel 
and IC installed by same user 
account. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2   

Telephony Connectors 
Programmer Guide 

/IC7.2 Voice.pdf 

Page 86,  

Section: Table under point 
“8. Complete the following 
fields on form 3:” 

Missing 
Information. 

Additional Information. 

Field: UUI Treatment 

Description: Enter value service-
provider. 

If the value is shared, SIP TS cannot 
route the call to agent. 

IC Administration 
Volume 1: Servers & 

Domains. 
/IC72admin1.pdf 

Page 99,  

Section : Incoming Email 
Server: Email Account Type 

In Avaya IC 

7.2, you 
can also 
use IMAP4 
protocol for 
receiving 
the emails. 
In IMAP4, 
all the 
emails 
remain on 
the email 
server. 

In Avaya IC 

7.2, you can also use IMAP4 
protocol for receiving the emails. In 
IMAP4, emails will be deleted from 
Exchange server, once they are 
processed by ICEmail server, like 
POP3. 

Avaya IC Installation 
and Configuration. 

Page 146 

Section: Installing the 
license file 

Missing 
information. 

Installing License file by non-root 
user for Unix variants. 

When weblm is running as non-root 
user, additional privilege must be 
given to this non-root user to be able 
to install license file.       Perform the 
steps below for Solaris/AIX: 

Login to solaris box with root login. 

Execute the command  usermod -K 
defaultpriv=basic,net_rawaccess 
<non-root user> 

Re-login the non-root user and start 
the weblm and then install the 
license file. 

Client SDK 
Programming Guide / 
IC72sdkProg.pdf 

Page 149 

Section: Voice Call Scenario 

Missing 
information. 

Section added, that illustrates 
normal call scenario (outbound and 
inbound calls) for SDK, list of events 
generated and objects generating 
them. 

Refer to http://support.avaya.com 

https://support.avaya.com/css/P8/documents/100059310
https://support.avaya.com/css/P8/documents/100059310
http://support.avaya.com/
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Agent User 
Guide / IC72agent.pdf 

Page 71 

Section: Managing Email 
Contacts 

Missing 
Information 

Added Note: 

Agent Should Not Explicitly add 
tracking id or tracking id like 
string/text to email subject, while 
doing reply or sending new 
outbound email. 

The format of tracking id is as below: 

Format 1: [T<4 digits for year><2 
digits for Month><2 digits for 
date><4 digit for base 32 string>S<2 
digits for special status><1 digit for 
agent preference for 
routing>Z<Messageid of outgoing 
email>] 

Format 2: [T<4 digits for year><2 
digits for Month><2 digits for 
date><4 digit for base 32 string>S<2 
digits for special status><1 digit for 
agent preference for routing>] 

Avaya Agent User 
Guide / IC72agent.pdf 

Page 116 

Section: Using Collaborative 
Form Filling 

Missing 
Information 

Note: 

If customer has installed the 
JDK/JRE on the machine from 
where a chat has been escalated to 
an agent and website has the 
property 
"chat.htmlclient.collaboration.enable
d = true" then a page pushed by the 
agent is displayed on a new window. 

But if customer does not have 
JDK/JRE installed on machine from 
where a chat has been escalated 
and website has the property 
"chat.htmlclient.collaboration.enable
d = true" the pushed page is 
displayed at the right frame (In 
docked mode).This behavior for all 
versions of IC from IC 7.1.5 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 245 

Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2   

Telephony Connectors 
Programmer Guide 

/ IC7.2 Voice.pdf 

Page: 92 

Section: Table under the 
section “Pattern for a 
contact in a media server 
address map” 

5061: The 
port 
number of 
the TCP. 

5061: The Port number of TLS. 

Avaya Agent User 
Guide / IC72agent.pdf 

Page: 114 

Section: Using Auto Sync 

Tip for 
Point 2. 

If you are handling two or more chat 
contacts simultaneously & you want 
to send URL of website to other 
customers, there is an Internet 
Explorer icon for each customer. 

Avaya Agent User 
Guide / IC72agent.pdf 

Page: 115 

Section: Using Auto Sync 

Tip for 
Point 8. 

If you begin a chat session with 
another customer before you 
complete the chat session you are 
currently handling, another browser 
will open for the second customer if  
you want to send URL of website to 
another customer. 

Avaya Agent User 
Guide / IC72agent.pdf 

Page: 116 

Section: Collaborative Form 
Filling 

To help 
your 
customer 
fill a form. 

1. Verify 
that your 
chat 
customer 
wants you 
to help fill 
out a form. 

To help your customer fill a form: 

1. Type the URL in the Text Entry 
area. Click Push URL. 

2. Verify that your chat customer 
wants you to help fill out a form. 

Avaya Interaction 
Center Release 7.2 IC 
Installation Planning 
and Prerequisites / IC 
Installation Planning 
and Prerequisites.pdf 

Page : 54 

Section: Required agent 
desktop software 

IC 7.2 Pre-
req guide 
mentions 
JRE 1.6 as 
required 
software on 
agent 
desktop (to 
be installed 
by 
customer). 

Since IC ships JRE, it is not needed 
that customers install JRE on agent 
desktop for Avaya Agent Rich Client. 

However JRE is required by Avaya 
Agent Web Client. Hence JRE need 
to be installed on every machine 
from where AAWC will be launched. 

https://support.avaya.com/css/P8/documents/100059310
https://support.avaya.com/css/P8/documents/100059310
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2 
Business Advocate 
Configuration and 
Administration / 

IC72Advocate.pdf 

Page : 53 

Section : Component 
Manager  

Document 
does not 
contain the 
complete 
information. 

The Primary RM, Secondary RM 
and the Advocate Supervisor 
depend on the MxDBFx.dll loaded 
by Component Manger to talk to the 
advocate database. The role of 
Component Manager is not limited 
till defining the primary and 
secondary RM during installation 
only.  

If the machine hosting component 
manager goes down, none of the BA 
components would be able to talk to 
the advocate database. 

Avaya Agent User 
Guide / IC 7.2 Avaya 
Agent User Guide.pdf 

Page : 64 

Section: Handling Contacts 
Without Auto Answer 

The steps 
mentioned 
are 
insufficient 
to answer 
the call. 

Double clicking on the contact in the 
phone task list does not provide the 
answer functionality. The agent has 
to explicitly use the "Answer" button 
to receive the call.  
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

IC Administration 
Volume 2: Agents, 
Customers, & 
Queues.pdf 

Page : 157 

Section: Using a shared 
directory for agent files 

Missing 
Information 

The globalpreferences.xml file is 
intended to be used on a shared 
network drive as a way to globally 
set preferences for all agents without 
having to make changes on each 
individual agent machine. However, 
agents are free to override these 
settings by setting their own 
preferences via WebAgent. Changes 
made to the agent's preferences in 
WebAgent are stored in the 
agentpreferences.xml file. So, the 
globalpreferences.xml file can be 
considered as the agent's initial 
default settings. If there is an 
agentpreferences.xml file with 
different settings, the 
agentpreferences.xml will override 
the settings from the 
globalpreferences.xml file.  

Additionally, the 
globalpreferences.xml file is used to 
create the agentpreferences.xml file 
when new agents first login. 

Configuration for 
globalpreferences.xml 

Put globalpreferences.xml file on a 
shared network drive. 

Login to ICManager. 

Modify following IC property 
Agent\Desktop\WAC and set shared 
network path for HomeDir property. 

Click on "Apply" button. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2 
Business Advocate 
Configuration and 
Administration / 

IC72Advocate.pdf 

Page : 20 

Section: How Business 
Advocate works with Avaya 
IC standard routing 

The steps 
mentioned 
are 
insufficient 
to 
configure. 

In a single system of IC, both the 
routing combinations(IC Standard 
routing and BA routing) can exist. 
But supported combinations are 

Email and chat channel with either 
standard or BA but not both at the 
same time. Both channels must use 
the same type of routing at a given 
time. 

Voice can have both types of 
routing. 

If an agent is enabled for BA it is 
expected that the agent receives 
contacts only through BA with an 
exception for voice contacts which 
he might receive from BA or directly 
through switch based routing. 

Avaya Interaction 
Center Release 7.2 IC 
Administration Volume 
1: Servers & Domains / 
IC 7.2 IC 
Administration Volume 
1 Servers and 
Domains.pdf 

Page: 56 

Section: Server overview for 
IC Email Server 

Missing 
Information 

Poller Server doesn't poll the emails, 
which doesn't have the FROM or 
REPLY-TO header. 

Such emails will be skipped by 
Poller Server and exchange admin 
needs to clean up such emails. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Agent User 
Guide / IC 7.2 Avaya 
Agent User Guide.pdf 

Page : 71 

Section: Managing Email 
Contacts 

Missing 
Information 

Monitoring an Email Session 
(Supervisors Only)  

To monitor agents' e-mail sessions 
one of the most important way is 
start agent in Supervisory mode. 

Supervisor can only view the e-mails 
but cannot perform any other 
operations. 

Note: Before Supervisor can monitor 
an agent, he must be designated as 
the supervisor of at least one of the 
agent's workgroups. 

To monitor an e-mail session:  

Before monitoring an e-mail session, 
Supervisor can set his availability for 
voice, chat, and e-mail to 0 in Avaya 
Agent Web Client. 

Select the Supervisor Tools > Begin 
supervisor session option on the 
main toolbar of the Avaya Agent 
Web Client. 

This displays a Supervisor pane 
besides the interaction list panel. In 
this Supervisor pane, he can view 
the workgroup and agents currently 
logged-in to the chat or e-mail 
session. 

To end monitoring session without 
switching to another session, select 
the Supervisor Tools > End 
supervisor session option. 

This ends supervisory mode for 
monitoring and he can start in an 
agent mode. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

IC721ReleaseNotes.pd
f 

Page : 69 

Section: Configurations / 
ICManager / Enabling Chat 
Typing Status for Avaya 
WebClient and Avaya SDK 
Clients 

Missing 
Information 

To Enable Chat Typing Status for 
Avaya Agent WebClient and SDK 
Clients 

Login to ICManager. 

Selects Tools->Property Declaration. 

This will open the Property 
Declaration dialog box. 

Add below properties under 
Agent/Desktop/Chat/Application. 

Add property ShowTypingStatus 
having dataype as boolean. 

Add property TypingStatusThreshold 
having datatype as integer. 

Click on Ok button of the Property 
Declaration dialog box. 

Modify following properties in IC 
Manager in section 
Agent/Desktop/Chat/Application. 

ShowTypingStatus = Yes 

TypingStatusThreshold=12 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

IC 7.2 Using Config 
Accelerator.pdf 

Page : 42 

Section: Sites Configuration 
/ WebACD (Web Automatic 
Call Distributor) server 

Missing 
Information 

Note: 

If CA tool is used to configure IC, 
user may have to change the 
"WACD WebServer" in WACD 
server parameter, depending upon 
the deployment of website. 

The steps to change the parameter 
are as follows: 

Open ICManager and edit WACD 
server. 

Go to WACD tab. 

In the 'WACD Webserver' field, enter 
the the name and domain of the 
computer that hosts the Web 
Administration pages. 

Click on "Apply" button and restart 
WACD server. 

Avaya Agent User 
Guide / IC 7.2 Avaya 
Agent User Guide.pdf 

Page : 114 

Section: Using Auto Sync 

It doesn't 
mention 
correct 
button. 

If a customer wants to send you a 
page, such as information they 
entered on a form, they must click a 
Send Message button. 

Point no. 6: 

If your customer wants to lead you to 
a different page, tell them to go to 
that page and click the Send 
Message button in their chat client. 
They can also paste the URL into 
the chat client and Send Message 
Page. 

Avaya Agent User 
Guide / IC 7.2 Avaya 
Agent User Guide.pdf 

Page : 116,117 

Section: Using Collaborative 
Form Filling 

It doesn't 
mention 
correct 
button. 

If the customer is viewing the form, 
ask them to click the Send Message 
button. 

Tip: When your customer clicks the 
button, the page you are viewing 
may be different from your 
customer‟s page. In this case, ask 
your customer to click the Send 
Message button again 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Agent User 
Guide / IC 7.2 Avaya 
Agent User Guide.pdf 

Page: 132 

Section: Handling a JoinUs 
Conference 

It doesn't 
mention 
correct 
button. 

Tip: You may want to tell your 
customer and friend how to lead the 
others to a Web page. They can go 
to the page or paste the URL in the 
URL box of their chat client, and 
then click the Send Message button. 

Avaya Interaction 
Center Release 7.2 
Avaya IC integration 
with VP / IR document 

Page: 84 

Alarm "Failed to create all of 
the ADUs" 

Duplicate 
Information 
(This 
information 
is present 
on Page : 
85 
correctly) 

Ignore this content. 

Avaya Interaction 
Center Release 7.2 
Avaya IC integration 
with VP / IR document 

Page: 85 

Alarm "Unable to load server 
configuration" 

Duplicate 
Information 
(This 
information 
is present 
on Page : 
90 
correctly) 

Ignore this content. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2  

Telephony Connectors 
Programmer Guide 

Page No: 257 

Section: 
TS.SingleStepConferenceV
DU 

Incorrect 
Information 

Read the parameters table as below: 

Value Description 

vduid EDUID of the call. 

destinat
ion 

The destination of the 
conference, which can 
be any of the following: 

Agent ID Number - The 
call is transferred to the 
agent‟s teleset. 

Name - The name is 
looked up in the Avaya 
IC Directory. If the 
telephone number field 
associated with the 
name contains an 
extension number, the 
call is conferenced to 
that extension. 

Sequence of digits to 
dial. 

Mode VISIBILITY_ON: The 
newly added party with 
full visibility 
Option will have listen 
and talking paths. 
VISIBILITY_OFF: Only 
listening paths will be 
provided for 
the newly added party. 

 

Avaya Interaction 
Center Release 7.2 

Installation and 
Configuration 

Page No: 315 

Section: Required 
permissions for agents 

Incorrect 
information 

For IC_INSTALL_DIR\etc and 
IC_INSTALL_DIR\logs Delete 
should also be in the list of Required 
permissions and not in Allowable 
restrictions in the table. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2 

Installation and 
Configuration 

Page No. 431 

Section: Troubleshooting the 
Data server 

(Consider this as a new 
point in this section) 

Missing 
Information 

Issue: 

SQL1220 when issuing db2start, 
SQL1084 when trying to connect to 
a database when running 32-bit DB2 
version 8.2 on AIX 6.1 with the 
Olson timezone format 

Solution: 

Running a 32-bit DB2 Version 8.2 
server on AIX 6.1 will encounter 
errors when using an Olson 
timezone format (TZ=US/pacific). 
In this configuration, AIX's ICU 
(International Unicode) component 
memory maps files which conflict 
with DB2's use of shared memory. 
Prior to 32-bit DB2 Version 8.2 
FP16, SQL1220 will be received 
on db2start. 
On 32-bit DB2 version 8.2 FP16 or 
higher, due to unrelated changes, an 
error will occur later when attempting 
the first connection to or activation of 
a database, at which point SQL1084 
will be received. 
The workaround is to switch to a 
POSIX timezone format, for example 
TZ=EST5. An alternative 
workaround on FP16 or higher is to 
enable AIX's Extended Shared 
Memory setting (EXTSHM). 

Recommendation: 

In view of the above, it is 
recommended to set the system 
timezone format (TZ) of the server 
running the DB2 server is set using 
the POSIX format as described 
above. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

IC 7.2 Avaya Agent 
User Guide 

Pages 82-83 

Section:  

Addressing Emails with the 
UAD 

This 
section 
documents 
steps to 
address an 
email using 
UAD, and 
mentions 
using 
queue in 
addition to 
agents. 

Email address is not associated with 
any queue. As such, the ability to 
select queue using UAD for Email 
has been disabled in AARC. 

The relevant section for „Addressing 
Emails with the UAD‟, should now be 
read without reference to 
queue/queue tab. 

IC 7.2 Avaya IC for 
Siebel 8 Integration 
Guide 

Page No. 212 

Section: 

Creating a Profile 

 

In step 6, 
adding the 
AICD 
Responsibil
ity section 
is 
mentioned 
only for 
Siebel 
8.1.1.0. 

AICD Responsibility is applicable for 
Siebel 8.0.0.0 as well. 

Avaya Interaction 
Center 

Release 7.2 

Avaya IC integration 
with VP / IR 

Page No. 26 

Section: Configure Dialog 
Designer 

Step 6. 

Incorrect 
filename 

Under “Ensure that the following files 
and folders are seen in the WEB-INF 
directory.”  

“ibm-web-bnd.xmi” file is incorrectly 
mentioned as “ibm-web-bnd.xml” file 

Avaya Interaction 
Center 

Release 7.2 

Installation and 
Configuration 

Page No. 47 

Section : Building the 
database schema for an 
additional Logical 
Resources Manager 

Sub-Section: Building the 
Business Advocate 
database schema for SQL 
Server 

Missing 
Information 

Note: Create a new database for 
Additional Logical Resource 
Manager configuration, by following 
the same steps used to create 
database for Primary Logical 
Resource Manager. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center 

Release 7.2 

Avaya IC for Siebel 8 
Integration Guide 

Page No. 162 

Section: ASIS parameters 

Missing 
Information 

JVM Options for ASIS Server 

To improve the performance of ASIS 
certain JVM options can be passed 
to the jloader which accordingly 
loads the JVM for running the ASIS 
inside it. 

Below are the steps to apply these 
parameters: 

1. In IC Manager, edit the ASIS 
server and go to the 
Configuration tab 

2. Click new (Name value pair) 

3. Go to the ASIS server 
configuration tab.  

4. Add the parameter e.g. "jvm:-
Xrs" into the Name field and 
leave the Value field blank.  

Perform steps 1 to 4 for all the 
desired JVM parameters listed. See 
examples below. 

Apply the settings and press OK  

Restart the ASIS server, update the 
directory server and refresh the IC 
Manager. 

Examples of the parameters: 

jvm:-Xrs  

jvm:-Xms128m  

jvm:-Xmx256m  

jvm:-Xgcpolicy:subpool 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center 

Release 7.2 

IC Administration 
Volume 2: Agents, 

Customers, & Queues 

Page No. 162 

Section: About contact 
acceptance RONA 

Additional 
Information 

Note: In Automatic blending mode, 
when only one agent is available 
and that agent rejects the contact 
(Email/Chat) by selecting “No” on 
the contact acceptance dialog box, 
the email/chat channel becomes 
busy and the pop up disappears. 
The entire agent does not go into 
aux, but only the Email/Chat channel 
goes into aux.  

To enable Email/Chat channel, put 
the entire agent in aux by clicking 
the agent head and then make the 
agent available by clicking agent 
head again so that agent becomes 
available on all the channels. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2 IC 
Administration Volume 
1: Servers & Domains / 
IC 7.2 IC 
Administration Volume 
1 Servers and 
Domains.pdf 

Page No. 79 

Section: Email services 

Missing 
Information 

Whenever the Primary ICEmail 
server in cluster fails and Secondary 
ICEmail server become active/ 
functional, for the agents logged in 
via AAWC/SDK server, the email 
channel status changes to 
"Impaired" state 

During this time agent would not 
receive any new incoming emails 
and can not send any outbound 
emails. However agent can 
compose new emails or replies and 
can read already accepted emails.  

After 2-3 minutes email channel 
status is changed to "OK" state 
automatically (cross sign disappears 
and email channel is available). 
Agent can continue working normally 
thereafter and the agents are NOT 
required to logoff and re-login again. 

Note: In AAWC, a cross sign 
appears on agent's email channel 
when the email channel is “Impaired” 
and the cross sign disappears when 
the email channel becomes 
available. 

In SDK, this UI representation may 
vary depending on the 
implementation to represent the 
channel availability information. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

IC 7.2 Avaya Agent 
Web Client online 
help.pdf 

Page No. 35 

Section: Email application 

Missing 
Information 

In AAWC, the list of fonts displayed 
in the „Fonts‟ drop-down shown 
during email 
composition/reply/forward is fetched 
from the „C:\WINDOWS\Fonts‟ folder 
in the agent's machine. 

Hence, the fonts that are displayed 
do not represent specific set of fonts 
supported by AAWC. The displayed 
list of font depends on the set of 
fonts present on the agent windows 
machine. 

Any fonts that the customer wishes 
to use in AAWC can be added to this 
font‟s directory and it will be 
displayed in the 'Fonts' drop-down.  

Avaya Interaction 
Center Release 7.2 IC 
Administration Volume 
1: Servers & Domains / 
IC 7.2 IC 
Administration Volume 
1 Servers and 
Domains.pdf 

Page No. 79 

Section: Email services 

Missing 
Information 

The time required to complete the 
"Refresh Email Templates" 
operation performed from 
JavaAppBridge server in IC 
Manager varies according to number 
of templates configured in the 
system. For large number of email 
templates (more than 1000), it may 
take 5 to 10 minutes depending on 
the size of the templates. 
 
During the time this operation is 
underway, the templates will not be 
available for agents. So if an agent 
logs in to AAWC before this 
operation is complete, the templates 
will not be visible to the agent. Agent 
needs to close the resource window 
and reopen again to view the 
templates once the caching 
operation is completed. 

It is recommended to perform the 
“Refresh Email Templates” operation 
during the Non-Peak hours. 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center Release 7.2 

IC Administration 
Volume 2: Agents, 
Customers, & Queues 

Page No. 95 

Section: Phone Type 

Missing 
Information 

Note: For Definity CM, the Phone 
Type “Direct” is not supported with 
IC:Client:AAWC (WebClient) 

Avaya Interaction 
Center Release 7.2 
Avaya Agent User 
Guide Release 7.2 

Page No. 74 

Section: Icons in the Email 
Task List 

Missing 
Information 

Note: 

When an agent is handling an email 
contact (Active email) and if a voice 
call comes, the email tasklist 
changes the email contact's status 
from Active to InActive/Pause 
state,the Webagent tool Bar gets 
greyed-out and the options under 
the Contact menu gets disabled.  
 
The email status (Inactive/Pause) 
and webagent toolbar will remain in 
this state, till the agent clicks the 
email task again (While in the voice 
call or after the call gets completed) 
to make the email contact Active. 

Avaya Interaction 
Center Release 7.2 

IC Administration 
Volume 1: Servers & 
Domains 

Page No. 343 

Section: Web Scheduled 
Callback server: 
WSCallback tab: Advanced 
Properties 

Incorrect 
Information 

&  

Missing  

Information 

Field: Call queue size 

Default is 50 

         & 

Minimum is 10 

Maximum is 200 
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Document Name Location Current 
Informatio
n 

Corrected /Added Information 

Avaya Interaction 
Center and 
Operational Analyst 
Release 7.2 

Software Upgrade and 
Data Migration 

Page No. 60 

Section: Migrate email data 
from Email server 

Incorrect 
Information 

&  

Missing 
Information 

Prerequisites for migrating Email 
data: 

Email contacts in the database can 
be in any state before the 
migrateemail tool is run. 

It is Mandatory to set the time and 
zone information of the machine 
where the migration tool is run to the 
same values as that of the server 
where IC Database (ccq and 
repository) resides. This is needed 
for correct DST and Standard offset 
calculations, which will be generated 
using the timezone information 
during migration of datetime fields. 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 262 

Known issues in Avaya IC 7.2 documentation 

Following are the known issues in IC documentation.  

Key Parent WI Summary 

wi00226552  Document that it is necessary to use a locale that supports use of the period for 
decimal representation for Advocate flows to work properly. 

wi00222300  Advocate documentation incorrectly states that Backup work gets only serviced 
if there is not reserved work that agent is activated for. 

wi00302242  Security checklist is not provided in IC documentation 

wi00307668  IC 7.2 - IR 4.0 - DD 5.0: Documentation: Integration is not successful by 
following "Avaya Interaction Center Release 7.2 – Avaya IC Integration with 
VP/IR" document. 

wi00225655  Need to mention in the product document that "AUXRONAReasonCode" works 
only when IC is integrated with BA for Voice Channel 

wi00223011  Prerequisite and installation documentation should explicitly address 
requirements for PDM with respect to database connectivity 

wi00226328  Need to update documentation for AIX, to change locale from "EN_US" to 
"en_US" 

wi00226228  Description provided for Generic.GenericUpdate method for TS server should 
be changed in the core.pdf (page 31) 

wi00224666  Remove Documentation Ordering information from all documentation -- after  

market printed documentation/doc CDs no longer supported per Product 
Management 

wi00224022  User document referencing Voice Chat does not match the Rich client GUI 

wi00287792  Log related configuration parameters must be documented for RLManager. 

wi00297674  Customer wants a setting that would stop the dataserver from trying to 
reconnect to the database, when the database is down for 30 minutes or more. 
In this case it is recommended to shut down IC. Need to document this. 

wi00307172  WACD WebServer name must be changed depending upon the website 
deployment. 

wi00231779  IC pre-req document for TS needs to be change  as AIC ASAI Core and  

Plus are not required as pre-requisites for Agent events/States to work. 
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Key Parent WI Summary 

wi00225504  WAA.RetryAfterTimeOut for requalifying contacts is not documented 

wi00226505  Suggested Responses should be document properly mentioning all the detailed 
steps 

wi00302239  IC7.2 Customization Guide is not available in the Server Machines. 

wi00303172  Need to document Rich and Thin Client behavior when default email cluster 
goes down. 

wi00225638  The IC system doesn't create the required subfolders for "Default WebSite" 
under IIS in French environment after running the configuration Tool. 

wi00297643  286378 issue needs to be documented. 

wi00299484  In Solaris IC server installation, a library path does not set correctly. 

wi00222836  VOX documentation dealing with "pings" initiated from an IVR that connects to 
the VOX needs to reference VOX.ping instead. 

wi00307651  IC 7.2 Documentation: Wrong file extension mentioned for required files in  web-
inf folder in icconnector directory of Dialog Designer Machine. 

wi00223700  AAWC OnLine help refers to prompt to install WindowsManager.ocx. Prompt 
has changed (we now install avayaaicagent.cab) 

wi00224417  Documentation needs to be updated to reflect no support for VoIP Chat and  
Collaborative Form Filling 

wi00224976  The WSC  help file contents needs to be corrected 

wi00297801  MS Exchange Server 2007 is changing invalid char set of the Email to valid 
character 

wi00300052  Documentation doesn't specify the limitations of "co-browsing/auto-syncing" for 
the websites that require authentication. 

wi00205351  SEC_DOC_AVAY_060 - A general section to address secure deployment and  

operation of AIC is needed in the documentation 

wi00224845  Documentation - NLS_LANG value for Oracle needs to be changed for all 
languages 

wi00225142  At the bottom of Page 144 of the install.pdf guide, there is missing text starting 
with "You can", but with nothing else 

wi00224967  FRA-OLH Footer in Contents is in English – this appears in the PDF 
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Key Parent WI Summary 

wi00225181  Installation docs should state location of nethome directory created by installer 

wi00221846  The Database Designer User Guide is referenced in the 7.0 manuals and that 
manual title no longer exists 

wi00225060  THA: incorrect spelling in Help Topic (about Translation) 

wi00371577 wi00350167 Tracking history shows Agent name "null", when Administrator will Resolve 
Contact with status from WACD Admin Page before Agent accepts the contact. 

wi00362089 wi00300052 Documentation doesn't specify the limitations of "co-browsing/auto-syncing" for 
the websites that require authentication. 

Workaround: 

For security reasons, certain fields like the password field and hidden field in a 
form are not synchronized across between clients. 

wi00364148 wi00340944 Transcript window of chat does not show any chat session after enabling default 
Visibility during monitoring chat sessions. 

Workaround: 

After making default mode visible of a supervisor from Tools > Preferences > 
Other & enable “Default mode visible when monitoring a chat session”, to view 
chat interaction transcript, click on agents name. Chat transcript interaction will 
be visible. 

wi00363744 wi00284682 Full support of Microsoft Exchange Server 2007 as a Mail Server with IC. IC 
Email server is complaint with RFC standards and in case of issues with MS 
Exchange 2007; those will be taken up appropriately. 

wi00366018  wi00362506 Email Channel is NOT Available on WebAgent login when there is NO Primary 
Email server configured, but Secondary is configured AND Secondary is 
FUNCTIONAL. 

Workaround: 

Always Configure Primary Email server in a Cluster. The primary email server 
field in Cluster Configuration "MUST NOT" be empty. 

wi00376378 wi00359484  IBM no longer suppoprts IBM HTTP Server release 1.3.28 (since September 
2008), this is shipped with WebSphere Application Server V5.1. 

Workaround (AIX only): 

Make changes to the deployment configuration as follows: Install core servers 
on AIX and deploy the website on a Windows 2003 machine. 

wi00387290 wi00309879 [PR for 7.2.3] On AIX machine, TimeZone format should be set to posix 
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Cisco TS known issues 

The following are Cisco TS known issues: 

Key Summary 

wi00314919 A generic error is obtained in the TS log for call related scenarios 

wi00314348 For a conference using the hard phone, when the agent does 'move 
conversation' twice, completes the conference and when one of the agent hangs 
up the call, the call disappears from agent's hard phone but still remains in the 
Soft phone. 

wi00314338 When a call gets RONA, there is a TS.Abandoned event instead of TS.Rona 
event in the TS log. 

Cisco TSQS known issues 

The following are Cisco TSQS known issues:  

Key Summary 

wi00314771 Cisco TSQS - The value for 'averagedelay' is incorrectly updated in the Cisco 
AWDB database and TSQS log. 
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Troubleshooting 

Email 

Problem Solution 

After configuration, opening email account 
shows no email account/ error message “Could 
not load Email Accounts” pops up. 

Check if "displayname" field was added to 
qem_mailaccount table in both ccq.adl and repository.adl 
and DB reconfigure was performed. 

After performing above configuration, please restart the 
DataServer, Directory Server and perform a Manager > 
Refresh on ICManager.  

This ensures ICManager loads the configured email 
accounts correctly.  

SME/REQ email alert functionality is not 
configurable as described in the documentation 
"admin2.pdf", pages 242-243. 

PSN (PSN2719) has been published to adderss this 
issue. 

Link to PSN: 
http://support.avaya.com/css/P8/documents/100073907 

ICEmail server reports an alarm on SMTP 
failure for message delivery. The SMTP-server 
specified in alarm did not accept the message 
for delivery.  

Check the Alarm text as below: 

 “Failed to send email through SMTP mail server [%s] at 
port [%u] for msgid <[%lu]>. Check ICEmail server logs 
for more details.” 

where: 

 <%s> is the location of the SMTP server. 

 <%u> is the port of the SMTP server. 

 <%lu> is the messageid of the email contact. 

If you see this alarm: 

Check whether the email address in the to/cc/bcc field of 
the failed email is a valid email address or not. 

http://support.avaya.com/css/P8/documents/100073907
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Problem Solution 

ICEmail server reports alarm on SMTP failure. 
When the SMTP-server specified in the alarm is 
unreachable, the ICEmail server will retry 15 
times to send the email contact. 

Check the Alarm text as below: 

 “Failed to send email through SMTP <[%s]> at port 
<[%u]> for msgid <[%lu]>, Tried for <[%d]> times.” 

where: 

 <%s> is the location of the SMTP server. 

 <%u> is the port of the SMTP server. 

 <%lu> is the messageid of the email contact. 

 <%d> is the retry count for that particular email contact. 

If you see this alarm: 

Check if the SMTP server specified in logs is reachable 
from the ICEmail server machine. 

SDK 

Problem Solution 

Chat typing status doesn‟t work for SDK Clients 
using SDK API's. 

Check Chat Typing Status feature in SDK Client is 
implemented as mentioned below. Please refer SDK API 
Docs from http://support.avaya.com for newly provided 
API's for Chat Typing Status. 

For displaying received Chat Typing Status from other 
participants of Chat room in SDK Client User Interface. 

SDK clients need to add and register listener for 
ChatMediaInteractionTypingStatusChanged event, 
retrieve typingstatusmessage from the event and display 
it in appropriate user interface. 

For Broadcasting chat typing status of agent to other 
participants in Chat room: 

SDK client need to invoke sendTypingStatus API 
exposed on ChatMediaInteraction object. 

Chat 

Problem Solution 

http://support.avaya.com/
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Problem Solution 

Chat typing status doesn‟t work for website Perform the following steps: 

Launch the web browser and navigate to the IC 
Website Administration Pages. 

Login and navigate to 
http:/website/admin/tenancy/addmd.jsp 

Confirm below property marked as true.  

Metadata name = chat.htmlclient.typingstatusenable 

Default value = true 

Tenant Property (Check this field) 

Restart website  

Updated Chat typing status message is not 
reflecting in status window of html chat 

Restart Web site. 

Chat typing status doesn‟t work for webagent Confirm that the <AARC 
install_dir>\Webagent\Application.properties file with 
the following properties marked as true. 

chat.typingstatus.enable=true  

Restart webagent 

Updated Chat typing status message is not 
reflecting in status window of webagent. 

Restart Web agent. 

WebAgent 

Problem Solution 

After upgrading to 721, Webagent doesn‟t launch 
over network home path. 

If the Shared Path “HomeDir” for WebAgent is 
configured in ICManager using the property 
“Agent/Desktop/WAC“, then copy the folders lexicons, 
images and editlive under this path. 

Verify that the directory has required read, write and 
execute permissions. 

Change in Agent's 'Preferred Name' is not 
reflecting at WebAgent, WebAgent displays the 
old preferred name only. 

After changing Agent's 'Preferred Name', Restart 
comhub server.         
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TS 

Problem Solution 

TServer puts default-ANI in data although 
configured as empty. 

 

Add a single space (“ “) instead of blank (“”) in the 
Default ANI configuration. 

TS generate a TS.Abandon event on receipt of 
an extraneous C_Drop event from CM. 

 

The issue i.e. extra C_DROP occurred was caused due 
to a CM Patch # 17374. 

The new CM patch superseding 17374 does not cause 
extra C_DROP from CM, resolves the issue. 

RL Manager 

Problem Solution 

After clicking on 'Apply' button once, 'Apply' 
button is not disabled until next change 

Though there is no change in button state, the Apply 
functionality works as expected. 

Siebel 

Problem Solution 

IC 7.2 sif file have a compatibility issues with 
Siebel SIA 7.8.2.6 and above. 

Before import of sif files shipped with IC 7.2 into Siebel 
SIA 7.8.2.6, do following modification in sif file. 

Steps to modify sif file - 

Open the file in some editor. 

Add following attribute for PROJECT tag of the file 
UI_FREEZE="N" 

Save the file and close it. 

Go ahead with importing this modified file. 

Agent is Not able to Reply/Reply All/Forward an 
email. 

1. Agent accepts the email sent by a customer. 

2. Select "Communications-->Communications List" 

3. Select All Communications from the drop down, that 
appears below "My Communications". 

4. Select the email from the list. 

5. Continue with normal Reply/Reply All/Forward 
operation. 
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Website 

Problem Solution 

Website failes to launch when configured using 
IBM HTTP server 7.x on AIX-6.1. 

Reason: If the config tool is re-launched due to any 
reason after performing all the steps mentioned under 
Configuring IBM HTTP server 7.x on AIX-6.1 then this 
problem would occur. 

Solution: Follow the Steps #2 & #3 again mentioned 
under the section: Configuring IBM HTTP server 7.x on 
AIX-6.1. 

Rich Client 

Problem Solution 

While starting the Rich Client through the citrix client if the 
following error pops-up:  

 

Error text:  

"Avaya Agent Error 11008: Cannot register appbar 
Termination application." 

Click the Ok button. 

On citrix server search for the qui.ini. 

Make sure that you update all the qui.ini files 
with the  following two lines 

[QConsole] 

ResizeDesktop=FALSE. 

Restart Rich Client. 

Installer 

Problem Solution 

The Service Pack installer may display popup messages for confirmation 
to overwrite files. 

It is safe to overwrite all files. 
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ICManager 

Problem Solution 

The template data is not displayed in “Email Account” 
panel. 

Edit the WACD server and go to “WACD” tab. 

Verify that correct value has been provided for 
“Default Email Cluster”. If not, provide correct 
value and apply changes. 

Make sure that atleast one ICEmail server in the 
“Default Email Cluster” is up and running. 

Restart the WACD server.  

 Perform steps #1 to #4 for both WACD instances 
if you have WACD cluster configured. 
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Product Limitations 
The items mentioned in the table below are Product Limitations of the Avaya Interaction Center due to 
underlying architecture. 

Component Parent WI Child WI Summary of reported defect 

IC:Client:AAWC wi00357129 wi00938347 One Reason code with multiple outcomes 
can be entered in wrapup codes. 

IC:Client:RichClient:WebAgent wi00225558  wi00332490 The "Contact -> Print" menu option in 
AVAYA Web Agent is disabled for newly 
composed emails. 

RichClient:WCAgentClient wi00825503  wi00829554 Ephox EditLive! editor in IC WebAgent 
does not render HTML comment & select 
tags as expected in IC 7.2.2. 

Note: This issue resides with 3rd party 
component Ephox, and not integral to 
RichClient. 

Workaround: 

For interactive elements (containing 
data), double clicking it will display the 
relevant information. 

The items mentioned in the table below were reported, but subsequently did not occur again on any test or 
production systems, hence are marked as Non-Reproducible.  

Component Parent WI Child WI Summary of reported defect 

IC:Advocate:WAA wi00879167  wi00898626 WAA Server hangs on receiving 
SimDeassign. 

IC:Client:AAWC:UOM:Email wi00909680  wi00927293 AAWC agent is unable to reply to an 
inbound email, if the email contains an 
inline image whoes source is a URL 

IC:Server:Email wi00844332 wi00857234 Email sent for Quality Assurance that is 
rejected by the approver is never 
completed with a status of 65028 

IC:Server:Email wi00844093 wi00853058  ICEmail server is failing to properly parse 
the Reply-To header which causes the 
email to arrive at the agent with a from 
address of '>'. 
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The items mentioned in the list below were reported by Customers. These items work consistent with the 
design of the Avaya Interaction Center software, hence marked as “Works as designed”. 

Component Parent WI Child WI Summary of reported defect 

IC:Client:RichClient:BlenderClient wi00892779  wi00898631 For manual blending mode Rich client 
sends an aux request to TS after 
Outbound call completed. 

IC:Client:RichClient:WebAgent  wi00889362  wi00892800  The HTML part of a multipart email is 
not rendered on webagent while 
setting the "Read html mode" as false 

IC:Client:RichClient:WebAgent wi00893313 wi00898640  Webagent doesn't creates bullet point 
with Enter key pressed 
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Service Pack Files 

 Avaya Agent component (Windows) 

 Avaya Agent Web Client component (Windows/Solaris/ AIX) 

 Avaya Agent Web Client Connector (Windows) 

 Avaya Agent Web Client Connector (Solaris) 

 Avaya Agent Web Client Connector (AIX) 

 Administration and Design component (Windows) 

 Server component (Windows) 

 Server component (Solaris) 

 Server component (AIX) 

 Siebel Integration component [IC Side] (Windows) 

 Siebel Integration component [IC Side] (Solaris) 

 Siebel Integration component [IC Side] (AIX) 

 Siebel Integration component [Siebel Side] (Windows) 

 Siebel Integration component [Siebel Side] (Solaris) 

 Siebel Integration component [Siebel Side] (AIX) 

 SDK component (Windows) 

 SDK component (Solaris) 

 SDK component (AIX) 

Avaya Agent component (Windows)  

The following table lists the files that are installed on the Avaya Agent on Windows platform: 

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

ActiveContactViewer.ocx Date: 
10/15/2009 
Version: 
7.2.1.16 

Date: 10/15/2009 
Version: 7.2.1.16 

Date : 
10/15/2009 
Version : 
7.2.0.0 

Date: 
7/30/2011 
Version: 7.2.0.0 

ActiveContactViewer.pdb Date: 
10/15/2009 
Version: 
7.2.1.16 

Date: 10/15/2009 
Version: 7.2.1.16 

Date : 
10/15/2009 
Version : 
7.2.0.0 

Date: 
7/30/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

AgentProxy.exe Date: 
11/06/2009 

Date: 11/06/2009 Date : 
11/6/2009 

Date: 
11/6/2009 

Version: 1.0.0.0 

asai.ini Date: 
08/19/2009 

Date: 08/19/2009 Date : 
8/19/2009 

Date: 
8/19/2009 

avaya_agent_en.cdl     Date : 8/6/2009 Date: 
7/28/2011 

AxInterop.BSLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

AxInterop.CDKTOOLKITOCXLib.dll       Date: 
11/26/2011 
Version: 7.2.0.0 

AxInterop.QCommCtlsLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 7.2.0.0 

AxInterop.QConsolefxLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/26/2011 
Version: 7.2.0.0 

AxInterop.QWdcocxLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 8/5/2011 
Version: 7.2.0.0 

AxInterop.QwrwocxLib.dl   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 7.2.0.0 

AxInterop.QWScriptsLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/4/2011 
Version: 7.2.0.0 

AxInterop.QXMLParseLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 7.2.0.0 

AxInterop.VespEngineLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 1.0.0.0 

AxInterop.wrapLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 7.2.0.0 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

BlenderClient.ocx Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 04/21/2010 
Version: 7.2.2.17 

Date : 
10/22/2010 
Version : 
7.2.3.16 

Date: 
11/26/2011 
Version: 
7.2.4.33 

BlenderClient.pdb Date: 
10/22/2009 

Date: 04/21/2010 Date : 
10/22/2010 

Date: 
11/26/2011 

BSLib.dll     Date : 
9/10/2010 
Version : 
7.2.0.0 

Date: 
6/24/2011 
Version: 7.2.0.0 

CallList.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

CallList.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 

ccq.adl     Date : 4/6/2010 Date: 
6/16/2011 

cdk.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.33 

cdk.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/26/2011 

CdkToolkitOcx.ocx       Date: 
12/12/2011 
Version: 1.0.0.1 

CdkToolkitOcx.pdb       Date: 
12/12/2011 

CDKTOOLKITOCXLib.dll       Date: 
11/26/2011 
Version: 7.2.0.0 

ChatList.ocx Date: 
08/13/2009 

Date: 08/13/2009 Date : 
7/31/2010 

Date: 
6/10/2011 
Version: 
7.2.4.12 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

ChatList.pdb Date: 
08/13/2009 

Date: 08/13/2009 Date : 
7/31/2010 

Date: 
6/10/2011 

clogin.ocx   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
6/24/2011 
Version: 
7.2.4.14 

clogin.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

cobrowse.jar     Date : 8/6/2010 Date: 8/6/2010 

consolefx.ocx   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.33 

consolefx.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/26/2011 

ContactHistoryBrowser.ocx - Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
6/24/2011 
Version: 
7.2.4.14 

ContactHistoryBrowser.pdb - Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

Core.dll     Date : 
10/15/2010 
Version : 
7.2.3.14 

Date: 
10/15/2010 
Version: 
7.2.4.14 

Core.pdb     Date : 
10/15/2010 

Date: 
10/15/2010 

CtiNmi.dll   Date: 04/14/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.33 

CtiNmi.pdb   Date: 04/14/2010 Date : 
9/10/2010 

Date: 
11/26/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

dco.ocx   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 8/5/2011 
Version: 
7.2.4.20 

dco.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 8/5/2011 

editlivejava.jar Date: 
11/27/2009 

Date: 11/27/2009 Date : 
11/27/2009 

Date: 
11/3/2011 

EduViewer.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

EduViewer.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 

getsysdir.bat       Date: 
11/9/2011 

ibmdom.dll       Date: 
11/3/2011 

icm.jar Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 03/14/2010 Date : 
9/17/2010 

Date: 
11/4/2011 

ImcClient.jar       Date: 
8/25/2011 

jdic.dll Date: 
10/07/2009 

Date: 10/07/2009 Date : 
10/7/2009 

Date: 
10/7/2009 
Version: 0.9.1.0 

jdic.jar Date: 
10/07/2009 

Date: 10/07/2009 Date : 
10/7/2009 

Date: 
10/7/2009 

jdic_stub_windows.jar Date: 
10/07/2009 

Date: 10/07/2009 Date : 
10/7/2009 

Date: 
10/7/2009 

libeay32.dll   Date: 11/10/2008 
Version: 0.9.8.4 

Date : 
11/10/2008 
Version : 
0.9.8.4 

Date: 
11/10/2008 
Version: 0.9.8.4 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

localeprops.jar Date: 
11/04/2009 

Date: 11/04/2009 Date : 
11/4/2009 

Date: 
11/4/2009 

MailEngine.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
11/26/2011 
Version: 
7.2.4.33 

MailEngine.pdb     Date : 
7/31/2010 

Date: 
11/26/2011 

mttlogger.dll       Date: 
11/25/2011 
Version: 
7.2.4.33 

mttlogger.pdb       Date: 
11/25/2011 

mttoolkit.dll   Date: 04/14/2010 
Version: 7.2.2.16 

Date : 9/9/2010 
Version : 
7.2.3.9 

Date: 
12/8/2011 
Version: 
7.2.4.33 

mttoolkit.pdb   Date: 04/14/2010 Date : 9/9/2010 Date: 
12/8/2011 

NewOutboundEmail.xml Date: 
12/04/2009 

Date: 12/04/2009 Date : 
12/4/2009 

Date: 
11/3/2011 

PhoneEngine.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

PhoneEngine.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 

PreviewEmailConfig.xml Date: 
12/04/2009 

Date: 12/04/2009 Date : 
12/4/2009 

Date: 
7/14/2011 

PrompterClient.ocx       Date: 
11/26/2011 
Version: 
7.2.4.33 

PrompterClient.pdb       Date: 
11/26/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

QCOMMCTLSLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 7.2.0.0 

qconfig.exe   Date: 04/14/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

QConsole_asai.ini Date: 
08/19/2009 

Date: 08/19/2009 Date : 
8/19/2009 

Date: 
8/19/2009 

QCONSOLEFXLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/26/2011 

qimport.exe   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

qimport.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

qui.exe Date: 
09/24/2009 

Date : 
04/15/2010 

Date : 
9/10/2010 

Date: 
11/28/2011 

qui.pdb Date: 
09/24/2009 

Date : 
04/15/2010 

Date : 
9/10/2010 

Date: 
11/28/2011 

qui.reg       Date: 3/9/2011 

qwbsext.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
11/4/2011 
Version: 
7.2.4.32 

qwdco.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.33 

qwdco.pdb       Date: 
11/26/2011 
Version: 
7.2.4.33 

QwdcocxLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/4/2011 
Version: 7.2.0.0 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

qwdcprop.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 9/9/2010 
Version : 
7.2.3.9 

Date: 
6/23/2011 
Version: 
7.2.4.14 

qwdcprop.pdb   Date: 04/15/2010 Date : 9/9/2010 Date: 
6/23/2011 

qwlog.dll       Date: 
11/3/2011 
Version: 
7.2.4.32 

qwlog.pdb       Date: 
11/3/2011 

QwrwocxLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/4/2011 
Version: 7.2.0.0 

QWScripts.ocx Date: 
08/13/2009 

Date : 
04/15/2010 
Version : 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
11/4/2011 
Version: 
7.2.4.32 

QWScripts.pdb Date: 
08/13/2009 

Date : 
04/15/2010 
Version : 7.2.2.16 

Date : 
9/10/2010 

Date: 
11/4/2011 

QWSCRIPTSLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/4/2011 
Version: 7.2.0.0 

qwtranscode.dll       Date: 
10/14/2011 

QXMLPARSELib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 7.2.0.0 

RegRichClient.bat       Date: 
12/2/2011 

ReplyForwardEmailConfig.xml Date: 
12/04/2009 

Date: 12/04/2009 Date : 
12/4/2009 

Date: 
11/3/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

ReportWizard.exe       Date: 
12/8/2011 
Version: 7.2.0.0 

ReportWizard.pdb       Date: 
12/8/2011 

ResourcesConfig.xml Date: 
12/04/2009 

Date: 12/04/2009 Date : 
12/4/2009 

Date: 
11/3/2011 

root_cert_AvayaIC_Client.pem   Date: 02/26/2010 Date : 
2/26/2010 

Date: 
2/26/2010 
Version: 
7.2.4.14 

rw.ocx   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
6/24/2011 
Version: 0.9.8.4 

rw.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

SoftPhoneGui.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

SoftPhoneGui.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 

sscege.tlx       Date: 
6/22/2011 

sscegn2.clx       Date: 
6/22/2011 

sscego2.clx       Date: 
6/22/2011 

ssleay32.dll   Date: 11/10/2008 
Version: 0.9.8.4 

Date : 
11/10/2008 
Version : 
0.9.8.4 

Date: 
11/10/2008 

ssllib.dll     Date : 9/9/2010 Date: 
6/23/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

ssllib.pdb     Date : 9/9/2010 Date: 
6/23/2011 

Status.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
11/4/2011 
Version: 
7.2.4.32 

Status.pdb     Date : 
7/31/2010 

Date: 
11/4/2011 

TaskLib.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

TaskLib.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 

TaskList.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

TaskList.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 

TelButton.ocx     Date : 
8/20/2010 
Version : 
7.2.3.6 

Date: 
10/21/2011 
Version: 
7.2.4.31 

TelButton.pdb     Date : 
8/20/2010 

Date: 
10/21/2011 

Telephony.dll Date: 
09/11/2009 
Version: 
7.2.1.11 

Date: 09/11/2009 
Version: 7.2.1.11 

Date : 
10/15/2010 
Version : 
7.2.3.14 

Date: 
12/9/2011 
Version: 
7.2.4.33 

Telephony.pdb Date: 
09/11/2009 
Version: 
7.2.1.11 

Date: 09/11/2009 
Version: 7.2.1.11 

Date : 
10/15/2010 

Date: 
12/9/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

TreeCtrl.ocx   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
6/24/2011 
Version: 
7.2.4.14 

TreeCtrl.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 

UAD.ocx   Date: 02/18/2010 
Version: 7.2.2.9 

Date : 
8/27/2010 
Version : 
7.2.3.7 

Date: 8/5/2011 
Version: 
7.2.4.20 

UAD.pdb   Date: 02/25/2010 Date : 
8/27/2010 

Date: 8/5/2011 

UnregRichClient.bat       Date: 
12/2/2011 

VespEngine.ocx   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 
9/10/2010 
Version : 
7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.33 

VespEngine.pdb   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
11/26/2011 

VESPENGINELib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 1.0.0.0 

vespidl.pk Date: 
10/04/2009 

Date: 10/04/2009 Date : 9/9/2010 Date: 9/9/2010 

vesporb.dll   Date: 04/14/2010 
Version: 7.2.2.16 

Date : 
10/15/2010 
Version : 
7.2.3.14 

Date: 
11/26/2011 
Version: 
7.2.4.33 

vtel.exe   Date: 04/14/2010 Date : 
10/15/2010 

Date: 
11/4/2011 
Version: 
7.2.4.32 

vtel.pdb   Date: 04/14/2010 Date : 
10/15/2010 

Date: 
11/4/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

VtelDispatch.dll     Date : 
10/15/2010 
Version : 
7.2.3.14 

Date: 
9/23/2011 
Version: 
7.2.4.27 

VtelDispatch.pdb     Date : 
10/15/2010 

Date: 
9/23/2011 

WACEngine.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
11/25/2011 
Version: 
7.2.4.33 

WACEngine.pdb     Date : 
7/31/2010 

Date: 
11/25/2011 

WebAgent.jar Date: 
12/01/2009 

Date: 02/25/2010 Date : 
10/1/2010 

Date: 
11/4/2011 

WebEngine.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
6/10/2011 
Version: 
7.2.4.12 

WebEngine.pdb     Date : 
7/31/2010 

Date: 
6/10/2011 

wrap.ocx   Date: 02/25/2010 
Version: 7.2.2.10 

Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

wrap.pdb   Date: 02/25/2010 Date : 
7/31/2010 

Date: 
7/31/2010 

WRAPLib.dll   Date: 04/15/2010 Date : 
9/10/2010 

Date: 
6/24/2011 
Version: 7.2.0.0 

Wrapup.ocx     Date : 
7/31/2010 
Version : 
7.2.3.3 

Date: 
7/31/2010 
Version: 7.2.3.3 

Wrapup.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

WrapUpEngine.ocx     Date : 
7/31/2010 
Version : 
7.2.0.0 

Date: 
7/31/2010 
Version: 7.2.0.0 

WrapUpEngine.pdb     Date : 
7/31/2010 

Date: 
7/31/2010 

Avaya Agent Web Client component (Windows)  

The following table lists the files that are installed with the Avaya Agent Web Client component on Windows 
platform:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

addressbook.js   Date: 
02/08/2010 

Date : 2/8/2010 Date: 5/4/2011 

 addressbookfooter.jsp       Date: 5/4/2011 

 addressbooklist.js       Date: 5/4/2011 

agent.jsp Date: 08/26/2009 Date: 
02/08/2010 

Date : 2/8/2010 Date: 2/8/2010 

agent_default.jsp       Date: 8/26/2009 

agentdefs.js.jsp Date: 08/26/2009 Date: 
02/08/2010 

Date : 
9/30/2010 

Date: 5/4/2011 

 application.js       Date: 6/24/2011 

 application.jsp       Date: 11/3/2011 

 autocomplete.js       Date: 5/4/2011 

avaya-common.jar Date: 09/03/2009 Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avayaicagent.cab   Date: 
04/14/2010 

Date : 
4/14/2010 

Date: 4/14/2010 

avaya-ic-bridges.jar     Date : 
9/10/2010 

Date: 10/21/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

avayaiccommon.jar Date: 09/03/2009 Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avayaicL10N.jar Date: 09/03/2009 Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-common.jar Date: 09/03/2009 Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-sample.jar Date: 09/03/2009 Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-server.jar Date: 09/03/2009 Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-services.jar Date: 10/04/2009 Date: 
04/15/2010 

Date : 
10/8/2010 

Date: 12/8/2011 

avaya-ic-webclient.jar       Date: 6/24/2011 

avaya-ic-webui.jar Date: 09/03/2009 Date: 
09/03/2009 

Date : 
10/19/2010 

Date: 8/5/2011 

body.js   Date: 
02/02/2010 

Date : 2/2/2010 Date: 11/3/2011 

chatAll.js Date: 10/07/2009 Date: 
10/07/2009 

Date : 
10/7/2009 

Date: 8/4/2011 

chatapp.jsp Date: 08/26/2009 Date: 
08/26/2009 

Date : 
8/26/2009 

Date: 8/26/2009 

chatPrintTemplate.jsp       Date: 4/14/2011 

chatsendtextpane.jsp Date: 08/26/2009 Date: 
08/26/2009 

Date : 
8/26/2009 

Date: 8/26/2009 

cobrowse.jar     Date : 8/6/2010 Date: 8/6/2010 

Collaborationcontrols.js   Date: 
02/08/2010 

Date : 2/8/2010 Date: 2/8/2010 

collaborationdialog.jsp Date: 08/13/2009 Date: 
08/13/2009 

Date : 
8/13/2009 

Date: 8/13/2009 

collaborationdialog_default.jsp Date: 08/13/2009 Date: 
08/13/2009 

Date : 
8/13/2009 

Date: 8/13/2009 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

cstable.js Date: 08/07/2009 Date: 
08/07/2009 

Date : 8/7/2009 Date: 8/7/2009 

customercontactdetails.js     Date : 
9/30/2010 

Date: 9/30/2010 

datacontroller.js       Date: 8/25/2011 

emailall.js Date: 08/07/2009 Date: 
08/07/2009 

Date : 8/7/2009 Date: 8/7/2009 

emailPrintTemplate.jsp       Date: 4/14/2011 

htmlarea.js Date: 08/07/2009 Date: 
08/07/2009 

Date : 8/7/2009 Date: 8/7/2009 

icapplication.js Date: 08/26/2009 Date: 
08/26/2009 

Date : 
8/26/2009 

Date: 11/3/2011 

icm.jar Date: 11/04/2009 Date: 
03/14/2010 

Date : 
9/17/2010 

Date: 11/4/2011 

ImcClient.jar       Date: 8/25/2011 

interactionlist.js       Date: 11/3/2011 

joinus.jsp Date: 08/07/2009 Date: 
08/07/2009 

Date : 8/7/2009 Date: 8/7/2009 

list.js       Date: 8/25/2011 

public_api.js Date: 08/26/2009 Date: 
08/26/2009 

Date : 
8/26/2009 

Date: 8/26/2009 

quickfind.js Date: 08/07/2009 Date: 
02/02/2010 

Date : 2/2/2010 Date: 5/4/2011 

spelling.js       Date: 6/24/2011 

spellingApp.js       Date: 6/24/2011 

sscege.tlx       Date: 6/30/2011 

sscegn2.clx       Date: 6/30/2011 

sscego2.clx       Date: 6/30/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

trackinghistory.js     Date : 
9/30/2010 

Date: 9/30/2010 

WebAgent.jar Date: 12/01/2009 Date: 
02/25/2010 

Date : 
10/1/2010 

Date: 11/4/2011 

Avaya Agent Web Client Connector (Windows)  

The following table lists the Avaya Agent Web Client Connector files that are installed on the Windows 
machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

admin.jar Date: 
09/11/2009 

Date: 04/15/2010 Date : 10/18/2010 Date: 9/30/2011 

cdk.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.32 

CommandScripter.exe   Date: 04/15/2010 Date : 9/10/2010 Date: 
11/26/2011 

core.jar Date: 
10/04/2009 

Date: 04/15/2010 Date : 8/20/2010 Date: 6/17/2011 

CtiNmi.dll   Date: 04/14/2010 
Version: 7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.32 

DCOBinding.dll   Date: 04/14/2010 Date : 9/9/2010 Date: 11/3/2011 

DCOBinding.pdb   Date: 04/14/2010 Date : 9/9/2010 Date: 11/3/2011 

 ibmdom.dll       Date: 11/3/2011 

icadmin.exe   Date: 04/14/2010 Date : 9/10/2010 Date: 11/4/2011 

icm.jar Date: 
11/04/2009 

Date: 03/14/2010 Date : 9/17/2010 Date: 11/4/2011 

ImcClient.jar       Date: 8/25/2011 

jloader.exe   Date: 04/14/2010 Date : 9/9/2010 Date: 11/3/2011 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 290 

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

libeay32.dll   Date: 11/10/2008 
Version: 0.9.8.4 

Date : 11/10/2008 
Version : 0.9.8.4 

Date: 
11/10/2008 
Version: 0.9.8.4 

 mttlogger.dll       Date: 
11/25/2011 
Version: 
7.2.4.32 

mttoolkit.dll   Date: 04/14/2010 
Version: 7.2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 12/8/2011 
Version: 
7.2.4.32 

mttoolkit.pdb   Date: 04/14/2010 Date : 9/9/2010 Date: 9/9/2010 

qconfig.exe   Date: 04/14/2010 Date : 9/10/2010 Date: 6/24/2011 

qwbsext.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 11/4/2011 
Version: 
7.2.4.32 

qwdco.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 
Version: 
7.2.4.33 

qwdcprop.dll   Date: 04/15/2010 
Version: 7.2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 6/23/2011 
Version: 
7.2.4.14 

 qwlog.dll       Date: 11/3/2011 
Version: 
7.2.4.32 

 qwtranscode.dll       Date: 
10/14/2011 

root_cert_AvayaIC_Client.
pem 

  Date: 02/26/2010 Date : 2/26/2010 Date: 2/26/2010 

sc.xml Date: 
08/13/2009 

Date: 04/15/2010 Date : 9/24/2010 Date: 
11/26/2011 

ssleay32.dll   Date: 11/10/2008 
Version: 0.9.8.4 

Date : 11/10/2008 
Version : 0.9.8.4 

Date: 
11/10/2008 
Version: 0.9.8.4 

ssllib.dll     Date : 9/9/2010 Date: 6/23/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

ssllib.pdb     Date : 9/9/2010 Date: 6/23/2011 

tools.jar   Date: 04/15/2010 Date : 4/15/2010 Date: 4/15/2010 

VespBridge.dll   Date: 04/14/2010 
Version: 7.2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 6/23/2011 
Version: 
7.2.4.14 

VespBridge.pdb   Date: 04/14/2010 Date : 9/9/2010 Date: 6/23/2011 

vespidl.pk Date: 
10/04/2009 

Date: 10/04/2009 Date : 9/9/2010 Date: 9/9/2010 

vesporb.dll   Date: 04/14/2010 
Version: 7.2.2.16 

Date : 10/15/2010 
Version : 7.2.3.14 

Date: 
11/26/2011 
Version: 
7.2.4.33 

WebAgent.jar Date: 
12/01/2009 

Date: 02/25/2010 Date : 10/1/2010 Date: 11/4/2011 

 

Avaya Agent Web Client Connector (Solaris)  

The following table lists the Avaya Agent Web Client Connector files that are installed on the Solaris machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

admin.jar Date: 
09/11/2009 

Date: 04/15/2010 Date : 
10/18/2010 

Date: 9/30/2011 

core.jar Date: 
10/04/2009 

Date: 04/15/2010 Date : 8/20/2010 Date: 6/17/2011 

Jloader   Date: 04/15/2010 Date : 9/10/2010 Date: 11/4/2011 

libADULib.so   Date: 04/15/2010 Date : 9/10/2010 Date: 9/23/2011 

libcdk.so   Date: 04/14/2010 Date : 9/9/2010 Date: 
11/25/2011 

libclusterlib.so   Date: 04/14/2010 Date : 9/10/2010 Date: 11/4/2011 

libcrypto.so   Date: 02/26/2010 Date : 2/26/2010 Date: 2/26/2010 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

libCtiNmi.so   Date: 04/15/2010 Date : 9/10/2010 Date: 
11/26/2011 

libDCOBinding.so   Date: 04/14/2010 Date : 9/9/2010 Date: 11/4/2011 

 libmttlogger.so       Date: 
11/25/2011 

libmttoolkit.so   Date: 04/14/2010 Date : 9/9/2010 Date: 
12/12/2011 

libqwbsext.so   Date: 04/14/2010 Date : 9/9/2010 Date: 11/4/2011 

libqwdc.so   Date: 04/14/2010 Date : 9/9/2010 Date: 
11/26/2011 

libqwibmdom.so       Date: 11/4/2011 

libqwlog.so       Date: 11/4/2011 

libqwrw.so   Date: 04/14/2010 Date : 9/9/2010 Date: 11/4/2011 

libRMBLib.so   Date: 04/15/2010 Date : 9/10/2010 Date: 6/24/2011 

libssl.so   Date: 02/26/2010 Date : 2/26/2010 Date: 2/26/2010 

libssllib.so   Date: 04/14/2010 Date : 9/9/2010 Date: 6/23/2011 

libsttssl.so   Date: 04/14/2010 Date : 9/9/2010 Date: 6/23/2011 

libUtilityLib.so   Date: 04/15/2010 Date : 9/10/2010 Date: 6/24/2011 

libVespBridge.so   Date: 04/14/2010 Date : 9/9/2010 Date: 6/23/2011 

libvesporb.so   Date: 04/14/2010 Date : 
10/15/2010 

Date: 
11/25/2011 

libWFSLib.so   Date: 04/15/2010 Date : 9/10/2010 Date: 6/24/2011 

root_cert_AvayaIC_Client.p
em 

  Date: 02/26/2010 Date : 2/26/2010 Date: 2/26/2010 

sc.xml Date: 
08/13/2009 

Date: 04/15/2010 Date : 9/24/2010 Date: 
11/26/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

tools.jar   Date: 04/15/2010 Date : 4/15/2010 Date: 4/15/2010 

vespidl.pk Date: 
10/04/2009 

Date: 10/04/2009 Date : 9/9/2010 Date: 9/9/2010 

 

Avaya Agent Web Client Connector (AIX)  

The following table lists the Avaya Agent Web Client Connector files that are installed on the AIX machine:  

File Name IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

admin.jar Date: 09/11/2009 Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 9/30/2011 

core.jar Date: 10/04/2009 Date: 
04/15/2010 

Date : 
8/20/2010 

Date: 6/17/2011 

icadmin   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/3/2011 

jloader   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/3/2011 

libADULib.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 9/23/2011 

libcdk.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/25/2011 

libclusterlib.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/3/2011 

libCtiNmi.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/25/2011 

libDCOBinding.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/3/2011 

libmttlogger.so       Date: 11/25/2011 

libmttoolkit.so   Date: 4/14/2010 Date : 
9/9/2010 

Date:12/12/2011 
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File Name IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

libqwbsext.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/3/2011 

libqwdc.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/25/2011 

libqwibmdom.so       Date: 11/3/2011 

libqwlog.so       Date: 11/3/2011 

libqwrw.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 11/3/2011 

libRMBLib.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

libssllib.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

libsttssl.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

libUtilityLib.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

libVespBridge.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

libvesporb.so   Date: 4/14/2010 Date : 
10/14/2010 

Date: 11/25/2011 

libWFSLib.so   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

orbsrv   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

qconfig   Date: 4/14/2010 Date : 
9/9/2010 

Date: 6/23/2011 

root_cert_AvayaIC_Client.pem   Date: 2/26/2010 Date : 
2/26/2010 

Date: 2/26/2010 

sc.xml Date: 08/13/2009 Date: 
04/15/2010 

Date : 
9/24/2010 

Date: 11/26/2011 
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File Name IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

tools.jar   Date:  4/15/2010 Date : 
4/15/2010 

Date: 4/15/2010 

vespidl.pk Date: 10/04/2009 Date: 
10/04/2009 

Date : 
9/9/2010 

Date: 9/9/2010 

 

Administration and Design component (Windows)  

The following table lists the files that are installed on the Administration and Design machine on the Windows 
platform after installing the Service Pack:  

File Name IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

ADLPathFix.bat     Date : 4/19/2010 Date: 
4/19/2010 

admin.jar Date: 09/11/2009 Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 
9/30/2011 

Advocate.scat Date: 10/21/2009 Date: 
10/21/2009 

Date : 
10/21/2009 

Date: 
10/21/2009 

agentAttributes.xml   Date: 
04/14/2010 

Date : 4/14/2010 Date: 
4/14/2010 

AgentWatcher.ocx     Date : 2/25/2010 
Version : 7.2.0.0 

Date: 
2/25/2010 

Version: 
7.2.0.0 

avaya_agent_de.cdl       Date: 
7/28/2011 

avaya_agent_en.cdl Date: 08/06/2009 Date: 
08/06/2009 

Date : 8/6/2009 Date: 
7/28/2011 

avaya_agent_es.cdl       Date: 
7/28/2011 

avaya_agent_fr.cdl       Date: 
7/28/2011 

avaya_agent_it.cdl       Date: 
7/28/2011 
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avaya_agent_ja.cdl       Date: 
7/28/2011 

avaya_agent_ko.cdl       Date: 
7/28/2011 

avaya_agent_pt.cdl       Date: 
7/28/2011 

avaya_agent_ru.cdl       Date: 
7/28/2011 

avaya_agent_sbl_en.cdl       Date: 
11/18/2011 

avaya_agent_th.cdl       Date: 
7/28/2011 

avaya_agent_zh.cdl       Date: 
7/28/2011 

avaya_agent_zt.cdl       Date: 
7/28/2011 

BAConfigurationTool.exe   Date: 
04/29/2010 

Date : 9/10/2010 Date: 
9/10/2010 

Version: 
7.2.0.0 

BAConfigurationTool.pdb   Date: 
04/29/2010 

Date : 9/10/2010 Date: 
9/10/2010 

cadl.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

cadl.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

ccq.adl   Date: 
04/06/2010 

Date : 4/6/2010 Date: 
6/16/2011 

cdk.dll   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 

Version: 
7.2.4.33 
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File Name IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

cdk.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

channel_state.qfd Date: 09/09/2009 Date: 
09/09/2009 

Date : 9/9/2009 Date: 
10/20/2011 

ChatList_Initialize.qsc Date: 08/06/2009 Date: 
08/06/2009 

Date : 8/6/2009 Date: 8/6/2009 

cleanupAdvocate.vbs       Date: 
8/16/2011 

cobrowse.jar     Date : 8/6/2010 Date: 8/6/2010 

comct332.ocx     Date : 4/25/2002 
Version : 
6.7.0.8988 

Date: 
4/25/2002 

Version: 
6.7.0.8988 

comctl32.ocx     Date : 7/25/2002 
Version : 6.0.81.5 

Date: 
7/25/2002 

Version: 
6.0.81.5 

comdlg32.ocx     Date : 4/25/2002 
Version : 
6.0.84.18 

Date: 
4/25/2002 

Version: 
6.0.84.18 

CommandScripter.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

Common.xml Date: 08/25/2009 Date: 
08/25/2009 

Date : 8/25/2009 Date: 
8/25/2009 

configAccelerator.jar Date: 10/04/2009 Date: 
10/04/2009 

Date : 10/4/2009 Date: 
10/4/2009 

core.jar Date: 10/04/2009 Date: 
04/15/2010 

Date : 8/20/2010 Date: 
6/17/2011 

CoreServices_Initialize.qsc       Date: 
10/20/2011 

CoreServices_Login.qsc       Date: 6/9/2011 
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File Name IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

CtiNmi.dll   Date: 
04/14/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 

Version: 
7.2.4.33 

CtiNmi.pdb   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/26/2011 

DataUnit56.ocx   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
1.0.0.1 

DCOBinding.dll   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

Version: 
1.0.0.1 

DCOBinding.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

DirectoryService56.ocx   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
1.0.0.1 

employee_seed.csv   Date: 
04/14/2010 

Date : 4/14/2010 Date: 
4/14/2010 

getsysdir.bat       Date: 
11/9/2011 

handle_exception.qfd Date: 10/21/2009 Date: 
10/21/2009 

Date : 
10/21/2009 

Date: 
10/21/2009 

ibmdom.dll       Date: 
11/3/2011 

ibmdom.pdb       Date: 
11/3/2011 

icadmin.exe   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 
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icdoctor.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
1.0.0.1 

icm.jar Date: 11/04/2009 Date: 
03/14/2010 

Date : 9/17/2010 Date: 
11/4/2011 

icmanager.jar Date: 10/04/2009 Date: 
04/15/2010 

Date : 9/17/2010 Date: 
6/10/2011 

ImcClient.jar       Date: 
8/25/2011 

jloader.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

libeay32.dll   Date: 
11/10/2008 

Date : 
11/10/2008 

Date: 
11/10/2008 

Version: 
0.9.8.4 

LogCollectorClient.exe   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 1.0.0.1 

Date: 
8/19/2011 

LogCollectorClient.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
8/19/2011 

msadodc.ocx     Date : 
12/24/2008 
Version : 6.0.88.4 

Date: 
12/24/2008 

Version: 
6.0.88.4 

mscomct2.ocx     Date : 4/25/2002 
Version : 6.0.88.4 

Date: 
4/25/2002 

Version: 
6.0.88.4 

mscomctl.ocx     Date : 4/25/2002 
Version : 
6.0.88.62 

Date: 
4/25/2002 

Version: 
6.0.88.62 
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 mttlogger.dll       Date: 
11/25/2011 

Version: 
7.2.4.33 

 mttlogger.pdb       Date: 
11/25/2011 

Version: 
7.2.4.33 

mttoolkit.dll   Date: 
04/14/2010 
Version: 2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 
12/8/2011 

Version: 
7.2.4.33 

mttoolkit.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
12/8/2011 

 MxCmClient.dll       Date: 6/3/2011 

Version: 
7.2.0.0 

 MxCmClient.pdb       Date: 6/3/2011 

MxDBFx.dll   Date: 
04/15/2010 

Date : 7/31/2010 Date: 
7/31/2010 

Version: 
7.2.0.0 

MxDBFx.pdb   Date: 
04/15/2010 

Date : 7/31/2010 Date: 
7/31/2010 

MxDrctSI.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
7.2.0.0 

MxDrctSI.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

MxRscMgr.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 7/1/2011 

Version: 
7.2.0.0 
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MxRscMgr.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 7/1/2011 

PrompterClient.ocx       Date: 
11/26/2011 

Version: 
7.2.4.33 

property.csv Date: 08/26/2009 Date: 
08/26/2009 

Date : 8/26/2009 Date: 6/9/2011 

propinstance.csv       Date: 6/9/2011 

propvalue.csv Date: 08/26/2009 Date: 
08/26/2009 

Date : 8/26/2009 Date: 
12/15/2011 

qconfig.exe   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

QConsole_ExitComponents.qsc       Date: 
11/2/2011 

QConsole_InitializeComponents.
qsc 

Date: 08/06/2009 Date: 
08/06/2009 

Date : 8/6/2009 Date: 8/6/2009 

QConsole_WrapContact.qsc   Date: 
12/28/2009 

Date : 
12/28/2009 

Date: 
12/28/2009 

qdesigner.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

Version: 
1.0.0.0 

qdesigner.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

QFlowControl56.ocx   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
1.0.0.0 

QFlowDebugUI.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
1.0.0.0 
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qimport.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

qimport.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

qualifychat_adv.qfd Date: 10/21/2009 Date: 
10/21/2009 

Date : 
10/21/2009 

Date: 
10/21/2009 

qualifyemail_adv.qfd Date: 10/21/2009 Date: 
10/21/2009 

Date : 
10/21/2009 

Date: 
10/21/2009 

qualifyvoice_adv.qfd Date: 10/21/2009 Date: 
10/21/2009 

Date : 
10/21/2009 

Date: 
10/21/2009 

qwbsext.dll   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/4/2011 

Version: 
7.2.4.32 

qwbsext.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

qwdco.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

Version: 
7.2.4.33 

qwdco.pdb       Date: 
11/26/2011 

qwdcprop.dll   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 
6/23/2011 

Version: 
7.2.4.14 

qwdcprop.pdb   Date: 
04/15/2010 

Date : 9/9/2010 Date: 
6/23/2011 

 qwlog.dll       Date: 
11/3/2011 

Version: 
7.2.4.32 
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 qwlog.pdb       Date: 
11/3/2011 

 qwtranscode.dll       Date: 
10/14/2011 

 RegAdvocate.bat       Date: 
12/2/2011 

repository.adl   Date: 
04/06/2010 

Date : 4/6/2010 Date: 
6/16/2011 

richtx32.ocx     Date : 4/25/2002 
Version : 6.0.88.4 

Date: 
4/25/2002 

Version: 
6.0.88.4 

root_cert_AvayaIC_Client.pem   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

sc.xml Date: 08/13/2009 Date: 
04/15/2010 

Date : 9/24/2010 Date: 
11/26/2011 

Scenario8.xml Date: 11/17/2009 Date: 
11/17/2009 

Date : 
11/17/2009 

Date: 
11/17/2009 

ssleay32.dll   Date: 
11/10/2008 

Date : 
11/10/2008 

Date: 
11/10/2008 

Version: 
0.9.8.4 

ssllib.dll     Date : 9/9/2010 Date: 
6/23/2011 

ssllib.pdb     Date : 9/9/2010 Date: 
6/23/2011 

 StatusDialog_ButtonClicked.qsc       Date: 
11/3/2011 

 StatusDialog_Create.qsc       Date: 
7/14/2011 

 StatusDialog_Update.qsc       Date: 6/9/2011 
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tools.jar   Date: 
04/15/2010 

Date : 4/15/2010 Date: 
4/15/2010 

transfertoagent_adv.qfd Date: 10/21/2009 Date: 
10/21/2009 

Date : 
10/21/2009 

Date: 
10/21/2009 

transfertovq.qfd   Date: 
01/19/2010 

Date : 1/19/2010 Date: 
1/19/2010 

TreeCtrl.ocx   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
7.2.4.14 

update_vq_cache.qfd   Date: 
01/19/2010 

Date : 1/19/2010 Date: 
1/19/2010 

VespBridge.dll   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

Version: 
7.2.4.14 

VespBridge.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

vespidl.pk Date: 10/04/2009 Date: 
10/04/2009 

Date : 9/9/2010 Date: 9/9/2010 

vesporb.dll   Date: 
04/14/2010 
Version: 
7.2.2.16 

Date : 
10/15/2010 
Version : 7.2.3.14 

Date: 
11/26/2011 

Version: 
7.2.4.33 

w_log_event_detail.csv Date: 10/01/2009 Date: 
10/01/2009 

Date : 10/1/2009 Date: 
10/1/2009 

w_log_event_master.csv Date: 10/01/2009 Date: 
10/01/2009 

Date : 10/1/2009 Date: 
10/1/2009 

WAC_Login.qsc   Date: 
03/17/2010 

Date : 3/17/2010 Date: 
3/17/2010 

 WAC_SendAddressLookup.qsc       Date: 6/9/2011 

 Web_Login.qsc       Date: 6/9/2011 
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WebAgent.jar Date: 12/01/2009 Date: 
02/25/2010 

Date : 10/1/2010 Date: 
11/4/2011 

WebEngine_WebStateChanged.
qsc 

  Date: 
12/28/2009 

Date : 
12/28/2009 

Date: 
12/28/2009 

website.jar     Date : 8/6/2010 Date: 
11/4/2011 

WorkFlowDesigner.exe Date: 08/13/2009 Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

Version: 
1.0.0.1 

WorkFlowDesigner.pdb Date: 08/13/2009 Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

Server component (Windows)  

The following table lists the files that are installed on the Windows server machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

.project     Date : 
12/21/2008 

Date: 
12/21/2008 

acuity.gif       Date: 
11/3/2011 

admin.jar Date: 
09/11/2009 

Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 
9/30/2011 

adusrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

adusrv.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

answers.gif       Date: 
11/3/2011 

armsrv.exe Date: 
10/04/2009 
Version: 
7.2.1.14 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 
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armsrv.pdb Date: 
10/04/2009 
Version: 
7.2.1.14 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

attrsrv.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
12/9/2011 

avaya-common.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-bridges.jar     Date : 9/10/2010 Date: 
10/21/2011 

avayaiccommon.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-client.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-common.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-sample.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-server.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-services.jar Date: 
10/04/2009 

Date: 
04/15/2010 

Date : 10/8/2010 Date: 
12/8/2011 

avaya-ic-webservices.jar Date: 
09/11/2009 

Date: 
09/11/2009 

Date : 
10/15/2010 

Date: 
10/15/2010 

avaya-ic-webui.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 
10/19/2010 

Date: 8/5/2011 

BAConfigurationTool.exe   Date: 
04/29/2010 

Date : 9/10/2010 Date: 
9/10/2010 

Version: 
7.2.0.0 

BAConfigurationTool.pdb   Date: 
04/29/2010 

Date : 9/10/2010 Date: 
9/10/2010 
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blendersrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

blendersrv.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

casrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/24/2011 

casrv.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/24/2011 

cdk.dll   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 

Version: 
7.2.4.33 

cdk.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

 chatconnection.jsp       Date: 
7/14/2011 

 chatframe.js.jsp       Date: 
7/14/2011 

 chatframe.jsp       Date: 
7/14/2011 

chathandler.js.jsp Date: 
10/07/2009 

Date: 
03/10/2010 

Date : 3/10/2010 Date: 
7/14/2011 

 chathandler.jsp       Date: 
7/14/2011 

 chattranscript.html       Date: 
7/14/2011 

 cleanupAdvocate.vbs       Date: 
8/16/2011 

clusterlib.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

clusterlib.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 
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cobrowse.jar     Date : 8/6/2010 Date: 8/6/2010 

 collabframe.js.jsp       Date: 
7/14/2011 

 collabframe.jsp       Date: 
7/14/2011 

comhubsrv.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

comhubsrv.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

command.jsp Date: 
08/07/2009 

Date: 
08/07/2009 

Date : 8/7/2009 Date: 
7/14/2011 

CommandScripter.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

constants.jsp Date: 
07/30/2009 

Date: 
07/30/2009 

Date : 7/30/2009 Date: 
7/30/2009 

Controller     Date : 9/6/2010 Date: 5/3/2011 

Core.dll     Date : 
10/15/2010 
Version : 7.2.3.14 

Date: 
10/15/2010 

Version: 
7.2.3.14 

core.jar Date: 
10/04/2009 

Date: 
04/15/2010 

Date : 8/20/2010 Date: 
6/17/2011 

Core.pdb     Date : 
10/15/2010 

Date: 
10/15/2010 

CSharptester.csproj     Date : 4/21/2010 Date: 
4/21/2010 

ctdmstssrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

ctdmstssrv.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 
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CtiNmi.dll   Date: 
04/14/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 

Version: 
7.2.4.33 

CtiNmi.pdb   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/26/2011 

ctsrv.exe Date: 
10/04/2009 

Date: 
04/14/2010 

Date : 9/16/2010 Date: 
9/23/2011 

ctsrv.pdb Date: 
10/04/2009 

Date: 
04/14/2010 

Date : 9/16/2010 Date: 
9/23/2011 

cvlansrv.exe Date: 
10/04/2009 
Version: 
7.2.1.14 

Date: 
04/14/2010 

Date : 9/16/2010 Date: 
11/4/2011 

cvlansrv.pdb Date: 
10/04/2009 
Version: 
7.2.1.14 

Date: 
04/14/2010 

Date : 9/16/2010 Date: 
11/4/2011 

dco.ocx   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 8/5/2011 

Version: 
7.2.4.20 

DCOBinding.dll   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

Version: 
1.0.0.1 

DCOBinding.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

default.htm       Date: 
7/14/2011 

dmdco.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

Doc     Date : 9/6/2010 Date: 5/3/2011 

domain_cert_AvayaIC_Server.pe
m 

  Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 310 

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

domain_key_AvayaIC_Server.pe
m 

  Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

dssrv.exe   Date: 
04/29/2010 

Date : 
10/21/2010 

Date: 
11/3/2011 

dssrv.pdb   Date: 
04/29/2010 

Date : 
10/21/2010 

Date: 
11/3/2011 

dustoresrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

dustoresrv.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

 
edit_status_dialog_template_pick
er_ajax.jsp 

      Date: 
9/13/2011 

 
edit_status_dialog_template_pick
er_bottom.jsp 

      Date: 
9/13/2011 

entry.jsp Date: 
10/07/2009 

Date: 
10/07/2009 

Date : 10/7/2009 Date: 
7/14/2011 

fulcrum_setup.cmd.template     Date : 9/30/2010 Date: 
9/30/2010 

fulcrum_updateerr.cmd   Date: 
01/05/2010 

Date : 1/5/2010 Date: 1/5/2010 

fulcrum_updateout.cmd   Date: 
01/05/2010 

Date : 1/5/2010 Date: 1/5/2010 

htmlarea.js Date: 
10/07/2009 

Date: 
10/07/2009 

Date : 10/7/2009 Date: 
10/7/2009 

 htmlchat.html       Date: 
7/14/2011 

httpvoxsrv.exe Date: 
10/08/2009 
Version: 
7.2.1.15 

Date: 
04/14/2010 

Date : 9/23/2010 Date: 
11/3/2011 
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httpvoxsrv.pdb Date: 
10/08/2009 
Version: 
7.2.1.15 

Date: 
04/14/2010 

Date : 9/23/2010 Date: 
11/3/2011 

 ibmdom.dll       Date: 
11/3/2011 

 ibmdom.pdb       Date: 
11/3/2011 

icadmin.exe   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 

icemailsrv.exe Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/15/2010 

Date : 9/24/2010 Date: 
12/21/2011 

icemailsrv.pdb Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/15/2010 

Date : 9/24/2010 Date: 
12/21/2011 

ICLogDevDco.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

ICLogDevFile.dll       Date: 
11/4/2011 

icm.jar Date: 
11/04/2009 

Date: 
03/14/2010 

Date : 9/17/2010 Date: 
11/4/2011 

ICMBridge.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
12/8/2011 

icmonserver.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

icmonserver.pdb     Date : 9/9/2010 Date: 
6/23/2011 

icsdk.war   Date: 
04/15/2010 

Date : 10/8/2010 Date: 
12/8/2011 

ImcClient.jar       Date: 
8/25/2011 
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installisapi7.vbs     Date : 9/30/2010 Date: 
7/14/2011 

jloader.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
10/28/2010 

joinus.jsp Date: 
08/07/2009 

Date: 
08/07/2009 

Date : 8/7/2009 Date: 
11/3/2011 

libeay32.dll   Date: 
11/10/2008 

Date : 
11/10/2008 

Date: 8/7/2009 

Version: 
0.9.8.4 

libeay32.dll   Date: 
11/10/2008 

Date : 
11/10/2008 

Date: 
11/10/2008 

licensesrv.exe Date: 
09/03/2009 
Version: 
7.2.1.10 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

licensesrv.pdb Date: 
09/03/2009 
Version: 
7.2.1.10 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

listadu.exe   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

listadu.pdb   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

listvdu.exe   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

listvdu.pdb   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

localeprops.jar Date: 
11/04/2009 

Date: 
11/04/2009 

Date : 11/4/2009 Date: 
11/4/2009 

LogCollectorSrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

LogCollectorSrv.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 
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logo.jsp       Date: 
7/14/2011 

migrateemail.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

mkvd7.vbs     Date : 8/5/2010 Date: 8/5/2010 

 mttlogger.dll       Date: 
11/25/2011 

Version: 
7.2.4.33 

 mttlogger.pdb       Date: 
11/25/2011 

mttoolkit.dll   Date: 
04/14/2010 
Version: 
7.2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 
12/8/2011 

Version: 
7.2.4.33 

mttoolkit.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
12/8/2011 

 MxCmClient.dll       Date: 6/3/2011 

 MxCmClient.pdb       Date: 6/3/2011 

MxDBFx.dll   Date: 
04/15/2010 

Date : 7/31/2010 Date: 
7/31/2010 

Version: 
7.2.0.0 

MxDBFx.pdb   Date: 
04/15/2010 

Date : 7/31/2010 Date: 
7/31/2010 

MxDrctSI.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Version: 
7.2.0.0 

MxDrctSI.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 314 

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

MxRscMgr.exe Date: 
09/11/2009 
Version: 
7.2.1.11 

Date: 
04/15/2010 

Date : 9/10/2010 
Version : 7.2.0.0 

Date: 7/1/2011 

Version: 
7.2.0.0 

MxRscMgr.pdb Date: 
09/11/2009 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 7/1/2011 

notifysrv.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

notifysrv.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

orbsrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

orbsrv.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

pagingsrv.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

pagingsrv.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

pdmJavaWrap.dll       Date: 
11/4/2011 

pdmsql.dll   Date: 
02/18/2010 

Date : 2/18/2010 Date: 
11/4/2011 

poll.js.jsp       Date: 
7/14/2011 

poll.jsp       Date: 
7/14/2011 

pollersrv.exe Date: 
11/19/2009 
Version: 
7.2.1.19 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
12/14/2011 

pollersrv.pdb Date: 
11/19/2009  
Version: 
7.2.1.19 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
12/14/2011 
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proactivecontact.dll       Date: 
11/4/2011 

qconfig.exe   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

qodbcsrv.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

qodbcsrv.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

qorasrv.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

qorasrv.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

qsqlsrv.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

qsqlsrv.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

 quintus.gif       Date: 
11/3/2011 

 quintussmall.gif       Date: 
11/3/2011 

qwbsext.dll   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/4/2011 

Version: 
7.2.4.32 

qwbsext.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

qwdco.dll   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 

Version: 
7.2.4.33 

qwdco.pdb   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/10/2010 
Version : 7.2.3.9 

Date: 
11/26/2011 
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qwdcprop.dll   Date: 
04/15/2010 
Version: 
7.2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 
6/23/2011 

Version: 
7.2.4.14 

qwdcprop.pdb   Date: 
04/15/2010 

Date : 9/9/2010 Date: 
6/23/2011 

qwesext.dll   Date: 
02/18/2010 

Date : 2/18/2010 Date: 
2/18/2010 

 qwlog.dll       Date: 
11/3/2011 

Version: 
7.2.4.32 

 qwlog.pdb       Date: 
11/3/2011 

qworkflowsrv.exe Date: 
09/24/2009 
Version: 
7.2.1.13 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

qworkflowsrv.pdb Date: 
09/24/2009 
Version: 
7.2.1.13 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

 qwtranscode.dll       Date: 
10/14/2011 

 qwtranscode.pdb       Date: 
10/14/2011 

 RegAdvocate.bat       Date: 
12/2/2011 

reportsrv.exe Date: 
09/24/2009 
Version: 
7.2.1.13 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

reportsrv.pdb Date: 
09/24/2009 
Version: 
7.2.1.13 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 
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rlmanager_message.properties       Date: 
10/3/2011 

root_cert_AvayaIC_Client.pem   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

sc.xml Date: 
08/13/2009 

Date: 
04/15/2010 

Date : 9/24/2010 Date: 
11/26/2011 

scripts.jar Date: 
12/09/2006 

Date: 
12/09/2006 

Date : 12/9/2006 Date: 
12/9/2006 

sdk     Date : 9/6/2010 Date: 5/3/2011 

sipsrv.exe Date: 
05/26/2009 

Date: 
04/14/2010 

Date : 9/16/2010 Date: 
9/23/2011 

sipsrv.pdb Date: 
05/26/2009 

Date: 
04/14/2010 

Date : 9/16/2010 Date: 
9/23/2011 

src     Date : 9/6/2010 Date: 5/3/2011 

ssleay32.dll   Date: 
11/10/2008 

Date : 
11/10/2008 

Date: 
11/10/2008 

Version: 
0.9.8.4 

ssllib.dll     Date : 9/9/2010 Date: 
6/23/2011 

ssllib.pdb     Date : 9/9/2010 Date: 
6/23/2011 

tasklst.html Date: 
10/01/2009 

Date: 
02/23/2010 

Date : 2/23/2010 Date: 
2/23/2010 

Telephony.dll Date: 
09/11/2009 
Version: 
7.2.1.11 

Date: 
09/11/2009 
Version: 
7.2.1.11 

Date : 
10/15/2010 
Version : 7.2.3.14 

Date: 
12/9/2011 

Version: 
7.2.4.33 

Telephony.pdb Date: 
09/11/2009 
Version: 
7.2.1.11 

Date: 
09/11/2009 
Version: 
7.2.1.11 

Date : 
10/15/2010 

Date: 
12/9/2011 
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title.gif       Date: 
11/3/2011 

tools.jar   Date: 
04/15/2010 

Date : 4/15/2010 Date: 
4/15/2010 

tsasrv.exe Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
9/23/2011 

tsasrv.pdb Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
9/23/2011 

tsqssrv_asai.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

tsqssrv_asai.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

tsqssrv_aspctportal.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

tsqssrv_aspctportal.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

tsqssrv_cisco.exe Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

tsqssrv_cisco.pdb Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

tsqssrv_csta.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

tsqssrv_csta.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

tsqssrv_msi.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 
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tsqssrv_msi.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

tsqssrv_rti.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

tsqssrv_rti.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

tsv5aspectcmi.exe Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 
04/15/2010 

Date : 9/17/2010 Date: 
11/4/2011 

tsv5aspectcmi.pdb Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 
04/15/2010 

Date : 9/17/2010 Date: 
11/4/2011 

tsv5cisco.exe Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 
04/15/2010 

Date : 9/17/2010 Date: 
11/4/2011 

tsv5cisco.pdb Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 
04/15/2010 

Date : 9/17/2010 Date: 
11/4/2011 

Ui     Date : 9/6/2010 Date: 1/1/1900 

util.js.jsp       Date: 
7/14/2011 

vdudasrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

vdusrv.exe   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

vdusrv.pdb       Date: 
6/23/2011 

VespBridge.dll   Date: 
04/14/2010 
Version: 
7.2.2.16 

Date : 9/9/2010 
Version : 7.2.3.9 

Date: 
6/23/2011 

Version: 
7.2.4.14 
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VespBridge.pdb   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

vespdde.exe   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

vespidl.pk Date: 
10/04/2009 

Date: 
10/04/2009 

Date : 9/9/2010 Date: 9/9/2010 

vesporb.dll   Date: 
04/14/2010 
Version: 
7.2.2.16 

Date : 
10/15/2010 
Version : 7.2.3.14 

Date: 
11/26/2011 

Version: 
7.2.4.33 

voxsrv.exe   Date: 
04/14/2010 

Date : 9/23/2010 Date: 
6/23/2011 

voxsrv.pdb   Date: 
04/14/2010 

Date : 9/23/2010 Date: 
6/23/2011 

VtelDispatch.dll     Date : 
10/15/2010 
Version : 7.2.3.14 

Date: 
9/23/2011 

Version: 
7.2.4.27 

VtelDispatch.pdb     Date : 
10/15/2010 

Date: 
9/23/2011 

waasrv.exe Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

waasrv.pdb Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

wacdsrv.exe Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 
11/4/2011 

wacdsrv.pdb Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 
11/4/2011 
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wcservlet.dll   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

web.config     Date : 
10/18/2010 

Date: 
10/18/2010 

web.xml.template       Date: 
10/31/2011 

WebAgent.jar Date: 
12/01/2009 

Date: 
02/25/2010 

Date : 10/1/2010 Date: 
11/4/2011 

webchannel.exe   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/18/2011 

webchannel.pdb   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/18/2011 

WebLM.war       Date: 
6/30/2011 

webservices.war Date: 
09/11/2009 

Date: 
04/15/2010 

Date : 
10/15/2010 

Date: 
10/21/2011 

website.jar     Date : 8/6/2010 Date: 
11/4/2011 

wscallback.jar       Date: 
3/30/2011 

xpdm.dll       Date: 
11/4/2011 

Server component (Solaris)  

The following table lists the files that are installed on the Solaris server machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

.project     Date : 
12/21/2008 

Date: 
12/21/2008 

acuity.gif       Date: 
11/3/2011 
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admin.jar Date: 
09/11/2009 

Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 
9/30/2011 

Adusrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

answers.gif       Date: 
11/3/2011 

armsrv Date: 
10/04/2009 
Version: 
7.2.1.14 

Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 

Asaisrv   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 

Aspctsrv   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 

Attrsrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
12/9/2011 

avaya-common.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-bridges.jar     Date : 9/10/2010 Date: 
10/21/2011 

avayaiccommon.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-client.jar     Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-common.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-sample.jar     Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-server.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-services.jar Date: 
10/04/2009 

Date: 
04/15/2010 

Date : 10/8/2010 Date: 
12/8/2011 

avaya-ic-webservices.jar Date: 
09/11/2009 

Date: 
09/11/2009 

Date : 
10/15/2010 

Date: 
10/15/2010 
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avaya-ic-webui.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 
10/19/2010 

Date: 8/5/2011 

blendersrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

casrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

 chatconnection.jsp       Date: 
7/14/2011 

 chatframe.js.jsp       Date: 
7/14/2011 

 chatframe.jsp       Date: 
7/14/2011 

chathandler.js.jsp Date: 
10/07/2009 

Date: 
03/10/2010 

Date : 3/10/2010 Date: 
7/14/2011 

 chathandler.jsp       Date: 
7/14/2011 

 chattranscript.html       Date: 
7/14/2011 

cobrowse.jar     Date : 8/6/2010 Date: 8/6/2010 

 collabframe.js.jsp       Date: 
7/14/2011 

 collabframe.jsp  
collabframe.js
p 

    Date: 
7/14/2011 

Comhubsrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

command.jsp Date: 
08/07/2009 

Date: 
08/07/2009 

Date : 8/7/2009 Date: 
7/14/2011 

CommandScripter   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/26/2011 

constants.jsp Date: 
07/30/2009 

Date: 
07/30/2009 

Date : 7/30/2009 Date: 
7/30/2009 
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Controller     Date : 8/18/2010 Date: 
8/18/2010 

COPYRIGHT   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

core.jar Date: 
10/04/2009 

Date: 
04/15/2010 

Date : 8/20/2010 Date: 
6/17/2011 

Cqsconfig   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 

CSharptester.csproj     Date : 4/21/2010 Date: 
4/21/2010 

ctsrv Date: 
10/04/2009 

Date: 
04/14/2010 

Date : 9/17/2010 Date: 
9/23/2011 

cvlansrv Date: 
10/04/2009 
Version: 
7.2.1.14 

Date: 
04/15/2010 

Date : 9/17/2010 Date: 
11/4/2011 

default.htm       Date: 
7/14/2011 

Doc     Date : 8/18/2010 Date: 
8/18/2010 

domain_cert_AvayaIC_Server.pe
m 

  Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

domain_key_AvayaIC_Server.pe
m 

  Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

Dssrv   Date: 
04/24/2010 

Date : 
10/22/2010 

Date: 
11/4/2011 

Dustoresrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

 
edit_status_dialog_template_pick
er_ajax.jsp 

      Date: 
9/13/2011 

 
edit_status_dialog_template_pick
er_bottom.jsp 

      Date: 
9/13/2011 
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entry.jsp Date: 
10/07/2009 

Date: 
10/07/2009 

Date : 10/7/2009 Date: 
7/14/2011 

fulcrum_updateerr.sh   Date: 
01/05/2010 

Date : 1/5/2010 Date: 1/5/2010 

fulcrum_updateout.sh   Date: 
01/05/2010 

Date : 1/5/2010 Date: 1/5/2010 

htmlarea.js Date: 
10/07/2009 

Date: 
10/07/2009 

Date : 10/7/2009 Date: 
10/7/2009 

htmlchat.html       Date: 
7/14/2011 

Httpvoxsrv Date: 
10/08/2009 
Version: 
7.2.1.15 

Date: 
04/15/2010 

Date : 9/24/2010 Date: 
11/4/2011 

Icadmin   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

Icemailsrv Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/15/2010 

Date : 9/24/2010 Date: 
12/21/2011 

icm.jar Date: 
11/04/2009 

Date: 
03/14/2010 

Date : 9/17/2010 Date: 
11/4/2011 

Icmonserver   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

icsdk.war   Date: 
04/15/2010 

Date : 10/8/2010 Date: 
12/8/2011 

 ImcClient.jar       Date: 
8/25/2011 

 index.htm  index.htm     Date: 
7/14/2011 

Jloader   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

joinus.jsp Date: 
08/07/2009 

Date: 
08/07/2009 

Date : 8/7/2009 Date: 8/7/2009 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

libADULib.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
9/23/2011 

libagentservlet.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

libcdk.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/25/2011 

libclusterlib.so   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 

libcrypto.so   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

libcrypto.so.0.9.8   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

libCtiNmi.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/26/2011 

libDCOBinding.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

libdmdco.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

libiclogdevdco.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

libiclogdevfile.so       Date: 
11/4/2011 

libICMBridge.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
12/9/2011 

 libiplanetdatasensor.so       Date: 
11/4/2011 

 libiplanetplugin.so       Date: 
11/4/2011 

liblber-2.4.so.2.5.2   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

libldap_r-2.4.so.2.5.2   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 
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libmttlogger.so       Date: 
11/25/2011 

libmttoolkit.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
12/12/2011 

libpdm.so       Date: 
11/4/2011 

libpdmJavaWrap.so       Date: 
11/4/2011 

libpdmsql.so   Date: 
02/18/2010 

Date : 2/18/2010 Date: 
11/4/2011 

libproactivecontact.so       Date: 
11/4/2011 

libqwbsext.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

libqwdc.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/26/2011 

libqwibmdom.so       Date: 
11/4/2011 

libqwlog.so       Date: 
11/4/2011 

libqwrw.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

libRMBLib.so Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

libssl.so   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

libssl.so.0.9.8   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

libssllib.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 
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libsttssl.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

libUtilityLib.so Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

libVespBridge.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

libvesporb.so   Date: 
04/14/2010 

Date : 
10/15/2010 

Date: 
11/25/2011 

libwcservlet.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

libWFSLib.so   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

LICENSE   Date: 
02/26/2010 

Date : 9/9/2010 Date: 
2/26/2010 

licensesrv Date: 
09/03/2009 
Version: 
7.2.1.10 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

Listadu   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

Listvdu   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

logCollectorsrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

logo.jsp       Date: 
7/14/2011 

Migrateemail   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

Notifysrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

nsscript.jar Date: 
12/09/2006 

 Date: 
12/09/2006 

Date : 12/9/2006 Date: 
12/9/2006 
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Orbsrv   Date: 
04/14/2010 

Date : 9/10/2010 Date: 
6/24/2011 

os_fill   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

pagingsrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

poll.js.jsp       Date: 
7/14/2011 

poll.jsp       Date: 
7/14/2011 

pollersrv Date: 
11/19/2009 
Version: 
7.2.1.19 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
12/14/2011 

Qconfig   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

qdb2srv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

qora10srv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

qora11srv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

qora9srv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

quintus.gif       Date: 
11/3/2011 

qworkflowsrv Date: 
09/24/2009 
Version: 
7.2.1.13 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

reportsrv Date: 
09/24/2009 
Version: 
7.2.1.13 

Date: 
04/14/2010 

Date : 9/10/2010 Date: 
11/4/2011 
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rlmanager_message.properties       Date: 
10/3/2011 

root_cert_AvayaIC_Client.pem   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

sc.xml Date: 
08/13/2009 

Date: 
04/15/2010 

Date : 9/24/2010 Date: 
11/26/2011 

scripts.jar Date: 
12/09/2006 

 Date: 
12/09/2006 

Date : 12/9/2006 Date: 
12/9/2006 

sdk     Date : 8/18/2010 Date: 
8/18/2010 

src     Date : 8/18/2010 Date: 
8/18/2010 

tasklst.html Date: 
10/01/2009 

Date: 
02/23/2010 

Date : 2/23/2010 Date: 
2/23/2010 

title.gif       Date: 
11/3/2011 

tools.jar   Date: 
04/15/2010 

Date : 4/15/2010 Date: 
4/15/2010 

tsasrv Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
9/23/2011 

tsqssrv_asai   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

tsqssrv_aspct   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

tsqssrv_csta   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

tsqssrv_msi   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

Ui     Date : 8/18/2010 Date: 
8/18/2010 
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util.js.jsp       Date: 
7/14/2011 

vdudasrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

vdusrv   Date: 
04/15/2010 

Date : 9/10/2010 Date: 
6/24/2011 

vespidl.pk Date: 
10/04/2009 
Version: 
7.2.1.14 

Date: 
10/04/2009 
Version: 
7.2.1.14 

Date : 9/9/2010 Date: 9/9/2010 

voxsrv   Date: 
04/15/2010 

Date : 9/24/2010 Date: 
6/24/2011 

waasrv Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/15/2010 

Date : 9/10/2010 Date: 
11/4/2011 

wacdsrv Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 
11/4/2011 

web.xml.template       Date: 
10/31/2011 

WebAgent.jar Date: 
12/01/2009 

Date: 
02/25/2010 

Date : 10/1/2010 Date: 
11/4/2011 

Webchannel   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/18/2011 

WebLM.war       Date: 
6/30/2011 

webservices.war Date: 
09/11/2009 

Date: 
04/15/2010 

Date : 
10/15/2010 

Date: 
10/21/2011 

website.jar     Date : 8/6/2010 Date: 
11/4/2011 

wscallback.jar       Date: 
3/30/2011 
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Server component (AIX)  

The following table lists the files that are installed on the AIX server machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

.project     Date : 
12/21/2008 

Date: 
12/21/2008 

acuity.gif       Date: 
11/3/2011 

admin.jar Date: 
09/11/2009 

Date: 
04/15/2010 

Date : 
10/18/2010 

Date: 
9/30/2011 

Adusrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

answers.gif       Date: 
11/3/2011 

Armsrv Date: 
10/18/2009 
Version: 
7.2.1.15 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

Aspctsrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

Attrsrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
12/9/2011 

avaya-common.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-bridges.jar     Date : 9/10/2010 Date: 
10/21/2011 

avayaiccommon.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-client.jar     Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-common.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-sdk-sample.jar     Date : 9/3/2009 Date: 9/3/2009 
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avaya-ic-sdk-server.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 9/3/2009 Date: 9/3/2009 

avaya-ic-services.jar Date: 
10/04/2009 

Date: 
04/15/2010 

Date : 10/8/2010 Date: 
12/8/2011 

avaya-ic-webservices.jar Date: 
09/11/2009 

Date: 
09/11/2009 

Date : 
10/15/2010 

Date: 
10/15/2010 

avaya-ic-webui.jar Date: 
09/03/2009 

Date: 
09/03/2009 

Date : 
10/19/2010 

Date: 8/5/2011 

Blendersrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

Casrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

chatconnection.jsp       Date: 
7/14/2011 

chatframe.js.jsp       Date: 
7/14/2011 

chatframe.jsp       Date: 
7/14/2011 

chathandler.js.jsp Date: 
10/07/2009 

Date: 
03/10/2010 

Date : 3/10/2010 Date: 
7/14/2011 

chathandler.jsp       Date: 
7/14/2011 

chattranscript.html       Date: 
7/14/2011 

cobrowse.jar     Date : 8/6/2010 Date: 8/6/2010 

collabframe.js.jsp       Date: 
7/14/2011 

collabframe.jsp       Date: 
7/14/2011 

Comhubsrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 
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command.jsp Date: 
08/07/2009 

Date: 
08/07/2009 

Date : 8/7/2009 Date: 
7/14/2011 

CommandScripter   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/25/2011 

constants.jsp Date: 
07/30/2009 

Date: 
07/30/2009 

Date : 7/30/2009 Date: 
7/30/2009 

Controller     Date : 8/18/2010 Date: 
8/18/2010 

COPYRIGHT   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

core.jar Date: 
10/04/2009 

Date: 
04/15/2010 

Date : 8/20/2010 Date: 
6/17/2011 

Cqsconfig   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

CSharptester.csproj     Date : 4/21/2010 Date: 
4/21/2010 

Cvlansrv Date: 
10/18/2009 
Version: 
7.2.1.15 

Date: 
04/14/2010 

Date : 9/16/2010 Date: 
11/3/2011 

Cvlansrv   Date: 
04/14/2010 

Date : 9/16/2010 Date: 
7/14/2011 

Doc     Date : 8/18/2010 Date: 
8/18/2010 

domain_cert_AvayaIC_Server.pe
m 

  Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

domain_key_AvayaIC_Server.pe
m 

  Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

Dssrv   Date: 
04/24/2010 

Date : 
10/21/2010 

Date: 
11/3/2011 

Dustoresrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 
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edit_status_dialog_template_pick
er_ajax.jsp 

      Date: 
9/13/2011 

 
edit_status_dialog_template_pick
er_bottom.jsp 

      Date: 
9/13/2011 

entry.jsp Date: 
10/07/2009 

Date: 
10/07/2009 

Date : 10/7/2009 Date: 
7/14/2011 

fulcrum_updateerr.sh   Date: 
01/05/2010 

Date : 1/5/2010 Date: 1/5/2010 

fulcrum_updateout.sh   Date: 
01/05/2010 

Date : 1/5/2010 Date: 1/5/2010 

htmlarea.js Date: 
10/07/2009 

Date: 
10/07/2009 

Date : 10/7/2009 Date: 
10/7/2009 

htmlchat.html       Date: 
7/14/2011 

Httpvoxsrv Date: 
10/18/2009 
Version: 
7.2.1.15 

Date: 
04/14/2010 

Date : 9/24/2010 Date: 
11/3/2011 

Icadmin   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

Icemailsrv Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/14/2010 

Date : 9/24/2010 Date: 
12/21/2011 

icm.jar Date: 
11/04/2009 
Version: 
7.2.1.18 

Date: 
03/14/2010 

Date : 9/17/2010 Date: 
11/4/2011 

Icmonserver   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

icsdk.war   Date: 
04/15/2010 

Date : 10/8/2010 Date: 
12/8/2011 
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ImcClient.jar       Date: 
8/25/2011 

index.htm       Date: 
7/14/2011 

Jloader   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

joinus.jsp Date: 
08/07/2009 

Date: 
08/07/2009 

Date : 8/7/2009 Date: 8/7/2009 

libADULib.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
9/23/2011 

libagentservlet.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

libapachedatasensor.so       Date: 
11/4/2011 

libapachedatasensor_ihs7.so     Date : 
10/15/2010 

Date: 
10/15/2010 

libapacheplugin.so       Date: 
11/4/2011 

libapacheplugin_ihs7.so     Date : 
10/15/2010 

Date: 
10/15/2010 

libcdk.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/25/2011 

libclusterlib.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

libCtiNmi.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/25/2011 

libDCOBinding.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

libdmdco.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

libiclogdevdco.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 
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libiclogdevfile.so       Date: 
11/4/2011 

libICMBridge.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
12/9/2011 

liblber-2.4.a   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

libldap_r-2.4.a   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

libmttlogger.so       Date: 
11/25/2011 

libmttoolkit.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
12/12/2011 

libpdm.so       Date: 
11/3/2011 

libpdmJavaWrap.so       Date: 
11/3/2011 

libpdmsql.so   Date: 
02/18/2010 

Date : 2/18/2010 Date: 
11/3/2011 

libproactivecontact.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

libqwbsext.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

libqwdc.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/25/2011 

libqwibmdom.so       Date: 
11/3/2011 

libqwlog.so       Date: 
11/3/2011 

libqwrw.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 
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libRMBLib.so Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

libssllib.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

libsttssl.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

libUtilityLib.so Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

libVespBridge.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

libvesporb.so   Date: 
04/14/2010 

Date : 
10/14/2010 

Date: 
11/25/2011 

libwcservlet.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

libWFSLib.so   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

LICENSE   Date: 
02/26/2010 

Date : 9/9/2010 Date: 
2/26/2010 

LICENSE     Date : 2/26/2010 Date: 
11/3/2011 

Licensesrv Date: 
09/03/2009 
Version: 
7.2.1.10 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

Listadu   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

Listvdu   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

logCollectorsrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
7/14/2011 
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Migrateemail   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

mod_jk_ihs7.so     Date : 
10/14/2010 

Date: 
10/14/2010 

Notifysrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

orbsrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

os_fill   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

pagingsrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/4/2011 

poll.js.jsp       Date: 
7/14/2011 

poll.jsp       Date: 
7/14/2011 

pollersrv Date: 
11/19/2009 
Version: 
7.2.1.19 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
12/14/2011 

Qconfig   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

qdb2srv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

quintus.gif       Date: 
11/3/2011 

qworkflow Date: 
09/25/2009 
Version: 
7.2.1.13 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

reportsrv Date: 
09/25/2009 
Version: 
7.2.1.13 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

rlmanager_message.properties       Date: 
10/3/2011 

root_cert_AvayaIC_Client.pem   Date: 
02/26/2010 

Date : 2/26/2010 Date: 
2/26/2010 

sc.xml Date: 
08/13/2009 

Date: 
04/15/2010 

Date : 9/24/2010 Date: 
11/26/2011 

scripts.jar Date: 
12/09/2006 

 Date: 
12/09/2006 

Date : 12/9/2006 Date: 
12/9/2006 

sdk     Date : 8/18/2010 Date: 
8/18/2010 

src     Date : 8/18/2010 Date: 
8/18/2010 

tasklst.html Date: 
10/01/2009 

Date: 
02/23/2010 

Date : 2/23/2010 Date: 
2/23/2010 

title.gif       Date: 
11/3/2011 

tools.jar   Date: 
04/15/2010 

Date : 4/15/2010 Date: 
4/15/2010 

Tsasrv Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
9/23/2011 

tsqssrv_asai   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

Ui     Date : 8/18/2010 Date: 
8/18/2010 

util.js.jsp       Date: 
7/14/2011 

vdudasrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 

vdusrv   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
6/23/2011 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

vespidl.pk Date: 
10/04/2009 

Date: 
10/04/2009 

Date : 9/9/2010 Date: 9/9/2010 

voxsrv   Date: 
04/14/2010 

Date : 9/24/2010 Date: 
6/23/2011 

waasrv Date: 
12/03/2009 
Version: 
7.2.1.20 

Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/3/2011 

wacdsrv Date: 
10/22/2009 
Version: 
7.2.1.17 

Date: 
04/14/2010 

Date : 
10/18/2010 

Date: 
11/4/2011 

web.xml.template       Date: 
10/31/2011 

WebAgent.jar Date: 
12/01/2009 

Date: 
02/25/2010 

Date : 10/1/2010 Date: 
11/4/2011 

Webchannel   Date: 
04/14/2010 

Date : 9/9/2010 Date: 
11/18/2011 

WebLM.war       Date: 
6/30/2011 

webservices.war Date: 
09/11/2009 

Date: 
04/15/2010 

Date : 
10/15/2010 

Date: 
10/21/2011 

website.jar     Date : 8/6/2010 Date: 
11/4/2011 

wscallback.jar       Date: 
3/30/2011 

Siebel Integration component [IC Side] (Windows) 

The following table lists the files that are installed on the Windows machine: 

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

avaya-ic-services.jar Date: 10/04/2009 Date: 04/15/2010 Date : 10/8/2010 Date: 12/8/2011 

asis.jar Date: 08/25/2009 Date: 02/19/2010 Date : 2/19/2010 Date: 2/19/2010 
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File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

eaisrv.exe   Date: 04/15/2010 Date : 9/10/2010 Date: 11/4/2011 

Version: 7.2.4.32 

eaisrv.pdb   Date: 04/15/2010 Date : 9/10/2010 Date: 11/4/2011 

Siebel Integration component [IC Side] (Solaris) 

The following table lists the files that are installed on the Solaris machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

avaya-ic-services.jar Date: 10/04/2009 Date: 04/15/2010 Date : 10/8/2010 Date: 12/8/2011 

asis.jar Date: 08/25/2009 Date: 02/19/2010 Date : 2/19/2010 Date: 2/19/2010 

Eaisrv   Date: 04/15/2010 Date : 9/10/2010 Date: 11/4/2011 

Siebel Integration component [IC Side] (AIX) 

The following table lists the files that are installed on the AIX machine: 

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

avaya-ic-services.jar Date: 10/04/2009 Date: 04/14/2010 Date : 10/8/2010 Date: 12/8/2011 

asis.jar Date: 08/25/2009 Date: 02/19/2010 Date : 2/19/2010 Date: 2/19/2010 

Eaisrv   Date: 04/14/2010 Date : 9/9/2010 Date: 11/3/2011 

Siebel Integration component [Siebel Side] (AIX) 

The following table lists the files that are installed on the Aix machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

libaicd.so Date: 10/18/2009 Date: 04/14/2010 Date : 9/9/2010 Date: 11/3/2011 

AICD.def Date: 08/11/2009 Date: 08/11/2009 Date : 8/11/2009 Date: 8/11/2009 
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Siebel Integration component [Siebel Side] 
(Solaris) 

The following table lists the files that are installed on the Solaris machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

libaicd.so Date: 10/04/2009 Date: 04/15/2010 Date : 9/10/2010 Date: 11/4/2011 

AICD.def Date: 08/11/2009 Date: 08/11/2009 Date : 8/11/2009 Date:  8/11/2009 

Siebel Integration component [Siebel Side] 
(Windows) 

The following table lists the files that are installed on the Windows machine:  

File Name  IC 7.2.1  IC 7.2.2 IC 7.2.3 IC 7.2.4 

aicd.dll Date: 10/04/2009 Date: 04/15/2010 Date : 9/10/2010 Date: 11/4/2011 

Version: 7.2.4.32 

aicd.pdb Date: 10/04/2009 Date: 04/15/2010 Date : 9/10/2010 Date: 11/4/2011 

AICD.def Date: 08/11/2009 Date: 08/11/2009 Date : 8/11/2009 Date: 8/11/2009 

SDK component (Windows)  

The following table lists the files that are installed on the Windows machine:  

File Name  IC 7.2.1  IC 7.2.2 IC7.2.4 

avaya-common.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avayaiccommon.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-common.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-sample.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-server.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 
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File Name  IC 7.2.1  IC 7.2.2 IC7.2.4 

avaya-ic-sdk-client.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-services.jar  Date: 10/04/09 Date: 04/15/2010 Date: 12/8/2011 

avaya-ic-webui.jar  Date: 09/03/09 Date: 09/03/09 Date: 8/5/2011 

icsdk.war  Date: 11/19/09 Date: 04/15/2010 Date: 12/8/2011 

Icm.jar Date: 11/04/09 Date: 03/14/2010 Date: 11/4/2011 

AvayaICSDKClient.dll Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

AvayaICSDKClient.pdb Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

AvayaICSDKClient.xml Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

Com.Avaya.Util.dll Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

Com.Avaya.Util.Messaging.dll Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

Com.Avaya.Util.Messaging.pdb Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

Com.Avaya.Util.pdb Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

CSharptester.pdb Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

CSharptester.exe Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

WebAgent.jar  Date: 12/01/09 Date: 02/25/2010 Date: 11/4/2011 

Controller (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

Doc (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

sdk (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

src (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

Ui (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

SDK component (Solaris) 

The following table lists the files that are installed on the Solaris machine:  

File Name  IC 7.2.1  IC 7.2.2 IC7.2.4 
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File Name  IC 7.2.1  IC 7.2.2 IC7.2.4 

avaya-common.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avayaiccommon.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-common.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-sample.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-server.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-client.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-services.jar  Date: 10/04/09 Date: 04/15/10 Date: 12/8/2011 

avaya-ic-webui.jar  Date: 09/03/09 Date: 09/03/09 Date: 8/5/2011 

icsdk.war  Date: 11/19/09 Date: 04/15/10 Date: 12/8/2011 

Icm.jar Date: 11/04/09 Date: 03/14/10 Date: 11/4/2011 

WebAgent.jar  Date: 12/01/09 Date: 02/25/10 Date: 11/4/2011 

Controller (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

Doc (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

sdk (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

src (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

Ui (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

SDK component (AIX)  

The following table lists the files that are installed on the Aix machine:  

File Name IC 7.2.1  IC 7.2.2 IC7.2.4 

avaya-common.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avayaiccommon.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-common.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-sample.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 



  

Copyright 2012 Avaya Inc. All rights reserved. 
Use pursuant to the terms of your signed agreement or Avaya policy. 346 

File Name IC 7.2.1  IC 7.2.2 IC7.2.4 

avaya-ic-sdk-server.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-sdk-client.jar  Date: 09/03/09 Date: 09/03/09 Date: 09/03/09 

avaya-ic-services.jar  Date: 10/04/09 Date: 04/15/10 Date: 12/8/2011 

avaya-ic-webui.jar  Date: 09/03/09 Date: 09/03/09 Date: 8/5/2011 

icsdk.war  Date: 11/19/09 Date: 04/15/10 Date: 12/8/2011 

Icm.jar Date: 11/04/09 Date: 03/14/10 Date: 11/4/2011 

WebAgent.jar  Date: 12/01/09 Date: 02/25/10 Date: 11/4/2011 

Controller (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

Doc (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

sdk (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

src (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 

Ui (folder)  Date: 11/23/09 Date: 11/23/09 Date: 5/3/2011 
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Technical Support 
If you are having trouble with IC 7.2.4, you should: 

1. Retry the action. Carefully follow the instructions in written or online documentation. 

2. Check the documentation that came with your hardware for maintenance or hardware-related problems. 

3. Note the sequence of events that led to the problem and the exact messages displayed. Have the Avaya 
documentation available. 

4. If you continue to have a problem, contact Avaya Technical Support by: 

5. Logging in to the Avaya Technical Support Web site http://www.avaya.com/support   

6. Calling or faxing Avaya Technical Support at one of the telephone numbers in the Support Directory 
listings on the Avaya support Web site. 

You may be asked to email one or more files to Technical Support for analysis of your application and its 
environment. 

Note: If you have difficulty reaching Avaya Technical Support through the above URL or email address, 
please go to http://www.avaya.com for further information. 

Avaya Global Services Escalation Management provides the means to escalate urgent service issues. For 
more information, see the Escalation Contacts listings on the Avaya Web site. 

For information about patches and product updates, see the Avaya Technical Support Web site 
http://www.avaya.com/support. 

 

 

 

 

 

 

 

 

 

 

 

  

http://www.avaya.com/support
http://support.avaya.com/css/appmanager/public/support?_nfpb=true&_pageLabel=Support_Directory_Public
http://www.avaya.com/
http://support.avaya.com/selfservice/microsites/searchEntry.do?cmd=displayKC&docType=kc&externalId=KB01049053&sliceId=SAL_ARCHIVED_2_8&dialogID=49798893&stateId=1%25200%252049776801
http://www.avaya.com/support
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